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hinweise finden Sie in der BASIS-BEDIENUNGS-
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Vielen Dank, dass Sie dieses Icom-Produkt erworben haben. Wir haben dieses Gerät mit unserer erstklassigen 
Technologie in hervorragender Verarbeitungsqualität gefertigt. Bei richtiger Benutzung sollte es jahrelang einwand-
frei funktionieren.

Dieses Produkt kombiniert traditionelle analoge Technologien mit neuer digitaler Technologie, Digital Smart Tech-
nologies for Amateur Radio (D-STAR), in einem ausgewogenem Verhältnis.

HANDBÜCHER (Stand November 2021)

Folgende Handbücher können zum Verständnis und zur Bedienung des Handfunkgeräts genutzt werden.
 LEin Glossar mit englischen Begriffen aus dem Amateurfunk kann man bei Bedarf von der Icom-Website herunterladen.

TIPP: Alle Anleitungen stehen auf der Icom-Website zum Herunterladen bereit.
https://www.icomeurope.com/support/
Geben Sie „ID-52A“ in das Suchfeld der Seite ein.

Basis-Bedienungsanleitung (wie mitgeliefert)

Anleitung für den grundlegenden Betrieb sowie  
Sicherheitshinweise.
Die D-STAR-ANLEITUNG erläutert die Registrierung 
des Rufzeichens bei einem Gateway-Repeater und 
den grundlegenden D-STAR-Betrieb.

Erweiterte Bedienungsanleitung (diese Anleitung)

 • Zubehör anbringen
 • Nutzung einer Micro-SD-Karte
 • Akkupack laden
 • Betrieb als FM-Rundfunkempfänger
 • Erweiterter D-STAR-Betrieb
 • Erweiterter GPS-Betrieb
 • Sendesprachspeicher
 • Aufzeichnungsfunktion
 • Speicherbetrieb
 • Suchlaufbetrieb
 • Repeater- und Duplexbetrieb
 • Set-Modus
 • Bluetooth®-Betrieb
 • Share-Pictures-Funktion
 • Weitere Funktionen
 • Update der Firmware
 • Zubehör

CI-V Reference Guide (PDF-Datei)

Englische Beschreibung der beim Fernsteuerungsbe-
trieb verwendeten CI-V-Steuerbefehle.

About the DV Gateway function (PDF-Datei)

Hinweise zu den Systemanforderungen und Bedie-
nung bei Nutzung der DV-Gateway-Funktion.

Updating the repeater list (PDF-Datei)

Schritt-für-Schritt-Anleitung zur Aktualisierung der 
Repeater-Liste.

Using the GPS Logger function (PDF-Datei)

Bedienungsanleitung für die GPS-Logger-Funktion  
zum Speichern von Positionsdatendaten eines 
GPS-Empfängers als Logdatei auf einer Micro-SD- 
Karte.

HANDELSMARKEN
Icom, Icom Inc. und das Icom-Logo sind registrierte Marken der Icom Inc. (Japan) in Japan, in den Vereinigten Staaten, im Ver-
einigten Königreich, in Deutschland, Frankreich, Spanien, Russland, Australien, Neuseeland und/oder in anderen Ländern.
Die Bluetooth®-Wortmarke und das Logo sind registrierte Marken der Bluetooth SIG, Inc. Icom Inc. hat die Lizenz für die Nut-
zung dieser Marken.
Adobe, Acrobat und Reader sind registrierte Marken oder Marken der Adobe Systems Incorporated in den Vereinigten Staaten 
und/oder in anderen Ländern.
APRS® ist eine registrierte Marke von Mr. Bob Bruninga in den Vereinigten Staaten und/oder in anderen Ländern.
Microsoft und Windows sind Marken der Microsoft-Unternehmensgruppe.
Google, das Google-Logo, Google Play, das Google-Play-Logo, Android und das Android-Logo sind Marken der Google LLC.
IOS ist eine Marke oder eingetragene Marke von Cisco in den USA und anderen Ländern und wird unter Lizenz verwendet.
iPadOS ist eine Marke von Apple Inc.
App Store ist eine Dienstleistungsmarke von Apple Inc.
Alle anderen Marken sind Eigentum der jeweiligen Markeninhaber.
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ADOBE®-ACROBAT®-READER®-FUNKTIONEN    
Nützliche Funktionen des Adobe® Acrobat® Reader® bei der Arbeit mit diesem PDF:

 • Stichwortsuche
Im Edit-Menü „Find (Ctrl+F)“ oder 
„Advanced Search (Shift+Ctrl+F)“ 
anklicken, um ein Suchfenster zu 
öffnen. Dies ist nützlich, wenn Sie 
nach einem bestimmten Wort oder 
einer Phrase in diesem Handbuch 
suchen.

 LDie Menüdarstellung kann je nach 
Adobe-Acrobat-Reader-Version ab-
weichen.

Klicken, um das Suchfenster oder
das Fenster für die erweiterte Suche 
zu öffnen.

 • Suchfenster

 • Fenster für die erweiterte Suche

 • Ausdrucken gewünschter Seiten
Im Edit-Menü „Find (Ctrl+F)“ oder „Advanced Search 
(Shift+Ctrl+F)“ anklicken, um ein Suchfenster zu 
öffnen. Dies ist nützlich, wenn Sie nach einem be-
stimmten Wort oder einer Phrase in diesem Hand-
buch suchen.

 LDie Menüdarstellung kann je nach Adobe-Acrobat- 
Reader-Version abweichen.
 LFür einen Ausdruck in Originalgröße „A4“ wählen.

 • Vorlesefunktion
Mit dieser Funktion kann man sich den Text
dieser PDF-Datei vorlesen lassen.
Details dazu finden sich in der Adobe-
Acrobat-Reader-Hilfe.
(Diese Funktion ist je nach PC-Konfiguration
und Betriebssystem evtl. nicht verfügbar.)

 LDie Menüdarstellung kann je nach Adobe-Acrobat-Reader-Version abweichen.
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TEXT EINGEBEN UND BEARBEITEN

Bedienelemente für die Texteingabe Zeichentyp ändern
1. Bei ausgewähltem Text oder gewählter Einfüge-

position [QUICK] drücken.
2. Mit [DIAL] einen Zeichentyp wählen und mit [ENT] 

bestätigen. 

Zeichen-
typ

wählbare Zeichen und  
Symbole

Zeichen-
umwandlung

ABC A bis Z, 0 bis 9, (Leerzeichen) A/a

abc a bis z, 0 bis 9, (Leerzeichen) A/a

123 0 bis 9, (Leerzeichen) –

!“#
! „ # $ % & ’ ( ) * + , - . / : ; < = 

> ? @ [ \ ] ^ _ ` { | } ˜  
(Leerzeichen)

–

TIPP: Wenn „ABC“ oder „abc“ als Zeichentyp  
gewählt ist, kann man während der Texteingabe 
[QUICK] drücken, um zwischen Groß- und Klein-
schreibung umzuschalten.

[QUICK] drücken

 • Zum Eingeben eines Textes den Cursor an die Ein-
gabestelle bewegen und dann [DIAL] drehen oder 
die Navigationstasten () drücken.

 • Zum Löschen eines Zeichens [CLR] drücken.
 • Um mehrere Zeichen nacheinander zu löschen, 
[CLR] gedrückt halten.

Zeichen durch Drehen 
von [DIAL] wählen

mit [ENT]
übernehmen

Cursor nach links
bewegen

Cursor nach rechts
bewegen

abbrechen löschen

Zeichen
wählen

öffnet das Fenster  
für die Wahl des  
Eingabemodus

Zeichen wählen
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NUTZBARE ZEICHEN
Die nutzbaren Zeichen und Symbole, sowie deren maximale Anzahl unterscheiden sich je nach Verwendung.  
Details siehe untenstehende Tabelle.

 LDie verwendbaren Zeichen und Symbole jedes Zeichentyps sind unten beschrieben.

Kategorie Verwendung Zeichentyp
maximale

Zeichenzahl
Information

FM-Rundfunk-
speicher

Gruppenname [ABC] [abc] [123] [!“#] 16 –

Name [ABC] [abc] [123] [!“#] 16 –

Speicherkanal
Gruppenname [ABC] [abc] [123] [!“#] 16 –

Name [ABC] [abc] [123] [!“#] 16 –

Anrufkanal Name [ABC] [abc] [123] [!“#] 16

Stationsrufzeichen
Name [ABC] [abc] [123] [!“#] 16 –

Rufzeichen A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

Repeater-Liste

Gruppenname [ABC] [abc] [123] [!“#] 16 –

Name [ABC] [abc] [123] [!“#] 16 –

Sub-Name [ABC] [abc] [123] [!“#] 8 –

Rufzeichen A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

Gateway-Rufzeichen A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

GPS-Sendemodus

Unproto Address [ABC] [abc] [123] [!“#] 56
in der Regel 12 Zeichen
(API52,DSTAR*)

Kommentar [ABC] [abc] [123] [!“#] 43
Die Anzahl der möglichen Zeichen 
hängt von der Datenerweiterung 
und der Angabe der Höhe ü. NN ab.

Objektname/ 
Item-Name

[ABC] [abc] [123] [!“#] 9 –

GPS-Mitteilung [ABC] [abc] [123] [!“#] 20 –

GPS-Speicher
Gruppenname [ABC] [abc] [123] [!“#] 16 –

Name [ABC] [abc] [123] [!“#] 16 –

Programmsuchlauf 
mit Eckfrequenzen

Name [ABC] [abc] [123] [!“#] 16 –

Program Link Program-Link-Name [ABC] [abc] [123] [!“#] 16 –

„Call Sign“-Display

UR A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

R1 A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

R2 A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

eignes Rufzeichen Rufzeichen A bis Z, 0 bis 9, /, (Leerzeichen) 12 (+1)
einschließlich „/“ zwischen
Rufzeichen und Notizfeld

eigene Station TX-Mitteilung [ABC] [abc] [123] [!“#] 20 –

DTMF-Speicher DTMF-Code 0 bis 9, A, B, C, D, *, # 24 –

SD-Karte

Einstellung  
speichern

[ABC] [abc] [123] [!“#] 23
unzulässige Zeichen:
/ : ; * < >

Export [ABC] [abc] [123] [!“#] 23
unzulässige Zeichen:
/ : ; * < >

Bluetooth Gerätename [ABC] [abc] [123] [!“#] 9 außer „ICOM BT“

DR-Display
Direkteingabe (UR) A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

Direkteingabe (RPT) A bis Z, 0 bis 9, /, (Leerzeichen) 8 –

[ABC]: A bis Z, 0 bis 9, (Leerzeichen)
[abc]: a bis z, 0 bis 9, (Leerzeichen)
[123]: 0 bis 9, (Leerzeichen)
[!“#]: ! „ # $ % & ’ ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜ (Leerzeichen)
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TEXTEINGABE
Beispiel: „Calling“ als Speichername eingeben.

[MENU] > MEMORY > Memory CH

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Memory CH“ wählen.
4. Gruppe mit dem zu bearbeitenden Speicherkanal 

wählen.
5. Mit [DIAL] einen Speicherkanal wählen. 

6. [QUICK] drücken.
7. „Edit“ wählen. 

 • Das Editierdisplay erscheint.
8. „NAME“ wählen. 

9. [QUICK] drücken.
10. Zeichentyp wählen. 

 LFür die Verwendung von Symbolen „!"#“ wählen.

11. Mit [DIAL] ein Zeichen wählen, dann [ENT] drücken. 

 L Information
 • Um den Cursor nach rechts zu bewegen, rechte 
Navigationstaste () drücken.

 • Um den Cursor nach links zu bewegen, linke  
Navigationstaste () drücken.

 • Zum Einfügen eines Zeichens den Cursor an die  
Einfügeposition bewegen und dann [DIAL] drehen.

 • Zum Löschen eines Zeichens [CLR] drücken.
 • Um mehrere Zeichen nacheinander zu löschen, 
[CLR] gedrückt halten.

 • Wenn „ABC“ oder „abc“ als Zeichentyp gewählt 
ist, kann man während der Texteingabe [QUICK] 
drücken, um zwischen Groß- und Kleinschreibung 
umzuschalten.

12. Schritte 9 bis 11 wiederholen, bis der Name  
eingegeben ist und mit [ENT] bestätigen. 

 • Rückkehr zum Editierdisplay, der eingegebene Name 
wird angezeigt.

13.  „<<OverWrite>>“ wählen. 

 • Ein Bestätigungsdialog erscheint.
14. „YES“ wählen. 

 • Der Speichername ist überschrieben.
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Akkupack anbringen/abnehmen

Das Anbringen und Abnehmen des Akkupacks oder 
des Batteriebehälters erfolgt wie unten abgebildet. 
Details zum Batteriebehälter sind auf S. 3-8 zu 
finden.

 LZum Anbringen den Akkupack in Pfeilrichtung 1 einset-
zen, leicht nach unten drücken und dann in Pfeilrichtung 
2 einrasten.
 LVor dem Abnehmen des Akkupacks ist das Handfunk-
gerät auszuschalten.

Antenne anbringen

Setzen Sie die Antenne auf den SMA-Antennen-
anschluss und drehen Sie sie vorsichtig fest.

TIPP: Antennen mit hohem Gewinn von anderen 
Anbietern können die Leistung des Handfunkgeräts 
steigern. Mit dem optionalen Antennenanschluss-
adapter AD-92SMA lassen sich auch Antennen mit 
BNC-Anschluss verwenden. (S. 17-2)

HINWEIS:
 • Auch wenn das Handfunkgerät ausgeschaltet ist, 
nimmt es einen geringen Ruhestrom auf. Daher 
sollte man bei längerer Nichtbenutzung den Akku-
pack bzw. den Batteriebehälter abnehmen. An-
dernfalls werden der Akkupack oder die Batterien 
im Batteriebehälter langsam entladen.

 • Sinkt die Temperatur unter 0°C, setzt die Akku-
schutzfunktion automatisch die Sendeleistung 
des Handfunkgeräts auf die geringste Stufe Low1 
(0,5 W). Die Sendeleistungsstufen High, Mid und 
Low2 sind nicht mehr verfügbar.

Akkupack oder
Batteriebehälter

Anbringen Abnehmen
Antenne
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Handschlaufe befestigen

Führen Sie die Handschlaufe durch die Öse und zie-
hen Sie das lange Ende durch die kleine Schlaufe, wie 
in der Abbildung gezeigt.

Gürtelclip befestigen/entfernen

Um den Gürtelclip zu befestigen oder zu entfernen, 
ist zunächst der Akkupack oder der Batteriebehälter – 
falls angebracht – abzunehmen (S. 1-2) Siehe unten 
stehende Abbildung.
Zum Befestigen den Gürtelclip in Pfeilrichtung ein-
schieben, bis er mit einem Klick hörbar einrastet.
Zum Entfernen den Gürtelclip anheben (1) und in 
Pfeilrichtung herausziehen (2).

Befestigen

 RWARNUNG! NIEMALS das Handfunkgerät mit 
der Handschlaufe herumschleudern. Das kann Sie 
oder andere Personen verletzen.

Gürtelclip

Akkupack oder
Batteriebehälter

Entfernen

Lasche

Handschlaufe
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NUTZUNG EINER MICRO-SD-KARTE

HINWEIS: Informationen zum Ein-
setzen und Entnehmen einer Micro- 
SD-Karte sowie weitere Hinweise 
finden Sie in der Basis-Bedienungs-
anleitung, im Abschnitt 6.
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Daten auf der Micro-SD-Karte

Folgende Daten lassen sich auf der Micro-SD-Karte speichern:

 • Einstellungen des Handfunkgeräts
 • Kommunikationsinhalte, Empfangslogdatei
 • Automatische Sprachantwort für den DV-Modus
 • Sprachaufzeichnung für die Sprachsendefunktion
 • Weitere Sprachaufzeichnungen
 • Displayfotos
 • Speicherkanalinhalte
 • FM-Radiospeicher

 • Rufzeichenspeicher (UR)
 • Repeater-Liste
 • GPS-Speicher
 • Empfangene GPS-Daten
 • Bilder für die Share-Pictures-Funktion
 • Bildersende- und -empfangs-History
 • Bilder zur Verwendung als Startbild

Einstellungen auf der Micro-SD-Karte speichern

Speicherkanäle, Einstellungen und die Repeater-Liste 
lassen sich auf der Micro-SD-Karte speichern.
Mithilfe dieser Daten ist die vorherige Konfiguration 
des Handfunkgeräts wiederherstellbar, selbst wenn 
ein Total-Reset durchgeführt wurde.

Man kann die Einstellungsdaten als neue Datei spei-
chern oder eine vorhandene Datei überschreiben.

 DAls neue Datei speichern
[MENU] > SET > SD Card > Save Setting

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen.  

3. „Save Setting“ wählen. 

4. <<New File>>“ wählen. 

 • Die Datei wird nach folgendem Schema benannt: 
Setyyyymmdd_xx 
yyyy: Jahr, mm: Monat, dd: Tag, xx: Dateinummer.
 LZum Ändern des Dateinamens s. S. 2-3.

5. [ENT] drücken. 

 • Ein Bestätigungsfenster öffnet sich.
6. „YES“ wählen. 

 • Während des Speicherns wird ein Fortschrittsbalken 
angezeigt. Wenn der Speichervorgang abgeschlossen 
ist, erscheint das „SD Card“-Display.
 LZum Verlassen die [MENU]-Taste drücken.

Eine vorhandene Datei überschreiben:
Wählen Sie die zu überschreibende Datei in Schritt 4 
auf der linken Seite aus.
 

TIPP:
 • Das Speichern der Daten erfolgt im ICF-Format. Diese 
Daten lassen sich auf den PC kopieren und dort mit der 
Programmiersoftware CS-52 bearbeiten.

 • Wenn bei „Save Form“ als Speicherformat eine frühere 
Firmware-Version eingestellt ist, erscheint nach Schritt 4 
ein Abfragefenster. Zum Bestätigen ist „YES“ zu wählen.
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Speichern mit einem anderen Dateinamen

[MENU] > SET > SD Card > Save Setting

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen.  

3. „Save Setting“ wählen. 

4. <<New File>>“ wählen. 

5. Zum Löschen der Zeichen [CLR] gedrückt halten. 

6. Dateinamen eingeben und mit [ENT] bestätigen. 

 LHinweise zur Zeicheneingabe s. S. iii.
7. „YES“ wählen. 

 • Während des Speicherns wird ein Fortschrittsbalken 
angezeigt. Wenn der Speichervorgang abgeschlossen 
ist, erscheint das „SD Card“-Display.
 LZum Verlassen die [MENU]-Taste drücken.
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Dateien von der Micro-SD-Karte laden

Speicherkanäle und Einstellungen lassen sich von der 
Micro-SD-Karte in das Handfunkgerät laden. 
Damit kann man z. B. Speicherkanäle oder die Re-
peater-Liste auf ein anderes ID-52E kopieren und mit 
denselben Daten arbeiten.

HINWEIS: Es wird empfohlen, die aktuellen Daten 
zu sichern, bevor andere Daten in das Handfunk-
gerät geladen werden.

Beispiel:  Alle Daten aus der Datei „Set20211101_01“ 
laden.

[MENU] > SET > SD Card > Load Setting

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen.  

3. „Load Setting“ wählen. 

4. Zu ladende Datei wählen. 

5. Zu ladende Inhalte wählen. 

 • ALL: 
Lädt alle Speicherkanäle, die im MENÜ vorge-
nommenen Einstellungen und die Repeaterliste 
in das Handfunkgerät.

 • Except My Station: 
Lädt alle Speicherkanäle und die im MENÜ vor-
genommenen Einstellungen außer eigene Ruf-
zeichen (MY call signs) und die Repeater-Liste.

 • Repeater List Only: 
Lädt nur die Repeater-Liste

6. „YES“ oder „NO“ wählen. 

 • YES: 
Die Übersprungeinstellungen der Repeater- 
Liste bleiben erhalten.

 • NO: 
Die Übersprungeinstellungen der Repeater- 
Liste werden gelöscht.

7. „YES“ wählen. 

 • Das Prüfen und Laden der Daten beginnt.
 • Nach dem erfolgreichen Laden erscheint  
„COMPLETED!“ im Display. 

8. Um mit den neuen Einstellungen zu arbeiten, 
muss das Handfunkgerät neu gestartet werden.
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Back-up der Micro-SD-Karte auf einem PC erstellen

Eine Sicherungskopie ermöglicht die Wiederher-
stellung von Daten, falls diese versehentlich gelöscht 
wurden.

ID-52 Capture

Csv MemoryCh

GpsMemory

RptList

Picture

Voice yyyymmdd

yyyymmdd

VoiceTx

QsoLog

Reply

RxLog

Setting

Private Rx

Tx

OpeningPicture

RadioMemory

YourMemoryGps

yyyymmdd

yyyymmdd

VoiceRec

 • ID-52 
Vom Handfunkgerät erzeugte Ordner werden im 
Ordner „ID-52“ gespeichert.

 • Capture 
Displayfotos im PNG- oder BMP-Format.

 • Csv 
Ordner für Repeater-Liste, Rufzeichenspeicher 
(UR), GPS-Speicher usw.

 DOrdnerstruktur auf der Micro-SD-Karte
Die Ordner auf der Micro-SD-Karte sind folgender-
maßen strukturiert:

 • GpsMemory 
GPS-Speicher im CSV-Format.

 • MemoryCh 
Speicherkanalinhalte im CSV-Format.

 • RadioMemory 
FM-Radio-Speicherinhalte im CSV-Format.

 • RptList 
Repeater-Liste im CSV-Format.

 • YourMemory 
„Your Call Sign“-Speicher (UR) im CSV-Format.

 • Gps 
GPS-Logdatei im LOG-Format.

 • OpeningPicture 
Bilder im BMP-Format für die Nutzung als Start-
bild.

 • Picture 
Bilder im JPG-Format, die mit der Share-Pictures- 
Funktion genutzt werden.

 • Private 
Bildempfangs- und -sende-History.

 • Rx 
Bildempfangs-History im DAT-Format.

 L Inhalte der Bildempfangs-History werden auf dem PC 
nicht angezeigt.

 • Tx 
Bildsende-History im DAT-Format.

 L Inhalte der Bildsende-History werden auf dem PC 
nicht angezeigt.

 • QsoLog 
QSO-Logdaten im CSV-Format.

 • Reply 
Audiodatei für die automatische Antwortfunktion im 
WAV-Format.

 • RxLog 
Empfangslogdatei im CSV-Format.

 • Setting 
Einstellungen des Handfunkgeräts im ICF-Format

 • Voice 
Ordner mit Audiodateien von QSOs nach Datum.

 • VoiceRec 
Ordner mit aufgezeichneten Audiodateien nach 
Datum.

 • yyyymmdd 
Aufgezeichnete Audiodateien im WAV-Format.

 • VoiceTx 
Sprachaufzeichnungen für die Voice-TX-Funktion 
im WAV-Format.
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Back-up der Micro-SD-Karte auf einem PC erstellen

 DBack-up auf dem PC
Diese Anleitung basiert auf dem Betriebssystem 
Windows® 10 (englisch).

1. Micro-SD-Karte in den Karten-Slot oder ein Spei-
cherkartenlesegerät am PC einsetzen.

2. „Open folder to view files“ anklicken, um auf die 
Karte zuzugreifen. 

Klick

 • Der Ordner „ID-52“ wird angezeigt.
3. Mit einem Rechtsklick auf „Removable disk“ das 

Kontextmenü öffnen.
4. „Copy“ anklicken. 

5. Ordner öffnen, in den die Back-up-Datei kopiert 
werden soll. Mit einem Rechtsklick das Kontext-
menü öffnen und dort auf „Paste“ klicken.

 • Die Daten werden von der Micro-SD-Karte auf den 
PC kopiert.

  (Beispiel:  Daten in den Ordner „Backup“ auf dem 
Laufwerk „C“ kopieren)

  

6. Zum Entnehmen der Micro-SD-Karte klickt man 
zuerst auf das Symbol  in der Startleiste, s. u., 
und anschließend auf „Eject Removable Disk“. 

7. Wenn die Anzeige „Safe To Remove Hardware“ 
erscheint, kann die Micro-SD-Karte entnommen 
werden. 

TIPP: Wenn bei „USB Connect“ die Einstellung  
„SD Card Mode“ gewählt wurde und das Handfunk-
gerät über ein USB-Datenkabel mit dem PC ver-
bunden ist, kann man vom PC aus direkt auf die im 
Handfunkgerät eingesetzte Micro-SD-Karte  
zugreifen.  
([MENU] > SET > Function > USB Connect)

Rechtsklick

Klick

Klick

Klick
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Importieren oder Exportieren einer CSV-Datei

Die folgenden Ausführungen sind zu beachten, be-
vor man Dateien im CSV-Format (Comma Separated 
Values) von der Micro-SD-Karte im- oder exportiert.
Folgende Daten lassen sich im- bzw. exportieren:

 • Speicherkanäle
 • FM-Radiospeicher
 • „Your Call Sign“-Rufzeichenspeicher
 • Repeater-Liste
 • GPS-Speicher

 DImportieren

HINWEIS:
 • Es wird empfohlen, vor dem Importieren die auf  
dem Handfunkgerät vorhandenen Daten auf einer  
Micro-SD-Karte zu sichern.

 • Das Handfunkgerät kann nur Dateien mit einem bis 
zu 23 Zeichen langen Dateinamen anzeigen. Längere 
Dateinamen sind entsprechend zu kürzen. Achten Sie 
auch darauf, wenn Sie mit der Programmiersoftware 
CS-52 Dateien im CSV-Format exportieren.

Beispiel:  Importieren des „Your Call Sign“- 
Rufzeichenspeichers.

[MENU] > SET > SD Card > Import/Export > Import

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen.  

3. „Import/Export“ wählen. 

4. „Import“ wählen. 

5. „Your Call Sign“ wählen. 

6. Zu importierende CSV-Datei wählen. 

 • Ein Bestätigungsfenster öffnet sich.

TIPP: Beim Importieren einer Repeater-Liste 
erscheint die Abfrage „Keep ,SKIP‘ settings in 
Repeater List?“. Details dazu sind auf S. 2-4 
zu finden.

7. „YES“ wählen. 

 • Der Import startet.
 • Nach dem erfolgreichen Import erscheint  
„COMPLETED!“ im Display. 

8. Zum Übernehmen der importierten Daten muss 
das Handfunkgerät aus- und wieder eingeschaltet 
werden.
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Importieren oder Exportieren einer CSV-Datei

 DExportieren
Als neue Datei speichern:
Beispiel:  Exportieren des „Your Call Sign“- 

Rufzeichenspeichers.

[MENU] > SET > SD Card > Import/Export > Export

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen.  

3. „Import/Export“ wählen. 

4. „Export“ wählen. 

5. „Your Call Sign“ wählen. 

6. <<New File>>“ wählen. 

 • Das „FILE NAME“-Display wird angezeigt..
 LDie Datei ist nach folgendem Schema benannt: 
Your*yyyymmdd_xx 
yyyy: Jahr, mm: Monat, dd: Tag, xx: Dateinummer. 
*  Bei anderen Einstellungen beginnt der Dateiname 

folgendermaßen: 
Memory CH: „Mch“ 
FM Radio Memory: „Radio“ 
Repeater List: „Rpt“ 
GPS Memory: „Gps“ 

 LHinweise zur Zeicheneingabe s. S. iii.
7. [ENT] drücken. 

 • Ein Bestätigungsfenster öffnet sich.
8. „YES“ wählen. 

 • Die Einstellungsdaten werden exportiert.
 LZum Verlassen die [MENU]-Taste drücken.

Eine vorhandene Datei überschreiben:
Dazu ist die zu überschreibende Datei in Schritt 6 
auszuwählen. 
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SD-Kartenmodus

Wenn bei „USB Connect“ die Einstellung „SD Card 
Mode“ gewählt wurde und das Handfunkgerät über 
ein USB-Datenkabel mit dem PC verbunden ist, kann 
man vom PC aus direkt auf die im Handfunkgerät ein-
gesetzte Micro-SD-Karte zugreifen.
So lassen sich die auf der Micro-SD-Karte gespei-
cherten Einstellungs- und Audiodaten auf einem PC 
sichern und Bilder für die Share-Pictures-Funktion  
sowie die Firmware-Daten auf die Micro-SD-Karte 
übertragen, ohne sie umzustecken.

[MENU] > SET > Function > USB Connect

1. Handfunkgerät und PC mittels USB-Datenkabel 
verbinden.

2. [MENU] drücken.
3. Im „SET“-Menü den Menüpunkt „Function“  

wählen.
4. „USB Connect“ wählen. 

5. „SD Card Mode“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
6. „YES“ wählen. 

HINWEIS: Bevor man das Handfunkgerät im 
SD-Kartenmodus mittels USB-Kabel an einen PC 
anschließt, muss eine Micro-SD-Karte eingesetzt 
werden.

 LSollte sich die Micro-SD-Karte nicht im Handfunkgerät 
befinden, so ist sie bei ausgeschaltetem Handfunkgerät 
einzusetzen und das USB-Kabel erneut anzuschließen.

TIPP: Im SD-Kartenmodus arbeitet das Handfunk-
gerät als Datenspeicher, was einige Funktionen 
beeinflusst:

 • Die Aufzeichnung wird beendet.
 • GPS- und Empfangs-Logfunktion pausieren.
 • Die Bluetooth-Verbindung wird getrennt.
 • Die Auto-Power-Off-Funktion wird deaktiviert.

Verlassen des SD-Kartenmodus:
 LDiese Anleitung basiert auf dem Betriebssystem  
Windows® 10 (englisch).

1. In der Taskleiste auf das Symbol „ “ klicken.
2. Auf „Eject Device“ klicken.
3. Wenn die Anzeige „Safe To Remove Hardware“ 

erscheint, kann das USB-Kabel vom PC ge-
trennt werden.
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Speicherplatz und Aufnahmezeit der Micro-SD-Karte prüfen

[MENU] > SET > SD Card > SD Card Info

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen. 
3. „SD Card Info“ wählen. 

 • Der freie Speicherplatz auf der Micro-SD-Karte und 
die verbleibende Aufnahmezeit werden angezeigt.
 LZum Verlassen die [MENU]-Taste drücken.
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Informationen zum Akkupack

 DBetriebsdauer
Für die Berechnung der unten angegebenen Betriebs-
dauer wurden folgende Bedingungen zugrunde ge-
legt:

 • Batteriesparfunktion: Auto (Short)
 • Verhältnis der Betriebszustände: 
TX : RX : Stand-by = 1 : 1 : 8  
(Variiert je nach konkreter Benutzung.)

Betriebszeit je Akkuladung:

Akkupack FM-Modus

BP-271 etwa 4,25 Stunden

BP-272 etwa 7,25 Stunden

BP-307 etwa 12 Stunden

 LDie Betriebszeit mit dem optionalen Batterie-
behälter BP-273 ist auf S. 3-8 angegeben.

HINWEIS: ERSETZEN SIE den Akkupack nach 
etwa 5 Jahren ab Produktionsdatum, selbst wenn 
er noch die volle Kapazität zu haben scheint. Das 
Material im Akku verändert sich mit zunehmendem 
Alter, auch wenn der Akkupack nur wenig in Ge-
brauch war. Akkupacks lassen sich etwa 300- bis 
500-mal laden, bevor ihre Kapazität so weit nach-
lässt, dass Ersatz beschafft werden muss. Dies zeigt 
sich auch daran, dass ein vermeintlich voll gelade-
ner Akkupack nicht mehr die spezifizierte Betriebs-
dauer erreicht.

TIPP: Batteriekontakte sauber halten und des Öfte-
ren reinigen.

 DAnzeige des Ladezustands
Wenn der Akkupack in das Handfunkgerät eingesetzt 
ist, wird sein Ladezustand mit dem Symbol „ “ 
angezeigt.

Symbol Ladezustand

Akkupack wird geladen.

Akkupack besitzt seine volle Kapazität.

Akkupack ist etwas entladen.

(grün)
Akkupack nähert sich seiner  
Entladung.

(rot)

Akkupack ist weitgehend entladen.
 LAkkupack unverzüglich aufladen. Wird er 
nicht aufgeladen, fängt das Symbol nach 
kurzer Zeit an zu blinken, „LOW BATTERY“ 
erscheint im Display und das Handfunk-
gerät schaltet sich automatisch aus.

keine  
Anzeige

Bei angeschlossener 
Gleichspannungs versorgung (12 V) 
wird der Akkupack nicht geladen, 
wenn:

 • der Akkupack bereits geladen ist.
 • bei „Charging (Power ON)“ die Einstellung 
„OFF“ gewählt wurde.

 LBeim Einsatz des Batterie behälters BP-273 lässt sich der  
Zustand der Alkaline-Batterien nicht ermitteln. Als Lade-
symbol wird dauerhaft „ “ angezeigt, dies sagt nichts 
über die tatsächliche Batteriekapazität aus.

Korrekten Ladezustand anzeigen
Im folgenden Menüpunkt ist der eingesetzte Akku-
pack zu wählen. (voreingestellt: BP-271/BP-272)
([MENU] > SET > Function > Battery Pack Select)

Um das Dialogfeld für die Akkuauswahl immer dann 
anzuzeigen, wenn der Akkupack gewechselt wird, wählt 
man beim folgenden Menüpunkt die Option „ON“.
([MENU] > SET > Function > Battery Pack Confirmation)
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Laden des Akkupacks

HINWEIS:
 • Vor der ersten Benutzung des Handfunkgeräts 
muss der Akkupack vollständig geladen werden, 
damit er eine möglichst lange Lebensdauer er-
reicht.

 • Das Handfunkgerät MUSS beim Laden im mit-
gelieferten Ladegerät ausgeschaltet sein, da der 
eingesetzte Akkupack sonst nicht geladen wird.

 LWährend des Ladens erscheinen das Symbol  
und die Anzeige „Charging....“ im Display.
 LBeide verlöschen, wenn der Akkupack vollständig 
geladen ist.

 DLaden über die [DC IN]-Buchse
Für die Berechnung der unten angegebenen Betriebs-
dauer wurden folgende Bedingungen zugrunde ge-
legt: TX : RX : Stand-by = 1 : 1 : 8

 • Bei Nutzung des optionalen Zigarettenanzünder-
kabels CP-12L oder des Gleichstromkabels OPC-
254L kann der Akkupack bei eingeschaltetem 
Gerät geladen werden. (S. 3-7)

 LDas Anschließen erfolgt wie unten abgebildet.
 • Der Batteriebehälter BP-273 besitzt keine Lade-
buchse und lässt sich nicht aufladen.

Ladedauer
 • BP-271: etwa 3 Stunden
 • BP-272: 5 Stunden
 • BP-307: 8 Stunden

+
_

in die
Netzsteckdose

Ausschalten*2

in die
[DC IN]- 
Buchse

BC-167S*1

in die Zigaretten-
anzünderbuchse 
(12 V DC)

in die 12-V-Gleich-
spannungsversorgung

CP-12L

OPC-254L

Schwarz:
Weiß: 

*1 Je nach Version in anderer Ausführung.
*2  Bei der Nutzung des Netzadapters BC-167S  

Handfunkgerät ausschalten.

Zum Aufladen des Akkupacks:
 • ist das mitgelieferte Ladegerät oder ein optionales 
Gleichstromkabel zu verwenden,

 • kann auch ein USB-Kabel verwendet werden (nicht im  
Lieferumfang), (S. 3-4),

 • lässt sich ein optionaler Schnelllader nutzen (S. 3-6).

Hinweis zum Laden
 • VORSICHT: Vor dem Anschließen des Gleich-
stromkabels den Akkupack anbringen.

 • Bei Nutzung des Netzadapters BC-167S ist das 
Handfunkgerät auszuschalten.

 • Das Laden eines bereits vollständig geladenen 
Akkupacks verkürzt seine Lebensdauer.

+
_
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 DLaden mit USB-Kabel
Der Akkupack lässt sich mithilfe eines USB-Kabels (Typ Micro-B) während des Betriebs des Handfunkgeräts aufladen.

Laden des Akkupacks

HINWEIS: 
 • Der Akkupack MUSS am Handfunkgerät angebracht 
sein.

 • Um ein Mobilgerät oder einen PC als externe Span-
nungsquelle zu verwenden, ist beim folgenden Punkt 
die Einstellung „ON“ zu wählen (voreingestellt): 
([MENU] > SET > Function  
> USB Power Input (Phone, Tablet, PC))

 • Während der Sendens wird immer der Akkupack ge-
nutzt, auch wenn eine externe Stromversorgung ange-
schlossen ist. Daher ist Senden mit entladenem Akku-
pack nicht möglich.

 • Laden ist eventuell nicht möglich: 
- Je nach verwendetem USB-Kabel oder Netzadapter.   
-  Bei Nutzung eines USB-Hubs oder Anschluss an 

einen USB-Port mit geringer Leistung.
 • Die Ladedauer ist vom verwendeten USB-Anschluss 
abhängig.

 • Wenn das S-Meter erscheint oder der USB-Netzadap-
ter Rauschen verursacht, ziehen Sie das USB-Kabel ab, 
um das Handfunkgerät von der USB-Stromversorgung 
zu trennen.

 • Beim Betrieb des Handfunkgeräts während des Lade-
vorgangs wird möglicherweise mehr Strom verbraucht 
als aufgeladen werden kann.

TIPP:
 • Ist ein USB-Kabel angeschlossen, wird der Ladevor-
gang beendet, wenn die maximale Kapazität des Akku-
packs erreicht ist. Beim Unterschreiten einer bestimm-
ten Kapazität beginnt der Ladevorgang erneut.

 • Den Betriebsmodus in den das Handfunkgerät versetzt 
wird, wenn es über ein USB-Kabel an einen PC ange-
schlossen ist, kann man ändern: 
([MENU] > SET > Function > USB Connect)

USB-Kabel

zu einem
Gerät mit 
USB-Port

Netzadapter oder externe  
Spannungsquelle
(nicht im Lieferumfang)

zum [USB]-Port

PC,
Mobilgerät
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Laden mit dem optionalen Schnelllader BC-202IP2

Mit dem optionalen Schnelllader BC-202IP2 kann 
man den Akkupack zügig aufladen.

 L Ist der Akkupack zu 90 % aufgeladen, stoppt der 
BC-202IP2 den Ladevorgang und die LED leuchtet 
grün. Die Betriebsdauer ist daher etwas kürzer als 
wenn er im Handfunkgerät geladen wird.

Ladedauer
 • BP-271: etwa 1,5 Stunden
 • BP-272: etwa 2,5 Stunden
 • BP-307: etwa 4 Stunden
 LDie Zeitangaben beziehen sich auf einen vollständig ent-
ladenen Akkupack und auf den Ladevorgang bei ausge-
schaltetem Handfunkgerät.

Dazu ist erforderlich:
 • Netzadapter BC-123S mit Winkelstecker 
( Je nach Version des Ladegeräts ist kein Netzadap-
ter oder ein Netzadapter in anderer Ausführung im 
Lieferumfang enthalten.)

Hinweis zum Laden
 R  GEFAHR! Verwenden Sie AUSSCHLIESSLICH 
von Icom hergestellte oder zugelassene Akku-
packs.

 • VORSICHT: Die [DC IN]-Buchse oder den 
[USB]-Anschluss an der Seite NICHT verwenden, 
wenn sich das Handfunkgerät im Schnellladege-
rät befindet. Dies kann zu einer Fehlfunktion des 
Ladegeräts führen. Blinkt die Ladeanzeige orange, 
ist der Netzadapter vom Ladegerät zu trennen 
und erneut anzuschließen.

 • Zum Laden MUSS das Handfunkgerät ausge-
schaltet sein. Lässt es sich nicht ausschalten, 
weil der Akkupack leer ist, entnehmen Sie den 
Akkupack und laden ihn separat auf.

 • Der schnelllader BC-202IP2 kann nur die Li- 
Ionen-akkupacks BP-271, BP-272 oder BP-307 
aufladen. Andere wiederaufladbare Batterien, wie 
z.B. Ni-Cd oder Ni-MH, lassen sich nicht laden.

 • Wenn die Ladeanzeige orange blinkt, ist ein Pro-
blem mit dem Akkupack oder dem Netzadapter  
aufgetreten. Bei Ladeproblemen mit einem neuen 
Akkupack wenden Sie sich an Ihren Händler.

Handfunkgerät mit Akkupack

Akkupack
BP-271, BP-272 oder BP-307

Netzsteckdose

Führung

Nut

BC-123S
( mit Winkelstecker)

Schrauben
(Selbst schneidende Schrauben:  
3,5 mm × mind. 30 mm) Separat zu beschaf-
fen. Die Befestigung des Ladegeräts mit diesen 
Schrauben wird empfohlen.

Ladeanzeige
 • Leuchtet orange: Akkupack wird aufgeladen.
 • Leuchtet grün: Ladevorgang ist abgeschlossen.
 • Blinkt orange: Ein Fehler ist aufgetreten.

BC-202IP2Anstelle des Netzadapters 
kann auch das Zigaretten-
anzünderkabel CP-23L 
der das Gleichstromkabel 
OPC-515L genutzt werden.

Ausschalten
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Laden mit dem optionalen Schnelllader BC-202IP3L

Mit dem optionalen Schnelllader BC-202IP3L kann 
man den Akkupack zügig aufladen.

 L Ist der Akkupack zu 90 % aufgeladen, stoppt der 
BC-202IP3L den Ladevorgang und die LED leuch-
tet grün. Die Betriebsdauer daher etwas kürzer als 
wenn er im Handfunkgerät geladen wird.

Ladedauer
 • BP-271: etwa 2 Stunden
 • BP-272: etwa 3 Stunden
 • BP-307: etwa 5 Stunden
 LDie Zeitangaben beziehen sich auf einen vollständig ent-
ladenen Akkupack und auf den Ladevorgang bei ausge-
schaltetem Handfunkgerät.

Dazu ist erforderlich:
 • Netzadapter BC-123S mit geradem Stecker

Handfunkgerät mit Akkupack

Netzsteckdose

 LZum Anschließen des Netzadapter an 
das Ladegerät muss man die linke  
Abdeckung des Ladegeräts abnehmen.

BC-202IP3L

Akkupack
BP-271, BP-272 
oder BP-307

BC-123S
(mit geradem Stecker)

Ladeanzeige

Aus-
schalten

 LAnstelle des Netz-
adapters kann auch das 
Zigarettenanzünderkabel 
CP-25H genutzt werden.

Hinweis zum Laden
 R  GEFAHR! Verwenden Sie AUSSCHLIESSLICH 
von Icom hergestellte oder zugelassene Akku-
packs.

 • VORSICHT: Die [DC IN]-Buchse oder den 
[USB]-Anschluss an der Seite NICHT verwenden, 
wenn sich das Handfunkgerät im Schnellladege-
rät befindet. Dies kann zu einer Fehlfunktion des 
Ladegeräts führen. Blinkt die Ladeanzeige orange, 
ist der Netzadapter vom Ladegerät zu trennen 
und erneut anzuschließen.

 • Zum Laden MUSS das Handfunkgerät ausge-
schaltet sein. Lässt es sich nicht ausschalten, 
weil der Akkupack leer ist, entnehmen Sie den 
Akkupack und laden ihn separat auf.

 • Der schnelllader BC-202IP3L kann nur die Li- 
Ionen-akkupacks BP-271, BP-272 oder BP-307 
aufladen. Andere wiederaufladbare Batterien, wie 
z.B. Ni-Cd oder Ni-MH, lassen sich nicht laden.

 • Wenn die Ladeanzeige orange blinkt, ist ein Pro-
blem mit dem Akkupack oder dem Netzadapter  
aufgetreten. Bei Ladeproblemen mit einem neuen 
Akkupack wenden Sie sich an Ihren Händler.
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+
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Betrieb mit externer Gleichspannung

Betriebshinweise
 • NIEMALS eine Gleichspannung von über 16 V 
direkt an die [DC IN]-Buchse des Handfunkgeräts 
anschließen. Die Versorgungsspannung muss 
zwischen 10 und 16 V DC betragen.

 • NICHT über einen längeren Zeitraum mit hoher 
Sendeleistung betreiben. Der Handfunkgerät wird 
heiß und es besteht Verbrennungsgefahr.

 • Zur externen Spannungsversorgung sind die  
Kabel CP-12L oder OPC-254L zu nutzen.

 • Bei Verwendung des Kabels OPC-254L muss 
man beim Anschließen an die externe Span-
nungsversorgung (nicht im Lieferumfang) auf die 
Polarität achten.

 • Um das Handfunkgerät mithilfe der Kabel CP-12L 
oder OPC-254L an eine 24-V-DC-Stromquelle 
anzuschließen, ist ein externer DC-DC-Wandler 
erforderlich. Fragen Sie Ihren Händler nach Ein-
zelheiten.

 • Bei Nutzung einer externen Spannungsversor-
gung wird die Batteriesparfunktion (S. 12-18) auto-
matisch ausgeschaltet.

 • Je nach externer Spannung kann der Akkupack 
für die Versorgung des Handfunkgeräts herange-
zogen werden, sodass seine Kapazität sinkt.

TIPP: Der Akkupack lässt sich bei eingeschaltetem 
Funkgerät laden, wenn bei „Charging (Power ON)“ 
die Einstellung „ON“ (voreingestellt) gewählt wird. 
Dabei können Störsignale oder Rauschen zu hören 
sein, bzw. die S-Meter-Anzeige kann erscheinen.
Wenn beim Laden während des laufenden Betriebs 
Signale nicht korrekt empfangen werden können, 
wählen Sie bei „Charging (Power ON)“ die Einstellung 
„OFF.“
([MENU] > SET > Function > Charging (Power ON))

CP-12L

OPC-254L

in die Zigaretten-
anzünderbuchse 
(12 V DC)

in die 
12-V-Gleichspan-
nungsversorgung

VORSICHT: Vor dem Anschließen des Gleichstrom-
kabels den Akkupack anbringen.

 LDer Netzadapter BC-167S ist nicht zur Spannungs-
versorgung bei laufendem Betrieb verwendbar.

Koppeln mehrerer BC-202IP3L-Schnelllader

Bis zu 6 Schnelllader BC-202IP3L lassen sich mitein-
ander verbinden.
1. Rechte Abdeckung des eines Schnellladers ent-

fernen (1).
2. DC-Stecker in die DC-Buchse auf der linken Seite 

des anderen Schnellladers stecken (2).

 RWARNUNG! Schalten Sie NIEMALS mehr als 6 
Ladegeräte zusammen. Das kann zu einem elektri-
schen Schlag, einem Brand, einer Überhitzung oder 
einer Beschädigung der Ladegeräte führen.

 RWARNUNG! Verwenden Sie beim Zusammen-
schalten von mehreren BC-202IP3L KEINEN ande-
ren Netzadapter als den BC-228. Ein elektrischer 
Schlag, ein Brand, Überhitzung oder Beschädigung 
der Ladegeräte kann die Folge sein.

2

1

in die
[DC IN]- 
Buchse Schwarz:

Weiß: +
_
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Informationen zum optionalen Batteriebehälter

Im Batteriebehälter BP-273 kommen drei  
AA-Alkaline-Batterien (LR6) zum Einsatz.
1. Abdeckung des Batteriebehälters entfernen.
2. Drei AA-Alkaline-Batterien (LR6) einsetzen.

 LAusschließlich Alkaline-Batterien verwenden.
 LBeim Einsetzen auf die Polarität achten.

3. Batteriebehälter anbringen. (S. 1-2)

Hinweise zu Batterien
 • Bei der Verwendung von Batterien unbedingt 
solche der gleichen Marke, des gleichen Typs 
und derselben Kapazität einsetzen. Alte und neue 
Batterien niemals mischen.

 • Leere Batterien NIEMALS ins Feuer werfen, da 
die dabei entstehenden Gase zu einer Explosion 
führen können.

 • Den Batteriebehälter NIEMALS Feuchtigkeit aus-
setzen. Falls er einmal nass geworden ist, muss 
er UNBEDINGT getrocknet werden, bevor man 
ihn benutzt.

 • NIE Batterien mit beschädigtem Außenmantel 
einsetzen.

 • Batteriekontakte sauberhalten. Es ist von Vorteil, 
sie gelegentlich zu reinigen.

 • Die Batterien aus dem Behälter entnehmen, wenn 
das Handfunkgerät nicht benutzt wird. Ansonsten 
entladen sie sich langsam, da der im Batterie-
behälter vorhandene DC-Konverter einen geringen 
Ruhestrom aufnimmt.

TIPP:
 • Ein eingebauter Aufwärtswandler im BP-273 
erhöht die Gleichspannung auf 5,5 V. Bei Verwen-
dung des Batteriebehälters ist eine Sendeleistung 
von etwa 100 mW möglich. Die Wahl anderer 
Sendeleistungen ist deaktiviert.

 • Mit angebrachtem Batteriebehälter BP-273 ist 
das Handfunkgerät spritzwassergeschützt gemäß 
Schutzart IPX4.

 • Bei niedrigen Temperaturen von unter –10 °C sinkt 
die Betriebsdauer der Batterien. Daher sollte man 
sie immer warmhalten.

 DBetriebsdauer
Für die Berechnung der unten angegebenen Betriebs-
dauer wurden folgende Bedingungen zugrunde ge-
legt:

 • Batteriesparfunktion: Auto (Short)
 • Verhältnis der Betriebszustände: 
TX : RX : Stand-by = 1 : 1 : 8  
(Variiert je nach konkreter Benutzung.)

Betriebsdauer:
FM-Modus

etwa 4,5 Stunden

 LDie Betriebsdauer hängt ganz wesentlich vom kon-
kreten individuellen Verhältnis der Betriebszustän-
de und den verwendeten Alkaline-Batterien ab.

 DBatteriewechsel
Wenn die im Batteriebehälter befindlichen Alkaline- 
Batterien verbraucht sind, erscheint „LOW BATTERY“ 
im Display und die Akkuanzeige beginnt zu blinken. 
10 Sekunden später schaltet sich das Handfunkgerät 
automatisch aus.
Bevor es wieder benutzt werden kann, müssen neue 
Batterien eingesetzt werden.

 LBeim Einsatz des Batterie behälters BP-273 lässt sich der  
Zustand der Alkaline-Batterien nicht ermitteln. Als Lade-
symbol wird dauerhaft „ “ angezeigt, dies sagt nichts 
über die tatsächliche Batteriekapazität aus.

BP-273 Alkaline-Batterie
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Technische Daten der Ladegeräte und Akkupacks

 DLi-Ionen-akkupack BP-271 (optional)
 • Spannung:   7,4 V
 • Kapazität:   mindestens 1150 mAh
 • Betriebstemperaturbereich: –20  °C bis +60 °C
 • Ladetemperaturbereich: 0 °C bis 40 °C
 • Lagertemperaturbereich:  –20 °C bis +50 °C (maximal ein Monat) 

–20 °C bis +35 °C (maximal drei Monate) 
–20 °C bis +20 °C (maximal ein Jahr)

 • Abmessungen:  58 mm × 86,9 mm × 9,1 mm (B × H × T, ohne vorstehende Teile)

 DLi-Ionen-akkupack BP-272 (mitgeliefert)
 • Spannung:   7,4 V
 • Kapazität:   mindestens 1880 mAh
 • Betriebstemperaturbereich: –20 °C bis +60 °C
 • Ladetemperaturbereich: 0 °C bis 40 °C
 • Lagertemperaturbereich:  –20 °C bis +50 °C (maximal ein Monat) 

–20 °C bis +35 °C (maximal drei Monate) 
–20 °C bis +20 °C (maximal ein Jahr)

 • Abmessungen:   58 mm × 86,9 mm × 14,2 mm (B × H × T, ohne vorstehende Teile)

 DLi-Ionen-akkupack BP-307 (optional)
 • Spannung:   7,2 V
 • Kapazität:   mindestens 3050 mAh
 • Betriebstemperaturbereich: –20 °C bis +60 °C
 • Ladetemperaturbereich: 0 °C bis 40 °C
 • Lagertemperaturbereich:  –20 °C bis +50 °C (maximal ein Monat) 

–20 °C bis +40 °C (maximal drei Monate) 
–20 °C bis +20 °C (maximal ein Jahr)

 • Abmessungen:   58 mm × 86,9 mm × 22,4 mm (B × H × T, ohne vorstehende Teile)

 Dschnelllader BC-202IP2 (optional)
 • Spannungsversorgung: 12 V bis 16 V DC oder angegebener Icom-Netzadapter
 • Ladetemperaturbereich: 10 °C bis 40 °C
 • Gewicht:    etwa 105 g (ohne Netzadapter)
 • Abmessungen:   88,0 mm × 47,5 mm × 72,5 mm (B × H × T, ohne vorstehende Teile)

 Dschnelllader BC-202IP3L (optional)
 • Spannungsversorgung: 12 V bis 15 V DC oder angegebener Icom-Netzadapter
 • Ladetemperaturbereich: 10 °C bis 40 °C
 • Gewicht:    etwa 120 g (ohne Netzadapter)
 • Abmessungen:  106,5 mm × 52,5 mm × 78,0 mm (B × H × T, ohne vorstehende Teile)
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 DBeschreibung
Mit dem ID-52E kann man sich FM-Rundfunksendun-
gen anhören, z. B. in einem Pop-up-Fenster während 
der Zweikanalüberwachung oder auch im Stand-by-
Modus
Zur einfacheren Nutzung lassen bis zu 500 Speicher-
plätze in 26 Gruppen nutzen.
Das Handfunkgerät verfügt außerdem über einen 
FM-Radiomodus, in dem es ausschließlich als 
FM-Rundfunkempfänger arbeitet und alle anderen 
Funktionen deaktiviert sind.

TIPP: Die Inhalte der Rundfunkspeicher, die in 
dieser Bedienungsanleitung gezeigt werden, sind 
versionsabhängig und können von den vorprogram-
mierten Inhalten Ihres Handfunkgeräts abweichen.

Rundfunk-Frequenzbereiche
FM: 76,0 MHz* bis 108,0 MHz
*  Der nutzbare FM-Frequenzbereich variiert je nach Version.

Grundbedienung

 DFM-Rundfunkempfänger einschalten
1. [QUICK] drücken.
2. <<FM Radio ON>>“ wählen.

 • Rückkehr zum Stand-by-Display, das  
„FM RADIO“-Fenster erscheint.

 • „ “ wird im Display angezeigt.

Wird bei eingeschaltetem 
FM-Rundfunkempfänger 
angezeigt.

TIPP:
Ausschalten des FM-Rundfunkempfängers
[QUICK] drücken und dann „<<FM Radio OFF>>“ 
wählen.

Rundfunk hören und gleichzeitig Haupt- und 
Subband überwachen.
[CLR] drücken, um das „FM RADIO“-Fenster zu 
schließen.

 • Im Stand-by-Modus kann man weiter Radio hören. 

 LUm das „FM RADIO“-Fenster erneut zu öffnen, drückt 
man [QUICK] und wählt anschließend „<<FM Radio>>“. 

HINWEIS: Wenn während der Zweikanalüber-
wachung das Bandskop eingeschaltet ist, können 
die Rundfunksignale von Audiosignalen aus den 
überwachten Bändern oder dem Flugfunkband 
unterbrochen werden.
Um dies zu unterbinden, kann man bei „Auto Mute“ 
oder bei „AF Output (DUAL/AIR Band)“ die Einstel-
lung „OFF“ wählen.

 LWenn „AF Output (DUAL/AIR Band)“ auf „ON“ gesetzt 
ist, sind die empfangenen Audiosignale während eines 
Sweeps kurzzeitig zu hören, und man weiß, dass ein 
Signal empfangen wurde, ohne auf das Display zu 
schauen.  
([MENU] > FM RADIO > FM Radio Set > Auto Mute) 
([MENU] > SET > Scope > AF Output (DUAL/AIR Band))
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Grundbedienung

 DAbstimm-/Speichermodus

1. Bei geöffnetem „FM RADIO“-Fenster [MR] drü-
cken, um zwischen Abstimm- und Speichermo-
dus umzuschalten.

2. [DIAL] drehen, um eine Frequenz oder einen  
Speicherkanal zu wählen.

 • Abstimmmodus
Der FM-Rundfunk-Abstimmmodus wird zur Einstel-
lung der gewünschten Rundfunkfrequenz benutzt.
im Display erscheint das Symbol „ “.
Zum Speichern der gewählten Frequenz drückt man 
[MR] 1 Sekunde lang.

 • Die Frequenz wird dabei in den Speicher mit der 
niedrigsten Nummer in der gewählten Speicher-
gruppe programmiert.

 DGruppenwahl im Speichermodus
In jeder Speichergruppe können bis zu 50 Rundfunk-
speicher programmiert werden, was die Auswahl 
eines Rundfunksenders wesentlich vereinfacht.

1. [MR] drücken, um den Speichermodus aufzurufen. 

 • „ “, Speichergruppe und Kanalnummer werden 
angezeigt.

2. [QUICK] drücken.
3. „Group Select“ wählen. 

4. Gewünschte Gruppe auswählen. 

 • Rückkehr zum Stand-by-Display. Die gewählte  
Speichergruppe wird angezeigt.

5. [DIAL] drehen, um einen Speicherkanal zu wählen.

TIPP: [QUICK] drücken, dann „VFO“ wählen, um 
den Abstimmmodus aufzurufen oder „MR“ wählen, 
um den Speichermodus aufzurufen.

Abstimmmodus

Speichermodus

 • Speichermodus
Der Rundfunk-Speichermodus ist zweckmäßig, um 
häufig gehörte Sender schnell aufrufen zu können.
Wenn der Speichermodus gewählt ist, erscheinen das 
Symbol „ “, die Speichergruppe (A bis Z) und 
die aktuelle Speichernummer im Display.
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Grundbedienung

 DFM-Rundfunksender-Suchlauf
Im Abstimmmodus eine der Navigationstasten () 
drücken und halten, um den Rundfunksender-Suchlauf 
zu starten.

 DEingangsabschwächer
Der Eingangsabschwächer reduziert die Signalpegel 
um NF-Störungen vorzubeugen, z. B.,wenn man sich 
in der Nähe starker Rundfunksender aufhält.

1. [QUICK] drücken.
2. „ATT“ wählen. 

3. „ON“ wählen.
 • „ATT“ wird angezeigt.

Erscheint bei eingeschaltetem 
Eingangsabschwächer

Frequenz ändert sich während  
des Suchlaufs

Beim Empfang eines Signals

 • Wenn man die Navigationstaste () gedrückt hält, startet 
der Suchlauf in absteigender, mit der Navigationstaste 
() in aufsteigender Richtung.

 • Beim Empfang eines Signals stoppt der Suchlauf auf 
dessen Frequenz.

 • Zum Beenden des Suchlaufs die Navigationstasten () 
oder [CLR] drücken.
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Grundbedienung

 DRauschsperre einstellen
Der Squelch sorgt dafür, dass nur Signale hörbar 
sind, deren Stärke größer als der eingestellte Pegel 
ist. Je höher der eingestellte Pegel, desto stärker 
muss das Signal sein, um die Rauschsperre zu öff-
nen. Bei niedrigem Pegel öffnen auch schwache 
Signale die Rauschsperre.
Der im „FM RADIO“-Fenster eingestellte Squelch- 
Pegel gilt nur für den FM-Rundfunkempfang.

[SQL]-Taste drücken und halten, durch Drehen von 
[DIAL] den Squelch-Pegel einstellen.

Automatischer 
Squelch-Pegel

Maximaler 
Squelch-Pegel

 L Information
 • Einstellbar sind:  „OPEN“, „AUTO“ (voreingestellt) und 

„LEVEL 1“ bis „LEVEL 3“
 • „LEVEL 1“ niedrig (für schwache Signale) und „LEVEL 3“ 
hoch (für starke Signale).

 • „AUTO“: automatische Pegeleinstellung durch einen 
Rauschimpulszähler.

 • „OPEN“: Rauschsperre ist permanent geöffnet.

 DMonitor-Funktion
Die Monitor-Funktion wird genutzt, um schwache  
Rundfunkstationen hören zu können, ohne die 
Rauschsperreneinstellung zu verändern.

[SQL] drücken und halten, um die eingestellte  
Frequenz abhören zu können.

 • Die Rauschsperre wird geöffnet.

Das erste Segment des S-Meters blinkt.

TIPP: Die Monitor-Funktion lässt sich im Menü  
so einstellen, dass sich die Rausch sperre jedes 
Mal öffnet oder schließt, wenn man die [SQL]-Taste 
drückt.
([MENU] > SET > Function > Monitor)
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FM-Rundfunkspeicher

 DNutzung der FM-Rundfunkspeicher
Um die Speicherverwaltung zu erleichtern, stehen  
26 Gruppen zur Verfügung, denen sich bis zu  
50 FM-Rundfunkspeicher zuweisen lassen. Maximal 
500 FM-Rundfunkspeicher können genutzt werden.
Für einen komfortablen Betrieb sind einige Regional-
sender bereits vorprogrammiert.

TIPP: Die Inhalte der Rundfunkspeicher, die in die-
ser Bedienungsanleitung gezeigt werden, können 
von den vorprogrammierten Inhalten Ihres Hand-
funkgeräts abweichen.

 DFM-Rundfunkspeicher hinzufügen

Schritt 1.  Hinzufügen eines FM-Rundfunkspeichers 
und Aufrufen des Editiermodus

[MENU] > FM RADIO > FM Radio Memory

1. [MENU] drücken.
2. Im „FM RADIO“-Menü „FM Radio Memory“ wählen.  

3. Gewünschte Gruppe wählen. 

 LWenn in der Gruppe noch kein FM-Rundfunk-
speicher vorhanden ist, wird „- Blank -“ angezeigt.

4. [QUICK] drücken.
5. „Add“ wählen. 

 • Das „FM RADIO MEM EDIT“-Display erscheint.

TIPP: Zum Ändern des Gruppennamens bei Schritt 4  
die [QUICK]-Taste drücken und anschließend  
„Edit Name“ wählen. 
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FM-Rundfunkspeicher

Schritt 2.  Rundfunkspeicher-Namen eingeben
1. „NAME:“ wählen. 

2. Namen eingeben. 

 LHinweise zur Zeicheneingabe s. S. iii.
3. Eingabe mit [ENT] bestätigen.

TIPP: Zum Wechseln der Gruppe erst „GROUP:“ 
und dann die gewünschte Gruppe wählen.

Schritt 3. Frequenz eingeben
1. „FREQUENCY:“ wählen. 

2. Durch Drehen von [DIAL] die Frequenz eingeben. 

 LDer Cursor lässt sich mit den Navigationstasten () 
bewegen.
 LDer nutzbare Frequenzbereich variiert je nach  
Version des Handfunkgeräts.

3. Eingabe mit [ENT] bestätigen.

Schritt 4. Übersprungeinstellung
1. „SKIP:“ wählen. 

2. „OFF“ oder „SKIP“ wählen. 

 • OFF:  Der Rundfunkspeicher ist im Speichermodus 
wählbar.

 • SKIP:  Der Rundfunkspeicher wird im Speichermodus 
nicht angezeigt.

Schritt 5. Rundfunkspeicher sichern
1. „<<Add Write>>“ wählen. 

2. „YES“ wählen. 

 • Die eingegebenen Inhalte werden im Rundfunk-
speicher gesichert, danach erfolgt die Rückkehr zur 
Anzeige der zuvor gewählten Gruppe.

TIPP: Dateneingabe abbrechen:
1. [CLR] drücken.
2. „YES“ wählen. 

 • Abbruch der Eingabe und Rückkehr zur Anzeige 
der zuvor gewählten Gruppe.

 D FM-Rundfunkspeicher hinzufügen
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FM-Rundfunkspeicher

 DFM-Rundfunkspeicher bearbeiten
Falls erforderlich lassen sich Rundfunkspeicher editie-
ren. Das ist nützlich, wenn die bereits eingegebenen 
Daten fehlerhaft sind, sich geändert haben oder neue 
Daten hinzugefügt werden sollen.

[MENU] > FM RADIO > FM Radio Memory

1. [MENU] drücken.
2. Im „FM RADIO“-Menü „FM Radio Memory“ wählen.  

3. Gruppe wählen, die den zu bearbeitenden Rund-
funkspeicher enthält. 

4. Zu bearbeitenden Rundfunkspeicher wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Edit“ wählen. 

7. Zu ändernden Eintrag wählen und bearbeiten.
 LDetails dazu sind auf S. 4-7 zu finden.

8. Nach erfolgter Bearbeitung „<<Overwrite>>“ 
wählen. 

9. „YES“ wählen. 

 • Die Speicherinhalte werden überschrieben, danach 
erfolgt die Rückkehr zur Anzeige der zuvor gewähl-
ten Gruppe.
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FM-Rundfunkspeicher

 DFM-Rundfunkspeicher löschen
Rundfunkspeicher können falls erforderlich gelöscht 
werden.

HINWEIS: Gelöschte Speicher lassen sich nicht 
wiederherstellen.

[MENU] > FM RADIO > FM Radio Memory

1. [MENU] drücken.
2. Im „FM RADIO“-Menü „FM Radio Memory“ wählen.  

3. Gruppe wählen, die den zu löschenden Rund-
funkspeicher enthält. 

4. Zu löschenden Rundfunkspeicher wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Delete“ wählen. 

7. „YES“ wählen. 

 • Der gewählte FM-Rundfunkspeicher wurde gelöscht.
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 DAnzeigereihenfolge der  
FM-Rundfunkspeicher ändern

Falls erforderlich kann man die Anzeigereihenfolge 
der programmierten Rundfunkspeicher innerhalb 
einer Gruppe ändern.

[MENU] > FM RADIO > FM Radio Memory

1. [MENU] drücken.
2. Im „FM RADIO“-Menü „FM Radio Memory“ wählen.  

3. Gruppe wählen, die den zu verschiebenden 
Rundfunkspeicher enthält. 

4. Zu verschiebenden Rundfunkspeicher wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Move“ wählen. 

FM-Rundfunkspeicher

7. Rundfunkspeicher auswählen über dem der zu 
verschiebende eingefügt werden soll. 

 • Der zu verschiebende Rundfunkspeicher wurde 
oberhalb des gewählten eingefügt.
 LWählt man „<<Move End>>“, wird der Rundfunk-
speicher am Ende der Gruppe eingefügt.
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FM-Rundfunkspeicher

 DÜbersprungeinstellung  
für FM-Rundfunkspeicher

Man kann mit der Übersprungeinstellung festlegen, 
ob ein Rundfunkspeicher im Speichermodus ange-
zeigt wird oder nicht.

[MENU] > FM RADIO > FM Radio Memory

1. [MENU] drücken.
2. „FM RADIO“ wählen.
3. „FM Radio Memory“ wählen. 

4. Gruppe wählen, die den zu überspringenden 
Rundfunkspeicher enthält. 

5. Zu überspringenden Rundfunkspeicher wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.

7. „SKIP“ wählen. 

 • Rechts neben dem gewählten Rundfunkspeicher 
wird „SKIP“ angezeigt.
 LUm das Überspringen zu beenden, [QUICK] drücken 
und erneut „SKIP“ wählen.

TIPP: Wenn man im Speichermodus bei geöffnetem 
„FM RADIO“-Fenster die Übersprungeinstellung 
ändern möchte, drückt man [QUICK] und wählt an-
schließend „SKIP“.
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FM-Radiomodus

Das Handfunkgerät verfügt über einen FM-Radio-
modus, in dem es ausschließlich als FM-Rundfunk-
empfänger arbeitet.

1. [QUICK] drücken.
2. „<<FM Radio Mode>>“ wählen. 

 • Das FM-Radiomodus-Display wird angezeigt.

TIPP: Beenden des FM-Radiomodus
1. [QUICK] drücken.
2. „<<Normal Mode>>“ wählen.

 L Im FM-Radiomodus werden keine anderen Funk-
tionen ausgeführt. Um das Handfunkgerät wie-
der normal nutzen zu können, beenden Sie den 
FM-Radiomodus.
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Menüeinstellungen und -befehle für den Rundfunkempfang

FM Radio Memory

[MENU] > FM RADIO > FM Radio Memory

Um die Speicherverwaltung zu erleichtern, stehen  
26 Gruppen zur Verfügung, denen sich bis zu  
50 FM-Rundfunkspeicher zuweisen lassen. Maximal 
500 FM-Rundfunkspeicher können genutzt werden.

Inhalt der FM-Radiospeicher

NAME

Name des FM-Rundfunkspeichers
 LFür jeden Speicher kann man einen 
Namen mit bis zu 16 alphanumeri-
schen Zeichen vergeben.

GROUP Buchstabe und Name der Gruppe

FREQUENCY
Eingegebene Frequenz

 LDer nutzbare Frequenzbereich variiert 
je nach Version des Handfunkgeräts.

SKIP

Anzeige der Übersprungeinstellung.
 LZu überspringende Rundfunkspeicher 
werden im Speichermodus nicht an-
gezeigt.

Auto Mute (voreingestellt: 2sec)

[MENU] > FM RADIO > FM Radio Set > Auto Mute

Wahl, ob der Rundfunkempfang stummgeschaltet 
wird*, wenn auf dem Haupt- oder Subband ein Signal 
empfangen wird.

 LUnabhängig von dieser Einstellung wird der Rundfunk-
empfang während des Sendens immer stummgeschaltet.

*  Details siehe „Rundfunk hören und gleichzeitig Haupt- und 
Subband überwachen“ auf Seite 4-2.

 • OFF:  Die automatische Stummschaltung ist deakti-
viert. Der Rundfunk ist hörbar, auch wenn auf 
dem Haupt- oder Subband ein Signal emp-
fangen wird. Der Rundfunkempfang wird nur 
beim Senden stummgeschaltet.

 • 0 to 10sec:  Der Rundfunkempfang wird automatisch 
stummgeschaltet, wenn auf dem Haupt- oder 
Subband ein Signal empfangen wird. Nach 
dem Senden oder Empfangen startet der 
Timer für die Beendigung der Stummschal-
tung. Nach dem Ablauf des Timers kann man 
wieder Radio hören. 
L Der Rundfunkempfang wird stummgeschal-

tet, wenn bei der Nutzung des Bandskops 
während eines Sweeps ein Signal empfan-
gen wird.

Earphone Antenna (voreingestellt: Not Used)

[MENU] > FM RADIO > FM Radio Set >  
Earphone Antenna

Wahl, ob die Anschlussleitung des Ohrhörers wird als 
Antenne für den FM-Rundfunkempfang genutzt wird.

 • Not Used:  Die Anschlussleitung des Ohrhörers wird nicht 
als Antenne genutzt.

 • Use:  Die Anschlussleitung des Ohrhörers wird als 
Antenne genutzt.

Power Save (FM Radio) (voreingestellt: ON)

[MENU] > FM RADIO > FM Radio Set >  
Power Save (FM Radio)

Einstellung der Batteriesparfunktion während des 
Rundfunkempfangs zur Verlängerung der Betriebs-
zeit.

 • OFF: Batteriesparfunktion ist ausgeschaltet.
 • ON:  Wenn man bei eingeschaltetem FM-Rundfunkemp-

fänger länger als 5 Sek. kein Signal empfängt, wird 
diese Funktion im Verhältnis 1:3 (300 ms : 900 ms) 
aktiviert.

HINWEIS: Wenn das Handfunkgerät mit externer 
Gleichspannung versorgt wird, ist diese Funktion 
deaktiviert.

<<FM Radio ON>>

[MENU] > FM RADIO > <<FM Radio ON>>

Einschalten des FM-Rundfunkempfangs.
Wenn auf dem Haupt- oder Subband ein Signal emp-
fangen wird, kann man weiterhin Radio hören.
Bei eingeschaltetem Rundfunkempfang ist im  
„FM RADIO“-Display die Option <<FM Radio OFF>> 
sichtbar, welche zum Ausschalten des Rundfunkemp-
fangs zu wählen ist.

 LDen Rundfunkempfang kann man ebenfalls ausschalten, 
indem man im Quick-Menü <<FM Radio OFF>> wählt.

<<FM Radio Mode>>

[MENU] > FM RADIO > <<FM Radio Mode>>

Aufrufen des FM-Radio modus, in dem das Hand-
funkgerät ausschließlich als FM-Rundfunkempfänger 
arbeitet.
Befindet sich das Handfunkgerät im FM-Radio- 
modus, ist im „FM RADIO“-Display die Option  
<<Normal Mode>> sichtbar, welche zum Beenden 
des FM-Radiomodus zu wählen ist.

 LDen FM-Radiomodus kann man ebenfalls beenden,  
indem man im Quick-Menü <<Normal Mode>> wählt.
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HINWEIS: Die in der in der Basis- 
Bedienungsanleitung enthaltene 
D-STAR-ANLEITUNG beinhaltet 
detaillierte Informationen darüber, 
wie man sein Rufzeichen an einem 
Gateway-Repeater registriert und 
zum grundlegenden Betrieb.
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ERWEITERTER D-STAR-BETRIEB

WICHTIG!
 • Die in dieser Bedienungsanleitung beispielhaft gezeigte Repeater-Liste kann von der in Ihrem Handfunkgerät 
vorprogrammierten abweichen.

 • Als Einstellungsbeispiele werden japanische Repeater verwendet. Japanische Repeater-Nodes (Ports) unter-
scheiden sich von denen anderer Länder. ACHTEN SIE DARAUF, den 8. Buchstaben des Repeater-Nodes 
entsprechend dem unten gezeigten Frequenzband hinzuzufügen. 
1200 MHz: A (B in Japan) 
430 MHz: B (A in Japan) 
144 MHz: C (keine 144-MHz-D-STAR-Repeater in Japan)

Digitale Kommunikation ist nicht nur mit der 
DR-Funktion möglich, sondern auch im VFO-,  
Speicher- oder Anrufkanalmodus.

Diese Bedienungsanleitung legt das Hauptaugenmerk 
auf die DR-Funktion, die die Bedienung erheblich 
vereinfacht. Falls man die DR-Funktion für die digi-
tale Kommunikation nicht verwenden möchte, geht 
man wie nebenstehend beschrieben vor oder wählt 
den Repeater in einem Speicherkanal.

Für einen Gebiets- oder Gateway-Anruf:
1. Einstellen der Einstiegsrepeater-Frequenz.  

(S. 11-2)
2. Ablagerichtung und Offset-Frequenz (Betrag der 

Ablage) einstellen. (S. 11-4)
3. Rufzeichen eingeben (UR/R1/R2). (S. 12-8)

Für einen Simplex-Anruf:
1. Betriebsfrequenz einstellen.
2. Rufzeichen eingeben (UR/R1/R2). (S. 12-8)

Digitale Kommunikation ohne D-STAR-Repeater (DR)-Funktion
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Einstellungen für „FROM“ (Einstiegs-Repeater)

Vor dem Senden eines Anrufs im DR-Modus muss bei „FROM“ der Einstiegs-Repeater eingestellt werden.
Die Einstellung des Einstiegs-Repeaters ist auf fünf verschiedenen Wegen möglich:

Durch Drehen von [DIAL]
Im DR-Display durch Drehen von [DIAL] einen voreingestellten 
Repeater auswählen. Erscheint  

währen des 
Drehens von 
[DIAL]

Wahl aus der Repeater-Liste (S. 5-4)
Wenn der gewünschte Einstiegs-Repeater in der Repeater-Liste des 
Handfunkgeräts vorprogrammiert ist, lässt er sich über das Repeater-
Gebiet, seinen Namen (falls programmiert) oder das Rufzeichen wählen.

 • Wenn der Einstiegs-Repeater bekannt ist:

Suchen eines Repeaters mit dem DR-Suchlauf (S. 5-5)
Beim normalen DR-Suchlauf stoppt der Suchlauf auf Repeater- 
Ausgabefrequenzen und auf Simplex-Signalen.

Der Near-Repeater-Suchlauf überprüft auf Grundlage des eigenen  
Standorts die Sendefrequenzen der nächstgelegenen Repeater,  
die aus der Repeater-Liste ermittelt werden, und listet diese auf.
Mit dem Near-Repeater-(FM)-Suchlauf lassen sich auch die nächst-
gelegenen FM-Repeater finden.

Suche des nächstgelegenen Repeaters (S. 5-6)
Das Handfunkgerät sucht den nächstgelegenen Repeater anhand der 
eigenen Positionsdaten in Verbindung mit den Positionen der in der  
Repeater-Liste gespeicherten Repeater.
Die nächstgelegenen werden zur Auswahl im Display angezeigt.
Der gewünschte Repeater-Typ (DV oder FM) ist wählbar.

 • Wenn der Einstiegs-Repeater unbekannt ist:

Suchlauf-
optionen

Auswahl aus der TX-History (S. 5-7)
Auswahl eines zuvor genutzten Repeaters aus der TX-History.

 • Wenn „FROM“-Daten in der TX-History gespeichert sind:
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Einstellungen für „FROM“ (Einstiegs-Repeater)

Für eine einfache Bedienung verfügt das Handfunk-
gerät über eine vorprogrammierte Repeater-Liste.  
Bei der Auswahl eines Repeaters aus der Liste wer-
den Rufzeichen, Frequenzen, Frequenzablage und 
Ablagerichtung automatisch eingestellt.

Beispiel:  Wahl des „Kirkland (IA)“-Repeaters in  
Washington, USA, aus der Repeater-Liste. 

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „FROM“ 
wählen und dann [ENT] drücken. 

3. „Repeater List“ wählen. 

4. Repeater-Gruppe wählen, zu der der eigene  
Einstiegs-Repeater gehört. 

TIPP:
Bei der Wahl eines FM-Repeaters:
Wenn in Ihrem Handfunkgerät FM-Repeater vorpro-
grammiert sind, lassen sich diese ebenfalls wählen. 
Bei der Wahl eines FM-Repeaters ist keine Einstel-
lung bei „TO“ erforderlich; dort wird „---“ angezeigt.

FM-Repeater gewählt.

Repeater-Gruppe wechseln:
Um im DR-Display die Repeater-Gruppe zu  
wechseln [QUICK] drücken und anschließend 
„Group Select“ wählen.

5. Eigenen Einstiegs-Repeater wählen. 

 • Rückkehr zum DR-Display, der Name des gewählten 
Repeaters wird bei „FROM“ angezeigt.
 LDie in dieser Bedienungsanleitung beispielhaft ge-
zeigte Repeater-Liste kann von der in Ihrem Hand-
funkgerät vorprogrammierten abweichen.

 DNutzung der Repeater-Liste
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Einstellungen für „FROM“ (Einstiegs-Repeater)

Der DR-Suchlauf dient zur Suche von Signalen auf 
Repeater- oder Simplex-Frequenzen. 
Es stehen zwei verschiedene Arten des DR-Suchlaufs 
zur Verfügung: der normale DR-Suchlauf und der 
Suchlauf nach nächstgelegenen Repeatern.

Normaler Suchlauf
Zum schnellen Finden von Repeatern werden beim 
Suchlauf alle Repeater übersprungen, die nicht als 
Einstiegs-Repeater eingestellt sind.

 L In der Repeater-Liste ist bei „USE (FROM)“ die Einstel-
lung „NO“ eingetragen. (S. 5-33) 
([MENU] > MEMORY > Repeater List)

Suchlauf nach nächstgelegenen Repeatern
Beim diesem Suchlauf werden in einem Umkreis von 
160 km die Frequenzen der 20 nächstgelegenen Re-
peater überprüft. Die Ermittlung und Auflistung erfolgt 
anhand der eigenen Position und der gespeicherten 
Positionen der Repeater.

 LWird das Handfunkgerät während des Suchlaufs nach 
nächstgelegenen Repeatern ausgeschaltet, setzt es den 
Suchlauf nach dem erneuten Einschalten fort.
 LWenn der Empfang von aktuellen eigenen Positionsdaten 
nicht möglich ist, wird die zuletzt empfangene Position 
verwendet.

HINWEIS: Es kann sein, dass der Repeater das vom 
Handfunkgerät gesendete Signal nicht empfangen 
kann, obwohl man den Repeater selbst gut emp-
fängt. Dies liegt möglicherweise daran, dass der 
Repeater eine deutlich höhere Sendeleistung als das 
Handfunkgerät hat und dessen Signal den Repeater 
nicht erreicht.

TIPP: Der DR-Suchlauf sucht auf den in der  
Repeater-Liste enthaltenen D-STAR-Repeater- und 
Simplex-Frequenzen

3. Suchlauftyp wählen.
 • Normal: 
Sucht nach Repeatern mit dem Eintrag „YES“ bei 
„USE (FROM)“.

 • Near Repeater (ALL): 
Sucht nach bis zu 20 nächstgelegenen  
DV- und FM-Repeatern (insgesamt 40 Repeater).

 • Near Repeater (DV): 
Sucht nach bis zu 20 nächstgelegenen  
DV-Repeatern.

 • Near Repeater (FM): 
Sucht nach bis zu 20 nächstgelegenen  
FM-Repeatern.

 • Der gewählte DR-Suchlauf startet.
 • Im DR-Suchlauf werden die Repeater nacheinander 
nach abnehmender Entfernung angezeigt.
 LDer Suchlauf wird in gleicher Weise fortgesetzt wie 
die anderen Suchlaufvarianten. (S. 12-5)

  

Die Repeater werden 
nacheinander angezeigt

4. Wenn das Handfunkgerät ein Signal von einem 
Repeater empfängt, stoppt der Suchlauf.  
[SCAN] drücken. 

 • Der DR-Suchlauf ist damit beendet und der Repeater 
wird bei „FROM“ angezeigt. 

 DNutzung des DR-Suchlaufs

Beispiel:  Wahl eines Repeaters mit dem DR-Suchlauf
1. [DR] 1 Sek. lang drücken, um das DR-Display 

aufzurufen.
2. [SCAN]-Taste 1 Sek. lang drücken. 

 • Ein Fenster zur Auswahl des Suchlauftyps öffnet 
sich.
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Einstellungen für „FROM“ (Einstiegs-Repeater)

Das Handfunkgerät kann mithilfe der eigenen und der 
in der Repeater-Liste gespeicherten Positionsdaten 
nach den nächstgelegenen Repeatern suchen.
Die nächstgelegenen Repeater aus der Liste werden 
als Auswahloption angezeigt.

HINWEIS:
 • Für die Nutzung der Suchlauffunktion nach nächst-
gelegenen Repeatern müssen gültige GPS-Daten  
vorliegen. Alternativ kann man die eigene Position 
manuell eingeben.

 • Wenn im Umkreis von 160 km kein Repeater gefunden 
wird, erscheint „No Repeater Found“ im Display.

 • Werden keine aktuellen GPS-Positionsdaten empfan-
gen, nutzt der Suchlauf die letzten gültigen. „GPS is 
invalid. Search by last valid position“ wird angezeigt.

Beispiel:  Wahl eines Repeaters aus der Liste der 
nächstgelegenen Repeater

Schritt 1:  Eigene GPS-Positionsdaten empfangen
Zunächst den GPS-Empfang prüfen.

 • Während der Suche nach Satelliten blinkt das GPS-Sym-
bol. 

 →  →  → 

 • Das GPS-Symbol hört auf zu blinken, sobald die für die 
Ermittlung der Position erforderliche Mindestanzahl von 
Satelliten gefunden ist. 

 LEs dauert einige Sekunden, bis gültige GPS-Daten 
empfangen werden. Unter ungünstigen Empfangsver-
hältnissen, bei denen die „Sicht“ zu den GPS-Satelliten 
behindert ist, können auch mehrere Minuten vergehen. 
Gegebenenfalls muss man den Standort wechseln.
 LWenn der Empfang von aktuellen Positionsdaten nicht 
möglich ist, wird die zuletzt empfangene Position ver-
wendet.

Schritt 2:  Wahl des Einstiegs-Repeaters aus der 
Liste der nächstgelegenen Repeater

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „FROM“ 
wählen und dann [ENT] drücken. 

3. „Near Repeater“ wählen. 

4. Anzuzeigenden Repeater-Typ auswählen. 

 • Near Repeater (ALL): 
Anzeige von bis zu 20 nächstgelegenen  
DV- und FM-Repeatern (insgesamt 40 Repeater).

 • Near Repeater (DV): 
Anzeige von bis zu 20 nächstgelegenen  
DV-Repeatern.

 • Near Repeater (FM): 
Anzeige von bis zu 20 nächstgelegenen  
FM-Repeatern.

5. Gewünschten Repeater wählen, um ihn als Ein-
stiegs-Repeater zu nutzen. Dabei die Entfernung be-
rücksichtigen.

Repeater-Rufzeichen

„FM“ steht für FM-Repeater.

Anzeige der Richtung* und 
der Entfernung zum Repeater

*  Wenn für die Genauigkeit der Position „Approximate“ 
gewählt ist, wird die Richtung bei Entfernungen von 
weniger als 5 km nicht angezeigt. (S. 5-34)
 • Rückkehr zum DR-Display, der gewählte Repeater 
wird bei „FROM“ angezeigt. 

 DNutzung der Suche nach Repeatern in der Nähe
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Einstellungen für „FROM“ (Einstiegs-Repeater)

Ein Einstiegs-Repeater lässt sich auch aus der 
TX-History wählen, in welcher bis zu 10 der zuletzt 
genutzten gespeichert sind.

Beispiel:  Wahl des „Hirano“-Repeaters in Japan aus 
der TX-History

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „FROM“ 
wählen und dann [ENT] drücken. 

3. „TX History“ wählen. 

4. „TX History (DV)“ oder „TX History (FM)“ wählen. 

 • TX History (DV):  In der TX-History werden nur 
DV-Repeater angezeigt.

 • TX History (FM):  In der TX-History werden nur 
FM-Repeater angezeigt.

5. Einstiegs-Repeater wählen. 

 • Rückkehr zum DR-Display, der gewählte Repeater 
wird bei „FROM“ angezeigt. 

TIPP: Wenn man bei Schritt 5 die [QUICK]-Taste 
drückt, kann man sich Detailinformationen zum  
Repeater ansehen bzw. einen oder alle Repeater 
aus der TX-History löschen.
 

 DNutzung der TX-History
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Einstellungen für „TO“ (Ziel-Repeater)

„CQCQCQ“, der Ziel-Repeater oder die Zielstation 
muss bei „TO“ eingestellt werden, um einen Anruf im 
DV-Modus senden zu können. Die Einstellung des 
Ziels ist auf neun verschiedenen Wegen möglich.

Drehen von [DIAL]
Mit [DIAL] einen Ziel-Repeater oder ein Ziel-
rufzeichen wählen, das im DR-Display angezeigt  
wird. (Diese Auswahl ist nicht möglich, wenn 
„CQCQCQ“ eingestellt ist.)

Gebietsanruf
Als Ziel in „TO“ die Einstellung „CQCQCQ“ wählen. 
 (S. 5-9)

Gateway-Anruf
Einen Repeater aus der Repeater-Liste wählen,  
um einen Gateway-Anruf zu senden. (S. 5-9)

Anrufen einer bestimmten Station
Das Rufzeichen der Station aus dem „Your Call 
Sign“-Speicher wählen. (S. 5-10)

Anrufen über einen Reflektor
Reflektor wählen, über den man anrufen möchte. 
(S. 5-14)

Wahl aus der RX-History
Empfangene Repeater- und Stationsrufzeichen 
werden in der RX-History gespeichert. Das  
gewünschte Ziel kann man aus der RX-History 
wählen. (S. 5-10)

Wahl aus der TX-History
Beim Senden eines Anrufs wird das Rufzeichen 
des Ziel-Repeaters bzw. der Zielstation in der 
TX-History gespeichert. Das gewünschte Ziel lässt 
sich aus der TX-History wählen. (S. 5-11)

Direkteingabe des Zielrufzeichens
Das Rufzeichen der Zielstation direkt eingeben. 
(S. 5-11)

Direkteingabe des Rufzeichens des Ziel-Repeaters
Das Rufzeichen des Ziel-Repeaters direkt einge-
ben. (S. 5-12)

TIPP: Nachdem man das Signal einer Station oder 
eines Repeaters empfangen hat, lässt sich das Ruf-
zeichen durch längeres Drücken der [RX→CS]-Taste 
übernehmen, sodass man ganz einfach antworten 
kann.

TIPP: Wechsel der Repeater-Gruppe:
Wenn man „Local CQ“ oder „Gateway 
CQ“ gewählt hat, ist es möglich, die  
Repeater-Gruppe zu wechseln. Um 
dies zu tun, drückt man bei geöffnetem 
DR-Display die [QUICK]-Taste und wählt 
anschließend „Group Select“.
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Einstellungen für „TO“ (Ziel-Repeater)

 D„Local CQ“ (Gebietsanruf) 
Wenn im „TO SELECT“-Display die Einstellung „Local 
CQ“ gewählt ist, erscheint bei „TO“ „CQCQCQ“.

Beispiel:  Gebietsanruf über den „Kirkland (IA)“- 
Repeater als Einstiegs-Repeater.

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

3. „Local CQ“ wählen. 

 • Rückkehr zum DR-Display, bei „TO“ wird „CQCQCQ“ 
angezeigt.

 D„Gateway CQ“ (Gateway-Anruf)
Wenn im „TO SELECT“-Display die Einstellung  
„Gateway CQ“ gewählt ist, kann man einen der auf-
gelisteten Repeater für den Gateway-Anruf wählen.

Beispiel:  Gateway-CQ-Anruf über den „Kirkland (IA)“ 
-Repeater und den „Hirano“-Repeater.

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

3. „Gateway CQ“ wählen. 

4. Repeater-Gruppe mit dem Ziel-Repeater wählen. 

5. Ziel-Repeater wählen. 

 LJeder Repeater verfügt über ein Repeater-Node  
(A-, B-, oder C-Band) über den gesendet wird. Siehe 
„WICHTIG!“ zur Buchstabenbezeichnung der Bänder 
auf Seite 5-2.

 • Rückkehr zum DR-Display, der Name des gewählten 
Repeaters wird bei „TO“ angezeigt.

TIPP: Nachdem ein Ziel-Repeater eingestellt ist, 
lässt sich durch Drehen von [DIAL] ein anderer ge-
speicherte Ziel-Repeater wählen.
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Einstellungen für „TO“ (Ziel-Repeater)

 DNutzung von „Your Call Sign“
Im „Your Call Sign“-Speicher werden Rufzeichen ge-
speichert. Wenn ein bestimmtes Rufzeichen aus „Your 
Call Sign“ für „TO“ (Ziel) gewählt ist, kann man einen 
Gateway-Anruf senden. Bei einem solchen Anruf wird 
der Ziel-Repeater genutzt, über den die Zielstation 
zuletzt aktiv war (Routing). Daher ist es für einen An-
ruf nicht erforderlich zu wissen, wo genau sich die 
Zielstation befindet.

HINWEIS: Wenn der bei „FROM“ eingestellte Ein-
stiegs-Repeater kein Gateway-Rufzeichen besitzt, 
sind Gateway-Anrufe nicht möglich.

Beispiel:  „Rick“ aus dem „Your Call Sign“-Speicher 
wählen

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

3. „Your Call Sign“ wählen. 

4. Namen oder Rufzeichen des Ziels wählen. 

 • Rückkehr zum DR-Display, das gewählte Ziel wird 
bei „TO“ angezeigt.

TIPP: Nachdem eine Zielstation eingestellt ist, lässt 
sich durch Drehen von [DIAL] eine andere gespei-
cherte Zielstation wählen.
 

 DNutzung der RX-History
Wenn ein DV-Signal empfangen wird, speichert das 
Handfunkgerät das Rufzeichen der Station und das 
des Repeaters in der RX-History. Bis zu 50 Anrufe 
werden gespeichert. Wenn man den 51. Anruf emp-
fängt, wird der älteste Eintrag der RX-History ge-
löscht.

Beispiel: „Rick“ aus der RX-History wählen.

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

3. „RX History“ wählen. 

4. Namen oder Rufzeichen des Ziels wählen. 

 • Rückkehr zum DR-Display, das gewählte Ziel wird 
bei „TO“ angezeigt.
 LVor dem gewählten Ziel wird ein Sternchen „*“ 
angezeigt. (S. 5-19)

TIPP: Wenn der im „RX HISTORY“-Display gewählte 
Eintrag  in den „Your Call Sign“-Speicher übernom-
men werden soll, drückt man die [QUICK]-Taste und 
wählt danach „Add To your Memory“.
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Einstellungen für „TO“ (Ziel-Repeater)

 DNutzung der TX-History
Die gesendeten Anrufe werden in der TX-History ge-
speichert. Bis zu 20 für Anrufe bei „TO“ (Ziel) genutzte 
Namen und/oder Rufzeichen sind in der TX-History 
verfügbar.

HINWEIS: Falls noch kein Anruf im DV-Modus ge-
sendet wurde, sind in der TX-History keine Einträge 
für die Wahl bei „TO“ (Ziel) vorhanden.

Beispiel:  Den „Kirkland (IA)“-Repeater aus der 
TX-History wählen.

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

3. „TX History“ wählen. 

4. Ziel-Repeater wählen.

 • Rückkehr zum DR-Display, der Name des gewählten 
Repeaters wird bei „TO“ angezeigt.

 DDirekteingabe des Ziels (UR)
Das Zielstations-Rufzeichen lässt sich direkt eingeben.

Beispiel: Direkteingabe des Rufzeichens „JM1ZLK“

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

3. „Direct Input (UR)“ wählen. 

4. Stationsrufzeichen mit bis zu acht Zeichen  
(einschließlich Leerzeichen) eingeben. 

 LHinweise zur Zeicheneingabes. S. iii.
5. Eingabe mit [ENT] bestätigen. 

 • Rückkehr zum DR-Display, das eingegebene Ziel-
rufzeichen wird bei „TO“ angezeigt.
 LNach der Eingabe lässt sich das Rufzeichen bei Be-
darf im „DIRECT INPUT (UR)“-Display korrigieren.
 LDas programmierte Rufzeichen bleibt im  
„DIRECT INPUT (UR)“-Display verfügbar, bis ein 
neues eingegeben wird.

TIPP: Wenn das eingegebene Rufzeichen auch 
im„Your Call Sign“-Speicher vorhanden ist, wird der 
Name angezeigt (falls programmiert).
 

TIPP: Im „TX HISTORY“-Display angezeigte Daten 
lassen sich in der Repeater-Liste speichern bzw. 
löschen. Dazu die [QUICK]-Taste drücken, und eine 
der Optionen auswählen.
 

Beiname wird angezeigt,
wenn ein Repeater gewählt ist.
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Einstellungen für „TO“ (Ziel-Repeater)

 DDirekteingabe des Ziel-Repeaters 
(RPT)

Das Rufzeichen des Ziel-Repeaters lässt sich auch 
direkt eingeben.

HINWEIS: Darauf achten, den Repeater-Node an  
8. Stelle einzugeben. Siehe Buchstabenbezeichnung 
der Bänder auf Seite 5-2.

Beispiel: Direkteingabe des Rufzeichens „JP3YDH A“

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

3. „Direct Input (RPT)“ wählen. 

4. Repeater-Rufzeichen mit bis zu acht Zeichen  
(einschließlich Leerzeichen) eingeben. 

 LHinweise zur Zeicheneingabe s. S. iii.
5. Eingabe mit [ENT] bestätigen.

 • Rückkehr zum DR-Display, „JP3YDH A“ wird bei 
„TO“ angezeigt.
 LNach der Eingabe lässt sich das Rufzeichen bei Be-
darf im „DIRECT INPUT (RPT)“-Display korrigieren.
 LDas programmierte Rufzeichen bleibt im  
„DIRECT INPUT (RPT)“-Display verfügbar, bis ein 
neues eingegeben wird.

TIPP:
 • Wenn das eingegebene Rufzeichen auch in der Repea-
ter-Liste vorhanden ist, wird der Name angezeigt (falls 
programmiert).

 • Bei direkter Eingabe des Repeater-Rufzeichens ist auch 
ein „/“ am Anfang korrekt.
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„REPEATER DETAIL“-Display

Je nach in die Repeater-Liste programmierten Inhal-
ten kann man sich z. B. Positionsdaten, UTC-Zeit-
verschiebung, Entfernung und Richtung zum Repeater 
und Zeit am Repeater-Standort im „REPEATER  
DETAIL“-Display anzeigen lassen. Es kann auch direkt 
aus dem „FROM SELECT“-Display aufgerufen werden.

Beispiel:  Details für den Repeater „Hirano/Icom“  
anzeigen

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“  
wählen, dann [ENT] drücken. 

3. „Gateway CQ“ wählen. 

4. Repeater-Gruppe „13: Japan“ wählen. 

5. „Hirano/Icom“ wählen.
 LNICHT die [ENT]-Taste betätigen!

6. [QUICK] drücken.
7. „Detail“ wählen. 

8. [ENT] drücken.
 • Rückkehr zur vorherigen Anzeige.

*  Wenn für die Genauigkeit der Position „Approxima-
te“ gewählt ist, wird die Richtung bei Entfernungen 
von weniger als 5 km nicht angezeigt. (S. 5-34)
 LWenn keine Positionsdaten vorliegen, erfolgt keine Ent-
fernungs- und Richtungsanzeige. Ermittlung der eigenen 
Position siehe Seite s. S. 6-3.
 LBei Wahl eines FM-Repeaters werden „FM“ oder „FM-N“ 
und die Repeater-Ton-Einstellung angezeigt.

TIPP: Das „REPEATER DETAIL“-Display lässt sich 
auch vom DR-Display aus aufrufen.
Wenn der Repeater wie unten gezeigt eingestellt 
wurde, drücken drückt man die [QUICK]-Taste und 
wählt dann „Repeater Detail“.
 

 • Das „REPEATER DETAIL“-Display wird angezeigt.

Entfernung

„REPEATER DETAIL“-Display

Rufzeichen
Beiname

Gruppennummer

Richtung von der
eigenen Position

Repeater-Zeit

Repeater-Frequenz

Duplex-
Einstellung

Repeater-Name Repeater- 
Typ
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Reflektorbetrieb

 DWas ist ein Reflektor?
Ein Reflektor ist ein spezieller Server, der mit dem Internet verbunden ist und auf dem eine Version der 
D-Plus-Software läuft. Wenn die D-Plus-Software auf dem Einstiegs-Repeater installiert ist, bietet sie verschie-
denste Funktionen einschließlich Gateway- und Reflektor-Link-Tauglichkeit (Dies ist als D-STAR-Reflektor-System 
bekannt). Das D-STAR-Reflektor-System ermöglicht den D-STAR-Repeatern rund um die Welt die Verlinkung mit 
anderen Reflektoren. Falls man über einen D-STAR-Repeater sendet, der mit einem Reflektor verlinkt ist, kann 
man den Anruf über andere verlinkte Reflektoren hören. Außerdem hört man selbst andere entfernte Stationen,  
die mit einem Reflektor verbunden sind.

CAN

AUS

USA
UK

D-STAR-Reflektor-System

Reflektor
Einstiegs-
Repeater

 DLink zu einem Reflektor unterbrechen
Bevor man sich mit einem anderen Reflektor verlinkt, 
MUSS der bestehende Link unterbrochen werden.

HINWEIS: Bevor man eine Verlinkung mit einem Re-
flektor unterbricht, muss man erfragen, ob ein Wech-
sel des Reflektors möglich ist und auf eine Antwort 
warten. VERGEWISSERN SIE SICH, dass Sie nach 
Beendigung der Konversation zum gleichen Reflek-
tor zurückverbunden werden.

1. [DR] 1 Sek. lang drücken, um das DR-Display 
aufzurufen.

2. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken.

 • Das „TO SELECT“-Display wird angezeigt.
3. „Reflector“ wählen. 

 • Das „REFLECTOR“-Display erscheint.

4. „Unlink Reflector“ wählen. 

 • Rückkehr zum DR-Display, „Unlink Reflector“ und 
„U“ werden bei „TO“ angezeigt. 

5. [PTT]-Taste gedrückt halten, um den Link zu 
unterbrechen.

 • Die TX/RX-LED leuchtet rot.
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Reflektorbetrieb

 DVerlinkung mit einem Reflektor
Wenn der eigene Repeater aktuell nicht mit einem Re-
flektor verlinkt ist oder man zu einem anderen Reflek-
tor wechseln möchte, geht man wie folgt vor. Dabei 
ist es vor der Verlinkung mit einem anderen Reflektor 
nötig, die Verlinkung mit dem bisherigen zu unterbre-
chen. (S. 5-14)

Direkteingabe
Beispiel: Direkte Eingabe von „REF030CL.“

1. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken. 

2. „Reflector“ wählen. 

3. „Link to Reflector“ wählen. 

4. „Direct Input“ wählen. 

5. Mit den Navigationstasten Reflektortyp, -nummer 
und Modulbuchstaben wählen. 

6. [ENT] drücken. 

 • Rückkehr zum DR-Display, „Link to Reflector“ und 
„REF030CL“ werden bei „TO“ angezeigt.

7. [PTT]-Taste gedrückt halten, um den Link zum 
Reflektor aufzubauen.

Nutzung der TX-History
In der TX-History werden bis zu 5 Reflektoren gespei-
chert, mit denen der eigene Einstiegs-Repeater zuvor 
verlinkt war.
Beispiel: „REF030CL“ aus der TX History wählen.
1. Mit der Navigationstaste () das Feld „TO“  

wählen, dann [ENT] drücken. 

 • Das „TO SELECT“-Display wird angezeigt.
2. „Reflector“ wählen. 

Das „REFLECTOR“-Display erscheint.
3. „Link to Reflector“ wählen. 

Das „Link to Reflector“-Display erscheint.
4. Reflektor wählen, mit dem man sich verlinken 

möchte. 

 • Rückkehr zum DR-Display, „Link to Reflector“ und 
„REF030CL“ werden bei „TO“ angezeigt. 

5. [PTT]-Taste gedrückt halten, um den Link zum 
Reflektor aufzubauen.
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Reflektorbetrieb

 DNutzung eines Reflektors
1. Mit der Navigationstaste () das Feld „TO“ wählen 

und dann [ENT] drücken.
 • Das „TO SELECT“-Display wird angezeigt.

2. „Reflector“ wählen. 
Das „REFLECTOR“-Display wird angezeigt.

3. „Use Reflector“ wählen. 

 • Rückkehr zum DR-Display, „Use Reflector“ und 
„CQCQCQ“ werden bei „TO“ angezeigt. 

4. Zum Senden [PTT]-Taste drücken und halten.

 DReflektor-Echotest
Um zu überprüfen, ob der Repeater das eigene Signal 
einwandfrei empfängt bzw. ob der Repeater normal 
arbeitet, kann man als Test eine kurze Sprachansage 
senden. Nach dem Senden wird die Sprachansage 
wiedergegeben.

1. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken.

 • Das „TO SELECT“-Display wird angezeigt.
2. „Reflector“ wählen. 

Das „REFLECTOR“-Display erscheint.
3. „Echo Test“ wählen. 

 • Rückkehr zum DR-Display, „Echo Test“ und „E“ 
werden bei „TO“ angezeigt. 

4. [PTT] gedrückt halten und ins Mikrofon sprechen.
5. [PTT] loslassen, um die eigene Sprachansage 

hören zu können.

 DAbfrage der Repeater-Information
Wenn man einen Befehl zur Abfrage der Repea-
ter-Information überträgt, wird vom Repeater eine 
ID-Nachricht zurückgesendet.

1. Mit der Navigationstaste () das Feld „TO“ wählen 
und dann [ENT] drücken.

 • Das „TO SELECT“-Display wird angezeigt.
2. „Reflector“ wählen.

 • Das „REFLECTOR“-Display erscheint.
3. „Repeater Information“ wählen. 

 • Rückkehr zum DR-Display, „Repeater Information“ 
und „I“ werden bei „TO“ angezeigt. 

4. [PTT] drücken und halten, um den Befehl zur  
Abfrage der Repeater-Information zu senden.

5. [PTT] loslassen, um die ID-Nachricht des  
Repeaters anzuhören.
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Kurzmeldungen

Das Handfunkgerät verfügt über 5 Speicher für Kurz-
meldungen, die man beim DV-Betrieb senden kann.
Sie dürfen bis zu 20 Zeichen enthalten.

 DProgrammieren von TX-Meldungen
[MENU] > SET > My Station > TX Message

Beispiel:  Programmieren der TX-Meldung  
„JAPAN TOM“ in den Speicher 1.

1. [MENU] drücken.
2. Im „SET“-Menü „My Station“ wählen.  

3. „TX Message“ wählen. 

4. Nummer des gewünschten Speichers wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Edit“ wählen. 

7. Eine Meldung mit bis zu 20 Zeichen eingeben. 

 LHinweise zur Zeicheneingabe s. S. iii.
8. Eingabe mit [ENT] bestätigen.

 • Rückkehr zum „TX MESSAGE“-Display.

 DSenden von TX-Meldungen
Programmierte TX-Meldungen lassen sich im DV- 
Modus durch Drücken der [PTT]-Taste am Mikrofon 
senden. Dazu die gewünschte TX-Meldung auswählen, 
wodurch die Sendefunktion eingeschaltet wird.

[MENU] > SET > My Station > TX Message

1. [MENU] drücken.
2. Im „SET“-Menü „My Station“ wählen.  

3. „TX Message“ wählen. 

4. Nummer des gewünschten Speichers wählen. 

 LSoll keine TX-Meldung gesendet werden,  
„OFF“ wählen.
 LZum Verlassen die [MENU]-Taste drücken.

 L Information
 • Die TX-Meldung wird mit der Sprache gesendet.
 • Die TX-Meldung wird bei jedem Senden übertragen.
 • Bei längeren Sendedurchgängen wird die TX-Meldung 
automatisch alle 30 Sek. gesendet.

TIPP: Anzeige empfangener Rufzeichen  
und Meldungen
In der Standardeinstellung werden das empfangene 
Rufzeichen und die Nachricht automatisch ange-
zeigt und gescrollt. Soll das nicht erfolgen, ist bei 
„RX Call Sign“ die Einstellung „OFF“ zu wählen.
([MENU] > SET > Display > RX Call Sign)
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Kurzmeldungen

 DLöschen von TX-Meldungen
[MENU] > SET > My Station > TX Message

Beispiel:  Löschen der TX-Meldung „JAPAN TOM“ 
aus dem Speicher 1.

1. [MENU] drücken.
2. Im „SET“-Menü „My Station“ wählen.  

3. „TX Message“ wählen. 

4. Nummer des gewünschten Speichers wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Clear“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
7. „YES“ wählen. 

 • Die eingegebene Meldung wird gelöscht.
 LZum Verlassen die [MENU]-Taste drücken.
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Anzeige empfangener Rufzeichen

Wenn ein DV-Signal empfangen wird, speichert das Handfunkgerät das Rufzeichen der Station und das des Re-
peaters in der RX-History. Bis zu 50 Anrufe werden gespeichert. Wenn man den 51. Anruf empfängt, wird der 
älteste Eintrag der RX-History gelöscht.

 LBeim Ausschalten des Handfunkgeräts bleibt die RX-History erhalten.

1. [CD]-Taste 1 Sek. lang drücken.
2. Zum Ansehen einen Eintrag der RX-History wählen

 L Information
 • Die erste Seite des „RX HISTORY“-Displays zeigt die 
Daten des zuletzt auf dem Hauptband empfangenen 
Anrufs. Auf den nachfolgenden Seiten sind die An-
rufe nach Empfangsdatum und -zeit geordnet, un-
abhängig davon, auf welchem Band sie empfangen 
wurden.

 • Angezeigt werden: die Nummer des RX-History-Ein-
trags, die Namen oder Rufzeichen des Anrufers und 
der angerufenen Station, die RX-Meldung, das Emp-
fangsdatum, die Zeit, „GW“ sowie „GPS“.

 • „GW“ erscheint, wenn ein Gateway-Anruf empfan-
gen wurde.

 • „GPS“ erscheint, wenn der empfangene Anruf 
GPS-Positionsdaten enthält.

 • „UP“ erscheint, wenn es sich bei dem empfangenen 
Anruf um ein Repeater-Uplink-Signal handelt.

 • Im QUICK-Menü sind folgende Einstellungen wählbar:
RX>CS:   Vorübergehende Rufzeichen-

übernahme ins Feld „TO“
Call Sign Display:  Modus zur Anzeige des empfan-

genen Rufzeichens.
Name Display:  Modus zur Anzeige des empfan-

genen Namens
Delete:   Löscht den gewählten  

RX-History-Eintrag.
Delete All:  Löscht die gesamte RX-History.

3. [ENT] drücken.
 • Details zum RX-History-Eintrag werden angezeigt.
 LMit den Navigationstasten () kann man durch den 
Inhalt scrollen.

<erste Seite>
 • CALLER:  Rufzeichen der anrufenden Station*2 

sowie die evtl. angefügte Anmer-
kung.

 • CALLED:  Rufzeichen der angerufenen  
Station*2.

 L „CQCQCQ“ erscheint bei Empfang 
eines Gebiets- oder Gateway-Anrufs.

<zweite Seite>
 • RX RPT1:  Name des Einstiegs-Repeaters der 

anrufenden Station*2. 
Falls der Anruf über ein Gateway 
und das Internet erfolgt ist, wird das 
Gateway-Repeater-Rufzeichen des 
lokalen Repeaters angezeigt, über 
den der Anruf empfangen wurde.

 • RX RPT2:  Name des Repeaters*2, über den 
der Anruf empfangen wurde.

 LAnstelle der oben genannten Anzeigen erscheint 
die Betriebsfrequenz, wenn der Anruf direkt, also 
simplex, ohne Nutzung eines Repeaters empfangen 
wurde.

    

 DAnzeige im „RX HISTORY“-Display

„RX HISTORY“-Display (RX01)

*1  Die angezeigten Symbole unterscheiden sich je 
nach D-PRS-Sendeformat. 
GPS: Position OBJ: Objekt 
ITEM: Item WX: Wetter

*2  Falls ein Name programmiert wurde, wird er ange-
zeigt.

Bei Empfang 
eines Gateway- 
Anrufs

Symbol für D-PRS- 
Sendeformat*1

Angerufene Station
(„CQCQCQ“ er-
scheint bei Empfang 
eines CQ-Anrufs.)

RX-History-
Eintrag

Anrufende Station*2

 L Hinter dem „/“ kann eine 
Anmerkung stehen)

Empfangsdatum
und -zeit

RX-Meldung
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Anzeige empfangener Rufzeichen

 D Anzeige im „RX HISTORY“-Display
<dritte Seite>
 • RX MESSAGE:  Text der Meldung, die mit 

dem Anruf empfangen wurde, 
sofern die anrufende Station 
eine TX-Meldung program-
miert und gesendet hat.

 • RX TIME:   Empfangsdatum und -zeit 
des Anrufs. 

<vierte bis sechste Seite>
Anzeige der Positionsdaten der anrufenden 
Station. Enthält der Anruf keine Positionsdaten, 
erfolgt keine Anzeige.

     

     

     

 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Löschen von RX-History-Daten
Im „RX HISTORY“-Display oder in der Detailanzeige 
die [QUICK]-Taste drücken und anschließend eine 
der Optionen „Delete“ oder „Delete All“ wählen.
 

TIPP: Je nach Kommunikationsweise können die 
Einstellungen für „RX RPT1“ unterschiedlich sein.

Beispiel 1: Empfang eines Gebietsanrufs.

JM1ZLK 
calling you...
JM1ZLK 
calling you...

JM1ZLK  

calling you...JM1ZLK  

calling you...

JM1ZLK  calling you...

JM1ZLK  calling you...

RXRPT2 RXRPT1

ANGERUFENE 
STATION

ANRUFER

EIGENE STATION

Beispiel 2: Empfang eines Gateway-Anrufs.

JM1ZLK calling from

JP1YIU port A...
JM1ZLK calling from

JP1YIU port A...

JM1ZLK calling from

JP1YIU port A...

JM1ZLK calling from

JP1YIU port A...

RXRPT2

RXRPT1

JM1ZLK calling from 
JP1YIU port A...
JM1ZLK calling from 
JP1YIU port A...

ANRUFER

GW

INTERNETINTERNET

ANGERUFENE
STATION

EIGENE STATION
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BK (Break in)-Kommunikation

Die Break-in (BK)-Funktion ermöglicht es, sich in 
Funkverbindungen von Stationen einschalten,  
die mit aktiviertem Rufzeichen-Squelch (DSQL) kom-
munizieren.

 LDie Break-in-Funktion wird beim Ausschalten des Hand-
funkgeräts automatisch ausgeschaltet.

[MENU] > SET > DV Set > BK

1. Während zwei Stationen im DV-Modus kommuni-
zieren, die [RX→CS]-Taste 1 Sek. lang drücken.

 • Nach dem Loslassen der [RX→CS]-Taste ist das Ruf-
zeichen der anrufenden Station oder des Repeaters 
bei „TO“ (Ziel) eingestellt.

 • Warntöne sind hörbar und das Rufzeichen der anru-
fenden Stationen wird angesagt.
 LWenn ein Rufzeichen nicht korrekt empfangen wur-
de, sind Fehlertöne hörbar und es wird nicht über-
nommen.

2. [MENU] drücken.
3. Im „SET“-Menü „DV Set“ wählen. 

Nutzung der Break-in-Funktion
Beim Betrieb mit digitalem Rufzeichen-Squelch (DSQL) ist die Rauschsperre geschlossen, es sind keine Signale 
zu hören. Sie öffnet nur, wenn ein Anruf empfangen wird, der an das eigene Rufzeichen („MY“) gerichtet ist.
Wird jedoch ein Anruf mit einem „BK ON“-Signal (Brake in) empfangen, öffnet sich die Rauschsperre auch wenn 
der Ruf an eine andere Station gerichtet ist und Signale sind hörbar.

4. „BK“ wählen. 

5. „ON“ wählen. 

6. [MENU] drücken. 

 • Rückkehr zum Stand-by-Display, „BK“ erscheint im 
Display.

7. Wenn beide Stationen gerade nicht senden, 
[PTT]-Taste zum Senden drücken und halten.

 L „BK“ blinkt beim Empfang eines Break-in-Anrufs.
 LZum Ausschalten der BK-Funktion bei Schritt 5 
„OFF“ wählen oder das Handfunkgerät ausschalten.

Station C ruft Station A mit „BK OFF“
Station A und B kommunizieren mit digitalem  
Rufzeichen-Squelch.

Station C ruft Station A mit „BK ON“
Station A und B kommunizieren mit digitalem  
Rufzeichen-Squelch.

Station B hört nicht, dass die
Station C die Station A ruft.

Station B hört auch, dass die
Station C die Station A ruft.

Station A Station AStation B Station B

Station C Station C
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EMR-Kommunikation

Im DV-Modus ist die EMR-Kommunikation (Enhanced 
Monitor Request) möglich, bei der es nicht erforderlich 
ist, vorab Rufzeichen zu programmieren.

 L Information
 • Funkgeräte, die ein EMR-Signal empfangen, öffnen den 
Squelch automatisch. Diese Funktion darf NUR im Notfall 
genutzt werden.

 • Wenn im EMR-Modus Signale empfangen werden, sind 
sie mit einer festgelegten Lautstärke hörbar, selbst wenn 
die Lautstärke des Handfunkgeräts auf ein Minimum ein-
gestellt wurde.

 • Der EMR-Modus wird automatisch beendet, wenn das 
Handfunkgerät ausgeschaltet wird.

[MENU] > SET > DV Set > EMR

Beispiel:  Senden im EMR-Modus über den  
„Hirano“-Repeater.

1. [MENU] drücken.
2. Im „SET“-Menü „DV Set“ wählen.  

3. „EMR“ wählen. 

4. „ON“ wählen. 

5. [MENU] drücken. 

 • Rückkehr zum Stand-by-Display, „EMR“ wird angezeigt.
6. [PTT]-Taste drücken.

 • Die TX/RX-LED leuchtet beim Senden rot.
 L „EMR“ blinkt im Display der Gegenstation, wenn 
diese den EMR-Anruf empfangen hat. Die Sprache 
ist mit der vorprogrammierten EMR-Lautstärke oder 
mit der über [VOL] eingestellten hörbar, je nachdem, 
welche von beiden höher ist.
 LZum Ausschalten der EMR-Modus bei Schritt 4 
„OFF“ wählen oder das Handfunkgerät ausschalten.

 DEinstellen der EMR-Lautstärke
Die Lautstärke empfangener EMR-Signale ist von  
0 bis 39 einstellbar.
Wenn ein EMR-Signal empfangen wird, hört man es 
mit der voreingestellten EMR-Lautstärke oder mit der
mit [VOL] eingestellten, je nachdem, welche höher ist.
Zur Unterdrückung von EMR-Signalen „0“ einstellen.

[MENU] > SET > DV Set > EMR AF Level

1. [MENU] drücken.
2. Im „SET“-Menü „DV Set“ wählen.  

3. „EMR AF Level“ wählen. 

4. [DIAL] drehen, um eine EMR-Lautstärke von   
0 (OFF) bis 39 (maximal) einzustellen. 
(voreingestellt: 19) 

 LZum Verlassen die [MENU]-Taste drücken.
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Automatisches Erkennen von DV-Signalen

Wenn beim Betrieb im DV-Modus ein FM-Signal 
empfangen wird, blinken die Symbole „DV“ und „FM“ 
abwechselnd im Display. Bei eingeschalteter Erken-
nungsfunktion wählt das Handfunkgerät automatisch 
FM, damit man das Signal vorübergehend hören 
kann. (voreingestellt: OFF)

 LUnabhängig von dieser Einstellung blinken die Symbo-
le „DV“ und „FM“ abwechselnd beim Empfang eines 
FM-Signals im DV-Modus.

HINWEIS: Bei eingeschaltetem digitalen Rufzei-
chen-Squelch (DSQL) oder digitalen Code-Squelch 
(CSQL) empfängt das Handfunkgerät auch bei akti-
vierter Erkennungsfunktion keine FM-Signale. Man 
kann weiterhin auf die gewünschten Digitalsignale 
warten.

[MENU] > SET > DV Set > DV Auto Detect

1. [MENU] drücken.
2. Im „SET“-Menü „DV Set“ wählen.  

3. „DV Auto Detect“ wählen. 

4. „ON“ wählen. 

 LZum Verlassen die [MENU]-Taste drücken.
 LWenn im DV-Modus ein FM-Signal empfangen wird, 
blinken die Symbole „DV“ und „FM“ abwechselnd im 
Display und das FM-Signal ist hörbar.

Wenn im DV-Modus ein FM-Signal empfangen wird

„DV Auto Detect“-Funktion: OFF
„DV“- und „FM“-Symbole blinken abwechselnd, aber 
das FM-Signal ist nicht hörbar.

„DV Auto Detect“-Funktion: ON
„DV“- und „FM“-Symbole blinken abwechselnd und 
das FM-Signal ist hörbar.

Symbole blinken 
abwechselnd

Symbole blinken 
abwechselnd

FM-Signal ist 
nicht hörbar.

FM-Signal ist 
hörbar.

•  •  •
Thanks for  
the nice QSO!
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Automatische Antwortfunktion

Wenn ein an das eigene Rufzeichen gerichteter Anruf 
empfangen wird, ist ein Warnton hörbar und die Funk-
tion beantwortet den Anruf automatisch durch Senden 
des eigenen Rufzeichens. (voreingestellt: OFF)
Je nach Einstellung kann nach dem Rufzeichen die 
aufgezeichnete Sprachmeldung mitgesendet werden.

HINWEIS: Die automatische Antwortfunktion ver-
wendet das empfangene Rufzeichen temporär als 
Zielrufzeichen.

TIPP: Aufzeichnen der Sprachmeldung
Für die automatische Antwortfunktion kann man eine 
Sprachmeldung aufzeichnen, Details s. S. 5-25. 
([MENU] > RECORD > DV Auto Replay)

[MENU] > SET > DV Set > Auto Reply

1. [MENU] drücken.
2. Im „SET“-Menü „DV Set“ wählen.  

3. „Auto Reply“ wählen. 

4. Eine Option wählen. 

 • ON:  Automatische Antwort mit dem eige-
nen Rufzeichen, ohne Sprachmeldung

 • Voice:  Automatische Antwort mit dem 
eigenen Rufzeichen und der auf der 
Mirco-SD-Karte aufgezeichneten 
Sprachmeldung (bis zu 10 Sek.).

 LWenn keine SD-Karte eingesetzt ist 
oder keine Meldung aufgezeichnet 
wurde, erfolgt die Antwort nur mit dem 
eigenen Rufzeichen.

 • Position:  Automatische Antwort mit dem 
eigenen Rufzeichen und eigenen 
GPS-Positionsdaten

 LWenn bei „GPS Select“ die Einstellung 
„OFF“ oder „Manual“ gewählt ist, wird 
der interne GPS-Empfänger vorüber-
gehend eingeschaltet.

5. [MENU] drücken.
 • Rückkehr zum Stand-by-Display, „ “ wird  
angezeigt
 LWenn man „ON“ oder „Voice“ gewählt hat, schaltet 
sich automatische Antwortfunktion aus, sobald man 
die [PTT]-Taste drückt.
 LWenn man „Position“ gewählt hat, bleibt die automa-
tische Antwortfunktion beim Drücken der [PTT]-Taste 
eingeschaltet.

Beispiel:  Beim Empfang eines Anrufs von „JM1ZLK“ 
ist ein Warnton hörbar und das Handfunk-
gerät sendet automatisch eine Antwort. 

 

Die „TO“-Einstellung ändert sich nicht, aber es 
erscheint „UR: JM1ZLK“ (Rufzeichen der anru-
fenden Station).
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Automatische Antwortfunktion

 DAufzeichnen einer Mitteilung für die 
automatische Antwort

Die Sprachmeldung für die automatische Antwort-
funktion lässt sich aufzeichnen und auf einer Mic-
ro-SD-Karte speichern, sodass das handfunkgerät 
einen Anruf außer mit dem eigenen Rufzeichen auch 
mit einer gesprochenen Mitteilung beantworten kann.

HINWEIS: Sicherstellen, dass sich eine Micro- 
SD-Karte im Kartenslot befindet, bevor man mit der 
Aufzeichnung der Ansage beginnt.

[MENU] > RECORD > DV Auto Reply

1. [MENU] drücken.
2. Im „RECORD“-Menü „DV Auto Reply“ wählen. 

3. Zum Aufzeichnen die [PTT]-Taste drücken und 
halten. Beim Loslassen der [PTT]-Taste wird die 
Aufzeichnung beendet. 

 L Information
 • Die maximale Aufzeichnungsdauer beträgt 10 Sek.
 • Das Mikrofon 5 bis 10 cm vor den Mund halten und mit 
normaler Lautstärke sprechen.
 • Es kann nur eine Ansage aufgezeichnet werden. Wenn man 
die Aufzeichnung wiederholt, wird die zuvor auf der Mic-
ro-SD-Karte gespeicherte überschrieben.

4. Zum Verlassen des Menüs zweimal [MENU]  
drücken.

Das „DV AUTO REPLY“-Display
  

TIPP: Die Aufzeichnung lässt sich löschen,  
indem man im „DV AUTO REPLY“-Display die 
[QUICK]-Taste drückt und dann „Clear“ wählt.
  

Aufnahme-
pegel

Mikrofonverstärkung so einstellen,  
dass der Aufnahmepegel diese  
Markierung nicht erreicht.
([MENU] > SET > Function > MIC Gain 
(Internal), MIC Gain (External))
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Automatische Antwortfunktion

 DAutomatische Antwort  
mit Positionsdaten

Wenn man einen Anruf empfängt, es aber im Moment 
nicht möglich ist, das Handfunkgerät zu bedienen, um 
zu antworten, wird mithilfe dieser Funktion ein Hin-
weiston ausgegeben und eine automatische Antwort 
mit dem eigenen Rufzeichen und den eigenen Posi-
tionsdaten gesendet.

Nach Empfang einer automatischen Antwort mit Posi-
tionsdaten werden Positionsdaten der Gegenstation 
im Display angezeigt.

 L Icom-Transceiver* zeigen die Position nach Empfang 
eines Anrufs an.
 LDie Anzeige der Position der anrufenden Station lässt 
sich ausschalten. (S. 12-26) 
([MENU] > SET > Display > Reply Position Display)

*  Außer ID-31A/E, IC-9100, ID-880H/E880, IC-80AD/E80D, 
IC-92AD/E92D, IC-2820H/E2820, ID-800H, IC-91AD/E91, 
IC-V82, IC-U82

3. Die Positionsdaten werden  
im Display des Anrufers  
angezeigt.

1. Anruf empfangen.

2. Automatisches 
Senden  
der eigenen  
Positionsdaten.

eigene Station

Ziel
(ID-52A/E)

In der unteren Zeile scrollt das Rufzei-
chen oder die empfangene TX-Meldung.

 LEs kann auch eine Statusmeldung ange-
zeigt werden.

Wenn keine gültigen Positionsdaten verfügbar sind

Nach dem Empfang eines an das eigene Rufzeichen 
gerichteten Anrufs wird der interne GPS-Empfänger 
vorübergehend für etwa 5 Minuten eingeschaltet, um 
Positionsdaten zu empfangen. Das geschieht auch 
dann, wenn im Menü bei „GPS Select“ die Einstellung 
„OFF“ oder „Manual“ gewählt wurde. Das Handfunk-
gerät antwortet automatisch mit einer Nachricht, wie 
unten beschrieben. 
([MENU] > GPS > GPS Set > GPS Select)

 LWenn sich der interne GPS-Empfänger vorübergehend 
einschaltet und gültige Positionsdaten empfängt, antwor-
tet das Funkgerät automatisch, sobald der an das eigene 
Rufzeichen gerichtete Anruf erneut empfangen wird.

Antwortmeldungen, wenn keine gültigen  
Positionsdaten verfügbar sind

Meldung Status

No Position Keine Positionsdaten verfügbar.

Old Position
Mehr als 2 Minuten sind seit 
dem Empfang der letzten Posi-
tionsdaten vergangen.

No Posi & GPS Start

Der interne GPS-Empfänger ist 
vorübergehend eingeschaltet, 
hat aber noch keine Positions-
daten empfangen.

Old Posi & GPS Start

Der interne GPS-Empfänger ist 
vorübergehend eingeschaltet 
und es sind mehr als 2 Minuten 
seit dem Empfang der letzten 
Positionsdaten vergangen.

TIPP:
 • Die Positionsdaten werden entsprechend der Ein-
stellung bei „GPS TX Mode“ gesendet. (S. 6-12)

 • Wenn die Einstellungen bei „GPS TX Mode“ für 
die automatische Antwortfunktion nicht korrekt 
sind, werden diese automatisch korrigiert, um auf 
einen Anruf antworten zu können.

 • Wenn bei „GPS TX Mode“ die Option „OFF“ ein-
gestellt ist, wird automatisch „D-PRS“ gewählt.

JA3YUA
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Datenkommunikation

Zusätzlich zu der digitalen Sprachkommunikation 
kann man Daten senden und empfangen. Außerdem 
lässt sich der schnelle DV-Datenbetrieb für Daten-
kommunikation nutzen. (S. 5-28)
Dazu sind ein USB-Kabel und die entsprechende 
Software erforderlich (beides selbst zu beschaffen).

HINWEIS: Bei „DV Data TX“ ist „Auto“ voreinge-
stellt. In diesem Fall sendet das Handfunkgerät die 
Daten automatisch, wenn man sie über die Tastatur 
des angeschlossenen PCs eingibt bzw. je nach Be-
dienung der genutzten Software.

 DAnschließen an den PC
Handfunkgerät wie abgebildet mit einem USB-Kabel 
an den PC anschließen.

HINWEIS: Bevor man erstmalig Daten senden kann, 
sind folgende Einstellungen vorzunehmen:

 • Bei „GPS Out (USB Port)“ Einstellung „OFF“ wählen. 
([MENU] > GPS > GPS Set > GPS Out (USB Port))

 • Bei „USB Connect“ „Serialport“ einstellen 
([MENU] > SET > Function > USB Connect)

 • Bei „USB Serialport Function“ „DV Data“ einstellen. 
([MENU] > SET > Function > USB Serialport Function)

 DEinstellungen für die  
Datenkommunikation

Die PC-Software für die Datenkommunikation muss 
folgendermaßen konfiguriert werden:

 • Port:  COM-Portnummer, die vom ID-52E genutzt 
wird.*

 • Baud-Rate: gewünschte Datenübertragungsrate
 • Datenbits: 8 Bit
 • Paritätsbit: keins
 • Stoppbit: 1 Bit
 • •Steuerung: Xon/Xoff

*  Je nach PC-Umgebung kann die COM-Portnummer, die 
vom ID-52E genutzt wird, höher als 5 sein. In diesem Fall 
ist eine Applikation zu wählen, welche die Vergabe einer 
Nummer über 5 gestattet.

 DDaten senden
1. Eigenes Rufzeichen, das der Gegenstation, das 

des Repeaters usw. einstellen.
2. Handbuch der Anwendersoftware für die Daten-

kommunikation beachten.
3. Wenn Daten direkt über den PC eingegeben 

werden, sendet das Handfunkgerät diese je nach 
Software und Einstellung automatisch.

 LWenn bei „DV Data TX“ die Einstellung „PTT“ ge-
wählt ist, werden beim Drücken der [PTT]-Taste 
Daten und Sprachsignale gesendet. (S. 12-10) 
([MENU] > SET > DV Set > DV Data TX)
 LVor der Datenübertragung sendet das Handfunkgerät 
etwa 500 ms lang einen Träger.

HINWEIS:
 • Für die Datenkommunikation können nur ASCII-
Code-Zeichen genutzt werden.

 • Mit einem DV-Sprachsignal lassen sich bis zu 20 
Zeichen lange Meldungen senden. (S. 5-17)

 • Unter Umständen können in Abhängigkeit vom 
verwendeten PC und der genutzten Datenkom-
munikationssoftware Datenverluste auftreten.

 • Bei Sprach- oder Datenkommunikation kann es 
bei QSOs zwischen verschiedenen Zonen über 
das Internet infolge unzureichenden Datendurch-
satzes zum Verlust von Datenpaketen kommen. In 
diesem Falle erscheint im Display ein „L“.

PC
zum  
[USB]-Port

zum  
USB-Port

ID-52E

USB-Kabel
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Datenkommunikation

 DSchneller DV-Datenbetrieb
Das Senden von Daten mithilfe des schnellen DV-Da-
tenbetriebs erfolgt wie unten aufgeführt.

 LDer schnelle DV-Datenbetrieb ist mit folgenden Transcei-
vern (Stand November 2021) möglich:

 • IC-705
 • IC-9700
 • ID-31A/E PLUS
 • ID-4100A/E
 • ID-5100A/E*
 • ID-51A/E (PLUS, PLUS2, 50th-Anniversary-Modell)
 • ID-52A/E

*  Nur bei Transceivern mit einer Firmware-Version der 
CPU ab M 1.10, S 1.00, C 1.10 und DSP 1.10 oder 
neuer.

HINWEIS: Wenn man GPS-Daten an Transceiver 
senden möchte, die Daten nur langsam empfangen 
können, ist bei „GPS Data Speed“ die Einstellung 
„Slow“ zu wählen. (S. 6-4)
([MENU] > SET > DV Set > DV Fast Data > GPS Data Speed)

[MENU] > SET > DV Set > DV Fast Data > Fast Data

1. MENU] drücken.
2. Im „SET“-Menü „DV Set“ wählen.  

3. „DV Fast Data“ wählen. 

4. „Fast Data“ wählen. 

5. „ON“ wählen. 

 • Zum Verlassen die [MENU]-Taste drücken.

Displaydarstellung

Zur besseren Lesbarkeit lassen sich Zeichen, z. B. der 
im DR-Display angezeigte Repeater-Name, vergrößert 
darstellen.

 LDiese Einstellung ist nur für die Einbandanzeige nutzbar.
1. Für das Hauptdisplay die Einbandanzeige wählen. 

2. [QUICK] drücken.
3. „Display Type“ wählen. 

4. Option „Large“ wählen. 

 • Die Zeichen, z. B. der Repeater-Name, werden  
vergrößert dargestellt.



5 ERWEITERTER D-STAR-BETRIEB

5-29

Digitale Squelch-Funktionen

Der Digital-Squelch öffnet nur, wenn ein empfangener 
Anruf das eigene Rufzeichen oder den passenden 
Digitalcode enthält. Dadurch hat man die Möglichkeit, 
bei stummgeschaltetem Handfunkgerät auf ganz be-
stimmte Anrufe zu warten.
Die digitalen Squelch-Funktionen lassen sich unab-
hängig für den VFO- und Speichermodus, die Anruf-
kanäle und den Betrieb im DR-Modus einstellen.

 DDigitalen Rufzeichen-Squelch  
einstellen

1. [QUICK] drücken.
2. „D.SQL“ wählen. 

3. „DSQL“ wählen.

„DSQL“ erscheint 
im Display

 • Wenn ein Signal empfangen wird, das ein passendes 
Rufzeichen enthält, öffnet die Rauschsperre und das 
Signal ist hörbar.
 LSignale ohne passendes Rufzeichen öffnen die 
Rauschsperre nicht, das Signal ist nicht hörbar, ob-
wohl das S-Meter die Signalstärke anzeigt.

HINWEIS:
 • Den digitalen Rufzeichen-Squelch NICHT ver-
wenden, wenn man ein QSO mit zwei oder mehr 
Stationen hat, weil die Rauschsperre dann nur 
öffnet, wenn das Signal das eigene Rufzeichen 
enthält.

 • Im DV-Modus können auch bei geschlossenem 
digitalen Rufzeichen-Squelch Daten empfangen 
werden.

 DDigital-Code-Squelch einstellen
1. [QUICK] drücken.
2. „D.SQL“ wählen. 

3. „CSQL“ wählen.

„CSQL“ erscheint 
im Display

4. [MENU] drücken.
5. Im „SET“-Menü „DUP/TONE...“ wählen.
6. „Digital Code“ wählen. 

7. Durch Drehen von [DIAL] einen Digitalcode wählen. 

 • Wenn ein Signal empfangen wird, das einen passen-
den Code enthält, öffnet die Rauschsperre und das 
Signal ist hörbar.
 LSignale ohne passenden Code öffnen die Rausch-
sperre nicht, das Signal ist nicht hörbar, obwohl das 
S-Meter die Signalstärke anzeigt.
 LZum Verlassen die [MENU]-Taste drücken.

HINWEIS: Im DV-Modus können auch bei geschlos-
senem digitalen Code-Squelch Daten empfangen 
werden.
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Repeater-Liste

Repeater-Daten und -Informationen von bis zu 2500 
Repeatern lassen sich für den schnellen und einfa-
chen Aufruf in der Repeater-Liste speichern, die bis 
zu 50 Repeater-Gruppen enthalten kann. Eine pro-
grammierte Repeater-Liste ist Voraussetzung für den 
Betrieb im DR-Modus. Gruppen und Einträge können 
hinzugefügt und bearbeitet werden.
Vier Kommunikationstypen sind für die Repeater-
Liste wählbar:

 • DV-Repeater
 • DV-Simplex
 • FM-Repeater
 • FM-Simplex

TIPP:
 • Für die einfache Bedienung des Handfunkgeräts 
ist eine Repeater-Liste vorprogrammiert. Bei 
einem Total-Reset wird diese gelöscht. Es ist 
daher ratsam, die vorhandene Repeater-Liste mit-
hilfe der optionalen Programmiersoftware CS-52 
auf einem PC oder einer Micro-SD-Karte zu spei-
chern.

 • Die Repeater-Liste steht auf der Icom-Website 
https://www.icomeurope.com/support/  
zum Download bereit. Eine Anleitung zur Aktuali-
sierung der Repeater-Liste ist unter dem Namen 
„Updating the repeater list“ auf der Website 
https://www.icomjapan.com/support/ 
zu finden.

 DInhalt der Repeater-Liste
Die Einträge in der Repeater-Liste können folgende 
Daten bzw. Informationen enthalten:

 • TYPE: Kommunikationstyp (S. 5-32)
 • NAME: Repeater-Name (S. 5-32)
 • SUB NAME: Repeater-Beiname (S. 5-32)
 • CALL SIGN:  Repeater-Rufzeichen und  

Port-Buchstabe (S. 5-32)
 • GW CALL SIGN:  Gateway-Repeater-Rufzeichen und 

Port-Buchstabe „G“ (S. 5-32)
 • GROUP: Repeater-Gruppe (S. 5-33)
 • USE (FROM): Einstiegs-Repeater (S. 5-33)
 • FREQUENCY:  Empfangsfrequenz des  

Einstiegs-Repeaters (S. 5-33)
 • DUP: Duplex-Ablagerichtung (S. 5-33)
 • OFFSET FREQ: Repeater-Offsetfrequenz (S. 5-33)
 • MODE: Sendeart (S. 5-34)
 • TONE: Ton-Einstellung (S. 5-34)
 • REPEATER TONE: Repeater-Ton (S. 5-34)
 • POSITION:  Genauigkeit der Positionsdaten  

(S. 5-34)
 • LATITUDE: Breitengrad (S. 5-34)
 • LONGITUDE: Längengrad (S. 5-35)
 • UTC OFFSET: Abweichung von der UTC (S. 5-35)

Beispiel: „Hirano“-Repeater-Informationen
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Neue Daten in die Repeater-Liste eingeben

Nachfolgend wird beschrieben, wie man Daten für 
einen neuen Repeater in die Repeater-Liste eingibt.
Welche Daten programmiert werden müssen, hängt 
von der jeweiligen Nutzung des Repeaters ab.

HINWEIS: Zuerst muss das Rufzeichen des Repea-
ters in die Repeater-Liste eingetragen werden, bevor 
man die weiteren Informationen eingeben kann.

 DErforderliche Daten für die Kommunikation

Inhalt der  
Repeater-Liste

Nutzung als 
Einstiegs- 
Repeater

Nutzung als
Ziel-

Repeater

Nutzung als
FM-Repeater

Simplex (FROM)

TYPE DV Repeater DV Repeater FM Repeater DV Simplex FM Simplex

NAME ○ ○ ○ ○ ○
SUB NAME ○ ○ ○ ○ ○
CALL SIGN ● ● ○ – –

GW CALL SIGN ●
(für Gateway-Anrufe)

● – – –

GROUP ○ ○ ○ ○ ○
USE(FROM) ● ○ ● ● ●
FREQUENCY ● ○ ● ● ●
DUP ● ○ ● – –

OFFSET FREQ ● ○ ● – –

MODE – – ○ – ○
TONE – – ○ – ○
REPEATER TONE – – ○ – ○
POSITION ○ ○ ○ ○ ○
LATITUDE ○ ○ ○ ○ ○
LONGITUDE ○ ○ ○ ○ ○
UTC OFFSET ○ ○ ○ ○ ○
●: Muss eingegeben werden.
○: Kann eingegeben werden.
  – : Nicht anwendbar.
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Neue Daten in die Repeater-Liste eingeben

Schritt 1. Repeater-Gruppe wählen

[MENU] > MEMORY > Repeater List

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Repeater List“ wählen. 

4. Repeater-Gruppe wählen, zu der der neue Repea-
ter hinzugefügt werden soll. 

 • Anzeige der Repeater der gewählten Gruppe.

5. [QUICK] drücken.
6. „Add“ wählen. 

 • Das „REPEATER LIST EDIT“-Display erscheint.

Schritt 2. Kommunikationstyp wählen
1. „TYPE“ wählen.
2. Kommunikationstyp wählen.

 • DV Repeater: Repeater-Betrieb im DV-Modus.
 • DV Simplex: Simplex-Betrieb im DV-Modus.
 • FM Repeater: Repeater-Betrieb im FM-Modus.
 • FM Simplex: Simplex-Betrieb im FM-Modus.

Schritt 3. Repeater-Namen eingeben
1. „NAME“ wählen.
2. Einen bis zu 16 Zeichen langen Namen eingeben.

 LHinweise zur Zeicheneingabe s. S. iii.
3. Eingabe mit [ENT] bestätigen.

 DNeuen Repeater in die Liste aufnehmen

Schritt 4. Repeater-Beinamen eingeben
1. „SUB NAME“ wählen.
2. Einen bis zu 8 Zeichen langen Namen eingeben.

 LHinweise zur Zeicheneingabe s. S. iii.
3. Eingabe mit [ENT] bestätigen.

Schritt 5. Repeater-Rufzeichen eingeben
 LWenn bei Schritt 2. Kommunikationstyp wählen 
die Einstellung „DV Simplex“ oder „FM Simplex“ 
gewählt ist, weiter mit Schritt 7. Ändern der Re-
peater-Gruppe.

1. „CALL SIGN“ wählen.
2. Repeater-Rufzeichen mit bis zu 8 Zeichen, ein-

schließlich Leerzeichen und Buchstabe für den 
Repeater-Node, eingeben. 

 

HINWEIS: ACHTEN SIE DARAUF, den 8. Buch-
staben des Repeater-Nodes entsprechend dem 
unten gezeigten Frequenzband hinzuzufügen.
Cross-Band-Betrieb zwischen verschiedenen Re-
peater-Nodes am gleichen Standort ist möglich.

 • 1200 MHz: A (B in Japan)
 • 430 MHz: B (A in Japan)
 • 144 MHz: C (in Japan nicht vorhanden)

3. Eingabe mit [ENT] bestätigen.

Schritt 6. Gateway-Repeater-Rufzeichen eingeben
 LWird angezeigt, wenn bei Schritt 2. Kommunika-
tionstyp wählen „DV Repeater“ eingestellt ist.
 LDie 8. Stelle des bei Schritt 5. Repeater-Rufzei-
chen eingeben eingegebenen Rufzeichens wird 
automatisch auf „G“ als Gateway-Port gesetzt. 
Diese Einstellung kann man also überspringen und 
mit dem nächsten Schritt fortfahren.

1. „GW CALL SIGN“ wählen.
2. Ein bis zu 8 Zeichen langes Gateway-Repeater-Ruf-

zeichen (einschließlich Leerzeichen) eingeben.
 LAn 8. Stelle kann nur ein „G“ eingegeben werden.

3. Eingabe mit [ENT] bestätigen.
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Schritt 7. Ändern der Repeater-Gruppe
 LDie bei Schritt 1. Repeater-Gruppe wählen ge-
wählte Repeater-Gruppe wird angezeigt. Zum 
Ändern der Gruppe, wie nachfolgend beschrieben 
vorgehen, ansonsten weiter mit Schritt 8.

1. „GROUP“ wählen.
2. Eine Repeater-Gruppe von 01 bis 50 wählen. 

Schritt 8.  „USE(FROM)“ als Einstiegs-Repeater 
einstellen

 LProgrammierte Repeater können als Einstiegs-Re-
peater für den DR-Modus genutzt werden. Wenn 
kein Einstiegs-Repeater genutzt werden soll, wählt 
man „NO“, weiter mit Schritt 15. Genauigkeit der 
Positionsdaten wählen. In diesem Fall erscheint 
der Repeater nicht im „DR“-Display bei „FROM“.

1. „USE(FROM)“ wählen.
2. „YES“ wählen, um den Repeater als Einstiegs- 

Repeater zu nutzen. 

Schritt 9.  Frequenz des Einstiegs-Repeaters  
einstellen

1. „FREQUENCY“ wählen.
2.  Zum Eingeben der Frequenz [DIAL] drehen. 

 LDer Cursor lässt sich mit den Navigationstasten () 
bewegen.

3. Eingabe mit [ENT] bestätigen.

 D Neuen Repeater in die Liste aufnehmen

Schritt 10. Duplex-Ablagerichtung wählen
 LWenn man bei Schritt 2. Kommunikationstyp 
wählen „DV Simplex“ oder „FM Simplex“ wählt, 
wird dieser Menüpunkt nicht angezeigt.
 L „DUP–“ erscheint automatisch, wenn im vorherigen 
Bedienschritt eine Einstiegs-Repeater-Frequenz 
eingegeben wurde. Falls erforderlich, kann man die 
Ablagerichtung ändern.

1. „DUP“ wählen.
2. Gewünschte Ablagerichtung wählen. 

 • OFF: Die Duplex-Funktion ist ausgeschaltet.
 • DUP–:  Die Sendefrequenz liegt um den Betrag der 

im nächsten Bedienschritt einzugebenden 
Repeater-Frequenzablage unterhalb der 
Empfangsfrequenz.

 • DUP+:  Die Sendefrequenz liegt um den Betrag der 
im nächsten Bedienschritt einzugebenden 
Repeater-Frequenzablage oberhalb der 
Empfangsfrequenz.

Schritt 11. Repeater-Frequenzablage einstellen
 LWenn man bei Schritt 2. Kommunikationstyp 
wählen „DV Simplex“ oder „FM Simplex“ wählt, 
wird dieser Menüpunkt nicht angezeigt.
 LDie Einstellung der Frequenzablage* erfolgt auto-
matisch, wenn bei Schritt 9. Frequenz des Ein-
stiegs-Repeaters einstellen eine Einstiegs-Re-
peater-Frequenz eingegeben wurde. Falls erforder-
lich, kann man die Frequenzablage ändern. 
*  Die werksvoreingestellten Frequenzablagen variieren je 

nach Version des Handfunkgeräts.

1. „OFFSET FREQ“ wählen.
2. Zum Eingeben der Frequenzablage [DIAL] drehen. 

(0.000.00 bis 59.995.00 MHz). 

 LDer Cursor lässt sich mit den Navigationstasten () 
bewegen.

3. Eingabe mit [ENT] bestätigen.
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Schritt 12. FM-Modus wählen
 LWenn man bei Schritt 2. Kommunikationstyp 
wählen „DV Simplex“ oder „FM Simplex“ wählt, 
wird dieser Menüpunkt nicht angezeigt.

1. „MODE“ wählen.
2. Eine der Optionen „FM“ oder „FM-N“ wählen. 

Schritt 13. Repeater-Ton einstellen
 LWenn man bei Schritt 2. Kommunikationstyp 
wählen „DV Simplex“ oder „FM Simplex“ wählt, 
wird dieser Menüpunkt nicht angezeigt.

1. „TONE“ wählen.
2. Eine Option wählen. 

 • OFF: Der Repeater-Ton ist ausgeschaltet.
 • TONE:  Wählen, wenn der Repeater zur Aktivierung 

einen Repeater-Ton benötigt.
 • TSQL:  Wählen, wenn man den Tone-Squelch beim 

Simplex-Betrieb nutzen möchte.

Schritt 14. Wahl der Repeater-Tonfrequenz
 LWenn man bei Schritt 2. Kommunikationstyp 
wählen „DV Simplex“ oder „FM Simplex“ wählt, 
wird dieser Menüpunkt nicht angezeigt.
 LDiese Einstellung ist erforderlich, wenn bei Schritt 
13. Repeater-Ton einstellen „TONE“ oder „TSQL“ 
gewählt wurde.

1. „REPEATER TONE“ wählen.
2. Repeater-Tonfrequenz durch Drehen von [DIAL] 

wählen und mit [ENT] bestätigen. 

 D Neuen Repeater in die Liste aufnehmen

Schritt 15. Genauigkeit der Positionsdaten wählen
 LWenn der Suchlauf nach Repeatern in der Nähe 
nicht genutzt oder die Entfernung bis zum Repea-
ter nicht benötigt wird, ist die Einstellung „None“ 
zu wählen und mit Schritt 18. Abweichung von 
der UTC einstellen fortzufahren.

1. „POSITION“ wählen.
2. Die gewünschte Genauigkeit wählen. 

 • None:   Wählen, wenn keine Positionsdaten  
für den Repeater verfügbar sind.

 • Approximate:  Wählen, wenn für den Repeater nur 
grobe Positionsdaten verfügbar sind.

 • Exact:   Wählen, wenn für den Repeater ge-
naue Positionsdaten verfügbar sind.

Schritt 16. Breitengrad eingeben
 LDieser Menüpunkt erscheint nur, wenn beim 
Schritt 15. Genauigkeit der Positionsdaten wäh-
len „Approximate“ oder „Exact“ gewählt wurde.

1. „LATITUDE“ wählen.
2. Zur Eingabe des Breitengrads [DIAL] drehen. 

 LDer Cursor lässt sich mit den Navigationstasten () 
bewegen.
 LFür eine nördliche Breite „N“, für eine südliche Breite 
„S“ wählen.

3. Eingabe mit [ENT] bestätigen.
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Schritt 17. Längengrad eingeben
 LDieser Menüpunkt erscheint nur, wenn beim 
Schritt 15. Genauigkeit der Positionsdaten wäh-
len „Approximate“ oder „Exact“ gewählt wurde.

1. Select „LONGITUDE“ wählen.
2. Zur Eingabe des Längengrads [DIAL] drehen. 

 LDer Cursor lässt sich mit den Navigationstasten () 
bewegen.
 LFür eine östliche Länge „E“, für eine westliche Länge 
„W“ wählen.

3. Eingabe mit [ENT] bestätigen.

Schritt 18. Abweichung von der UTC einstellen
 LDie Abweichung von der UTC (Universal Time 
Coordinated) bezieht sich auf die Ortszeit am 
Standort des Repeaters. Diese Information ist für 
Anrufe über weit entfernte Repeater zweckmäßig. 
(S. 5-13)

1. „UTC OFFSET“ wählen.
2. Zum Einstellen der Zeitdifferenz zwischen UTC 

und Ortszeit [DIAL] drehen, dann [ENT] drücken. 

 D Neuen Repeater in die Liste aufnehmen

Schritt 19. Repeater-Liste speichern

1. „<<Add Write>>“ wählen.
 • Ein Bestätigungsfenster öffnet sich.

2. „YES“ wählen. 

 • Die eingegebenen Inhalte werden gespeichert und 
die Anzeige kehrt zur gewählten Repeater-Gruppe 
zurück.

TIPP: Eingabe abbrechen
1. [CLR] drücken. Das Bestätigungsfenster  

„Cancel edit?“ erscheint.
2. „YES“ wählen. 

 • Die Eingabe wird abgebrochen und die Anzeige 
kehrt zur gewählten Repeater-Gruppe zurück.
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 DRepeater-Daten editieren
Repeater-Daten kann man editieren, falls sie fehler-
haft sind, Einstellungen geändert oder Informationen 
hinzugefügt werden müssen.

[MENU] > MEMORY > Repeater List

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Repeater List“ wählen. 

4. Repeater-Gruppe mir dem zu editierenden  
Repeater wählen. 

5. Repeater wählen und [QUICK] drücken.
6. „Edit“ wählen. 

7. Eine Einstellung wählen und editieren.
 LDetails siehe Seiten 5-32 bis 5-35.

8. Nach erfolgter Bearbeitung „<<Overwrite>>“ 
wählen. 

 • Ein Bestätigungsfenster öffnet sich.
9. „YES“ wählen. 

 • Die editierten Inhalte werden gespeichert und die An-
zeige kehrt zur gewählten Repeater-Gruppe zurück.
 LZum Verlassen die [MENU]-Taste drücken.

 DRepeater-Daten löschen
[MENU] > MEMORY > Repeater List

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Repeater List“ wählen. 

4. Repeater-Gruppe mir dem zu löschenden  
Repeater wählen. 

5. Repeater wählen und [QUICK] drücken.
6. „Delete“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
7. „YES“ wählen. 

 • Die Daten des Repeaters werden aus der Liste  
gelöscht und die Anzeige kehrt zur gewählten  
Repeater-Gruppe zurück.
 LZum Verlassen die [MENU]-Taste drücken.

HINWEIS: Die Daten des aktuell im DR-Modus ge-
nutzten Repeaters lassen sich weder editieren noch 
löschen. Vor dem Bearbeiten oder Löschen muss ein 
anderer Repeater für den DR-Modus gewählt werden.
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Die Anzeigereihenfolge der Repeater innerhalb der 
Repeater-Gruppe lässt sich ändern.

[MENU] > MEMORY > Repeater List

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Repeater List“ wählen. 

4. Repeater-Gruppe mir dem zu verschiebenden  
Repeater wählen. 

5. Zu verschiebenden Repeater wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Move“ wählen. 

8. Repeater wählen, vor dem der zu verschiebende 
Repeater eingefügt werden soll. 

 LBeim Verschieben blinkt „DESTINATION“ links oben 
im Display.

 • Der Repeater wird vor dem gewählten Repeater ein-
gefügt.
 LWenn man „<<Move End>>“ wählt, wird der Repeater 
an das Ende der Gruppe verschoben.
 LZum Verlassen die [MENU]-Taste drücken.

 DAnzeigereihenfolge der Repeater ändern



5 ERWEITERTER D-STAR-BETRIEB

5-38

Bearbeiten der Repeater-Liste

1. [CD]-Taste 1 Sek. lang drücken.
 • Die RX-History erscheint.

2. Mit den Navigationstasten () den Repeater 
wählen, dessen Informationen in die Repeater- 
Liste übernommen werden sollen, dann [ENT] 
drücken. 

 • Details zum RX-History-Eintrag werden angezeigt.
3. Navigationstasten () drücken bis „RXRPT1“ und 

„RXRPT2“ erscheinen. 

4. [QUICK] drücken.
5. „Add To RPT List“ wählen. 

6. Repeater-Rufzeichen wählen, das zur Liste  
hinzugefügt werden soll. 

 • Das „REPEATER LIST EDIT“-Display erscheint.  
Das gewählte Repeater-Rufzeichen wird automatisch 
übernommen.
 LBefindet sich das Repeater-Rufzeichen bereits in der 
Liste, wird „Duplicate Call Sign“ angezeigt.
 LDetails zum Editieren der Liste s. S. 5-32 bis 5-35.

 DRepeater-Informationen aus der RX-History hinzufügen
7. „<<Add Write>>“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
8. „YES“ wählen. 

 • Die Daten des Repeaters werden zur Liste  
hinzugefügt und die Anzeige kehrt zum  
„RX HISTORY“-Display zurück.
 LZum Verlassen der RX-History [MENU]-Taste  
drücken.
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 DÜbersprungeinstellung für den 
DR-Suchlauf

Beim DR-Suchlauf kann man bestimmte Repeater 
überspringen, wodurch der Suchlauf beschleunigt 
wird. Es ist möglich, einzelne Repeater oder alle  
Repeater einer Gruppe vom Suchlauf auszunehmen

 LWenn ein Repeater mit einer Übersprungmarkierung ver-
sehen wird, erhält er für „USE (FROM)“ automatisch die 
Einstellung „NO“. In diesem Fall lässt er sich auch nicht 
mehr als Einstiegs-Repeater bei „FROM“ wählen.

<Individuelle Übersprungeinstellung>

[MENU] > MEMORY > Repeater List

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Repeater List“ wählen. 

4. Repeater-Gruppe wählen, der der Repeater zuge-
ordnet ist, der beim DR-Suchlauf übersprungen 
werden soll. 

5. Zu überspringenden Repeater wählen und dann 
[QUICK] drücken.

6. „SKIP“ wählen. 

 L „SKIP“ erscheint innerhalb der Repeater-Zeile.

 L „SKIP“ erneut wählen, um die SKIP-Markierung 
wieder zu entfernen.
 L „SKIP All ON“ wählen, um alle Repeater einer  
Gruppe zu überspringen.

<Übersprungeinstellung für Repeater-Gruppen>
1. Im „REPEATER GROUP“-Display wie links be-

schrieben eine Repeater-Gruppe wählen.
2. [QUICK] drücken und dann „SKIP All ON“ wäh-

len, um alle Repeater der Gruppe während eines 
DR-Suchlaufs zu überspringen.

 L ”SKIP All OFF“ wählen, um die SKIP-Markierung der 
Repeater-Gruppe wieder zu entfernen.

TIPP:
 • Wenn man im „FROM SELECT“-Display „Repeater List“ 
wählt, lassen sich die Übersprungeinstellungen in glei-
cher Weise wie zuvor beschrieben vornehmen.

 • Wenn im „DR“-Display „FROM“ gewählt ist, [QUICK]
drücken, dann wie bereits gezeigt vorgehen. 

 L Im Feld „FROM“ wird „SKIP“ angezeigt.
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[MENU] > MEMORY > Repeater List

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Repeater List“ wählen. 

4. Repeater-Gruppe mit dem zu editierenden Namen 
wählen. 

 LNICHT die [ENT]-Taste betätigen!
 LEin bereits vorhandener Gruppenname wird über-
schrieben.

5. [QUICK] drücken.
6. „Edit Name“ wählen. 

7. Einen bis zu 16 Zeichen langen Gruppennamen 
eingeben. 

 

Verwendbare Zeichen und Symbole

A to Z, a to z, 0 to 9, ! " # $ % & ’ ( ) * + , - . / : ; < = > 
? @ [ \ ] ^ _ ` { | } ˜ (Leerraum)

 LHinweise zur Zeicheneingabe s. S. iii.

8. Die Eingabe mit [ENT] bestätigen. 

 • Der eingegebene Name wird übernommen.
 LZum Verlassen die [MENU]-Taste drücken.

 DRepeater-Gruppennamen eingeben und editieren
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 DZielrufzeichen eingeben
Your-Rufzeichen als Ziel lassen sich manuell einge-
ben. Wenn das Zielrufzeichen bei „TO“ eingestellt ist, 
kann man dieses Rufzeichen anrufen, auch wenn man 
den aktuellen Standort der Station nicht kennt Bis zu 
300 Zielrufzeichen lassen sich speichern.

[MENU] > MEMORY > Your Call Sign

Beispiel:  „Rick/JM1ZLK“ als Zielrufzeichen eingeben.

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Your Call Sign“ wählen. 

4. Im „YOUR CALL SIGN“-Display [QUICK] drücken.
5. „Add“ wählen. 

6. „NAME“ wählen. 

7. Einen Stationsnamen mit bis zu 16 Zeichen  
eingeben. 

 LHinweise zur Zeicheneingabe s. S. iii.
8. Eingabe mit [ENT] bestätigen.

9. „CALL SIGN“ wählen. 

10. Stationsrufzeichen mit bis zu acht Zeichen  
(einschließlich Leerzeichen) eingeben. 

11. Eingabe mit [ENT] bestätigen.
12. „<<Add Write>>“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
13. „YES“ wählen. 

 • „Rick JM1ZLK“ wurde in den Rufzeichenspeicher 
übernommen.
 LZum Verlassen die [MENU]-Taste drücken.
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 D Zielrufzeichen eingeben

TIPP:
Rufzeicheneingabe abbrechen
1. [CLR] drücken. Das Bestätigungsfenster  

„Cancel edit?“ erscheint.
2. „YES“ wählen, um die Eingabe abzubrechen  

und zum „YOUR CALL SIGN“-Display zurück-
zukehren. 

Zielrufzeichen editieren
Wenn das eingegebene Zielrufzeichen fehlerhaft ist, 
sich geändert hat oder etwas hinzugefügt werden 
muss, kann man es editieren, indem man bei  
Schritt 5 „Edit“ wählt.
  

Zielrufzeichen (Your Call Sign) eingeben

 DZielrufzeichen löschen
[MENU] > MEMORY > Your Call Sign

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Your Call Sign“ wählen. 

4. Zu löschendes Zielrufzeichen wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Delete“ wählen. 

 • Ein Bestätigungsdialog erscheint.
7. „YES“ wählen. 

 • Das gewählte Zielrufzeichen wird gelöscht und die An-
zeige kehrt zum „YOUR CALL SIGN“-Display zurück.
 LZum Verlassen die [MENU]-Taste drücken.

HINWEIS: Das aktuell im DR-Modus genutzte 
Zielrufzeichen lässt sich weder bearbeiten noch 
löschen. Vor dem Bearbeiten oder Löschen dieses 
Zielrufzeichens muss man für den DR-Modus ein 
anderes wählen.
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 DAnzeigereihenfolge der  
Zielrufzeichen ändern 

Die Anzeigereihenfolge der Zielrufzeichen lässt sich 
ändern, sodass die am häufigsten genutzten ganz 
oben in der Liste stehen.

[MENU] > MEMORY > Your Call Sign

Beispiel: Zielrufzeichen „Rick“ vor „Eddy“ schieben.
1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.
3. „Your Call Sign“ wählen. 

4. Zu verschiebendes Zielrufzeichen wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Move“ wählen. 

Zielrufzeichen (Your Call Sign) eingeben

7. Das Zielrufzeichen wählen, über dem das zu 
verschiebende eingefügt werden soll. 

 LBeim Verschieben blinkt „DESTINATION“ links oben 
im Display.

 • Das Zielrufzeichen wird vor dem gewählten ein-
gefügt.
 LWenn man „<<Move End>>“ wählt, wird das Ziel-
rufzeichen an das Ende der Gruppe verschoben
 LZum Verlassen die [MENU]-Taste drücken.
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Sind die Einstellungen korrekt?

Wenn man einen Gebietsanruf sendet und noch die 
Gateway-Anrufeinstellungen gewählt sind, sendet der 
bei „TO“ gewählte Ziel-Repeater ebenfalls.
In diesem Fall können Stationen, die diesen Repeater 
als Einstiegs-Repeater nutzen, nicht auf ihn zugreifen 
(siehe Abbildung).

IMMER sicherstellen, dass nach einem Gateway-An-
ruf bzw. nach Beendigung einer Gateway-Funkverbin-
dung bei „TO“ „CQCQCQ“ eingestellt ist.

Beispiel: JA3YUA möchte einen Gebietsanruf tätigen.

CQ D-STAR Hirano, this is JA3YUA 
through JP3YHH port A for a local call...
CQ D-STAR Hirano, this is JA3YUA 
through JP3YHH port A for a local call...

CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call...CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call...

CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call...

CQ D-STAR Hirano, this is 

JA3YUA through JP3YHH port A 

for a local call...

INTERNETINTERNET

His setting is wrong! 
I can’t access the repeater!
His setting is wrong! 
I can’t access the repeater!

Fehlerhafte Einstellung bei JA3YUA

Die Einstellung bei „TO“ ist falsch.

Korrekte Einstellung

Für einen Gebietsanruf muss als Ziel („TO“) 
„CQCQCQ“ eingestellt sein. Details dazu sind auf  
S. 5-9 zu finden.

HINWEIS: Mit dieser falschen Einstellung ist zwar 
ein Gebietsanruf möglich, aber der Ziel-Repeater, 
der bei „TO“ gewählt ist, sendet ebenfalls.
Aus diesem Grunde können die Stationen in Funk-
reichweite des Ziel-Repeaters diesen vorüber-
gehend nicht als Einstiegs-Repeater nutzen.

Anrufer
(JA3YUA)

Hirano-Gebiet Hamacho-Gebiet

angerufene 
Station



6-1

Abschnitt 6
GPS-Betrieb .......................................................................................... 6-2

Vor dem GPS-Betrieb ............................................................................ 6-3
 D GPS-Empfang prüfen ................................................................................ 6-3

GPS-Sendearten und Positionsdatenformate ....................................... 6-4

Unterschied zu älteren Icom-Funkgeräten ............................................ 6-4

Wenn ein empfangenes Signal Positionsdaten enthält ......................... 6-5

Ermitteln der GPS-Position ................................................................... 6-5
 D Positionsdaten anzeigen ........................................................................... 6-5
 D „GPS POSITION“-Displays und ihre Bedeutung ....................................... 6-6
 D RX-Positionsfenster ................................................................................... 6-7
 D Anzeigetyp (Haupt- oder Subband) ........................................................... 6-8
 D Kursanzeige ............................................................................................... 6-8
 D Locator-Anzeige ........................................................................................ 6-9
 D GPS-Speicher bzw. GPS-Alarm ändern .................................................... 6-9
 D Kompass-Grundausrichtung ändern ....................................................... 6-10
 D Eigene oder empfangene Positionsdaten speichern .............................. 6-10

GPS-Status überprüfen ....................................................................... 6-11

D-PRS-Daten senden .......................................................................... 6-12
 D D-PRS ..................................................................................................... 6-12
 D Betrieb im D-PRS-Modus ....................................................................... 6-12
 D Angezeigte Informationen ....................................................................... 6-13
 D D-PRS-Position einstellen (Mobilstation/Basisstation) ........................... 6-14
 D D-PRS-Objekt/Item einstellen ................................................................. 6-15
 D D-PRS-Wetter einstellen ......................................................................... 6-16
 D Daten einer Wetterstation senden ........................................................... 6-17
 D Einstellungen für die Datenübertragung .................................................. 6-17
 D Wetterstationsdaten prüfen ..................................................................... 6-17
 D Einzelheiten der Wetterdaten .................................................................. 6-17
 D Eigene Position mittels Kartensoftware anzeigen ................................... 6-18

NMEA-Daten senden ........................................................................... 6-20
 D GPS-Datensatz einstellen ....................................................................... 6-20
 D GPS-Meldung eingeben .......................................................................... 6-21

Automatischen Senden von GPS-Daten ............................................. 6-21

GPS-Speicher ..................................................................................... 6-22
 D GPS-Speicher hinzufügen ....................................................................... 6-22
 D Namen für GPS-Speichergruppen eingeben .......................................... 6-25
 D GPS-Speicher löschen ............................................................................ 6-25
 D Anzeigereihenfolge von GPS-Speichern ändern ..................................... 6-26

GPS-Alarm .......................................................................................... 6-27
 D GPS-Alarm für alle GPS-Speicher einstellen .......................................... 6-28
 D GPS-Alarm für eine bestimmte Station einstellen ................................... 6-29

GPS-Menüeinstellungen ..................................................................... 6-30

ERWEITERTER GPS-BETRIEB



6 ERWEITERTER GPS-BETRIEB

6-2

D-PRS-Erweiterungen (S. 6-4)
Mit der D-PRS Extension-Funktion kann man zusätzlich zu den Positionsdaten Objekt-, Item- und Wetterinforma-
tionen empfangen. Darüber hinaus werden von einigen Stationen, die im DV-Modus senden, zusammen mit den 
NF-Signalen Informationen über Erdbeben, Verkehrsunfälle und ähnliche Ereignisse übertragen.

GPS-Speicher (S. 6-22)
Das Handfunkgerät verfügt über 300 GPS-Speicher. Wenn man die GPS-Position eines Ziels eingibt, ist die 
GPS-Alarmfunktion nutzbar. Ermittelte Positionsdaten lassen sich ebenfalls in GPS-Speichern speichern.

I can enter the location information 
of the mountain I’m going to hike!
I can enter the location information 
of the mountain I’m going to hike!

Editing GPS Memories using 
a PC is easier than using 
the transceiver!

Editing GPS Memories using 
a PC is easier than using 
the transceiver!

GPS-Alarm-Funktion (S. 6-27)
Wenn die Zielstation in ein voreingestelltes Alarmgebiet eintritt oder wenn man selbst das im GPS-Speicher pro-
grammierte Gebiet erreicht, lässt sich mit dieser Funktion ein Alarmton auslösen, um darauf aufmerksam zu ma-
chen, dass man sich einem bestimmten Ziel nähert.

I’m almost there!I’m almost there!

GOAL!GOAL!

GPS-Logfunktion
Die GPS-Logfunktion ermöglicht es, mit dem GPS-Empfänger ermittelte Positionsdaten als Logdatei auf der  
Micro-SD-Karte zu speichern. Wenn der GPS-Logger während der Fahrt aktiviert ist, kann man die zurückgelegte 
Fahrstrecke mit einer Kartensoftware überprüfen.

I can track my GPS log in a 
mapping software program.
This is how I traveled...interesting!

I can track my GPS log in a 
mapping software program.
This is how I traveled...interesting!

GPS-Betrieb

Details zur Nutzung dieser Funktion sind in der englischsprachigen Anleitung „Using the GPS Logger function“ 
enthalten, die auf der Website https://www.icomjapan.com/support/ zum Herunterladen zur Verfügung steht.
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Vor dem GPS-Betrieb

HINWEIS: Vor der Nutzung der GPS-Funktion lesen Sie bitte im Abschnitt „Wichtige Hinweise“ der Basis-Bedie-
nungsanleitung die Informationen zur Nutzung des GPS-Empfängers.

Das Handfunkgerät verfügt über einen eingebauten 
GPS-Empfänger, der in jeder Betriebsart GPS-Posi-
tionsdaten empfangen kann.

HINWEIS: Positionsdaten können nur im DV-Modus 
gesendet werden.

 DGPS-Empfang prüfen
Zunächst prüfen, ob der GPS-Empfänger Positions-
daten und die Zeit empfängt.
  Während der Suche nach Satelliten blinkt das 

GPS-Symbol.
  →  →  → 
  Das GPS-Symbol hört auf zu blinken, sobald die 

für die Ermittlung der Position erforderliche Min-
destanzahl von Satelliten gefunden ist.

 

 L Information
 • Es dauert einige Sekunden, bis gültige GPS-Daten 
empfangen werden. Unter ungünstigen Empfangsver-
hältnissen, bei denen die „Sicht“ zu den GPS-Satelliten 
behindert ist, können auch mehrere Minuten vergehen. 
Gegebenenfalls muss man den Standort wechseln.

 • Wenn man bei „GPS Select“ die Einstellung „Manual“ 
wählt, wird das Symbol nicht angezeigt. 
([MENU] > GPS > GPS Set > GPS Select)

HINWEIS: Wenn der interne GPS-Empfänger dauer-
haft eingeschaltet ist, wird der Akkupack schnell 
entladen. Die Betriebsdauer lässt sich aber verlän-
gern, wenn man die Batteriesparfunktion einschal-
tet, siehe S. 6-30.
( [MENU] > GPS > GPS Set > GPS Option  
> Power Save)

TIPP: Verlängern der Betriebsdauer beim 
GPS-Betrieb
Die Betriebsdauer lässt sich verlängern, indem man 
die GPS-Position manuell aktualisiert.

1. Bei „GPS Select“ die Einstellung „ON“ wählen 
und Positionsdaten empfangen. 
([MENU] > GPS > GPS Set > GPS Select)

2. Das „MANUAL POSITION“-Display öffnen und 
dann [QUICK] drücken. 
([MENU] > GPS > GPS Set> Manual Position)

3. „Capture From GPS“ wählen. 

 • Die aktuelle Position wird gespeichert und im  
„MANUAL POSITION“-Display angezeigt.

4. Danach im „GPS Select“-Display „Manual“ 
wählen. 
([MENU] > GPS > GPS Set > GPS Select)
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GPS-Positionsdaten werden in zwei Modi gesendet, 
D-PRS und NMEA. Für die D-PRS-Daten gibt es fünf 
Positionsdatenformate: Position (Mobilstation/Basis-
station), Objekte, Items und Wetter sind wählbar.

Beispiel:  Station sendet D-PRS-Positionsdaten als 
Mobilstation
([MENU] > GPS > GPS Position)

GPS-Sendearten und Positionsdatenformate

D-PRS
D-PRS ist eine Funktion, bei der die Station im Slow-Speed-Modus simultan mit der 
Sprache Datenpakete mit Positionsdaten vom internen GPS-Empfänger überträgt.

Position (Mobile)
Die Station sendet aus einem Fahrzeug oder von einem anderen als dem norma-
len festen Standort.

Position (Base) Die Station sendet von normalen festen Standort oder aus einem Gebäude.

Object
Senden von Objektdaten wie Informationen zu Erdbeben, zur Satellitenverfolgung 
usw. Objekte enthalten Zeitmarken.

Item
Senden von Item-Daten wie Verkehrsunfälle, Leuchttürme, Antennen,  
DV-Access-Punkte usw. Items enthalten keine Zeitmarken.

Weather
Die Station sendet Wetterinformationen, die von einer Wetterstation empfangen 
wurden.

NMEA Die Station sendet Positionsdaten (NMEA0183) vom internen GPS-Empfänger.

 (Stand November 2021)
 • Die GPS-TX-Modi „GPS (DV-G)“ und „GPS-A (DV-A)“ werden nun als „NMEA (DV-G)“ und „D-PRS (DVA)“ bezeichnet. 
GPS (DV-G) → NMEA (DV-G) 
GPS-A (DV-A) → D-PRS (DV-A)

 • Für Nutzer, die eines der folgenden Funkgeräte verwenden: 
ID-800H, IC-91AD/E91, IC-U82, IC-V82, IC-7100, ID-51A/E, ID-31A/E, IC-9100, IC-80AD/E80D, ID-880H/E880, 
IC-92AD/E92D, IC-2820H/E2820 
Beim Empfang von D-PRS-Position (Basisstation), Objekt, Item oder Wetter werden keine Daten angezeigt.

 • Nur die Funkgeräte ID-51A/E PLUS, ID-51A/E PLUS2, ID-31A/E PLUS, ID-5100A/E, ID-4100A/E, IC-R30, IC-
9700, IC-705 und ID-52A/E empfangen Daten zur Sendeleistung, Höhe über NN, Gewinn und Richtung.

 • Wenn die Höhe mitgesendet wird und das D-PRS-Signal mit einem der Transceiver IC-9100, IC-80AD/E80D, ID-
880H/E880, IC-92AD/E92D, IC-U82, IC-V82empfangen wird, erscheint die Höhe als Anmerkung.

 • Wenn GPS-Daten an eine Station gesendet werden sollen, die ein früheres Modell benutzt (IC-2820H/E2820, 
ID-800H, IC-91AD/E91, IC-V82, IC-U82, IC-2200H), muss GSV als Datensatz abgeschaltet werden, da dieser 
nicht kompatibel mit diesen Transceivern ist. Mit einem ID-52E gesendete GSV-Datensätze werden nicht richtig 
angezeigt.

Unterschied zu älteren Icom-Funkgeräten
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Wenn ein empfangenes Signal 
Positionsdaten enthält

Wenn empfangene Signale Positionsdaten enthalten, 
wird die Position des Anrufers im RX-Positionsfenster 
angezeigt.
Details siehe rechts.

Beispiel:  Signal von JG3LUK enthält Positionsdaten. 
 

Wenn das Signal empfangen wird, werden 
die enthaltenen Positionsinformationen im 
RX-Positionsfenster angezeigt.

Nach einigen Sekunden verschwindet das
Fenster wieder. 

RX-Positionssymbol

 

Wenn das empfangene Signal Positions-
daten enthält, erscheint das RX-Positions-
symbol wie oben angezeigt.

 LDie Anzeige der Positionsdaten des Anrufers kann man 
ausschalten. 
([MENU] > SET > Display > RX Position Display)
 LDie Anzeige des RX-Positionssymbols lässt sich eben-
falls ausschalten. 
([MENU] > SET > Display > RX Position Indicator)

Ermitteln der GPS-Position

Die eigene Position lässt sich anzeigen. Nachfolgend 
wird davon ausgegangen, dass GPS-Daten vorliegen.

 LDie Display-Abbildungen sind beispielhaft.

 DPositionsdaten anzeigen
1. [QUICK] drücken.
2. „GPS Position“ wählen.

 • Das „GPS POSITION“-Display erscheint.
3. [DIAL] drehen.

 • Die Anzeige wechselt zwischen „MY“ (eigene Posi-
tion), „RX“ (empfangene Position), „MEM“ (GPS- 
Speicherposition) und „ALM“ (GPS-Alarmposition). 

Das Symbol entspricht dem angezeigten 
Display (MY, RX, MEM oder ALM).

4. Zum Schließen des „GPS POSITION“-Displays 
[MENU]-Taste drücken.

HINWEIS: Längen- und Breitengrad sowie die  
Höhenangabe ü. N. N., variieren je nach Standort.

TIPP:
 • Wenn man bei geöffnetem „GPS POSITION“-Display 
sendet, wird es geschlossen. Um die Position während 
des Sendens zu überprüfen [QUICK] drücken, dann 
„GPS Position“ wählen.

 • Die bei „MY“ oder „RX“ angezeigten Positionsdaten, 
kann man in einen GPS-Speicher schreiben, indem 
man [QUICK] drückt und dann „GPS Memory“ wählt.

 • Details zur GPS-Speicherfunktion siehe S. 6-22, zur 
GPS-Alarmfunktion siehe S. 6-27.
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„MY“-Display (eigene Position)

Ermitteln der GPS-Position

 D„GPS POSITION“-Displays und ihre Bedeutung

 L Information
 • [QUICK] zum Ändern der Kompass-Grundausrichtung 
drücken (S. 6-10)

 • Kursanzeige (S. 6-8)
 • Locator-Anzeige (S. 6-9)

Beispiel für die „GPS POSITION“-Anzeige:

GPS-Speicher:
Tokyo Skytree

GPS-Alarm:
Tokyo Big Sight

Empfangene Station
(D-PRS: mobile)

Kurs: 95°
Geschwindigkeit: 5,6 mph

Eigene Station
Kurs: 0°

Geschwindigkeit: 
2,3 mph

251 Meilen

248 Meilen

107 Meilen

Entfernung
vom eigenen
Standort

„RX“-Display (Position der empfangenen Station)

eigene Bewe-
gungsrichtung Breitengrad

Längengrad

Höhe

Zeit

eigener Kurs

Geschwindigkeit

Locator

Wenn bei „GPS Select“ die Einstellung „Manual“ 
gewählt ist, erfolgt keine Anzeige von Kompass- und 
-bewegungsrichtung. (S. 6-30) 
([MENU] > GPS > GPS Set > GPS Select)

Die angezeigten Informationen können abweichen 
bzw. werden je nach GPS-Sendeart und Positions-
datenformat des Anrufers eventuell nicht angezeigt. 
(S. 6-7)
Beispiel:  Die GPS-Sendeart der empfangenen Station 

ist „D-PRS“ und das Positionsdatenformat ist 
„Position (Mobile)“.

D-PRS-Symbol

Rufzeichen der empfangenen Station mit SSID

Kurs der  
empfangenen
Station

Zeit, zu der die 
empfangene 
Station die 
Positionsdaten 
ermittelt hat.

Geschwindig-
keit der  
empfangenen
Station

„MEM“-Display (Position im GPS-Speicher)

„ALM“-Display (Position im GPS-Alarm-Speicher)

*  Wenn ein GPS-Speicher keinen Namen hat, werden 
Datum und Zeit anstelle des Namens angezeigt.  
Im QUICK-Menü-Fenster kann man das „GPS  
POSITION“-Display aufrufen und GPS-Speicher 
oder GPS-Alarme ändern. (S. 6-9)

Richtung vom 
eigenen Standort

Richtung vom 
eigenen Standort

*

*

Richtung  
vom eigenen 
Standort
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 DRX-Positionsfenster

Ermitteln der GPS-Position

GPS-Sendeart:
 D-PRS

Zeit, zu der die  
Objektdaten gesendet 
wurden.

Object

 LFür eine Item-Station erfolgt keine Zeitanzeige.

Item

Zeit, zu der die Wetter-
daten bezogen wurden.

Weather

Symbol für
einen festen
Standort

Für einen festen Standort 
werden Sendeleistung,
Antennenhöhe, Antennen-
gewinn und Antennenstrahl-
richtung angezeigt

Position (Base)

GPS-Sendeart:
 NMEA
   

 LSymbol oder SSID werden nicht angezeigt, wenn die GPS-Sendeart der Station NMEA ist.

Bewegungssymbol Kurs und  
Geschwindigkeit 
einer Mobilstation

Position (Mobile)

 LDas Rufzeichen wird mit SSID angezeigt.
 LWenn die Objekt- oder Item-Station ausgeschaltet ist, erscheint „KILLED“ im Display
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 DKursanzeige
Der in „GPS POSITION“-Displays angezeigte Kurs 
wird in Grad angegeben.

0°

90°270°

180°

45°

135°225°

315° N

E

S

W

Ermitteln der GPS-Position

 DAnzeigetyp (Haupt- oder Subband)
Für die Anzeige des RX-Positionsfensters kann man 
zwischen verschiedenen Typen wählen.

1. Bei geöffnetem RX-Positionsfenster [QUICK] 
drücken.

2. „Display Select (MAIN/SUB)“ wählen. 

3. Eine Option wählen. 

 • Latest (MAIN/SUB):  Anzeige der neuesten, auf dem 
Haupt- oder Subband empfan-
genen Positionsdaten der Ziel-
station.

 • MAIN:   Anzeige der neuesten, auf dem 
Hauptband empfangenen Posi-
tionsdaten der Zielstation.

 • SUB:   Anzeige der neuesten, auf dem 
Subband empfangenen Posi-
tionsdaten der Zielstation.
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Ermitteln der GPS-Position

 DGPS-Speicher bzw. GPS-Alarm  
ändern

Die Inhalte der GPS-Speicher und die GPS-Alarme 
lassen sich bei Bedarf im „GPS POSITION“-Display 
ändern.

1. Bei eingeblendetem „MEM“- oder „ALM“-Display 
[QUICK] drücken.

2. „GPS Memory Select“ oder „Alarm Select“  
wählen.

„MEM“-Display

„ALM“-Display

3. GPS-Speicher bzw. die Art des GPS-Alarms für 
die Anzeige im „GPS POSITION“-Fenster wählen. 

 LHinzufügen und Editieren von GPS-Speichern  
s. S. 6-22.
 LGPS-Alarm einstellen s. S. 6-27.

 DLocator-Anzeige
Der Grid Locator (GL) ist eine sechsstellige Positions-
angabe, die aus Breiten- und Längengrad berechnet 
wird.
Für die Berechnung teilt man die Erdoberfläche in Fel-
der ein. Wenn der Locator bekannt ist, lässt sich der 
etwaige Standort einer Station ermitteln.

Locator-Karte von Japan
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07

06

05
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03
02
01
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15
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241404
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69
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50

59
58
57

56

55
54

53
52
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52

53
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40

49
48
47

46

45
44

43
42
41

41

42

43

44

140°

40°

PN

PM

QN

QM

PM74SO
Großfeld

KleinfeldMittelfeld
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D Kompass-Grundausrichtung ändern
Die Kompass-Ausrichtung lässt sich zwischen 
„Heading Up“ (Richtung oben), „North Up“ 
(Norden oben) und „South Up“ (Süden oben) wählen.

1. Bei eingeblendetem „GPS POSITION“-Display 
[QUICK] drücken.

2. „Compass Direction“ wählen.

3. Ausrichtung wählen.

DEigene oder empfangene 
Positionsdaten speichern

Man kann die eigene oder die Position einer empfan-
genen Station speichern. 
Dazu verfügt das Handfunkgerät über insgesamt 300 
GPS-Speicher, die sich einer von 27 Gruppen (A bis Z)
oder keiner Gruppe (No Group) zuordnen lassen.

1. Display mit den zu speichernden Positionsdaten 
aufrufen.
LZum Speichern der eigenen Position: 

„MY“-Display
LZum Speichern einer empfangen Position: 

„RX“-Display
2. [QUICK] drücken.
3. „Add To GPS Memory“ wählen.

LDetails zur Eingabe s. S. s. S. 6-22 bis 6-24.
4. „<<Add Write>>“ wählen.

LUm die Daten in einer Gruppe zu speichern, die Zeile 
„GROUP“ wählen.

5. „YES“ wählen.

• Die Daten werden in den GPS-Speicher 
übernommen und die Anzeige kehrt zum 
„GPS POSITION“-Display zurück.

6. Zum Schließen des „GPS POSITION“-Displays 
MENU] drücken.

TIPP: Durch die Auswahl von „GROUP“ lassen sich 
Positionsdaten in der gewählten Gruppe speichern. 
(Schritt 4)
([MENU] > GPS > GPS Memory)

Ermitteln der GPS-Position

„Heading Up“ „South Up“„North Up“

Kursrichtung
oben

Norden
oben

Süden
oben
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Das „GPS INFORMATION“-Display dient zur Prüfung 
der Empfangsmöglichkeiten der GPS-Satelliten und 
sollte geöffnet werden, wenn das GPS-Symbol unge-
wöhnlich lange blinkt.
Hier kann man die Anzahl der empfangbaren 
GPS-Satelliten sowie deren Signalstärke und ihre 
Position ablesen. Darüber hinaus werden die Rich-
tung, der Elevationswinkel, die Nummern und die 
Signalstärke der Satelliten angezeigt.

1. [QUICK] drücken.
2. „GPS Information“ wählen. 

Anzeigen
 • : Signal des Satelliten nicht nutzbar.
 • :  Nutzbarer Satellit mit schwachem Signal, 

die Nummer wird angezeigt.
 • :  Nutzbarer Satellit mit starkem Signal, die 

Nummer wird angezeigt.
 • SAT: Anzahl der nutzbaren Satelliten.
 • Höhe:  Höhe des eigenen Standorts über N. N. Die 

Höhe wird nur angezeigt, wenn mindestens 
vier auswertbare Satelliten empfangen wer-
den. Andernfalls erscheint „------ft“.

 • Breite und Länge: 
  Breiten- und Längengrad des eigenen 

Standorts.

TIPP: Folgende Satellitennummern sind den ein-
zelnen Satellitennavigationsystemen zugeordnet:

 • GPS: 01 bis 32
 • SBAS: 33 bis 71
 • GLONASS: 65 bis 96
 • QZSS: 193 bis 202

3. Zum Schließen des „GPS INFORMATION“- 
Displays MENU] drücken.

GPS-Status überprüfen

Beispiel für den Satelliten Nummer 06

Elevationswinkel 90°
(Zenit) Elevationswinkel 

60°
Elevations-
winkel 30°

Elevations-
winkel 0° 
(Horizont)Satellit 

Nr. 06

N

W

E

S

„Sky view“- 
Anzeige

Satellit  
Nr. 06 mit  

starkem  
Signal

Satellit Nr. 19
mit schwa-

chem Signal
nicht auswertbarer
Satellit

Elevationswinkel  
0° (Horizont)

Elevationswinkel 
30°

Elevationswinkel 
60°

Elevationswinkel 
90° (Zenit)

Anzahl 
auswert-
barer 
Satelliten

Höhe
Breite
Länge
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Wenn D-PRS als GPS-Sendemodus gewählt ist, kann 
man D-PRS-Daten senden. Während des D-PRS-Be-
triebs werden folgende Daten zum angeschlossenen 
PC übertragen. Der D-PRS-Code basiert auf dem 
APRS®-Code.
(APRS®: Automatic Packet Reporting System).

DD-PRS
D-STAR Packet Reporting System (D-PRS) ist eine 
Funktion, die im DV-Modus zusammen mit den 
Sprachsignalen im Low-Speed-Data-Packet-Space 
aktuelle GPS-Positionsdaten, die vom internen 
GPS-Empfänger bereitgestellt werden, sendet. In 
analogen Betriebsarten ist es nicht möglich, Sprache 
und Daten gleichzeitig zu senden oder zu empfangen. 
Im Gegensatz dazu sind D-PRS-kompatible Funkge-
räte hierzu in der Lage. I-GATE ist erforderlich, wenn 
die Positionsdaten zu einem APRS-Server übermittelt 
werden sollen.

 D-PRS-Daten senden

Das Prinzip von D-PRS

D-STAR-Repeater
Sprache, Nachrichten und
D-PRS-Positionen

<Nutzung eines Repeaters>

<Simplex-Betrieb>

Sprache, Nachrichten und
D-PRS-Positionen

Sprache, Nachrichten und
D-PRS-Positionen

Sprache, Nachrichten und
D-PRS-Positionen

I-GATE

APRS-Server

INTERNETINTERNET

PC

JA3YUA-Z

Die aktuellen Positionen
lassen sich auf einer
Karte ansehen.

D-PRS-Positionen

D-PRS-Positionen

D-PRS-Positionen

Information von einem
APRS-Netzwerk

DBetrieb im D-PRS-Modus
Für das Senden im D-PRS-Betrieb sind folgende 
Schritte erforderlich, die auf den jeweils angegebenen 
Seiten detailliert beschrieben sind:
1. „MY“ (eigenes Rufzeichen) eingeben.

(Basis-Bedienungsanleitung, D-STAR-ANLEITUNG)
2. GPS-Empfang prüfen.
3. Als GPS-Sendemodus „D-PRS“ einstellen 

(S. 6-14)
4. Sendeinformationen einstellen.
LSSID und Symbol müssen eingestellt werden.

([MENU] > GPS > GPS TX Mode > D-PRS)
      ↓
Fertig! Sie können nun im D-PRS-Modus senden.

TIPP: Mit D-PRS lassen sich neben den Positions-
daten Informationen über Erdbeben, das Wetter 
usw. übermitteln
([MENU] > GPS > GPS TX Mode > D-PRS > TX Format)

D-PRS-Positionsdatenformate
• Position (Mobile/Base):

 Zum Senden von Positionsdaten.
• Object:  Zum Senden spezieller Positionsdaten 

(enthält Zeitinformationen).
• Item:  Zum Senden spezieller Positionsdaten

(keine Zeitinformationen).
• Weather: Zum Senden von Wetterinformationen.

HINWEIS:
• Wenn bei „GPS select“ die Einstellung „Manual“ ge-

wählt ist, werden die bei „Manual Position“ eingegebe-
nen Positionsdaten zum Senden in das D-PRS-Format 
umgewandelt.
([MENU] > GPS > GPS Set > GPS Select)

• Wenn bei „GPS Auto TX“ eine andere Einstellung als 
„OFF“ gewählt ist, werden die GPS-Positionsdaten ent-
sprechend der eingestellten Zeit automatisch gesendet.
([MENU] > GPS > GPS Auto TX)
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 DAngezeigte Informationen
Je nach Positionsdatenformat variieren die Einstellmöglichkeiten und die Reihenfolge der Anzeige.

D-PRS

Position Object Item
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Unproto-Adresse ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Bemerkung ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Höhe ✓ ✓

Objekt-/Item-Name ✓ ✓ ✓ ✓ ✓ ✓

Datentyp ✓ ✓ ✓ ✓ ✓ ✓

Positions-
information
( Breitengrad/
Längengrad/Höhe)

✓ ✓ ✓ ✓ ✓ ✓

Datenerweiterung ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

 Kurs ✓ ✓

 Geschwindigkeit ✓ ✓

 Sendeleistung ✓ ✓ ✓

 Antennenhöhe ✓ ✓ ✓

 Antennengewinn ✓ ✓ ✓

  Antennenstrahl-
richtung

✓ ✓ ✓

Symbol ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

SSID ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓

Zeitmarke ✓ ✓ ✓ ✓ ✓ ✓

✓: wird angezeigt

D-PRS-Daten senden
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 DD-PRS-Position einstellen 
(Mobilstation/Basisstation)

Einstellungen zum Senden als D-PRS-Mobil- oder 
-Basisstation.

 LDetails siehe Seite 6-31.

1. Als GPS-Sendemodus „D-PRS“ einstellen

[MENU] > GPS > GPS TX Mode > D-PRS

2. Unproto-Adresse prüfen
Die werksvoreingestellte Adresse sollte verwendet 
werden. Ein Editieren ist nicht empfohlen.

3. Positionsdatenformat auf „Position“ einstellen
Bei „TX Format“ Einstellung „Position“ wählen.

4. D-PRS-Symbol wählen
Wahl des gewünschten D-PRS-Symbols für die Dar-
stellung der Betriebssituation.

 Leinstellen des Symbols s. S. 6-31.

5. SSID einstellen
Zur Hilfe bei der Identifizierung eines Stationstyps 
wird die angezeigte APRS®-basierte (Automatic Pa-
cket Reporting System) SSID an das D-PRS- 
Daten-Rufzeichen angefügt. (S. 6-32)

6. Bemerkung eingeben
Man kann eine Bemerkung eingeben, die zusammen 
mit den D-PRS-Positionsdaten gesendet wird.

 LDie Anzahl der für die Bemerkung möglichen Zeichen 
variiert je nach Einstellung für die Datenerweiterung und 
die Übertragung der Höhe. (S. 6-32)

1. „Comment“ wählen.
2. [QUICK] drücken.
3. „Edit“ wählen.
4. Eine Bemerkung eingeben.
5. Eingabe mit [ENT] bestätigen.
6. [ENT] erneut drücken.

7. Zeitmarke einstellen
Einstellen der zu sendenden Zeitmarke als UTC  
(Universal Time Coordinated). (S. 6-32)

8. Höhe einstellen
Einstellen, ob die vom GPS-Empfänger empfangene 
Höhe gesendet wird. (S. 6-33)

HINWEIS: Wenn man sendet und bei „Altitude“ die 
Einstellung „ON“ gewählt hat, wird die Höhe als Be-
merkung mitgesendet, kann jedoch von einigen
Transceivern nicht angezeigt werden. (S. 6-4)

D-PRS-Daten senden

9. Datenerweiterung einstellen
Datenerweiterung für Informationen zu Ihrer Station 
einstellen.

 LDatenerweiterung auf „Course/Speed“ einstellen, um als 
Mobilstation zu senden.
 LBeim Senden von einem festen Standort „Power/Height/
Gain/Directivity“ einstellen.

Bei Verwendung der Einstellung
„Power/Height/Gain/Directivity“:

9-1. Sendeleistung einstellen
Wahl der Sendeleistung einer Basisstation, die 
zusätzlich zu den Positionsdaten gesendet werden 
soll.

9-2. Antennenhöhe einstellen
Wahl der Antennenhöhe einer Basisstation, die 
zusätzlich zu den Positionsdaten gesendet werden 
soll.

9-3. Antennengewinn einstellen
Wahl des Antennengewinns einer Basisstation, der 
zusätzlich zu den Positionsdaten gesendet werden 
soll.

9-4. Antennenrichtung einstellen
Wahl der Antennenrichtung einer Basisstation, die 
zusätzlich zu den Positionsdaten gesendet werden 
soll.

10. Verlassen des „POSITION“-Displays
Zum Schließen des „POSITION“-Displays  
MENU] drücken.

 • Rückkehr zum Stand-by-Display,  wird angezeigt.
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 DD-PRS-Objekt/Item einstellen
Einstellungen zum Senden als D-PRS-Objekt- oder 
Item-Station.

 LDetails siehe Seite 6-31.

1. Als GPS-Sendemodus „D-PRS“ einstellen

[MENU] > GPS > GPS TX Mode > D-PRS

2. Unproto-Adresse prüfen
Die werksvoreingestellte Adresse sollte verwendet
werden. Ein Editieren ist nicht empfohlen.

3.  Positionsdatenformat auf „Object“ oder „Item“ 
einstellen

Bei „TX Format“ Einstellung „Object“ oder „Item“ 
wählen.

4. Objekt- oder Item-Namen eingeben
Objekt- oder Item-Name eingeben, z. B. Name des Ereig-
nisses oder des Ortes.

5. Einstellen des Datentyps
Objekt- oder Item-Stationsstatus einstellen.

 LWenn z. B. Informationen über ein abgeschlossenes  
Ereignis als Objekt gesendet werden sollen, setzen man 
den Datentyp auf „Killed Object“.

6. D-PRS-Symbol einstellen
Wahl des gewünschten Symbols zur Veranschauli-
chung der Objekt- oder Item-Station.

 LEinstellung des Symbols siehe s. S. 6-31.

7. Bemerkung eingeben
Man kann eine Bemerkung eingeben, die zusammen 
mit den Objekt- oder Itemdaten gesendet wird.

 LDie Anzahl der für die Bemerkung möglichen Zeichen 
variiert je nach Einstellung für die Datenerweiterung und 
die Übertragung der Höhe, s. S. 6-34, 6-36.

1. „Comment“ wählen.
2. [QUICK] drücken.
3. „Edit“ wählen.
4. Eine Bemerkung eingeben.
5. Eingabe mit [ENT] bestätigen.
6. [ENT] erneut drücken.

8. Positionsdaten eingeben
Eingeben der Positionsinformationen für eine  
Objekt- oder Item-Station.

 LWenn man z. B. eine Positionsinformation zu einem 
aktuellen Verkehrsunfall übermitteln möchte, gibt man die 
Position ein, an der sich der Unfall ereignet hat.
 LWenn diese Position in einen GPS-Speicher program-
miert wurde, kann man diese einfach aus dem Speicher 
übernehmen.

D-PRS-Daten senden

9. Datenerweiterung einstellen
Datenerweiterung der Objekt- oder Item-Station ein-
stellen.

 LDatenerweiterung auf „Course/Speed“ einstellen, um als 
Mobilstation zu senden.
 LBeim Senden von einem festen Standort „Power/Height/
Gain/Directivity“ einstellen.

Bei Verwendung der Einstellung  
„Course/Speed“:

9-1. Kurs einstellen
Eingeben des Kurses, falls sich die Objekt- oder 
Item-Station bewegt.

9-2. Geschwindigkeit einstellen
Einstellen der Geschwindigkeit der Objekt- oder 
Item- Station.

Bei Verwendung der Einstellung
„Power/Height/Gain/Directivity“:

9-3. Sendeleistung einstellen
Wahl der Sendeleistung einer Objekt- oder 
Item-Station, die zusätzlich zu den Positionsdaten 
gesendet werden soll, wenn es sich bei der Station 
um einen Repeater, einen Node, einen Access-Point 
usw. handelt und eine Antenne angeschlossen ist.

9-4. Antennenhöhe einstellen
Wahl der Antennenhöhe einer Objekt- oder 
Item-Station.

9-5. Antennengewinn einstellen
Wahl des Antennengewinns einer Objekt- oder 
Item-Station.

9-6. Antennenrichtung einstellen
Wahl der Antennenrichtung einer Objekt- oder 
Item-Station.

10. SSID einstellen
Zur Hilfe bei der Identifizierung eines Stationstyps 
wird die angezeigte APRS®-basierte (Automatic
Packet Reporting System) SSID an das D-PRS-Da-
ten-Rufzeichen angefügt. (S. 6-32)

11. Zeitmarke einstellen
 LErscheint nur, wenn das Datenformat „Object“ ist.

Einstellen der zu sendenden Zeitmarke als UTC (Uni-
versal Time Coordinated). (S. 6-35)

12. Verlassen des „OBJECT“- oder „ITEM“-Displays
Zum Schließen des „OBJECT“ oder „ITEM“-Displays 
MENU] drücken.

 • Rückkehr zum Stand-by-Display,  wird angezeigt.
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 DD-PRS-Wetter einstellen
Einstellungen für das Senden als D-PRS-Wetterstation.

 LDetails siehe Seite 6-31.

1. Als GPS-Sendemodus „D-PRS“ einstellen

[MENU] > GPS > GPS TX Mode > D-PRS

2. Unproto-Adresse prüfen
Die werksvoreingestellte Adresse sollte verwendet
werden. Ein Editieren ist nicht empfohlen.

3. Positionsdatenformat auf „Weather“ einstellen
Bei „TX Format“ Einstellung „Weather“ wählen.

4. D-PRS-Symbol wählen
Wahl des gewünschten Symbols zur Veranschau-
lichung der Wetterstation.

 LEinstellung des Symbols siehe Seite 6-31.

5. SSID einstellen
Zur Hilfe bei der Identifizierung eines Stationstyps 
wird die angezeigte APRS®-basierte (Automatic
Packet Reporting System) SSID an das D-PRS-Da-
ten-Rufzeichen angefügt. (S. 6-32)

6. Bemerkung eingeben
Bemerkung eingeben, die von der D-PRS Wetter-
station mitgesendet werden soll.
1. „Comment“ wählen.
2. [QUICK] drücken.
3. „Edit“ wählen.
4. Eine Bemerkung eingeben.
5. Eingabe mit [ENT] bestätigen.
6. [ENT] erneut drücken.

7. Zeitmarke einstellen
Einstellen der zu sendenden Zeitmarke als UTC  
(Universal Time Coordinated). (S. 6-38)

8. Verlassen des „WEATHER“-Displays
Zum Schließen des „WEATHER“-Displays  
MENU] drücken.

 • Rückkehr zum Stand-by-Display,  wird angezeigt.

D-PRS-Daten senden
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 DDaten einer Wetterstation senden
Wenn Wetterdaten gesendet werden sollen, muss 
man die entsprechenden Einstellungen vornehmen 
und die Wetterdaten von der Wetterstation über den 
[USB]-Anschluss in das Handfunkgerät übertragen.
Als Wetterstation eignen sich Geräte verschiedener 
Fremdhersteller, wobei deren Ausgangsdaten mit 
einem PC bzw. Mikrocomputer in das APRS-Wetter-
datenformat umgesetzt werden müssen.
Nachdem abgeschlossener Einstellung und Über-
nahme der Wetterdaten, kann man als Wetterstation 
senden.

HINWEIS: Zur Eingabe von Wetterdaten über die 
[USB]-Buchse bei „USB Connect“  
„Serialport“ einstellen und bei „USB Serialport  
function“ die Einstellung „DV Data“ wählen.
([MENU] > SET > Function > USB Connect)
([MENU] > SET > Function > USB Serialport function)
Wenn über den Micro-USB-Anschluss keine Wetter-
daten zur Verfügung gestellt werden, kann man 
nicht als Wetterstation senden.

Wetter-
station

Mikrocomputer

PC

USB-Kabel
(nicht im  

Lieferumfang)

oder
zum [USB]-Port

 DEinstellungen für die  
Datenübertragung

Die PC-Software muss folgendermaßen konfiguriert
werden:

 • Port:   COM-Portnummer, die vom ID-52E genutzt 
wird*.

 • Baud-Rate:   gewünschte Datenübertragungs-
geschwindigkeit

 • Datenbits:  8 Bit
 • Paritätsbit: keins
 • Startbit: 1 Bit
 • Stoppbit: 1 Bit
 • Steuerung: keine

*  Je nach PC-Umgebung kann die COM-Portnummer, die 
vom ID-52E genutzt wird, höher als 5 sein. In diesem Fall 
wählt man eine Applikation, die die Vergabe einer Nummer 
über 5 erlaubt

D-PRS-Daten senden

 DWetterstationsdaten prüfen
Man kann prüfen, ob am [USB]-Anschluss nutzbare 
Wetterdaten zur Verfügung stehen oder nicht.
1. Bei „GPS TX Mode“ die Einstellung „D-PRS“ und 

bei „TX format“ die Einstellung „Weather“ wählen. 
(S. 6-16)

2. Im Stand-by [QUICK] drücken.
3. „Weather Information“ wählen.

 LWenn das nachfolgend abgebildete Fenster sichtbar 
wird, stehen am [USB]-Anschluss Wetterdaten zur Ver-
fügung und können gesendet werden.
 LWenn an den entsprechenden Stellen „-“ erscheint, sind 
am [USB]-Anschluss keine Wetterdaten verfügbar und 
die Einstellungen bzw. die Konfiguration müssen über-
prüft werden.

 DEinzelheiten der Wetterdaten
Die Wetterdaten müssen folgendem Format entspre-
chen (basierend auf APRS®-Wetterdaten):

Beispiel:
220/004 g005 t077 r000 p000 P000 h50 b09900 End-Code
 1 2 3 4 5 6 7 8 9

Nr. Wetterdaten-Detail Wert Einheit

1 Windrichtung 000 bis 360 °

2 Windgeschwindigkeit 000 bis 999 mph

3 Böengeschwindigkeit g000 bis g999 mph

4
Temperatur t-99 bis t-01,

t000 bis t999
°F

5 Regen r000 bis r999*1 inch

6 Regen (24 Stunden) p000 bis p999*1 inch

7 Regen (Mitternacht) P000 bis P999*1 inch

8
Luftfeuchtigkeit h00, h01 bis h99

(h00 entspricht  
100 %)

%

9
Luftdruck b00000 bis 

b99999*2
hPa,
mb

*1  Die letzten beiden Stellen sind die nach dem Dezimal-
punkt.

*2 Die letzte Stelle ist die nach dem Dezimalpunkt..
 LWenn für ein Wetterdaten-Detail keine Daten verfügbar 
sind, kann man Leerzeichen oder Punkte anstelle der 
Ziffern einfügen. 
(Beispiel: „.../...g...t077r000p...P...h50b.....“)
 L<CR>, <LF> oder <CR><LF> als End-Code eingeben.
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Wenn man an eine I-GATE-Station sendet und auf der 
entsprechenden Website sein Rufzeichen eingibt, er-
scheint das eingestellte Symbol auf der Karte.

Beispiel: Die eigene Position kann man sich auf der 
Website APRS.fi ansehen.

1. Frei zugängliche APRS®-Karten-Website im Inter-
net aufsuchen. (Beispiel: http://aprs.fi/)

2. Eigenes Rufzeichen bei „Track callsign“ eingeben.
3. Auf <Search> klicken.

 • Das D-PRS-Symbol der eigenen Station wird auf der 
Karte angezeigt.

D-PRS-Daten senden

 DEigene Position mittels Kartensoftware anzeigen

Der aktuelle Standort kann im Internet  
angesehen werden.

PC Smartphone

Eigenes Rufzeichen
eingeben und danach 
auf <Search> klicken.

Eigenes Symbol und Rufzeichen
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D-PRS-Daten senden

TIPP:
D-PRS-Datenaufbau
D-PRS data content are shown below.

DD-PRS-Daten sind wie folgt strukturiert:
(z.B.)

(z.B.)

DPosition (Base)

(z.B.)

DObject

(z.B.)

DItem

(z.B.)

DWeather

q w e r
o

iu
o

!1 !3 !4!0

!0

JA3YUA-A>API705,DSTAR*:/002338h3437.38N/13534.29E>090/002/A=000012IC-705 OP.SATOH

q w e r
o

i

i

u

u

u

o
!2

!2

!4!0

JA3YUA-A>API705,DSTAR*:/002338h3437.38N/13534.29E-PHG5132OP.SATOH

q w e r
oyt

o
!4

JA3YUA-A>API705,DSTAR*:;HAM FESTA*012345z3437.38N\13534.29Eh2020.01.01 am10-pm4

!0iq w e r
oyt

o !4

JA3YUA-A>API705,DSTAR*:)REPEATER!3454.00N/13536.00ErPHG5132439.39MHz DV RPT JP3YHH A

!5 !6 !7 !8 !9 @0 @1 @2!0iq w e r
oo

JA3YUA-A>API705,DSTAR*:/012345z3454.00N/13536.00E_220/004g005t077r000p000P000h50b09900

qRufzeichen
wSSID
eUnproto-Adresse
rD-PRS-Datentyp
    / Position mit Zeitmarke
    ! Position ohne Zeitmarke
    ; Object
    ) Item
tObject-Name/Item-Name
yDatentyp
    * Live Object
    ! Live Item
    _ Killed Object/Killed Item
uZeitmarke (UTC)
    h Stunde Minute Sekunde
    z Tag Stunde Minute
iBreitengrad
oSymbol
!0Längengrad
!1Datenerweiterung
   (Kurs/Geschwindigkeit)
    Kurs: 0 bis 360°
    Geschwindigkeit: 0 bis 999 Knoten

!2Datenerweiterung (PHG-Codes)
    PHG-Codes-Definitionen

!3Höhe
    −99999 bis 999999 feet
!4Bemerkung
!5Windrichtung/Windgeschwindigkeit
   Windrichtung: 0 bis 360°
   Windgeschwindigkeit: 0 bis 999 mph
!6Windböen-Geschwindigkeit
    0 bis 999 mph
!7Temperatur
    −99 bis 999 ƒ
!8Regen
    0,00 bis 9,99 inch

!9Regen (24 Stunden)
   0,00 bis 9,99 inch
@0Regen (Mitternacht)
   0,00 bis 9,99 inch
@1Luftfeuchtigkeit
   1 bis 99%, 00 = 100%
@2Luftdruck
   0,0 bis 9999,9 hPa

First: Power

Second: Height

Third: Gain

Fourth: Directivity

0

0

10

0

omni

2

4

40

2

90°E

3

9

80

3

135°SE

4

16

160

4

180°S

5

25

320

5

225°SW

6

36

640

6

270°W

7

49

1280

7

315°NW

8

64

2560

8

360°N

9

81

5120

9

−

(W)

(feet)

(dB)

−

1

1

20

1

45°NE
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NMEA-Daten senden

Für das Senden von GPS-Positionsdaten im  
DV-Modus kann man GPS-Datensätze wählen.

 DGPS-Datensatz einstellen

Inhalte der verschiedenen GPS-Datensätze
Daten-

satz
Lon/
Lat

Alt UTC
Date
(UTC)

Status
2D/
3D

COG
(True)

SOG
(knot)

Ergänzung

RMC ✔ ✔ ✔ ✔ ✔ ✔ Magnetische Abweichung, Modus-Indikator

GGA ✔ ✔ ✔ ✔

Anzahl der ausgewerteten Satelliten, HDOP,
Geoidale Trennung, Alter der Differenzial-GPS- 
Daten, ID der Differenzial-Referenzstation

GLL ✔ ✔ ✔ Modus-Indikator

VTG ✔ ✔ COG, SOG (km/h), Modus-Indikator

GSA ✔ ✔
PRN-Nummern der Satelliten, PDOP,
HDOP, VDOPP

GSV
Gesamtanzahl der Datensätze, Datensatznummer, 
Anzahl der „sichtbaren“ Satelliten und weitere Sa-
telliteninformationen (ID, Elevation, Azimuth, S/N)

1. [MENU] drücken.
2. Im „GPS“-Menü „GPS TX Mode“ wählen.
3. „NMEA“ wählen.
4. „GPS Sentence“ wählen. 

5. Gewünschten GPS-Datensatz wählen. 

 • Beim gewählten Datensatz erscheint „ “.
 LWählbar sind: RMC, GGA, GLL, VTG, GSA und GSV. 
Werksvoreingestellt ist der Datensatz GGA.
 LZum Zurücksetzen auf die Werksvoreinstellung 
[QUICK] drücken und dann „Default“ wählen.

[MENU] > GPS > GPS TX Mode > NMEA > GPS Sentence

6. Schritt 5 wiederholen, um weitere Datensätze 
auszuwählen.

 LBis zu 4 Datensätze sind gleichzeitig möglich.
7. Zum Schließen des „GPS Sentence“-Displays  

MENU] drücken.
 • Rückkehr zum Stand-by-Display,  wird  
angezeigt.

HINWEIS:
 • Wenn GPS-Daten an einen herkömmlichen digitalen 
Transceiver gesendet werden sollen, muss bei „GSV Sen-
tence“ die Einstellung „OFF“ gewählt werden (S. 6-4)

 • Wenn bei „GPS Select“ die Einstellung „Manual“ ge-
wählt ist, nutzt das Handfunkgerät automatisch NMEA 
und sendet die Positionsdaten, die bei „Manual Posi-
tion“ eingegeben worden sind. 
([MENU] > GPS > GPS Set > GPS Select) 
([MENU] > GPS > GPS Set > Manual Position)

 • Wenn bei „GPS Auto TX“ eine andere Einstellung als 
„OFF“ gewählt ist, werden die GPS-Positionsdaten ent-
sprechend der eingestellten Zeit automatisch gesendet. 
([MENU] > GPS > GPS Auto TX)

 LFalls bei „GPS Select“ „OFF“ oder „Manual“ ein-
gestellt ist, steht die automatische Sendefunktion 
nicht zur Verfügung.
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NMEA-Daten senden

 DGPS-Meldung eingeben
Zusammen mit den GPS-Positionsdaten lassen sich  
GPS-Meldungen senden.

Beispiel: Eingeben der Meldung „OSAKA Suzuki“

[MENU] > GPS > GPS TX Mode > NMEA >  
GPS Message

1. [MENU] drücken.
2. Im „GPS“-Menü „GPS TX Mode“ wählen.
3. „NMEA“ wählen.
4. „GPS Message“ wählen. 

5. [QUICK] drücken.
6. „Edit“ wählen. 

7. Eine GPS-Meldung mit bis zu 20 Zeichen  
eingeben. 

 LHinweise zur Zeicheneingabe s. S. iii.
8. Eingabe mit [ENT] bestätigen. 

 • Die eingegebene Meldung kann man sich noch ein-
mal ansehen.

9. Zum Schließen des „GPS Message“-Displays 
MENU] drücken.

HINWEIS:
 • Die automatische GPS-Sendefunktion nur im Sim-
plex-Betrieb verwenden.

 • Das automatische Senden von GPS-Daten über Repea-
ter kann den Funkverkehr anderer Stationen stören.

Das automatische Senden von GPS-Daten lässt sich 
im folgenden Menüpunkt einstellen.

[MENU] > GPS > GPS Auto TX

Bei eingeschalteter Funktion erfolgt das automatische 
Senden von GPS-Daten entsprechen des eingestell-
ten Zeitintervalls.

 LFür das automatische Senden von GPS-Daten muss das 
eigene Rufzeichen (MY) eingegeben worden sein.
 LFalls bei „GPS Select“ „OFF“ oder „Manual“ eingestellt 
ist, steht die automatische Sendefunktion nicht zur Ver-
fügung. 
([MENU] > GPS > GPS Set > GPS Select)

Automatischen Senden von 
GPS-Daten
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GPS-Speicher

Die GPS-Speicher lassen sich mit GPS-Positions-
daten programmieren und editieren. Dadurch kann 
man die eigene Position, die empfangenen Positions-
daten anderer Stationen oder beliebige manuell ein-
gegebene speichern.
Der GPS-Speicher des Handfunkgeräts bietet ins-
gesamt 300 Speicherplätze, die sich 27 Speicher-
gruppen, A bis Z und „(No Group)“, zuordnen lassen. 
Die Gruppen A bis Z können mit Namen versehen 
werden.

 DGPS-Speicher hinzufügen
Beispiel: „HOME“ zu „(No Group)“ hinzufügen.

1.  GPS-Speicher hinzufügen und Editiermodus  
aufrufen

[MENU] > GPS > GPS Memory

1. [MENU] drücken.
2. Im „GPS“-Menü „GPS Memory“ wählen. 

 • Im „GPS MEMORY“-Display werden bereits  
programmierte GPS-Speicher angezeigt.

3. „(No Group)“ wählen. 

4. [QUICK] drücken.
5. „Add“ wählen. 

 • Das „GPS MEMORY EDIT“-Display erscheint.

TIPP: Zum Editieren eines bereits programmierten 
GPS-Speichers bei Schritt 5 „Edit“ wählen; neuen 
Inhalt dann so wie oben eingeben.

GPS Memory

(No Group)

B: HAM festa

A: ICOM

C: Railroad

Z:

Icom Osaka HC

Tokyo Big Sight

Dayton Hamvention

Die Namen der 
Speichergruppen 
sind Beispiele.

Icom America

Friedrichshafen

2. Namen für GPS-Speicher eingeben
1. „NAME“ wählen.
2. Einen bis zu 16 Zeichen langen Namen für den 

GPS-Speicher eingeben. (Beispiel: HOME) 

 LHinweise zur Zeicheneingabe s. S. iii.
3. Eingabe mit [ENT] bestätigen. 
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 D GPS-Speicher hinzufügen (Fortsetzung)

3. Datum für den GPS-Speicher einstellen
1. „DATE“ wählen.
2. Der Cursor lässt sich mit den Navigationstasten 

() bewegen.
3. Durch Drehen von [DIAL] das Datum einstellen.

 LEinstellbar: 2000/01/02 bis 2099/12/30.
4. Schritte 2 und 3 wiederholen, bis das Datum 

vollständig eingestellt ist. 

5. Eingabe mit [ENT] bestätigen. 

4. Zeit für den GPS-Speicher einstellen
1. „TIME“ wählen.
2. Der Cursor lässt sich mit den Navigationstasten 

() bewegen.
3. Durch Drehen von [DIAL] die Zeit einstellen.

 LEinstellbar: 00:00:00 bis 23:59:59.
4. Schritte 2 und 3 wiederholen, bis die Zeit  

vollständig eingestellt ist. 

5. Eingabe mit [ENT] bestätigen. 

5. Breitengrad für den GPS-Speicher einstellen
1. „LATITUDE“ wählen.
2. Der Cursor lässt sich mit den Navigationstasten 

() bewegen.
3. Zur Eingabe des Breitengrads [DIAL] drehen.

 L Information
 • Einstellbar von 0°00.00′ and 90°00.00′.
 • Die angezeigte Einheit kann man ändern.  
( [MENU] > SET > Display > Display Unit >  
Latitude/Longitude)

 • Für nördliche Breite „N“, für südliche Breite „S“ wählen.
4. Schritte 2 und 3 wiederholen, bis der Breitengrad 

eingestellt ist. 

5. Eingabe mit [ENT] bestätigen. 

6. Längengrad für den GPS-Speicher einstellen
1. Select „LONGITUDE“ wählen.
2. Der Cursor lässt sich mit den Navigationstasten 

() bewegen.
3. Zur Eingabe des Längengrads [DIAL] drehen.

 L Information
 • Einstellbar von 0°00.00′ and 180°00.00′.
 • Die angezeigte Einheit kann man ändern. 
( [MENU] > SET > Display > Display Unit >  
Latitude/Longitude)

 • Für östliche Länge „E“, für westliche Länge „W“ wählen.
4. Schritte 2 und 3 wiederholen, bis der Längengrad 

eingestellt ist. 

5. Eingabe mit [ENT] bestätigen. 
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 D GPS-Speicher hinzufügen (Fortsetzung)

7. Höhe für den GPS-Speicher eingeben
1. „ALTITUDE“ wählen.
2. Mit [DIAL] das Vorzeichen einstellen (+/–).
3. Der Cursor lässt sich mit den Navigationstasten 

() bewegen.
4. Durch Drehen von [DIAL] die Höhe einstellen.

 LEinstellbar von –32808 bis +32808 ft.
5. Schritte 3 und 4 wiederholen, bis die Höhe ein-

gestellt ist. 

6. Eingabe mit [ENT] bestätigen. 

8. Speichergruppe für den GPS-Speicher wählen
1. „GROUP“ wählen. 

2. Speichergruppe wählen, (No Group) oder A bis Z. 

 LJeder Speichergruppe können bis zu 300 GPS- 
Speicher zugeordnet werden.

9.  Eingegebene Daten in den GPS-Speicher 
schreiben

1. „<<Add Write>>“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
 LBeim Editieren eines bereits vorhandenen GPS-Spei-
chers ist „<<Overwrite>>“ zu wählen.

2. „YES“ wählen. 

 • Die Daten werden in den GPS-Speicher geschrieben, 
danach erscheint die Anzeige der Speichergruppen.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP:
Eingegebene Daten überprüfen:
Betreffenden GPS-Speicher wählen, dann [DIAL] 
drehen, um den gesamten Inhalt anzusehen.
 

Eingabe abbrechen:
Während der Eingabe oder beim Editieren eines 
GPS-Speichers [CLR] drücken, worauf ein Abfrage-
fenster erscheint. 
Zum Abbrechen der Eingabe „YES“ wählen. Es erfolgt 
die Rückkehr zur GPS-Speichergruppenanzeige.
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 DNamen für GPS-Speichergruppen  
eingeben

Man kann für jede GPS-Speichergruppe einen Namen 
eingeben.

[MENU] > GPS > GPS Memory

1. [MENU] drücken.
2. Im „GPS“-Menü „GPS Memory“ wählen. 

3. Zu benennende Gruppe wählen. 

 LNICHT die [ENT]-Taste betätigen!
4. [QUICK] drücken.
5. „Edit Name“ wählen. 

6. Einen bis zu 16 Zeichen langen Gruppennamen 
eingeben. 

 LHinweise zur Zeicheneingabe s. S. iii.
7. Eingabe mit [ENT] bestätigen. 

 LZum Verlassen die [MENU]-Taste drücken.

 DGPS-Speicher löschen
GPS-Speicher lassen sich auf zwei Arten löschen:

 • Löschen aller GPS-Speicher einer Speichergruppe.
 • Löschen eines bestimmten GPS-Speichers.

HINWEIS: Gelöschte GPS-Speicher kann man nicht 
wiederherstellen.

[MENU] > GPS > GPS Memory

Beispiel: Alle GPS-Speicher der Gruppe E löschen.
1. [MENU] drücken.
2. Im „GPS“-Menü „GPS Memory“ wählen.
3. Gruppe wählen, der die zu löschenden  

GPS-Speicher zugeordnet sind. 

 LNICHT die [ENT]-Taste betätigen!
4. [QUICK] drücken.
5. „Delete All In Group“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
6. „YES“ wählen. 

 • Alle GPS-Speicher in der gewählten Gruppe werden 
gelöscht. Rückkehr zum „GPS MEMORY“-Display.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Löschen eines bestimmten GPS-Speichers
1. Zu löschenden GPS-Speicher wählen, dann 

[QUICK] drücken.
2. „Delete“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
3. „YES“ wählen.

 • Der gewählte GPS-Speicher wird gelöscht.
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Die Anzeigereihenfolge von GPS-Speichern innerhalb 
der gewählten GPS-Speichergruppe kann geändert 
werden.

 LUm einen GPS-Speicher in eine andere GPS-Speicher-
gruppe zu verschieben, muss man dem GPS-Speicher im  
„GPS MEMORY EDIT“-Display eine andere Speicher-
gruppe zuweisen.

[MENU] > GPS > GPS Memory

1. [MENU] drücken.
2. Im „GPS“-Menü „GPS Memory“ wählen. 

3. GPS-Speichergruppe mit dem zu verschiebenden 
GPS-Speicher wählen. 

4. Zu verschiebenden GPS-Speicher wählen und 
dann [QUICK] drücken. 

5. „Move“ wählen. 

 • Links oben im Display blinkt die Anzeige  
„DESTINATION“.

6. GPS-Speicher wählen, über dem der zu verschie-
bende eingefügt werden soll. 

 • Der zu verschiebende GPS-Speicher wird oberhalb 
des gewählten eingefügt.
 LWenn man „<<Move End>>“ wählt, wird der 
GPS-Speicher um unteren Ende der GPS-Speicher-
gruppe eingefügt.
 LZum Verlassen die [MENU]-Taste drücken.

 DAnzeigereihenfolge von GPS-Speichern ändern
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Wenn die Zielstation in das programmierte Alarmgebiet eintritt oder wenn man das im GPS-Speicher program-
mierte Gebiet erreicht, lässt sich mit dieser Funktion ein Alarmton auslösen. Die Funktion ist anwendbar für eine 
bestimmte Station, alle oder einen bestimmten GPS-Speicher sowie eine ganze GPS-Speichergruppe.

Alarmgebiet (Group) (Einstellung für mehrere Stationen)
Wenn „All Memories“ oder eine GPS-Speichergruppe gewählt ist:

Punkt C
drei Hinweistöne

eigene Position

Punkt A

Punkt B

50
0 

m
50

0 
m

500 m 500 m
N

Alarmgebiet (RX/Memory) (Einstellung für bestimmte Station)
Wenn ein bestimmter GPS-Speicher gewählt ist:

Zielstation

drei Hinweistöneein Hinweiston

Eingegrenzter Bereich,
Radius etwa 500 m

Erweiterter Bereich,
Radius etwa 1 km

Eigener Standort

N
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[MENU] > GPS > GPS Alarm

1. [MENU] drücken.
2. Im „GPS“-Menü „GPS Alarm“ wählen. 

3. „Alarm Select“ wählen. 

4. „Group“ wählen. 

5. „All Memories“ wählen. 

 • Rückkehr zum „GPS ALARM“-Display.
 LSoll der Alarm für eine bestimmte GPS-Speicher-
gruppe eingestellt werden, „(No Group)“ oder eine 
der Speichergruppen A bis Z wählen.
 LZum Verlassen die [MENU]-Taste drücken.

 DGPS-Alarm für alle GPS-Speicher einstellen

 L Information
 • Wenn irgendeine Station der GPS-Speichergruppe 
in das programmierte Alarmgebiet eintritt, ertönt der 
Alarm dreimal.

 • Wenn der Alarmton ertönt, erscheint „GPS ALARM“ 
im Display und „ “ blinkt, siehe untenstehende Ab-
bildung.

 • Zum Ausschalten der GPS-Alarmfunktion bei Schritt 4 
„OFF“ wählen, siehe links.

blinkt

GPS ALARM

„GPS ALARM“ erscheint im Display, 
der Alarm ertönt dreimal.

TIPP: Wurde im Schritt 5 „All Memories“,  
„(No Group)“ oder eine GPS-Speichergruppe von  
A bis Z gewählt, muss man auch „Alarm Area (Group)“ 
einstellen, um die GPS-Alarmfunktion nutzen zu 
können. (S. 6-43)
([MENU] > GPS > GPS Alarm > Alarm Area (Group))
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[MENU] > GPS > GPS Alarm

1. [MENU] drücken.
2. Im „GPS“-Menü „GPS Alarm“ wählen. 

3. „Alarm Select“ wählen. 

4. „RX“ wählen. 

 • Rückkehr zum „GPS ALARM“-Display.
 LSoll der Alarm für einen bestimmten GPS-Speicher 
eingestellt werden, muss man die Zeile „Memory“ 
wählen und dann einen GPS-Speicher in einer Spei-
chergruppe wählen.
 LZum Verlassen die [MENU]-Taste drücken.

 DGPS-Alarm für eine bestimmte Station einstellen

 L Information
 • Wenn eine Station, für die eine GPS-Alarm-Einstellung 
vorgenommen wurde, in ein Gebiet mit einem Radius 
von etwa 1 km eintritt, ertönt der Alarm einmal. Wenn 
sich die Station auf eine Distanz von unter 500 m 
nähert, ertönt der Alarm dreimal.

 • Wenn der Alarmton ertönt, erscheint „GPS ALARM“ 
im Display und „ “ blinkt, siehe untenstehende Ab-
bildung.

 • Zum Ausschalten der GPS-Alarmfunktion bei Schritt 4 
„OFF“ wählen, siehe links.

blinkt

GPS ALARM

„GPS ALARM“ erscheint im Display, 
der Alarm ertönt dreimal.

HINWEIS: Wenn in Schritt 4 „RX“ gewählt ist, die 
empfangene Station jedoch keine GPS-Positionsda-
ten sendet, kann kein GPS-Alarm ausgelöst werden.

TIPP: Wurde im Schritt 4 „RX“ oder ein bestimmter 
GPS-Speicher gewählt, muss man auch „Alarm Area 
(RX/Memory)“ einstellen, um die GPS-Alarmfunktion 
nutzen zu können. (S. 6-44)
([MENU] > GPS > GPS Alarm > Alarm Area (RX/Memory))
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HINWEIS: Alle angegebenen Voreinstellwerte beziehen sich auf die USA-Version des Handfunkgeräts. Dement-
sprechend können die Voreinstellwerte Ihres Handfunkgeräts davon abweichen. Zum Zurückzusetzen auf die 
Werkseinstellungen die [QUICK]-Taste drücken und dann „Default“ wählen.

GPS Select (voreingestellt: ON)

[MENU] > GPS > GPS Set > GPS Select

Wahl des Ursprungs der GPS-Daten.
 LWenn „GPS Time Correct“ die Option „Auto“ eingestellt 
ist, muss man bei diesem Menüpunkt „ON“ wählen, um 
die Zeit automatisch mit empfangenen GPS-Daten zu 
korrigieren (S. 12-30)
 • OFF: Ein GPS-Empfänger wird nicht benutzt.
 • ON:  Vom internen GPS-Empfänger ermit-

telte Positionsdaten werden für die 
GPS-Funktionen genutzt.

 • Manual:  Manuelle Eingabe der aktuellen Position 
und der Höhe ü. NN. bei „Manual Posi-
tion.“

SBAS (voreingestellt: OFF)

[MENU] > GPS > GPS Set > GPS Option > SBAS

Ein- bzw. Ausschalten der SBAS-Funktion (Satelliten-
basiertes Ergänzungssystem).

 LBei eingeschalteter Funktion kann sich die Genauigkeit 
der GPS-Position erhöhen, allerdings entlädt sich der 
Akkupack des Handfunkgeräts schneller.
 • OFF:  Funktion ausgeschaltet.
 • ON:  Funktion eingeschaltet.

GLONASS (voreingestellt: OFF)

[MENU] > GPS > GPS Set > GPS Option > GLONASS

Wahl, ob Daten der GLONASS-Satelliten genutzt 
werden (GLObal’naya NAvigatsionnaya Sputnikovaya 
Sistema).

 LBei eingeschalteter Funktion kann sich die Genauigkeit 
der GPS-Position erhöhen, allerdings entlädt sich der 
Akkupack des Handfunkgeräts schneller.
 • OFF:  Daten der GLONASS-Satelliten werden 

nicht genutzt.
 • ON:  Daten der GLONASS-Satelliten werden 

genutzt.

Power Save (voreingestellt: Auto)

[MENU] > GPS > GPS Set > GPS Option >  
Power Save

Einstellung der Akkusparfunktion für den internen 
GPS-Empfänger.
Wenn der GPS-Empfänger bei eingeschalteter Funk-
tion 5 Minuten lang keine Signale von einem Satelliten 
empfängt, schaltet er sich für die hier eingestellte Zeit 
aus.

 • OFF: GPS-Empfänger immer eingeschaltet.
 • 1, 2, 4, 8min: 
    Wenn der GPS-Empfänger 5 Minuten 

lang keine Satellitensignale empfängt, 
wird er für die gewählte Zeit (1, 2, 4 oder 
8 Minuten) ausgeschaltet. Danach wird 
der Empfang fortgesetzt

 • Auto:  Wenn der GPS-Empfänger 5 Minuten 
lang keine Satellitensignale empfängt, 
wird er für 1 Minute ausgeschaltet. 
Danach wird der Empfang fortgesetzt. 
Werden für weitere 5 Minuten keine 
Signale empfangen, verlängert sich die 
Akkuspar-Intervallzeit auf 2, 4 und dann 
8 Minuten.

Satellite Information Out 
 (voreingestellt: GPS/QZSS/GLONASS)

[MENU] > GPS > GPS Set > GPS Option >  
Satellite Information Out

Wahl, ob die Daten von den QZSS-Satelliten (Quasi-Ze-
nith-Satellitensystem) und den GLONASS-Satelliten 
ausgegeben werden sollen.

 • GPS/QZSS/GLONASS: 
    Daten der GPS-Satelliten, der QZSS- 

Satelliten und der GLONASS-Satelliten 
werden ausgegeben.

 • GPS Only:  Nur Daten der GPS-Satelliten werden 
ausgegeben.

Manual Position 
(voreingestellt:  LATITUDE: 0°00.00′N, 

LONGITUDE:0°00.00′W, ALTITUDE: 
------ft)

[MENU] > GPS > GPS Set > Manual Position

Manuelle Eingabe der aktuellen Position und der Höhe 
ü. NN.

 LPositionsdaten des GPS-Empfängers lassen sich über-
nehmen, wenn „Capture From GPS“ ausgewählt ist.
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Symbol (voreingestellt: Person)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Symbol

GPS-Symbole veranschaulichen die eigene Betriebs-
situation. Das im gewählten GPS-Symbolkanal (1 bis 
4) gespeicherte GPS-Symbol wird beim Senden der 
Positionsdaten mit übertragen

< Editieren eines Symbols mit einem zweistelligen 
Symbolcode>

1. GPS-Symbolkanal wählen.
 LNICHT die [ENT]-Taste betätigen!

2. [QUICK] drücken.
3. „Edit Symbol“ wählen.
4. [QUICK] drücken.
5. „Direct Input“ wählen.
6. Zum Ändern der ersten Stelle [DIAL] drehen.
7. Mit der Navigationstaste () die zweite Stelle 

wählen.
8. Zweite Stelle durch Drehen von [DIAL] ändern.

Nutzbare Zeichen und Symbole

<für die erste Stelle> /, \, 0 to 9, A to Z

<für die zweite Stelle> A to Z, a to z, 0 to 9, ! „ #
$ % & ’ ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ˜

9. Nach erfolgter Bearbeitung [ENT] drücken.
 • Das GPS-Symbol wird in den bei Schritt 1 gewählten 
GPS-Symbolkanal übernommen.

< Ein vorprogrammiertes GPS-Symbol wählen>
1. GPS-Symbolkanal wählen.

 LNICHT die [ENT]-Taste betätigen!
2. [QUICK] drücken.
3. „Edit Symbol“ wählen.
4. Ein Symbol wählen.

 • Das GPS-Symbol wird in den bei Schritt 1 gewählten 
GPS-Symbolkanal übernommen.

GPS Out (USB Port) (voreingestellt: OFF)

[MENU] > GPS > GPS Set > GPS Out (USB Port)

Wahl, ob die Positionsdaten über den USB-Port aus-
gegeben werden sollen.

 • OFF:  Über den USB-Port erfolgt keine  
Positionsdatenausgabe.

 • ON:  Positionsdaten werden über den  
USB-Port ausgegeben.

GPS TX Mode (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode

Wahl des Modus für das Senden von Positionsdaten 
im DV-Modus.

 • OFF: Positionsdaten werden nicht gesendet.
 • D-PRS:  Positionsdaten werden im D-PRS-Format 

gesendet.
 • NMEA:  Positionsdaten werden im NMEA-Format 

gesendet.

Unproto Address (voreingestellt: API52,DSTAR*)

[MENU] > GPS > GPS TX Mode > D-PRS > Unproto 
Address

Eingabe einer Unproto-Adresse mit einer Länge von 
bis zu 56 alphanumerischen Zeichen.

HINWEIS: Die werksvoreingestellte Adresse sollte 
verwendet werden. Ein Editieren ist nicht empfohlen.
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Comment

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Comment

Eingabe einer Anmerkung, die zusammen mit den 
D-PRS-Positionsdaten gesendet wird.
Bis zu vier Anmerkungen lassen sich eingeben.
Die Anzahl der für die Bemerkung möglichen Zeichen 
variiert je nach Einstellung für die Datenerweiterung 
und die Übertragung der Höhe.

Datenerweiterung Höhe
maximale

Zeichenzahl

OFF
OFF 43  

(voreingestellt)

OFF ON 35

Course/Speed OFF 36

Course/Speed ON 28

Power/Height/Gain/Directivity OFF 36

Power/Height/Gain/Directivity ON 28

Bei der Eingabe markiert das Symbol „ “ das Ende 
des sendbaren Anmerkungstextes. Zeichen hinter 
diesem Symbol werden nicht mitgesendet.

Sendbare Textlänge bei der Eingabe
(in diesem Beispiel max. 28 Zeichen)

Time Stamp (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Time Stamp

Wahl des Formats der gesendeten Zeitmarke. Die 
Zeitmarke wird im D-PRS-Modus als UTC zusammen 
mit den Positionsdaten gesendet.

 LBei manueller Positionseingabe, wird die Zeitmarke nicht 
mitgesendet.
 • OFF: Zeitmarke wird nicht gesendet.
 • DHM:  Zeitmarke wird im Format Tag, Stunde 

und Minute gesendet.
 • HMS:  Zeitmarke wird im Format Stunde, Minute 

und Sekunde gesendet.

SSID (voreingestellt: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > SSID

Wahl einer APRS®-SSID als Zusatz zum eigenen 
Rufzeichen oder als Kennzeichnung der Art des Funk-
betriebs.

 LDie Art und Weise des Anfügens der SSID unterscheidet 
sich, wenn das Rufzeichen Leerzeichen enthält.
 • ---:  Leerzeichen im Rufzeichen werden in „-“ 

umgesetzt.
 LWenn nach dem Leerzeichen kein weiterer 
Text folgt, wird das Leerzeichen nicht um-
gesetzt, sondern gelöscht. 
Beispiel:  JA3YUA → JA3YUA 

JA3YUA A → JA3YUA-A
 • (-0): Es wird keine SSID angefügt.

 LWenn das Rufzeichen ein Leerzeichen 
enthält, wird jeglicher Text nach dem Leer-
zeichen gelöscht. 
Beispiel:  JA3YUA → JA3YUA 

JA3YUA A → JA3YUA
 • -1bis -15:  Anfügen einer SSID von „-1“ bis „-15“ an 

das Rufzeichen.
 LBeispiel:  Die SSID ist „-9.“ 

JA3YUA → JA3YUA-9 
JA3YUA A → JA3YUA-9

 • -A~-Z:  Anfügen einer SSID von „-A“ bis „-Z“ an 
das Rufzeichen.

 LBeispiel:  Die SSID ist „-Z.“ 
JA3YUA → JA3YUA-Z 
JA3YUA A → JA3YUA-Z

TIPP: Über die SSID
Zur Vereinfachung der Identifizierung der verschie-
denen Stationsarten bei D-PRS (APRS®) werden 
bestimmte Rufzeichen-SSIDs verwendet, die den 
allgemeinen Richtlinien entsprechen.
Diese Richtlinien unterliegen gewissen Modifika-
tionen, wenn sich bestimmte Umstände wie neue 
Produkte und Netzwerke verändern. Die neuesten 
Richtlinien, an die man sich halten sollte, findet man 
im Internet auf Webseiten, die sich mit den Themen 
D-PRS und APRS® beschäftigen.
http://aprs.org/aprs11/SSIDs.txt
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Height (voreingestellt: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Height

Wahl der Antennenhöhe einer Basisstation, die zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 10, 20, 40, 80, 160, 320, 640, 1280, 
2560 oder 5120 ft* 
*  Wenn als Einheit „m“ eingestellt wurde, sind 3, 6, 12, 

24, 49, 98, 195, 390, 780 oder 1561 m wählbar.

Gain (voreingestellt: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS > 
 TX Format > Position > Gain

Wahl des Antennengewinns einer Basisstation, die zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 0 bis 9 dB

Directivity (voreingestellt: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Directivity

Wahl der Antennenstrahlrichtung einer Basisstation, 
die zusätzlich zu den Positionsdaten gesendet wer-
den soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: Omni, 45° NE, 90° E, 135° SE, 
180°S, 225° SW, 270° W, 315° NW oder 360° N

Object Name 

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Object Name

Eingabe eines bis zu 9 Zeichen langen Namens für 
eine Objektstation.

Data Type (voreingestellt: Live Item)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Data Type

Wahl des Status der Objektstation.
 • Live Item: Objektstation ist gültig.
 • Killed Item: Objektstation ist ungültig.

Symbol (voreingestellt: Transceiver)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Symbol

Das Symbol veranschaulicht das Transportmittel oder 
den Standort des Objekts. Das gespeicherte Symbol 
wird im D-PRS-Modus zusätzlich zu den Positions-
daten gesendet.

 LDetails zum Editieren eines Symbols s. S. 6-31.

Altitude (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Altitude

Ein- und Ausschalten des Sendens der Höhe als  
Zusatz zu den Positionsdaten im D-PRS-Modus.

 LDie Anzahl der nutzbaren Zeichen bei „Comment“ variiert 
je nach den aktuellen Einstellungen von „Data Extension“ 
und „Altitude“.
 • OFF:  Nur Positionsdaten (ohne Höhe) werden 

gesendet.
 • ON:  Positionsdaten werden mit der Höhe als 

Zusatz gesendet.

Data Extension (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Data Extension

Ein- und Ausschalten des Sendens von Kurs und 
Geschwindigkeit oder Sendeleistung/Höhe über NN/
Gewinn/Richtung als Zusatz zu den Positionsdaten im 
D-PRS-Modus.

 LDie Anzahl der nutzbaren Zeichen bei „Comment“ variiert 
je nach den aktuellen Einstellungen von „Data Extension“ 
und „Altitude“.
 • OFF: Nur Positionsdaten werden gesendet.
 • Course/Speed: 
    Kurs und Geschwindigkeit werden als 

Zusatz gesendet.
 LBei manueller Positionseingabe werden 
Kurs und Geschwindigkeit nicht mitgesen-
det.
 LWenn man mit dieser Einstellung sendet, 
wird die Station als Mobilstation angese-
hen.

 • Power/Height/Gain/Directivity: 
    Sendeleistung, Höhe über NN, Gewinn 

und Richtung werden als Zusatz gesen-
det.

 LDie Daten werden auch dann gesendet, 
wenn die Position manuell eingegeben 
wurde.
 LWenn man mit dieser Einstellung sendet, 
wird die Station als Basisstation angese-
hen.

Power (voreingestellt: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Position > Power

Wahl der Sendeleistung einer Basisstation, die zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 0, 1, 4, 9, 16, 25, 36, 49, 64 oder  
81 W.
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Comment

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Comment

Eine Bemerkung eingeben, die mit den D-PRS-Posi-
tionsdaten gesendet werden soll.
Bis zu vier Bemerkungen lassen sich eingeben.
Die Anzahl der nutzbaren Zeichen variiert je nach den 
aktuellen Einstellungen bei „Data Extension“ und  
„Altitude“.

Datenerweiterung Höhe
maximale

Zeichenzahl

OFF
— 43  

(voreingestellt)

OFF Entered 35

Course/Speed — 36

Course/Speed Entered 28

Power/Height/Gain/Directivity — 36

Power/Height/Gain/Directivity Entered 28

Bei der Eingabe markiert das Symbol „ “ das Ende 
des sendbaren Anmerkungstextes. Zeichen hinter 
diesem Symbol werden nicht mitgesendet.

Sendbare Textlänge bei der Eingabe
(in diesem Beispiel max. 28 Zeichen)

GPS-Menüeinstellungen

Position 
(voreingestellt:  LATITUDE: 0°00,00′N, 

LONGITUDE:0°00,00′W, ALTITUDE: 
------ft)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Position

Anzeige der Positionsdaten der Objektstation. 
[QUICK] drücken, um das unten abgebildete Fenster 
zu öffnen.

TIPP: Wenn die Einstellung „Capture From GPS“ 
oder „Set From GPS Memory“ gewählt ist, werden 
Positionsdaten für die Objektstation vom GPS-Emp-
fänger bzw. vom GPS-Speicher übernommen.

Positionsdaten manuell eingeben
1. Im Quick-Menüfenster „Edit“ wählen.

 • Das „POSITION EDIT“-Display wird angezeigt.
2. „LATITUDE“ wählen.
3. Breitengrad eingeben.

 L „N/S“ wählen, um zwischen Nord und Süd zu  
wechseln.

4. [ENT] drücken.
5. Select „LONGITUDE“ wählen.
6. Längengrad eingeben.

 L „E/W“ wählen, um zwischen Ost und West zu  
wechseln.

7. [ENT] drücken.
8. „ALTITUDE“ wählen.
9. Höhe eingeben.

 L [+/−] wählen, um zwischen üNN und uNN zu  
wechseln.

10. [ENT] drücken.
11. <<Write>>“ wählen.
12. „YES“ wählen.

 • Die eingegebenen Positionsdaten werden übernom-
men.
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Gain (voreingestellt: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Gain

Wahl des Antennengewinns einer Objektstation,
der zusätzlich zu den Positionsdaten gesendet
werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 0 bis 9 dB

Directivity (voreingestellt: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Directivity

Wahl der Antennenstrahlrichtung einer Objekt-Sta-
tion, die zusätzlich zu den Positionsdaten gesendet 
werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Ex-
tension“ die Einstellung „Power/Height/Gain/Directivity“ 
gewählt ist.
 • Wählbar sind: Omni, 45° NE, 90° E, 135° SE, 
180°S, 225° SW, 270° W, 315° NW oder 360° N

SSID (voreingestellt: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > SSID

Wahl einer APRS®-SSID als Zusatz zum eigenen 
Rufzeichen oder als Kennzeichnung der Art des Funk-
betriebs.

 LDie Art und Weise des Anfügens der SSID unterscheidet 
sich, wenn das Rufzeichen Leerzeichen enthält.
 LDetails zur SSID s. S. 6-32.
 • ---:   Leerzeichen im Rufzeichen werden in 

„-“ umgesetzt.
 • (-0):  Keine SSID ist angefügt.
 • -1 bis -15:  Anfügen einer SSID von „-1“ bis 

„-15“ an das Rufzeichen.
 • -A bis -Z:  Anfügen einer SSID von „-A“ bis „-Z“ 

an das Rufzeichen.

Time Stamp (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Time Stamp

Wahl des Formats der gesendeten Zeitmarke.
Die Zeitmarke wird im D-PRS-Modus als UTC zusam-
men mit den Positionsdaten gesendet.

 LBei manueller Positionseingabe, wird die Zeitmarke nicht 
mitgesendet.
 • DHM:  Zeitmarke wird im Format Tag, Stunde 

und Minute gesendet.
 • HMS:  Zeitmarke wird im Format Stunde, Minu-

te und Sekunde gesendet.

Data Extension (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Data Extension

Ein- und Ausschalten des Sendens von Kurs und 
Geschwindigkeit oder Sendeleistung/Höhe/Ge-
winn/Richtung als Zusatz zu den Positionsdaten im 
D-PRS-Modus.

 LDie Anzahl der nutzbaren Zeichen bei „Comment“ variiert 
je nach Einstellungen von „Data Extension“ und „Altitude“.
 • OFF: Nur Positionsdaten werden gesendet.
 • Course/Speed: 
    Kurs und Geschwindigkeit werden als 

Zusatz gesendet.
 • Power/Height/Gain/Directivity: 
    Sendeleistung, Höhe über NN, Gewinn 

und Richtung werden als Zusatz gesendet.

Course (voreingestellt: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Course

Eingabe des Kurses der Objektstation von 0º bis 360º.
 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Course/Speed“ gewählt ist.

Speed (voreingestellt: 0mph)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Speed

Eingabe der Geschwindigkeit der Objektstation  
zwischen 0 und 1150 mph.*
*  Bei gewählter Einheit „km/h“: 0 bis 1850 km/h, bei 

gewählter Einheit „knots“: 0 und 999 kn.
 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Course/Speed“ gewählt ist.

Power (voreingestellt: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Power

Wahl der Sendeleistung einer Objektstation, die zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind:  0, 1, 4, 9, 16, 25, 36, 49, 64 oder 81 W.

Height (voreingestellt: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Object > Height

Wahl der Antennenhöhe einer Objekt-Station, die zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 10, 20, 40, 80, 160, 320, 640, 1280, 
2560 oder 5120 ft* 
*  Wenn als Einheit „m“ eingestellt wurde, sind 3, 6, 12, 

24, 49, 98, 195, 390, 780 oder 1561 m wählbar.

GPS-Menüeinstellungen
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Position 
(voreingestellt:  LATITUDE: 0°00,00′N, 

LONGITUDE:0°00,00′W, ALTITUDE: 
------ft)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Position

Anzeige der Positionsdaten der Item-Station.
[QUICK] drücken, um das unten abgebildete Fenster 
zu öffnen.

TIPP: Wenn die Einstellung „Capture From GPS“ 
oder „Set From GPS Memory“ gewählt wird, werden 
Positionsdaten für die Objektstation vom GPS-Emp-
fänger bzw. vom GPS-Speicher übernommen.

 LManuelles Eingeben von Positionsdaten s. S. 6-34.

Data Extension (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Data Extension

Ein- und Ausschalten des Sendens von Kurs und 
Geschwindigkeit oder Sendeleistung/Höhe über NN/
Gewinn/Richtung als Zusatz zu den Positionsdaten im 
D-PRS-Modus.

 LDiese Einstellung beeinflusst die Anzahl der nutzbaren 
Zeichen bei „Comment“.
 • OFF: Nur Positionsdaten werden gesendet.
 • Course/Speed: 
    Kurs und Geschwindigkeit werden als 

Zusatz gesendet.
 • Power/Height/Gain/Directivity: 
    Sendeleistung, Höhe über NN, Gewinn 

und Richtung werden als Zusatz gesendet.

Course (voreingestellt: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Course

Eingabe des Kurses der Item-Station von 0º bis 360º.
 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Course/Speed“ gewählt ist.

Item Name 

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Item Name

Eingabe des Namens einer Item-Station mit einer 
Länge von bis zu 9 Zeichen.

Data Type (voreingestellt: Live Item)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Data Type

Wahl des Status der Item-Station.
 • Live Item: Item-Station ist gültig.
 • Killed Item: Item-Station ist ungültig.

Symbol (voreingestellt: Transceiver)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Symbol

Das Symbol veranschaulicht das Transportmittel 
oder den Standort der Item-Station. Das gespeicher-
te Symbol wird im D-PRS-Modus zusätzlich zu den 
Positionsdaten gesendet.

 LDetails zum Editieren eines Symbols s. S. 6-31 .

Comment

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Comment

Eine Bemerkung eingeben, die mit den D-PRS-Posi-
tionsdaten gesendet werden soll.
Die Anzahl der nutzbaren Zeichen variiert je nach den 
aktuellen Einstellungen bei „Data Extension“ und „Alti-
tude“.

Datenerweiterung Höhe
maximale

Zeichenzahl

OFF
— 43 

(voreingestellt)

OFF Entered 35

Course/Speed — 36

Course/Speed Entered 28

Power/Height/Gain/Directivity — 36

Power/Height/Gain/Directivity Entered 28

Bei der Eingabe markiert das Symbol „ “ das Ende 
des sendbaren Anmerkungstextes. Zeichen hinter 
diesem Symbol werden nicht mitgesendet.

Sendbare Textlänge bei der Eingabe
(in diesem Beispiel max. 28 Zeichen)
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Power (voreingestellt: 0W)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Power

Wahl der Sendeleistung einer Item-Station, die zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 0, 1, 4, 9, 16, 25, 36, 49, 64 oder  
81 W.

Height (voreingestellt: 10ft)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Height

Wahl der Antennenhöhe einer Item-Station, die zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 10, 20, 40, 80, 160, 320, 640, 1280, 
2560 oder 5120 ft* 
*  Wenn als Einheit „m“ eingestellt wurde, sind 3, 6, 12, 

24, 49, 98, 195, 390, 780 oder 1561 m wählbar.

Gain (voreingestellt: 0dB)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Gain

Wahl des Antennengewinns einer Item-Station, der zu-
sätzlich zu den Positionsdaten gesendet werden soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: 0 bis 9 dB

Directivity (voreingestellt: Omni)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Directivity

Wahl der Antennenstrahlrichtung einer Item-Station, 
die zusätzlich zu den Positionsdaten gesendet wer-
den soll.

 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Power/Height/Gain/Directivity“ gewählt ist.
 • Wählbar sind: Omni, 45° NE, 90° E, 135° SE, 
180°S, 225° SW, 270° W, 315° NW oder 360° N

SSID (voreingestellt: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > SSID

Wahl einer APRS®-SSID als Zusatz zum eigenen 
Rufzeichen oder als Kennzeichnung der Art des Funk-
betriebs.

 LDie Art und Weise des Anfügens der SSID unterscheidet 
sich, wenn das Rufzeichen Leerzeichen enthält.
 LDetails zu SSID s. S. 6-32.
 • ---:   Leerzeichen im Rufzeichen werden in 

„-“ umgesetzt.
 • (-0):  Keine SSID ist angefügt.
 • -1 bis -15:  Anfügen einer SSID von „-1“ bis 

„-15“ an das Rufzeichen.
 • -A bis -Z:  Anfügen einer SSID von „-A“ bis „-Z“ 

an das Rufzeichen.

Speed (voreingestellt: 0°)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Item > Speed

Eingabe der Geschwindigkeit der Item-Station von 0 
bis 1150 mph.*
*    Bei gewählter Einheit „km/h“: 0 bis 1850 km/h, bei 

gewählter Einheit „knots“: 0 und 999 kn.
 LDieser Menüpunkt erscheint nur, wenn bei „Data Exten-
sion“ „Course/Speed“ gewählt ist.
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Symbol (voreingestellt: WX Station)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Weather > Symbol

Das Symbol veranschaulicht das Transportmittel oder 
den Standort der Wetterstation. Das gespeicherte 
Symbol wird im D-PRS-Modus zusätzlich zu den 
Positionsdaten gesendet.

 LDetails zum Editieren eines Symbols s. S. 6-31.

SSID (voreingestellt: ---)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Weather > SSID

Wahl einer APRS®-SSID als Zusatz zum eigenen 
Rufzeichen oder als Kennzeichnung der Art des Funk-
betriebs.

 LDie Art und Weise des Anfügens der SSID unterscheidet 
sich, wenn das Rufzeichen Leerzeichen enthält.
 LDetails zur SSID s. S. 6-32.
 • ---:   Leerzeichen im Rufzeichen werden in 

„-“ umgesetzt.
 • (-0):  Keine SSID ist angefügt.
 • -1 bis -15:  Anfügen einer SSID von „-1“ bis 

„-15“ an das Rufzeichen.
 • -A bis -Z:  Anfügen einer SSID von „-A“ bis „-Z“ 

an das Rufzeichen.

Comment 

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Weather > Comment

Eingabe einer bis zu 43 Zeichen langen Anmerkung.

Time Stamp (voreingestellt: OFF)

[MENU] > GPS > GPS TX Mode > D-PRS >  
TX Format > Weather > Time Stamp

Wahl des Formats der gesendeten Zeitmarke.
Die Zeitmarke wird im D-PRS-Modus als UTC zusam-
men mit den Positionsdaten gesendet.

 • OFF: Zeitmarke wird nicht gesendet.
 • DHM:  Zeitmarke wird im Format Tag, Stunde 

und Minute gesendet.
 • HMS:  Zeitmarke wird im Format Stunde, Minu-

te und Sekunde gesendet.

GPS-Menüeinstellungen
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GPS Sentence (voreingestellt: GGA)

[MENU] > GPS > GPS TX Mode > NMEA >  
GPS Sentence

Wahl der Datensätze, die beim Senden von Posi-
tionsdaten im GPS-Modus verwendet werden sollen. 
Wählbar sind: RMC, GGA, GLL, VTG, GSA und GSV.

HINWEIS: Wenn GPS-Daten an herkömmliche digi-
tale Transceiver gesendet werden sollen, muss der 
GSV-Datensatz abgeschaltet werden, da dieser mit 
diesen Transceivern nicht kompatibel ist (S. 6-4).

 L Information
 • Bis zu 4 GPS-Datensätze lassen sich bei einem Sende-
durchgang verwenden.

 • „ “ erscheint bei eingeschaltetem Datensatz.
 • „VTG“, „GSA“ und „GSV“ werden nicht gesendet, wenn 
die Eingabe der eigenen Position manuell erfolgt ist.

GPS Message 

[MENU] > GPS > GPS TX Mode > NMEA >  
GPS Message

Eingabe einer bis zu 20 Zeichen langen GPS-Meldung 
(S. 6-21)

HINWEIS: Falls das Senden einer GPS-Meldung 
nicht erwünscht ist, sollte sie gelöscht werden.

GPS Information 

[MENU] > GPS > GPS Information

Anzeige der Richtung der Satelliten, der Höhe, der 
Satellitennummer und des Empfangsstatus (S. 6-11)

TIPP: Inhalte der verschiedenen GPS-Datensätze
Die Zeitmarke basiert auf UTC (Universal Time Coordinated).

Datensatz Lon/Lat Alt
GPS Time 

Stamp 
(UTC)

Date
(UTC)

Status 2D/3D
COG
(True)

SOG
(knot)

RMC ✔ ✔ ✔ ✔ ✔ ✔

GGA ✔ ✔ ✔ ✔

GLL ✔ ✔ ✔

VTG ✔ ✔

GSA ✔ ✔

GSV

Datensatz Ergänzung

RMC Magnetische Abweichung, Modus-Indikator

GGA
Anzahl der ausgewerteten Satelliten, HDOP, Geoidale Trennung, Alter der Differenzial-GPS-Daten, 
ID der Differenzial-Referenzstation

GLL Modus-Indikator

VTG COG (Magnetischer Norden), SOG (km/h), Modus-Indikator

GSA ID-Nummern der Satelliten, PDOP, HDOP, VDOP

GSV
Gesamtanzahl der Datensätze, Datensatznummer, Anzahl der „sichtbaren“ Satelliten, 
Satelliteninformationen (ID, Höhe, Azimut, S/N)
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GPS Position

[MENU] > GPS > GPS Position

Anzeige der aktuellen eigenen GPS-Positionsdaten, 
der empfangenen Position, der Position aus dem 
GPS-Speicher oder der GPS-Alarmposition. (S. 6-6)
[DIAL] drehen, um die Anzeige zwischen „MY“, „RX“, 
„MEM“ und „ALM“ zu wechseln.

„MY“-Display (eigene Position)
Compass* Kompassrichtung

Course eigener Kurs

Latitude eigener Breitengrad

Longitude eigener Längengrad

GL Locator der eigenen Position

ALT eigene Höhe

SPEED eigene Geschwindigkeit (über Grund)

TIME
aktuelle aus den GPS-Daten  
ermittelte Zeit

 LWenn bei „GPS Select“ die Einstellung „Manual“ gewählt 
ist, werden nur der Breitengrad, der Längengrad, die Hö-
he, der Locator und die Zeit der internen Uhr angezeigt.

„RX“-Display  
(empfangene Positionsdaten der Gegenstation)
Je nach GPS-Sendeart des Anrufers und des verwen-
deten Positionsdatenformats unterscheiden sich die 
angezeigten Informationen und deren Bedeutung. Die 
nachfolgenden Auflistungen beschreiben die einzel-
nen Informationen für jede Kategorie.
Wenn von der Gegenstation keine Daten empfangen 
wurden, wird im „RX“-Fenster nichts angezeigt.

<1. GPS-Sendeart des Anrufers ist NMEA>
Compass* Richtung zum Anrufer

Latitude Breitengrad des Anrufers

Longitude Längengrad des Anrufers

GL Locator des Anrufers

ALT Höhe des Anrufers

DST Entfernung zum Anrufer

Call sign Rufzeichen des Anrufers

COURSE Kurs (über Grund) des Anrufers

SPEED Geschwindigkeit des Anrufers

GPS Time Stamp
Zeit, zu der der Anrufer die 
GPS-Daten ermittelt hat

<2.  Positionsdatenformat des Anrufers ist  
D-PRS Position (Mobile station)>

Compass* Richtung zum Anrufer

Symbol D-PRS-Symbol des Anrufers

Latitude Breitengrad des Anrufers

Longitude Längengrad des Anrufers

GL Locator des Anrufers

ALT Höhe des Anrufers

DST Entfernung zum Anrufer

Call sign Rufzeichen des Anrufers (mit SSID)

COURSE Kurs (über Grund) des Anrufers

SPEED Geschwindigkeit des Anrufers

GPS Time Stamp
Zeit, zu der der Anrufer die 
GPS-Daten ermittelt hat

*  Die Kompassanzeige lässt sich im „QUICK“-Menü-
fenster ändern.



6 ERWEITERTER GPS-BETRIEB

6-41

GPS-Menüeinstellungen

GPS Position (Fortsetzung)

<3.  Positionsdatenformat des Anrufers ist  
D-PRS Position (Base station)>

Compass* Richtung zum Anrufer

Symbol D-PRS-Symbol des Anrufers

Latitude Breitengrad des Anrufers

Longitude Längengrad des Anrufers

GL Locator des Anrufers

ALT Höhe des Anrufers

DST Entfernung zum Anrufer

Call sign Rufzeichen des Anrufers (mit SSID)

POWER Sendeleistung des Anrufers

HEIGHT Antennenhöhe des Anrufers

GAIN Antennengewinn des Anrufers

DIRECT
Antennenstrahlrichtung des  
Anrufers

GPS Time Stamp
Zeit, zu der der Anrufer die 
GPS-Daten ermittelt hat

<4.  Positionsdatenformat des Anrufers ist  
D-PRS Object/Item>

Compass*
Richtung zur Objekt- oder 
Item-Station

Symbol
D-PRS-Symbol der Objekt- oder 
Item-Station

Latitude
Breitengrad der Objekt- oder 
Item-Station

Longitude
Längengrad der Objekt- oder 
Item-Station

GL
Locator der Objekt- oder  
Item-Station

ALT Höhe der Objekt- oder Item-Station

DST
Entfernung zur Objekt- oder 
Item-Station

Object/Item name
Name der Objekt- oder Item- 
Station

Call sign Rufzeichen des Anrufers (mit SSID)

COURSE
Kurs (über Grund) der Objekt- oder 
Item-Station

SPEED
Geschwindigkeit der Objekt- oder 
Item-Station

POWER
Sendeleistung der Objekt- oder 
Item-Station

HEIGHT
Antennenhöhe der Objekt- oder 
Item-Station

GAIN
Antennengewinn der Objekt- oder 
Item-Station

DIRECT
Antennenstrahlrichtung der Objekt- 
oder Item-Station

GPS Time Stamp
Zeit, zu der die Objekt- oder Item- 
Station die Daten gesendet hat

 LWenn die Objekt- oder Item-Station ausgeschaltet ist, 
erscheint „KILLED“ im Display.

*  Die Kompassanzeige lässt sich im „QUICK“-Menü-
fenster ändern.
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*  Die Kompassanzeige lässt sich im „QUICK“-Menü-
fenster ändern.

GPS Position (Fortsetzung)

<5.  Positionsdatenformat des Anrufers ist  
D-PRS Weather>

Compass* Richtung zum Anrufer

Symbol D-PRS-Symbol des Anrufers

Latitude Breitengrad des Anrufers

Longitude Längengrad des Anrufers

GL Locator des Anrufers

DST Entfernung zum Anrufer

Call sign Rufzeichen des Anrufers (mit SSID)

Temperature Temperatur am Ort des Anrufers

Humidity
Luftfeuchtigkeit am Ort des  
Anrufers

RAIN Niederschlag am Ort des Anrufers

WIND DIR Windrichtung am Ort des Anrufers

WIND SPD
Windgeschwindigkeit am Ort des 
Anrufers

BARO Luftdruck am Ort des Anrufers

GPS Time Stamp
Zeit, zu der der Anrufer die 
GPS-Daten ermittelt hat

„MEM“-Display (GPS-Speicher-Position)

Compass*
Richtung zur Position im 
GPS-Speicher

Latitude Breitengrad im GPS-Speicher

Longitude Längengrad im GPS-Speicher

GL Locator im GPS-Speicher

DST
Entfernung zur Position im 
GPS-Speicher

GPS memory name
Anzeige des Rufzeichens  
(mit SSID)

 LDen GPS-Speicher kann man im „QUICK“-Menüfenster 
ändern.

„ALM“-Display (GPS-Alarm-Position)

Compass*
Richtung des GPS-Alarmgebiets 
von der eigenen Position

Latitude Breitengrad des GPS-Alarmgebiets

Longitude Längengrad des GPS-Alarmgebiets

GL Locator des GPS-Alarmgebiets

DST Entfernung zum GPS-Alarmgebiet

GPS Alarm

Anzeige von „RX“, GPS-Speicher-
gruppenname oder GPS-Speicher-
name, der für die GPS-Alarm-
funktion festgelegt ist.

 LDen GPS-Alarm kann man im „QUICK“-Menüfenster 
ändern.
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GPS Memory

[MENU] > GPS > GPS Memory

Das Handfunkgerät verfügt über 300 GPS-Speicher, 
in denen sich empfangene oder oft genutzte Posi-
tionsdaten sowie die zugehörigen alphanumerischen
Namen speichern lassen. Zur besseren Übersichtlich-
keit können die GPS-Speicher GPS-Speichergruppen 
(A bis Z) oder keiner Gruppe „(No Group)“ zugeordnet 
werden.

Anzeige des „GPS MEMORY“-Displays

(No Group)
GPS-Speicher ist keiner 
GPS-Speichergruppe zugeordnet

A bis Z:  
Gruppenname

GPS-Speicher ist der entsprechen-
den GPS-Speichergruppe zuge-
ordnet

GPS-Speichergruppen (A bis Z)

GROUP NAME
Name der GPS-Speichergruppe 
(bis zu 16 alphanumerische Zeichen)

 LGPS-Speichergruppennamen kann man bearbeiten, 
siehe S. 6-25.

GPS-Speicher

NAME
Name des GPS-Speichers (bis zu 
16 alphanumerische Zeichen )

DATE Speicherdatum

TIME Speicherzeit

LATITUDE gespeicherte Position (Breitengrad)

LONGITUDE gespeicherte Position (Längengrad)

ALTITUDE gespeicherte Höhe

GROUP
Buchstabe und Name der 
GPS-Speichergruppe

 LErfolgt die Übernahme der empfangenen Positionsdaten 
in einen GPS-Speicher über das „GPS POSITION“-Dis-
play, wird das empfangene Rufzeichen automatisch als 
Name des GPS-Speichers verwendet.
 L Inhalte von GPS-Speichern, wie z. B. der Name, lassen 
sich im „QUICK“-Menüfenster editieren.

Alarm Select (voreingestellt: OFF)

[MENU] > GPS > GPS Alarm > Alarm Select

Wahl der Zielpositionen für die GPS-Alarmfunktion.
 • OFF:  Die Funktion ist ausgeschaltet.
 • RX:   Wenn eine Station (letzte empfangene 

Positionsdaten) in das Alarmgebiet 
eintritt, wird ein GPS-Alarm ausgelöst.

 • Group:  Wenn eine Station (Positionsdaten im 
GPS-Speicher oder der gewählten 
GPS-Speichergruppe) in das Alarm-
gebiet eintritt, wird ein GPS-Alarm 
ausgelöst.

 • Memory:  Wenn eine Station (Positionsdaten 
im GPS-Speicher) in das Alarmgebiet 
eintritt, wird ein GPS-Alarm ausgelöst.

Alarm Area (Group) (voreingestellt: 0.25′)

[MENU] > GPS > GPS Alarm > Alarm Area (Group)

Einstellung des GPS-Alarmgebiets. Wenn eine Station 
in das Alarmgebiet eintritt, wird ein GPS-Alarm aus-
gelöst und das GPS-Alarmsymbol.

 LDiese Einstellung ist verfügbar, wenn man bei „Alarm 
Select“ die Einstellung „Group“ wählt.

Die einstellbaren Werte hängen von der Einstellungen 
für „Latitude/Longitude ab“.

 • Latitude/Longitude = ddd°mm.mm′ 
Bereich: 00,08′ bis 59,99′ (0,01′-Schritte)

 • Latitude/Longitude = ddd°mm′mm″ 
Bereich: 00′05″ bis 59′59″ (0′01″-Schritte)

 • Latitude/Longitude = ddd.dddd° 
Bereich: 0,0014° bis 0,9999° (0,0001°-Schritte)

 LDer Cursor lässt sich mit den Navigationstasten () 
auf die jeweiligen Nachkommastellen bewegen.

Beispiel:
Wenn eine Station in das Alarmgebiet eintritt, wird ein 
GPS-Alarm ausgelöst und das Alarmsymbol blinkt

Punkt C
drei Hinweistöne

eigene Position

Punkt A

Punkt B

50
0 

m
50

0 
m

500 m 500 m
N
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Alarm Area (RX/Memory) (voreingestellt: Both)

[MENU] > GPS > GPS Alarm >  
Alarm Area (RX/Memory)

Wahl des aktiven GPS-Alarmgebiets. Wenn eine Sta-
tion in das aktive Alarmgebiet eintritt, wird ein GPS-
Alarm ausgelöst und das Alarmsymbol blinkt.

 LDiese Einstellung ist verfügbar, wenn man bei „Alarm Se-
lect“ die Einstellung „RX“ oder „Memory“ wählt. (S. 6-43)
 • Limited:  Drei Alarmtöne sind zu hören und 

das GPS-Alarm-Symbol blinkt, so-
bald sich das Ziel innerhalb eines 
500-m-Radius befindet.

 • Extended:  Drei Alarmtöne sind zu hören und 
das GPS-Alarm-Symbol blinkt, so-
bald sich das Ziel innerhalb eines 
1-km-Radius befindet.

 • Both:   Ein Alarmton ist zu hören und das 
GPS-Alarm-Symbol blinkt, so-
bald sich das Ziel innerhalb eines 
1-km-Radius befindet. Drei Alarmtöne 
sind zu hören und das GPS-Alarm-
Symbol blinkt, sobald sich das Ziel 
innerhalb eines 500-m-Radius befin-
det. Verlässt das Ziel den 500-m-Ra-
dius, befindet sich aber immer noch 
innerhalb des 1-km-Radius, blinkt 
das GPS-Alarmsymbol, aber es sind 
keine Alarmtöne hörbar.

Beispiel:
Wenn eine Station in das aktive Alarmgebiet eintritt, 
wird je nach eingestelltem Radius (500 m oder 1 km) 
ein GPS-Alarm ausgelöst und das GPS-Alarm-Sym-
bol blinkt.

Zielstation

drei Hinweistöneein Hinweiston

Eingegrenzter Bereich,
Radius etwa 500 m

Erweiterter Bereich,
Radius etwa 1 km

Eigener Standort

N

GPS Logger (voreingestellt: ON)

[MENU] > GPS > GPS Logger

Ein- und Ausschalten der GPS-Log-Funktion Diese 
Funktion loggt die Position, die Höhe, den Kurs, die 
Geschwindigkeit und die Anzahl der ausgewerteten 
Satelliten.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  Die GPS-Log-Funktion ist eingeschaltet. 

GPS-Daten werden automatisch geloggt, bis 
die Funktion wieder ausgeschaltet wird. Dies 
gilt auch für den Fall, dass das Handfunk-
gerät zwischenzeitlich aus- und wieder einge-
schaltet wird.

 LFür die Nutzung dieser Funktion ist eine Micro-SD-Karte 
erforderlich (nicht im Lieferumfang enthalten).
 LWenn bei „GPS select“ die Einstellung „OFF“ oder  
„Manual“ gewählt ist, wird keine Logdatei gespeichert.

TIPP: Die Logdatei wird auf der Micro-SD-Karte
gespeichert. Die Vergabe des Dateinamens erfolgt 
automatisch nach folgendem Schema:

 • Log-Start (Datum/Zeit): 1. November 2021, 15:30:00 Uhr
 • Dateiname: 20211101_153000.csv

Record Interval (voreingestellt: 10sec)

[MENU] > GPS > GPS Logger > Record Interval

Einstellen des Aufzeichnungsintervalls für die 
GPS-Log-Funktion auf 1, 5, 10 oder 30 Sekunden 
bzw. auf 1, 5, oder 10 Minuten.

Record Sentence 
 (voreingestellt: ✔  RMC/ ✔  GGA/ ✔  VTG/ ✔  GSA)

[MENU] > GPS > GPS Logger > Record Sentence

Wahl der GPS-Datensätze (RMC, GGA, VTG oder 
GSA).

 • Ausgewählte Datensätze sind mit „ “ markiert.

HINWEIS: Mindestens einen Datensatz muss aus-
gewählt sein, sonst ertönt ein Fehlerton.

<<GPS Logger Only>>

[MENU] > GPS > GPS Logger >  
<<GPS Logger Only>>

Im „GPS Logger Only“-Modus werden nur GPS- 
Daten geloggt. Man kann weder senden noch emp-
fangen.

 L Information
 • SICHERSTELLEN, dass eine Micro-SD-Karte in das 
Handfunkgerät eingesetzt ist.

 • Bei „GPS Select“ die Einstellung „ON“ wählen. (S. 6-30)
 • Zum Beenden dieses Modus muss man das Handfunk-
gerät aus- und wieder einschalten.
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GPS Auto TX (voreingestellt: OFF)

[MENU] > GPS > GPS Auto TX

Ein- und Ausschalten der automatischen GPS-Sende-
funktion sowie Wahl des gewünschten Sendeinter-
valls.
Die Einstellung legt fest, in welchen Intervallen die 
vom GPS-Empfänger ermittelten Positionsdaten und 
die programmierte GPS-Meldung gesendet werden.

 • OFF:  Automatikfunktion ausgeschaltet. Das Sen-
den der GPS-Daten und -Meldung kann 
durch Drücken der [PTT]-Taste manuell ver-
anlasst werden.

 • 30 sec bis 30 min: 
    GPS-Daten und -Meldung werden entspre-

chend der Einstellung gesendet (30 Sekun-
den bzw. 1, 3, 5, 10 oder 30 Minuten).

GPS-Menüeinstellungen
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Mit der Voice-TX-Funktion kann man die auf der 
Micro-SD-Karte gespeicherte Sprachaufzeichnung 
einmalig oder bis zu 10 Minuten lang mit einem ein-
gestellten Wiederholintervall senden.
Sie lässt sich z. B. für wiederholte CQ-Rufe nutzen.
Die Tastenfunktion [Voice TX] lässt sich auch einer 
Taste am optionalen Lautsprechermikrofon HM-75LS 
oder Bluetooth-Headset VS-3 zuweisen (S. 12-18, 
12-34).

HINWEIS: Vor der Sprachaufzeichnung MUSS eine 
Micro-SD-Karte in das Handfunkgerät eingesetzt 
werden.

Sprachsendefunktion

 DSprachaufzeichnung
[MENU] > VOICE > Record

1. [MENU] drücken.
2. „VOICE“ wählen.
3. „Record“ wählen. 

4. [PTT] drücken, um die Aufzeichnung zu starten.

 L Information
 • Das Mikrofon 5 bis 10 cm vor den Mund halten und 
mit normaler Lautstärke sprechen.

 • Die maximale Aufzeichnungszeit beträgt 1 Minute.
 • Es lässt sich nur eine Aufzeichnung speichern.

TIPP: Eine Aufzeichnung kann man löschen, 
indem man im „VOICE TX RECORD“-Display die 
[QUICK]-Taste drückt und dann „Clear“ wählt.

5. Zum Bestätigen der Sprachaufzeichnung [ENT] 
drücken.

 • Die Wiedergabe der Aufzeichnung startet.

NF-Pegel

Dauer der 
Aufzeichnung

 LWenn man die [PTT] gedrückt hält, startet die Auf-
zeichnung erneut und die vorherige wird überschrie-
ben.
 LZum Verlassen die [MENU]-Taste drücken.

wird während 
der Wieder-
gabe ange-
zeigt

bereits  
wiedergegeben

Gesamtdauer der 
Aufzeichnung

wird während 
der Aufzeich-
nung ange-
zeigt
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Sprachsendefunktion

HINWEIS: SICHERSTELLEN, dass eine Micro- 
SD-Karte in das Handfunkgerät eingesetzt ist.

[MENU] > VOICE > <<Single TX>>

[MENU] > VOICE > <<Repeat TX>>

1. [MENU] drücken.
2. „VOICE“ wählen.
3. „<<Single TX>>“ oder „<<Repeat TX>>“ wählen.

 • Bei der Wahl von <<Single TX>>: 
Die Sprachaufzeichnung wird einmalig gesendet. 

 • Bei der Wahl von <<Repeat TX>>: 
Die Sprachaufzeichnung wird wiederholt gesendet.

 L Information
 • Während des Sendens blinkt das SD-Kartensymbol.
 • Wenn die Option „<<Repeat TX>>“ gewählt wurde, 
sendet das Handfunkgerät die Sprachaufzeichnung für 
bis zu 10 Minuten gemäß dem dem bei „Repeat Time“ 
eingestellten Zeitintervall. 
([MENU] > VOICE > TX Set > Repeat Time) 

 • Das automatisch wiederholte Senden lässt sich 
folgender maßen beenden: 
- durch Drücken der [PTT]-Taste, 
- durch Aus- und Wiedereinschalten des Handfungeräts, 
-  durch Drücken einer beliebigen Taste  

(außer [VOL] und [ ]).
 • Nach dem ersten Senden der Aufzeichnung pausiert das 
Handfunkgerät entsprechend dem eingestellte Wieder-
holintervall auch dann, wenn ein Signal empfangen wird 
und die Busy-Lockout-Funktion eingeschaltet ist.  
([MENU] > SET > Function > Busy Lockout) 
Falls man den Squelch bei FM manuell öffnet, erfolgt  
das Senden der Sprachaufzeichnung im eingestellten 
Wiederholintervall.

 • Mann kann wählen, ob beim Senden eine Lautsprecher-
wiedergabe der Sprachaufzeichnung erfolgen soll. 
([MENU] > VOICE > TX Set > TX Monitor) 

TIPP: Zum Senden der Sprachaufzeichnung im 
„QUICK“-Menüfenster, [QUICK] drücken und  
„ Voice TX“ wählen.
 

 DSprachaufzeichnung senden

blinkt

Sendepause
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Record

[MENU] > VOICE > Record

Die für die Sprachsendefunktion auf der Micro-SD- 
Karte gespeicherte Aufzeichnung kann bis zu einer 
Minute lang sein. (S. 7-2)
Es lässt sich nur eine Aufzeichnung speichern.

 LSICHERSTELLEN, dass eine Micro-SD-Karte in das 
Handfunkgerät eingesetzt ist.
 LWährend der Aufzeichnung eines QSOs ist die Funktion 
nicht nutzbar.

Repeat Time (voreingestellt: 5sec)

[MENU] > VOICE > TX Set > Repeat Time

Das Zeitintervall für das wiederholte Senden der 
Sprachaufzeichnung ist in 1-Sek.-Schritten von 1 bis 
15 Sekunden einstellbar.

HINWEIS: Die automatische Sendewiederholung 
wird nach 10 Minuten automatisch beendet. Die 
letzte Sendung erfolgt vollständig, auch wenn wäh-
rend dieser das 10-Minuten-Limit überschritten wird.

TX Monitor (voreingestellt: ON)

[MENU] > VOICE > TX Set > TX Monitor

Ein- und Ausschalten der Monitor-Funktion beim Sen-
den der Sprachaufzeichnung.

 • OFF:  Keine Wiedergabe der Sprachaufzeichnung 
während des Sendens.

 • ON:  Lautsprecherwiedergabe der Sprachaufzeich-
nung während des Sendens.

Menüeinstellungen und -befehle für die Sprachsendefunktion

<<Single TX>>

[MENU] > VOICE > <<Single TX>>

Die Sprachaufzeichnung wird einmalig gesendet.
 L „Single TX“ lässt sich auch im „QUICK“-Menüfenster 
wählen.  
([QUICK] > Voice TX > Single TX)

<<Repeat TX>>

[MENU] > VOICE > <<Repeat TX>>

Die Sprachaufzeichnung wird für bis zu 10 Minuten 
gemäß dem dem bei „Repeat Time“ eingestellten 
Zeitintervall gesendet.

 L Information
 • „Repeat TX“ lässt sich auch im „QUICK“-Menüfenster 
wählen.  
([QUICK] > Voice TX > Repeat TX)

 • Die automatische Sendewiederholung wird nach  
10 Minuten automatisch beendet. Die letzte Übertragung 
erfolgt vollständig.

 • Das automatisch wiederholte Senden lässt sich 
folgender maßen beenden: 
- durch Drücken der [PTT]-Taste, 
- durch Aus- und Wiedereinschalten des Handfungeräts, 
-  durch Drücken einer beliebigen Taste  

(außer [VOL] und [ ]).
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HINWEIS:
 • Für die Aufzeichnungen muss eine Micro-SD-Karte in 
das Handfunkgerät eingesetzt werden.

 • Die Aufzeichnungsfunktion ist dauerhaft eingeschaltet, 
auch nach dem Aus- und Wiedereingeschalten des 
Handfunkgeräts.

Aufzeichnen von QSOs

Aufzeichnung starten
1. [QUICK] drücken.
2. „<<REC Start>>“ wählen. 

 • „Recording started.“ wird angezeigt, dann erfolgt die 
Rückkehr zum Stand-by-Display.

Aufzeichnung stoppen
1. [QUICK] drücken.
2. „<<REC Stop>>“ wählen. 

Aufnahme-Stand-by

Die Aufzeichnung beginnt,  
wenn man sendet oder der 
Squelch geöffnet wird.
Während der Aufnahme blinkt das 
SD-Kartensymbol.

 L Information
 • Wenn kein Signalempfangen wird, pausiert die Aufnah-
me. Sie wird fortgesetzt, sobald wieder ein Signal vor-
handen ist.

 • Die Aufzeichnung läuft bis sie manuell gestoppt wird 
bzw. bis die Kapazität der Micro-SD-Karte erschöpft ist.

 • Sobald die Dateigröße bei der Aufzeichnung 2 GB er-
reicht hat, wird sie in einer neuen Datei fortgesetzt.

TIPP: 
 • Man kann wählen, ob nur Signale vom Haupt-
band oder vom Haupt- und Subband aufgezeich-
net werden. (S. 8-15) 
( [MENU] > RECORD > QSO Recorder  
> Recorder Set > REC Operation)

 • Wenn bei „RX REC Condition“ die Einstellung 
„Always“ gewählt ist, startet die Aufzeichnung 
automatisch, sobald man „<<REC Start>>“ wählt. 
Die Aufzeichnung erfolgt dauerhaft, auch wenn 
kein Signal empfangen wird.* (S. 8-15) 
( [MENU] > RECORD > QSO Recorder  
> Recorder Set > RX REC Condition) 
*  In diesem Fall enthält die Aufzeichnungsdatei 

keine Audiosignale.
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Wiedergabe eines aufgezeichneten QSOs

HINWEIS: Für die Wiedergabe muss sich die Micro- 
SD-Karte mit den gespeicherten Aufzeichnungen im 
Handfunkgerät befinden.

[MENU] > RECORD > QSO Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „QSO Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Ordner wählen, der die anzuhörende Aufzeichnung 
enthält. 

 LDie Ordner sind folgendermaßen benannt: 
yyyymmdd (yyyy: Jahr, mm: Monat, dd: Tag)

6. Datei für die Wiedergabe wählen.
 • Das „VOICE PLAYER“-Display wird angezeigt und 
die Wiedergabe beginnt.

Das „VOICE PLAYER“-Display

Schnell vorwärts [LO]/Rückwärts [CD]
 • Jeweilige Taste halten, um in einer Aufzeichnung eine 
voreingestellte Zeit vorwärts bzw. rückwärts zu springen.

 • Die voreingestellte Zeit beträgt 10 Sekunden. Sie lässt 
sich ändern, Details dazu siehe S. 8-16.

 • [DIAL] drehen, um den Abspielpunkt vorwärts oder 
rückwärts zu verschieben. Er wird dabei unabhängig 
von der Gesamtdauer der Aufzeichnung jeweils um 
1/20 der Gesamtdauer verschoben.

 • Wird die [CD]-Taste innerhalb der ersten Sekunde der 
Wiedergabe einer neuen Datei gedrückt, wird das Ende 
der vorherigen Datei wiedergegeben.

Wiedergabe der vorherigen Datei [RX→CS]
 • Wenn man während der Wiedergabe der ältesten Datei 
des Ordners [RX→CS] drückt, wird sie erneut abgespielt.

 • Wenn die Wiedergabe pausiert und man drückt [RX→CS], 
wird die vorherige Datei von Anfang an abgespielt.

Wiedergabe der nächsten Datei [DR]
Wenn man während der Wiedergabe der neuesten Datei 
des Ordners [DR] drückt, wird sie erneut abgespielt.

Betriebsinformationen
Hier werden Frequenz, Sendeart und Audiokategorie (RX 
oder TX) angezeigt.

TIPP: Wahl des Dateityps für die Anzeige
Bei Schritt 6 [QUICK] drücken, dann „Display File“ 
und anschließend den Aufzeichnungsdateityp wählen. 
 

 • ALL: Alle aufgezeichneten Dateien werden angezeigt.
 • A only:  Aufzeichnungen vom Band A werden angezeigt.
 • B only:  Aufzeichnungen vom Band B werden angezeigt

Band (A/B)

Frequenz
Sendeart

TX/RX
gesamte Wiedergabezeit

Zeitpunkt der Aufzeichnung

bereits angehörte Aufzeichnungen/ 
Gesamtzahl aller Aufzeichnungen

Band (A/B)
TX/RXBetriebs-

informationen

Datum und
Uhrzeit des
Beginns der
Aufzeichnung

Wiedergabe-
zeit/Gesamtzeit

[ENT] Pause/Wiedergabe

[LO] schnell vorwärts

[RX→CS] 
Wiedergabe der  
vorherigen Datei

[DR] Wiedergabe der nächsten Datei

[CD] 
rückwärts
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Aufzeichnungseinstellungen ändern

Fortsetzung der Aufzeichnung  
bei geschlossenem Squelch

[MENU] > RECORD > QSO Recorder >  
Recorder Set > RX REC Condition

 LVoreingestellt ist „Squelch Auto“ (Aufzeichnung nur bei 
geöffnetem Squelch).

Aufzeichnung eines QSOs als Gesamtdatei

[MENU] > RECORD > QSO Recorder >  
Recorder Set > File Split

 LVoreingestellt ist „ON“ (empfangene und gesendete Sig-
nale werden als separate Dateien gespeichert).
 LWenn bei „RX REC Condition“ die Einstellung „Squelch 
Auto“ gewählt wurde, wird bei jedem Öffnen des Squelch 
eine neue Datei angelegt. Die empfangenen Signale wer-
den als separate Dateien gespeichert

Separates Starten oder Stoppen der Aufnahme auf 
dem gewählten Band (Hauptband)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > REC Operation

 LVoreingestellt ist „A/B Link“ (gleichzeitiges Starten oder 
Stoppen der Aufnahme auf dem Haupt- und Subband).

Die Aufzeichnungseinstellungen kann man ändern, 
Details dazu siehe S. 8-15 und 8-16.

Aufnahme mit der PTT-Taste starten

[MENU] > RECORD > QSO Recorder >  
Recorder Set > PTT Auto REC

 LVoreingestellt ist „ON“ (Die Aufnahme beginnt beim Drü-
cken der [PTT]-Taste).

TIPP: Wenn „PTT Auto REC“ eingeschaltet ist
 • Die Aufnahme lässt sich nicht nur durch Drücken der 
[PTT] am Handfunkgerät starten, sondern auch wenn 
die Sendeumschaltung mit einem Lautsprechermikro-
fon, einem Bluetooth-Headset, durch einen CI-V-Befehl 
oder die VOX-Funktion erfolgt.

 • Ein Signal, das innerhalb von 10 Sekunden nach Schlie-
ßen des Squelch empfangen wird, wird noch in dersel-
ben Datei gespeichert.

Änderung der Sprungzeit für das  
Vor- und Zurückspulen

[MENU] > RECORD > QSO Recorder >  
Player Set > Skip Time

 LVoreingestellt ist „10sec“.
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Löschen von Aufzeichnungsordnern/-dateien

HINWEIS: Gelöschte Audiodateien können nicht 
wiederhergestellt werden.

 DAufzeichnungsordner löschen

HINWEIS: Alle Dateien in gelöschten Ordnern  
werden ebenfalls gelöscht.

[MENU] > RECORD > QSO Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „QSO Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Zu löschenden Ordner wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Delete“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
8. „YES“ wählen. 

 • Der Ordner ist gelöscht.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Alle Ordner löschen
Bei Schritt 7 „Delete All Folders“ wählen.
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Löschen von Aufzeichnungsordnern/-dateien

 DAufzeichnungsdatei löschen
[MENU] > RECORD > QSO Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „QSO Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Ordner wählen, der die zu löschende Datei enthält. 

6. Datei zum Löschen wählen. 

 LNICHT die [ENT]-Taste betätigen!
7. [QUICK] drücken.
8. „Delete“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
9. „YES“ wählen. 

 • Die Datei ist gelöscht.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Alle Dateien löschen
Bei Schritt 8 „Delete All“ wählen.

 LWenn bei „Display File“ die Einstellung „A only“ oder  
„B only“ gewählt ist, werden nur die angezeigten Datei-
en gelöscht.

 • Die Einstellung bei „Display File“ ist „ALL“. 

 • Die Einstellung bei „Display File“ ist „A only“. 

 • Die Einstellung bei „Display File“ ist „B only“. 
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Dateiinformationen anzeigen

Die aufgezeichneten Dateien enthalten nicht nur Audio-
signale, sondern auch Informationen zur Aufzeichnung.
Inhalt der Aufzeichnungsdaten s. S. 8-8.

[MENU] > RECORD > QSO Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „QSO Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Ordner wählen, der die Datei enthält, deren Infor-
mationen angezeigt werden sollen. 

6. Datei zur Informationsanzeige wählen. 

 LNICHT die [ENT]-Taste betätigen!
7. [QUICK] drücken.

8. „File Information“ wählen. 

9. [DIAL] drehen, um durch die Anzeige zu scrollen.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Ordnerinformation anzeigen
Um sich Informationen zu einem Ordner anzeigen zu 
lassen, drückt man bei Schritt 5 [QUICK] und wählt 
dann „Folder Information“.

Ordnername
Dateianzahl (Gesamtgröße)

Erstellungsdatum und -zeit
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Dateiinformationen anzeigen

Beispiele für Dateiinformationen
 LJe nach Aufnahmestatus werden einige Informationen nicht angezeigt.
 LDie Datei ist nach folgendem Schema benannt:  yyyymmdd_hhmmss  

(yyyy: Jahr, mm: Monat, dd: Tag, hh: Stunde, mm: Minute, ss: Sekunde)

 • Informationen zu gesendeten Audiodateien  • Informationen zu empfangenen Audiodateien
Betriebsinformationen (TX)
Aufnahmedatum und -zeit

eigene Positionsdaten

DR-Einstellung

Dateiname, -größe sowie  
Erstellungsdatum und -zeit 

Betriebsinformationen (RX)
Aufnahmedatum und -zeit

eigene Positionsdaten

Informationen zum Anrufer 
und zum Empfangs-Repeater

Positionsdaten des Anrufers

Dateiname, -größe sowie  
Erstellungsdatum und -zeit 
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Nutzung der Sprachaufzeichnungsfunktion

Die Mikrofonsignale, einschließlich der von einem 
angeschlossenen externen Mikrofon, lassen sich mit 
dem ID-52E ganz einfach aufzeichnen.

HINWEIS: Vor Beginn der Aufzeichnung MUSS eine  
Micro-SD-Karte in das Handfunkgerät eingesetzt werden.

 DEine Sprachaufzeichnung starten

HINWEIS: Wenn gerade ein QSO aufgenommen 
wird, kann keine Sprachaufzeichnung erfolgen.  
Dazu im Stand-by-Display [QUICK] drücken und 
„Stop Recording“ wählen, um die Aufnahme zu  
beenden.

[MENU] > RECORD > Voice Recorder > Record

1. [MENU] drücken.
2. „Record“ wählen.
3. „Voice Recorder“ wählen. 

4. „Record“ wählen.
 • Das „VOICE RECORDER“-Display wird angezeigt.

5. Mit der [PTT]-Taste die Aufzeichnung starten.
 • Die Aufzeichnung der Mikrofonsignale beginnt.

6. Zum Beenden der Aufzeichnung [PTT] erneut 
drücken.

 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Drückt man die [PTT]-Taste am Handfunk-
gerät, erfolgt die Aufnahme über das interne Mikro-
fon. Um über das externe Mikrofons aufzunehmen, 
ist dessen [PTT]-Taste zu drücken. Zum Aufnehmen 
mit dem Bluetooth-Headset, ist die [PTT]-Taste am 
Headset zu nutzen.

Mikrofonverstärkung ändern
Im „VOICE RECORDER“-Display die [QUICK]-Taste 
drücken und „MIC Gain“ wählen.
 

 LJe nach Speicherkapazität der verwendeten Micro- 
SD-Karte lassen sich bis etwa 37 Stunden kontinuierlich 
aufzeichnen. Wenn die Dateigröße 2 GB überschreitet, 
wird die Sprachaufzeichnung automatisch in einer neuen 
Datei im selben Ordner fortgesetzt.

verbleibende Aufnahmezeit

Mikrofonverstärkung

Aufnahmezeit

Mikrofonpegel
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Nutzung der Sprachaufzeichnungsfunktion

 DWiedergabe einer Sprachaufzeichnung

HINWEIS: Wenn gerade ein QSO aufgenommen 
wird, kann keine Sprachaufzeichnung wiedergege-
ben werden. Dazu im Stand-by-Display [QUICK] 
drücken und „Stop Recording“ wählen, um die Auf-
nahme zu beenden.

[MENU] > RECORD > Voice Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „Voice Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Ordner wählen, der die anzuhörende Aufzeichnung 
enthält. 

 LDie Ordner sind folgendermaßen benannt: 

Das „VOICE PLAYER“-Display

Schnell vorwärts [LO]/Rückwärts [CD]
 • Jeweilige Taste halten, um in einer Aufzeichnung eine 
voreingestellte Zeit vorwärts bzw. rückwärts zu springen.

 • Die voreingestellte Zeit beträgt 10 Sekunden. Sie lässt 
sich ändern, Details dazu siehe S. 8-16.

 • [DIAL] drehen, um den Abspielpunkt vorwärts oder 
rückwärts zu verschieben. Er wird dabei unabhängig 
von der Gesamtdauer der Aufzeichnung jeweils um 
1/20 der Gesamtdauer verschoben.

 • Wird die [CD]-Taste innerhalb der ersten Sekunde der 
Wiedergabe einer neuen Datei gedrückt, wird das Ende 
der vorherigen Datei wiedergegeben.

Wiedergabe der vorherigen Datei [RX→CS]
 • Wenn man während der Wiedergabe der ältesten Datei 
des Ordners [RX→CS] drückt, wird sie erneut abgespielt.

 • Wenn die Wiedergabe pausiert und man drückt [RX→CS], 
wird die vorherige Datei von Anfang an abgespielt.

Wiedergabe der nächsten Datei [DR]
Wenn man während der Wiedergabe der neuesten Datei 
des Ordners [DR] drückt, wird sie erneut abgespielt.

bereits angehörte Aufzeichnungen/ 
Gesamtzahl aller Aufzeichnungen

Datum und
Uhrzeit des
Beginns der
Aufzeichnung

Wiedergabezeit/ 
Gesamtzeit

[ENT] Pause/Wiedergabe

[LO] schnell vorwärts

[RX→CS] 
Wiedergabe der  
vorherigen Datei

[DR] Wiedergabe der nächsten Datei

[CD] 
rückwärts

yyyymmdd (yyyy: Jahr, mm: Monat, dd: Tag)
6. Datei für die Wiedergabe wählen.

 • Das „VOICE PLAYER“-Display wird angezeigt und 
die Wiedergabe beginnt.

gesamte Wiedergabezeit

Zeitpunkt der Aufzeichnung
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Nutzung der Sprachaufzeichnungsfunktion

 DAufzeichnungsordner löschen

HINWEIS: 
 • Alle Dateien in gelöschten Ordnern werden ebenfalls 
gelöscht.

 • Gelöschte Audiodateien können nicht wiederhergestellt 
werden.

[MENU] > RECORD > Voice Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „Voice Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Zu löschenden Ordner wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Delete“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
8. „YES“ wählen. 

 • Der Ordner ist gelöscht.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Alle Ordner löschen
Bei Schritt 7 „Delete All Folders“ wählen.
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Nutzung der Sprachaufzeichnungsfunktion

 DAufzeichnungsdatei löschen

HINWEIS: Gelöschte Audiodateien können nicht 
wiederhergestellt werden.

[MENU] > RECORD > Voice Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „Voice Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Ordner wählen, der die zu löschende Datei enthält. 

6. Datei zum Löschen wählen. 

 LNICHT die [ENT]-Taste betätigen!
7. [QUICK] drücken.
8. „Delete“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
9. „YES“ wählen. 

 • Die Datei ist gelöscht.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Alle Dateien löschen
Bei Schritt 8 „Delete All“ wählen.
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Nutzung der Sprachaufzeichnungsfunktion

 DDateiinformationen anzeigen
[MENU] > RECORD > Voice Recorder > Play Files

1. [MENU] drücken.
2. „Record“ wählen.
3. „Voice Recorder“ wählen. 

4. „Play Files“ wählen. 

5. Ordner wählen, der die Datei enthält deren Infor-
mationen angezeigt werden sollen. 

6. Datei zur Informationsanzeige wählen. 

 LNICHT die [ENT]-Taste betätigen!
7. [QUICK] drücken.
8. „File Information“ wählen. 

 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Ordnerinformation anzeigen
Um sich Informationen zu einem Ordner anzeigen zu 
lassen, drückt man bei Schritt 5 [QUICK] und wählt 
dann „Folder Information“.
 

Ordnername
Dateianzahl (Gesamtgröße)

Erstellungsdatum und -zeit
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Wiedergabe einer Aufzeichnung auf einem PC

Die gespeicherten Aufzeichnungen lassen sich auch 
über einen PC anhören.

 LZusätzliche Dateiinformationen wie Frequenz, Datum 
usw. werden jedoch nicht auf dem PC angezeigt.
 LFür dieses Anleitung wurde das Betriebssystem  
Windows 10 auf Englisch genutzt.

Beispiel:  Wiedergabe einer auf der Micro-SD-Karte 
gespeicherten Audiodatei auf dem PC.

1. Die aus dem Handfunkgerät entnommene Micro- 
SD-Karte in den Kartenslot des PC oder einen 
Kartenleser einsetzen.

2. „Open folder to view files“ anklicken, um auf die 
Micro-SD-karte zuzugreifen. 

Klick

3. Doppelklick auf den Ordner „ID-52“. 

Doppelklick

4. Doppelklick auf den Ordner „Voice“. 

Doppelklick

PC
zum 
Kartenleser

Micro-SD-Karte

ID-52A/E

5. Doppelklick auf den Ordner, der Datei für die 
Wiedergabe enthält. (Beispiel: „20211101“) 

Doppelklick

6. Doppelklick auf die Datei, um sie abzuspielen.  
(Beispiel: „20211101_152135A.wav“) 

Doppelklick

 LEinzelheiten zur Bedienung Ihres Players finden Sie 
in deren Bedienungsanleitung.
 LJe nach Player kann die Audiodatei möglicherweise 
nicht wiedergegeben werden.

TIPP: Wenn bei „USB Connect“ die Einstellung  
„SD Card Mode“ gewählt wurde und das Handfunk-
gerät über ein USB-Kabel mit dem PC verbunden 
ist, kann man auf die im Handfunkgerät eingesetzte 
Micro-SD-Karte direkt vom PC aus zugreifen.
([MENU] > SET > Function > USB Connect)
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<<REC Start>>

[MENU] > RECORD > QSO Recorder >  
<<REC Start>>

Wenn man „<<REC Start>>“ wählt startet die Auf-
zeichnung des QSOs.

 • „Recording started“ wird im Display angezeigt.

 L Information
 • SICHERSTELLEN, dass eine Micro-SD-Karte eingesetzt ist.
 • Während der Aufzeichnung wird „<<REC Stop>>“ im 
„QSO RECORDER“-Display angezeigt. Zum Stoppen der 
Aufzeichnung „<<REC Stop>>“ wählen.

 • Eine begonnene Aufzeichnung wird fortgesetzt, auch wenn 
das Handfunkgerät aus- und wieder eingeschaltet wird.

Play Files

[MENU] > RECORD > QSO Recorder > Play Files

Anzeige der Ordner mit den aufgezeichneten Dateien.
 • SICHERSTELLEN, dass eine Micro-SD-Karte eingesetzt ist.

Wiedergabe:
1. Ordner wählen, der die gewünschte Datei enthält.
2. Datei für die Wiedergabe wählen.

 • Das „VOICE PLAYER“-Display wird angezeigt und 
die Wiedergabe beginnt.
 LDetails s. S. 8-3.

3. Zum Verlassen des „VOICE PLAYER“-Displays 
MENU] drücken.

HINWEIS:
 • Ordner werden automatisch nach folgendem Schema 
benannt: 
(Beispiel) 
Aufnahmedatum 1. November 2021 
Ordnername: 20211101

 • Dateien werden automatisch nach folgendem Schema 
benannt: 
(Beispiel) 
Aufnahmedatum  
und -zeit: 1. November 2021, 15:30:00 
Dateiname: 20211101_153000

 • Die Aufzeichnungen werden auf der Micro-SD-Karte im 
WAV-Format gespeichert. (Die Dateiendung „.wav“ ist 
im Display des Handfunkgeräts nicht sichtbar.)

 • Die Aufzeichnungen lassen sich auch auf einem PC 
wiedergeben.

Menüeinstellungen und -befehle für die Aufzeichnungsfunktion

RX REC Condition (voreingestellt: Squelch Auto)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > RX REC Condition

Wahl, ob die Aufzeichnung der Audiosignale vom 
Squelch-Status abhängig sein soll

 • Always:  Das Handfunkgerät zeichnet die 
Audiosignale unabhängig vom 
Squelch-Status auf.

 • Squelch Auto:  Das Handfunkgerät zeichnet die 
Audiosignale nur auf, wenn der 
Squelch geöffnet ist. Schließt der 
Squelch während der Aufnahme, 
wird die Aufnahme noch 2 Sekunden 
lang fortgesetzt und pausiert dann.

File Split (voreingestellt: ON)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > File Split

Ein- und Ausschalten der File-Split-Funktion.
 • OFF:  Die Aufzeichnung erfolgt in einer einzigen 

Datei.
 LWenn die Dateigröße 2 GB überschreitet, wird 
die Aufzeichnung automatisch in einer neuen 
Datei im selben Ordner fortgesetzt.

 • ON:  Wenn während der Aufzeichnung zwischen  
Senden und Empfang umgeschaltet wird 
bzw. der Squelch öffnet oder schließt, wird 
jedes Mal automatisch eine neue Datei im 
gleichen Ordner erstellt. 
*  Nur, wenn bei „RX REC Condition“ die  

Einstellung „Squelch Auto“ gewählt ist.

REC Operation (voreingestellt: A/B Link)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > REC Operation

Wahl, ob die Signale des Bandes A und des Bandes 
B oder nur die auf dem Hauptband empfangenen 
Signale aufgezeichnet werden.

 • A/B Separate:  Nur die Signale des Hauptbandes 
aufgezeichnet werden.

 • A/B Link:  Die Signale von Band A und Band B 
werden aufgezeichnet.* 
L  Im Einbandmodus werden nur die 

Signale des Hauptbandes aufge-
zeichnet.
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Menüeinstellungen und -befehle für die Aufzeichnungsfunktion

PTT Auto REC (voreingestellt: ON)

[MENU] > RECORD > QSO Recorder >  
Recorder Set > PTT Auto REC

Ein- oder Ausschalten der automatischen PTT-Aufzeich-
nungsfunktion.

 LDie Aufnahme lässt sich auch durch Drücken der [PTT] 
an einem Lautsprechermikrofon bzw. an einem Blue-
tooth-Headset, durch Nutzung der VOX-Funktion oder 
Senden eines CI-V-Befehls starten.

 • OFF:  Die Funktion ist ausgeschaltet.
 • ON:  Die Aufnahme startet beim Umschalten von 

Empfang auf Senden.
 Die Aufnahme wird beendet, wenn:

 • innerhalb von 10 Sek. nach dem letzten Senden nicht 
erneut gesendet wird.

 • innerhalb von 10 Sek. nach dem letzten Senden kein 
Signal empfangen wird.

 LWenn man innerhalb von 10 Sek. nach dem letzten 
Senden ein Signal empfängt, wird startet die Auf-
zeichnung automatisch.

 • nach dem letzten Senden die Frequenz, der Frequenz-
wahlmodus oder die Sendeart geändert wurde.

Skip Time (voreingestellt: 10sec)

[MENU] > RECORD > QSO Recorder >  
Player Set > Skip Time

Einstellung der Sprungzeit für das Vor- und Zurück-
spulen bei der Wiedergabe eines aufgezeichneten 
QSOs. Einstellbar sind 3, 5, 10 oder 30 Sekunden.

 LDie Erläuterung zum Vor- und Zurückspulen ist im Ab-
schnitt „Das ,VOICE PLAYER‘-Display“ auf S. 8-3 zu 
finden.

Record

[MENU] > RECORD > Voice Recorder > Record

Die [ENT]-Taste drücken, um das „VOICE RECOR-
DER“-Display aufzurufen und dann durch Drücken 
der [PTT]-Taste die Sprachaufzeichnung starten. 
Drückt man während der Aufnahme die [PTT] erneut, 
stoppt die Aufzeichnung. (S. 8-9)

 L Information
 • SICHERSTELLEN, dass eine Micro-SD-Karte eingesetzt ist.
 • Mit dieser Funktion lässt sich kein QSO aufzeichnen.
 • Während der Aufzeichnung eines QSOs ist diese Funk-
tion nicht nutzbar.

Play Files

[MENU] > RECORD > Voice Recorder > Play Files

Wiedergabe der im „VOICE RECORDER“-Display auf-
genommenen Sprachaufzeichnungen.
[ENT] drücken, um die Ordner mit den Sprach-
aufzeichnungen anzuzeigen.

 • SICHERSTELLEN, dass eine Micro-SD-Karte eingesetzt ist.

MIC Gain (voreingestellt: 3)

[MENU] > RECORD > Voice Recorder >  
Recorder Set > MIC Gain

Einstellung der Empfindlichkeit des internen Mikro-
fons für die Sprachaufzeichnung von 1 (minimale 
Empfindlichkeit) bis 4 (maximale Empfindlichkeit).

Skip Time (voreingestellt: 10sec)

[MENU] > RECORD > Voice Recorder >  
Player Set > Skip Time

Einstellung der Sprungzeit für das Vor- und Zurück-
spulen bei der Wiedergabe einer Sprachaufzeich-
nung. Einstellbar sind 3, 5, 10 oder 30 Sekunden.

 LDie Erläuterung zum Vor- und Zurückspulen ist im Ab-
schnitt „Das ,VOICE PLAYER‘-Display“ auf S. 8-10 zu 
finden.

DV Auto Reply

[MENU] > RECORD > DV Auto Reply

Für die automatische DV-Antwortfunktion kann eine 
Sprachansage von bis zu 10 Sek. Länge aufgezeich-
net werden.

 • SICHERSTELLEN, dass eine Micro-SD-Karte eingesetzt ist.
 LDetails zur Aufzeichnung finden sich auf S. 5-25.
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Speicherkanäle

Der Speicherbetrieb ermöglich es, oft genutzte Fre-
quenzen, Sendearten und andere Parameter schnell 
aufzurufen. Die Betriebsfrequenz, die Sendeart usw. 
lassen sich temporär ändern ohne den Speicher-
kanalinhalt zu überschreiben.

Gruppe
Speicher-

kanal
Beschreibung

00 bis 99 00 bis 99
Reguläre Speicherkanäle.
Bis zu 1000 Kanäle lassen sich 
separat in 100 Gruppen speichern.

CALL CH
144 C0/C1
430 C0/C1

Anrufkanäle im  
2-m- und 70-cm-Band.

 DSpeicherkanalinhalt
Die Speicherkanäle können folgende Daten und  
Einstellungen enthalten:

 • Frequenz
 • Duplex EIN/AUS
 • Duplex-Ablagerichtung (DUP+ oder DUP–)
 • Frequenzablage
 • Speichername
 • Übersprungmarkierung für den Suchlauf
 • Abstimmschrittweite
 • Sendeart
 • Subaudioton-Coder, CTCSS oder DTCS EIN/AUS
 • Subaudioton-Frequenz, CTCSS-Frequenz oder 
DTCS-Code mit Polarität

 • Digitalcode
 • Digitaler Rufzeichen-Squelch oder digitaler  
Code-Squelch EIN/AUS

 • Ziel-Rufzeichen
 • R1/R2-Rufzeichen

HINWEIS: Speicherdaten können z.B. durch stati-
sche Aufladungen oder elektromagnetische Felder 
gelöscht werden. Außerdem können die Inhalte 
der Speicherkanäle durch Fehlfunktionen oder bei 
der Reparatur verlorengehen. Daher empfehlen wir, 
die Speicherdaten auf einer Micro-SD-Karte* oder 
einem PC zu sichern.
*nicht im Lieferumfang enthalten

 LZur Datensicherung kann man programmiersoftware 
CS-52 nutzen. Details sind in der Anleitung der Soft-
ware enthalten.



9 SPEICHERBETRIEB

9-3

Wahl eines Speicherkanals

Im Speichermodus lassen sich die Speicherkanäle 
durch Drehen von [DIAL] auswählen..

1. Zum Aufrufen des Speichermodus [MR] drücken. 

2. [DIAL] drehen.
 • Ein Speicherkanal wird ausgewählt.
 LNur programmierte Speicherkanäle sind wählbar.
 LUm eine Speichergruppe zu wählen, drückt man 
[QUICK] und wählt dann „Group Select“.
 LDie Speicherkanäle werden gemeinsam für das  
A- und B-Band genutzt. Wenn Sie auf dem B-Band 
einen Speicherkanal wählen, der außerhalb des 
wählbaren Frequenzbereichs liegt, wird „ “ an-
gezeigt und es können keine Signale empfangen 
werden.

TIPP: Nacheinander Kanäle in verschiedenen
Gruppen wählen
1. [QUICK] drücken.
2. „Channel Select Group Range“ wählen. 

3. „All Groups“ wählen. 

Wahl eines Anrufkanals

Anrufkanäle dienen dem schnellen Aufruf der am 
häufigsten genutzten Frequenzen.
Die in ihnen enthaltenen Frequenzen und Sendearten 
sind werkseitig vorprogrammiert, lassen sich jedoch 
an die eigenen Erfordernisse anpassen.

1. [CALL] 1 Sek. lang drücken, um den Anrufkanal-
modus aufzurufen. 

2. [DIAL] drehen.
 • Ein Anrufkanal wird ausgewählt.
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Speicherkanäle programmieren

Nachdem im VFO-Modus eine Frequenz eingestellt 
wurde, kann man diese in einen gewählten Speicher-
kanal oder einen automatisch gewählten freien Spei-
cherkanal übernehmen.

 DProgrammieren eines gewählten 
Speicherkanals

Beispiel:  146,030 MHz/FM-Modus in den Kanal 11 in 
Gruppe 01 programmieren.

1. Zum Aufrufen des VFO-Modus [VFO/MHz] drücken.
2. [MODE] drücken, um den FM-Modus aufzurufen.
3. Mit [DIAL] die Frequenz auf 146,030 MHz einstellen. 

4. [MW] 1 Sek. lang drücken.
 • Ein kurzer und ein langer Piepton sind zu hören.

5. „Write to New CH“ wählen. 

6. [QUICK] drücken.
7. „Group Select“ wählen. 

8. Gruppe 01 wählen. 

9. Mit [DIAL] Kanal 11 wählen. 

10. [ENT] drücken.
 • Ein Bestätigungsfenster öffnet sich.

11. „YES“ wählen. 

 • Es sind Pieptöne zu hören und der Speicherinhalt 
wird kurz angezeigt, danach erfolgt die Rückkehr in 
den VFO-Modus.

TIPP: Bei Schritt 7 sind folgende Optionen wählbar:
 • NAME: 
Anzeige des Displays zum Editieren des Spei-
chernamens. (S. 9-11)

 • SKIP: 
Anzeige der Übersprungeinstellungen.

 • Group Select: 
Anzeige des Gruppenauswahl-Displays.

 • <<Write>>: 
Speichern in den gewählten Kanal.

 • <<Insert Write>>: 
Fügt einen Speicherkanal oberhalb des ausge-
wählten ein.
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Speicherkanäle programmieren

 DÜberschreiben eines gewählten 
Speicherkanals

Die Frequenz eines bereits programmierten Speicher-
kanals kann man überschreiben.

Beispiel:  146,330 MHz/FM-Modus in den Kanal 11 in 
Gruppe 01 programmieren.

1. Zum Aufrufen des Speichermodus [MR] drücken.
2. Mit [DIAL] Kanal 11 in Gruppe 01 wählen. 

 LUm eine Speichergruppe zu wählen, drückt man 
[QUICK] und wählt dann „Group Select“.

3. Zum Aufrufen des VFO-Modus [VFO/MHz] drücken.
4. Mit [DIAL] die Frequenz auf 146,330 MHz einstellen. 

5. [MW] 1 Sek. lang drücken.
 • Ein kurzer und ein langer Piepton sind zu hören.

6. „Write to Selected CH“ wählen. 

7. [MR] drücken.
8. „YES“ wählen. 

 • Es sind Pieptöne zu hören und der Speicherinhalt 
wird kurz angezeigt, danach erfolgt die Rückkehr in 
den VFO-Modus.

 DProgrammieren eines freien  
Speicherkanals

Beispiel:  441,100 MHz/FM-Modus in einen freien 
Speicherkanal programmieren.

1. Zum Aufrufen des VFO-Modus [VFO/MHz] drücken.
2. [MODE] drücken, um den FM-Modus aufzurufen.
3. Mit [DIAL] die Frequenz auf 441,100 MHz einstellen. 

4. [MW] 3 Sek. lang drücken. 

 • Der Speicherkanalinhalt wird für 2 Sekunden  
angezeigt, danach erfolgt die Rückkehr in den 
VFO-Modus.
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Kopieren eines Speicherkanalinhalts in den VFO

Das Kopieren des Speicherkanalinhalts in den VFO ist 
von Vorteil, wenn man in der Nähe der Frequenz eines 
Speicher- oder Anrufkanals arbeiten möchte.

Beispiel:  Kopieren des Inhalts von Speicherkanal 11 
der Gruppe 01 in den VFO.

1. Zum Aufrufen des Speichermodus [MR] drücken.
2. Mit [DIAL] Kanal 11 in Gruppe 01 wählen. 

 LUm eine Speichergruppe zu wählen, drückt man 
[QUICK] und wählt dann „Group Select“.

3. [MW] 1 Sek. lang drücken.
 • Ein kurzer und ein langer Piepton sind zu hören.

4. „Copy to VFO“ wählen. 

5. „YES“ wählen. 

 • Pieptöne sind zu hören und der ausgewählte Spei-
cherinhalt wurde in den VFO kopiert, danach erfolgt 
die Rückkehr in den VFO-Modus.
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„MEMORY“-Display

Im „MEMORY“-Display lassen sich die Inhalte der 
Speicher- und Anrufkanäle komfortabel verwalten.

 DBaumstruktur des  
„MEMORY“-Displays

 DSpeicherkanalinhalt anzeigen
Das „MEMORY“-Display zeigt Speicherkanalinhalte 
an.

Beispiel:  Inhalt von Kanal 01 der Gruppe 00 ansehen.

[MENU] > MEMORY > Memory CH

1. [MENU] drücken.
2. Auf der ersten Menüseite „MEMORY“ wählen.

 L Im VFO-, Speicher- oder Anrufkanalmodus lässt sich 
das „MEMORY“-Display aufrufen, indem man [MW]  
1 Sek. lang drückt und dann „Manage Memory“ 
wählt.

3. „Memory CH“ wählen.
4. Gruppe 00 wählen. 

5. Kanal 01 wählen. 

 • Der Inhalt des Kanals wird angezeigt.
 L [DIAL] drehen, um durch das Display zu scrollen.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Editieren, Kopieren oder Löschen des  
Speicherinhalts
1. Bei Schritt 5 [QUICK] drücken.
2. „Edit“, „Copy“ oder „Clear“ wählen. 

MEMORY

Memory CH

Call CH

Your Call Sign

Repeater List

Group 00

S: SKIP CH*

Group 99

00

144 C0

430 C0

99

144 C1

430 C1

*  Die gespeicherte Frequenz wird beim Suchlauf über-
sprungen. 
( Wenn ein VFO-Suchlauf auf einer Frequenz stoppt, 
die übersprungen werden soll, drückt man [MW]  
1 Sekunde lang, um die Frequenz als Übersprung-
frequenz zu markieren.)
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Speicherkanalinhalt in einen anderen Speicherkanal kopieren

Den Inhalt eines Speicherkanals kann man in einen 
anderen Speicherkanal kopieren.

Beispiel:  Inhalt von Kanal 01 der Gruppe 00 in den 
Kanal 06 der Gruppe 00 kopieren.

[MENU] > MEMORY > Memory CH

1. [MENU] drücken.
2. „MEMORY“ wählen.
3. „Memory CH“ wählen.
4. Gruppe 00 wählen.
5. Kanal 01 wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Copy“ wählen. 

8. Zielkanal auswählen. 

 • Pieptöne sind zu hören, der Inhalt des Speicher-
kanals wurde in den Zielkanal kopiert.
 LFalls man einen bereits programmierten Speicher-
kanal als Zielkanal wählt, erscheint ein Dialogfenster. 
Bei Bestätigung mit „YES“ wird der zuvor program-
mierte Speicherkanalinhalt überschrieben.

TIPP: Kopieren in einen Speicherkanal einer 
anderen Gruppe
Bei Schritt 6 im „DESTINATION“-Display [QUICK] 
drücken und „Group Select“ wählen. 
 

 • Das „GROUP SELECT“-Display wird angezeigt.
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Speicherkanalinhalt in einen Speicherkanal einer anderen Gruppe 
verschieben

Der Speicherkanalinhalt lässt sich auch in einen Spei-
cherkanal in einer anderen Gruppe verschieben.

Beispiel:  Inhalt von Kanal 01 der Gruppe 00 in den 
Kanal 00 der Gruppe 02 verschieben.

[MENU] > MEMORY > Memory CH

1. [MENU] drücken.
2. „MEMORY“ wählen.
3. „Memory CH“ wählen.
4. Gruppe 00 wählen.
5. Kanal 01 wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Move“ wählen. 

8. [QUICK] drücken.
9. „Group Select“ wählen. 

10. Gruppe wählen, die den Zielkanal enthält. 

11. Zielkanal auswählen. 

 • Pieptöne sind zu hören, der Inhalt des Speicher-
kanals wurde in den Zielkanal verschoben.
 LDer nun freie Ursprungskanal wird hinter die pro-
grammierten Kanäle verschoben.

TIPP: Anzeigereihenfolge in der gewählten  
Gruppe neu ordnen
Im „DESTINATION“-Display bei Schritt 7 mit Schritt 
11 fortfahren. 
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Einfügen eines freien Speicherkanals

Man kann einen freien Speicherkanal zwischen zwei 
Speicherkanäle einfügen. Diese Funktion ist sehr 
komfortabel, um die Speicherkanäle zu organisieren.

Beispiel:  Einen freien Kanal zwischen Kanal 00 und 
01 der Gruppe 00 einfügen.

[MENU] > MEMORY > Memory CH

1. [MENU] drücken.
2. „MEMORY“ wählen.
3. „Memory CH“ wählen.
4. Gruppe 00 wählen.
5. Kanal 01 wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Insert“ wählen. 

 • Pieptöne sind zu hören, ein freier Speicher kanal 
wurde vor dem gewählten Kanal eingefügt.
 LWenn man bei Schritt 5 den Kanal 99 wählt, er-
scheint ein Dialogfenster. Bei Bestätigung mit „YES“ 
wird Kanal 99 gelöscht.

TIPP:  Einfügen einer leeren Gruppe
Im Gruppenauswahl-Display eine Gruppe wählen, 
[QUICK] drücken und anschließend „Insert Group“ 
wählen. 
 

 • Eine leere Gruppe wird vor der gewählten eingefügt.
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Gruppen- und Speicherkanalnamen eingeben

Die Speicherkanalgruppen (00 bis 99) und die Spei-
cherkanäle lassen sich mit bis zu 16 Zeichen langen 
Namen versehen.

Beispiel:  Eingabe des Namens „Calling“ für den 
Speicherkanal 01 der Gruppe 00.

[MENU] > MEMORY > Memory CH

1. [MENU] drücken.
2. „MEMORY“ wählen.
3. „Memory CH“ wählen.
4. Gruppe 00 wählen.
5. Kanal 01 wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Edit“ wählen. 

8. „NAME“ wählen. 

9. Namen eingeben. 

 LHinweise zur Zeicheneingabe s. S. iii.

10. Eingabe mit [ENT] bestätigen. 

11. „<<Overwrite>>“ wählen. 

12. „YES“ wählen. 

 • Pieptöne sind zu hören, Rückkehr zum  
„MEMORY CH“-Display.

TIPP:  Eingabe eines Gruppennamens
Im Gruppenauswahl-Display eine Gruppe wählen, 
[QUICK] drücken und anschließend „Edit Name“ 
wählen.
 

 • Ein Display zum Editieren des Gruppennamens wird 
angezeigt.
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Anzeigetyp für Speicherkanalnamen wählen

Im Speichermodus kann man unter verschiedenen 
Anzeigetypen zur Darstellung des eingegebenen 
Speicherkanalnamens wählen.

Beispiel:  Wahl der Option „Name (Large)“ für die 
Einzelbandanzeige.

1. [MR] drücken, um den Speichermodus aufzurufen.
2. [QUICK] drücken.
3. „Display Type“ wählen. 

4. Anzeigetyp auswählen. 

 LVoreingestellt ist „Freq (Name OFF)“.

TIPP: 5 Anzeigetypen stehen zur Verfügung.

 • Freq (Name OFF):  
Es wird nur die Frequenz angezeigt. 

 • Freq (Normal Name):  
Zeigt die Frequenz in großer Schrift und den Speicher-
kanalnamen in kleiner Schrift an.

 LFür die Dualbandanzeige ist „Freq“ zu wählen.
 

 • Freq (Large Name):  
Zeigt die Frequenz und den Speicherkanalnamen in 
großer Schrift an.

 LDiese Einstellung ist für die Dualbandanzeige nicht 
wählbar.

 

 • Name (Normal):  
Zeigt den Speicherkanalnamen und die Frequenz in 
kleiner Schrift an. 

 • Name (Large):  
Zeigt den Speicherkanalnamen in großer Schrift und die 
Frequenz in kleiner Schrift an. 
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Speicherkanalinhalt löschen

Nicht mehr benötigte Speicherkanalinhalte lassen 
sich löschen.

 LNach dem Löschen ist der Speicherkanal frei.
 LÜbersprungkanäle (Gruppe „S“) kann man ebenfalls 
löschen.

HINWEIS: Gelöschte Speicherkanalinhalte lassen 
sich nicht wiederherstellen.

Beispiel:  Löschen des Inhalts von Speicherkanal 01 
der Gruppe 00.

[MENU] > MEMORY > Memory CH

1. [MENU] drücken.
2. „MEMORY“ wählen.
3. „Memory CH“ wählen.
4. Gruppe 00 wählen.
5. Kanal 01 wählen. 

 LNICHT die [ENT]-Taste betätigen!
6. [QUICK] drücken.
7. „Clear“ wählen. 

8. „YES“ wählen. 

 • Pieptöne sind zu hören, der Inhalt ist gelöscht.

TIPP: Löschen eines Speicherkanals
Bei Schritt 7 „Delete (next CH moves up)“ wählen. 
 

 • Der gewählte Speicherkanal wurde gelöscht.
 LGruppen lassen sich ebenso löschen. Dazu erst eine 
Gruppe und dann „Delete Group“ wählen.
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 DVFO-Suchlauf
Der VFO-Suchlauf sucht nach Signalen innerhalb 
eines bestimmten Frequenzbereichs.

Allbereichssuchlauf (ALL)
Wiederholter Suchlauf über den gesamten Frequenz-
bereich des ID-52E.

Untergrenze des
Empfangsbereichs

des ID-52A

Obergrenze des
Empfangsbereichs

des ID-52A

Suchlauf

Rücksprung

P SKIPP SKIP

Bandsuchlauf (BAND)
Wiederholter Suchlauf über das gewählte Band.

Suchlauf

Rücksprung

PSKIPPSKIP

untere
Bandgrenze

obere
Bandgrenze

Programmsuchlauf (P00 bis P24)
Wiederholter Suchlauf über einen programmierten 
Frequenzbereich (Eckfrequenzen 00 bis 24).
       

Suchlauf

Rücksprung
Sprung

Frequenzbereich

untere
Eckfrequenz

obere
Eckfrequenz

PSKIPPSKIP

 LEs muss mindestens ein Frequenzbereich (mit zwei 
Eckfrequenzen) programmiert sein, um einen Programm-
suchlauf starten zu können. 
([MENU] > SET > Scan > P-Scan Edge) 
Weitere Details s. S. 10-7.

Programm-Link-Suchlauf (P-LINK 0 bis 9)
Sequenzieller Suchlauf über alle im Menü bei „Program 
Link“ verlinkten programmierten Frequenzbereiche.  
([MENU] > SET > Scan > Program Link)

 LWeitere Details s. S. 10-8.
       

Eckfrequenzen (Beispiel: P00 bis P10)

Rücksprung

Suchlauf
P00 P01 P02 P03 P10

 DSpeichersuchlauf
Der Speichersuchlauf sucht nach Signalen innerhalb 
der programmierten Speicherkanäle.

Suchlauf über alle Speicherkanäle (ALL)
Suchlauf über alle Speicherkanäle.
 Speichergruppen (00 bis 99 und S: Skip CH)

00 01 02 98 99 S03

Leere Gruppen werden übersprungen.
Rücksprung

Suchlauf

Band-Speichersuchlauf (BAND)
Suchlauf über alle Speicherkanäle, deren program-
mierte Frequenzen im aktuell gewählten Band liegen.

Sendearten-Speichersuchlauf (MODE)
Suchlauf über alle Speicherkanäle, deren program-
mierte Sendeart der aktuell gewählten entspricht.

 LDer Sendearten-Speichersuchlauf durchsucht alle Spei-
chergruppen. (Group 00 bis 99, S: SKIP CH)

 

AM FM AM AM AMDV
Suchlauf

Andere Sendearten werden übersprungen.

Beispiel:  Suchlauf im AM-Modus  
Speichergruppe 02

Gruppen-Link-Suchlauf (GROUP LINK)
Sequenzieller Suchlauf über alle im Menü bei „Group 
Link“ verlinkten Speichergruppen.
 

01 0200 99  S98

Rücksprung

Suchlauf

Speichergruppen (00 bis 99 und S: Skip CH)

Nicht markierte Speichergruppen werden übersprungen.

 LMindestens zwei Speichergruppen müssen markiert sein, 
um einen Gruppen-Link-Suchlauf starten zu können. 
([MENU] > SET > Scan > Group Link) 
Weitere Details s. S. 10-10.

Gruppensuchlauf (GROUP 00 bis 99)
Suchlauf über alle Speicherkanäle in der gewählten 
Gruppe.

Suchlaufarten

Der Suchlauf ist eine sehr vielseitige Funktion zur automatischen Suche nach Signalen, um diese zu beobachten 
oder um mit der empfangenen Station einen Funkkontakt herzustellen. Unerwünschte Frequenzen bzw. Speicher-
kanäle lassen sich beim Suchlauf überspringen.
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Suchlaufarten

Duplex-Suchlauf (DUP)
Dieser Suchlauf sucht nach Signalen auf den beim 
Duplex-Betrieb verwendeten Sende- und Emp-
fangsfrequenzen.  
(S. 11-4).

 L Im Duplex-Modus wird „D–“ oder „D+“ angezeigt.
 LDer Duplex-Suchlauf startet nicht, wenn keine  
Frequenzablage eingestellt ist.

Tonsuchlauf
Der Tonsuchlauf sucht nach Signalen mit 
CTCSS-Tönen oder DTCS-Codes.

 LEin Tonsuchlauf kann im VFO-, Speicher- oder Anruf-
kanalmodus durchgeführt werden.
 LWährend eines Suchlaufs lässt sich durch Drehen von 
[DIAL] die Suchlaufrichtung ändern.
 LTon- und Code-Squelch-Funktion  
s. S. 15-8 und 15-9.
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 DBedienung von [DIAL] während  
eines Suchlaufs

 • Dreht man während eines Suchlaufs [DIAL], ändert sich 
die Suchlaufrichtung.

 • Hat der Suchlauf gestoppt, kann man ihn durch Drehen 
von [DIAL] fortsetzen.

 DSquelch-Einstellung für den Suchlauf
Damit der Suchlauf einwandfrei funktioniert, muss der 
Squelch so eingestellt werden, dass er ohne Signal 
geschlossen ist und die gesuchten Signale ihn öffnen 
können.

 LWährend eines Suchlaufs bei gedrückter [SQL]-Taste 
[DIAL] drehen, um den Squelch-Pegel einzustellen. Der 
Suchlauf wird nach der Einstellung fortgesetzt.

blinkt

 DAbstimmschrittweite für den 
VFO-Suchlauf

Für den VFO-Suchlauf wird die aktuell gewählte Ab-
stimmschrittweite angewandt. Für den Programm-
suchlauf oder den Programm-Link-Suchlauf die Ab-
stimmschrittweite innerhalb der Suchlaufeckfrequen-
zen einstellen (P-Scan Edge).

 DÜbersprungfunktion
Diese Funktion bewirkt eine Beschleunigung des 
Suchlaufs, da unerwünschte Frequenzen bzw. Spei-
cherkanäle übersprungen werden.

 LDiese Einstellung kann man für Band A und B separat vor-
nehmen.

Im VFO-Modus
Während des Suchlaufs werden Frequenzen, die in 
Speicherkanälen mit „PSKIP“ markiert sind, über-
sprungen (S. 10-6)

Im Speichermodus
Frequenzen, die als Übersprungfrequenzen markiert 
sind („PSKIP“ und „SKIP“), werden nicht in den Such-
lauf einbezogen. (S. 10-11)

 LZum Starten eines Speichersuchlaufs müssen zwei oder 
mehr Speicherkanäle programmiert werden.

TIPP: Wenn bei „Program Skip“ die Einstellung 
„OFF“ gewählt ist, kann die Übersprungfunktion 
nicht genutzt werden. (S. 12-5)
([MENU] > SET > Scan > Program Skip)

 DSendeart während eines Suchlaufs
 • Der VFO-Suchlauf erfolgt in der gewählten Sendeart.
 • Beim Suchlauf im Speichermodus, wird die im jeweiligen 
Speicherkanal programmierte Sendeart verwendet.

 DWenn ein Signal empfangen wird
Wenn ein Signal gefunden wurde, stoppt der Suchlauf 
für die eingestellte Zeitdauer. (S. 12-5)
Verschwindet das Signal, wird der Suchlauf nach der 
eingestellten Zeitdauer fortgesetzt. (S. 12-5)

 LDiese Einstellungen kann man für Band A und B separat 
vornehmen.

[MENU] > SET > Scan > Pause Timer

[MENU] > SET > Scan > Resume Timer

blinkt

 DSuchlaufstopp mit Piepton  
signalisieren

Wenn der Suchlauf ein Signal gefunden hat, kann dies
mit einem Piepton signalisiert werden.
Diese Funktion lässt sich im Menü ein- bzw. aus-
schalten. (S. 12-29)

[MENU] > SET > Sounds > Scan Stop Beep

Über den Suchlauf
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1. Zum Aufrufen des VFO-Modus [VFO/MHz] drücken.
2. [MODE] drücken, um die Sendeart zu wählen.
3. [SCAN]-Taste 1 Sek. lang drücken.

 • Das Suchlaufauswahlfenster öffnet sich.
4. Suchlaufart wählen. 

blinkt

 • Der Suchlauf beginnt.
 • Der Dezimalpunkt und die Anzeige der Suchlaufart 
blinken.
 LBeim Empfang eines Signals zeigt das S-Meter die 
Empfangssignalstärke an.

5. [SCAN]-Taste 1 Sek. lang drücken.
 • Der Suchlauf stoppt.
 LDer Suchlauf lässt sich auch durch Drücken der 
[CLR]-Taste beenden.

 DSuchlaufarten
 • ALL:  Allbereichssuchlauf
 • BAND: Bandsuchlauf
 • DUP:   Duplex-Suchlauf 

(Wird nur angezeigt, wenn Duplex einge-
stellt ist.)

 • P-LINK0 bis 9: Programm-Link-Suchlauf
 • P00 bis 24: Programmsuchlauf
 • TONE:  Tonsuchlauf 

(Suche nach Signalen mit CTCSS-Tönen 
oder DTCS-Codes)

 L Information
 • Während des Suchlaufs werden die Frequenzen der 
Speicherkanäle, die mit der Übersprungmarkierung 
„PSKIP“ versehen sind, übersprungen. (S. 10-6)

 • Wenn im Menü bei „Program Skip“ die Einstellung „OFF“ 
gewählt ist, werden diese Frequenzen nicht übersprun-
gen. (S. 12-5) 
([MENU] > SET > Scan > Program Skip)

 • Einrichten eines Programm-Link-Suchlaufs s. S. 10-8.
 • Einrichten eines Programmsuchlaufs s. S. 10-7.

TIPP:
 • Dreht man während eines Suchlaufs [DIAL], ändert sich 
die Suchlaufrichtung.

 • Drücken der [MODE]-Taste während eines Suchlaufs 
ändert die Sendeart.

 • Mit der [ ]-Taste kann man während eines Suchlaufs 
die Verriegelungsfunktion ein- bzw. ausschalten.

 • Der Suchlauf wird auch dann fortgesetzt, wenn man die 
[MENU]- oder [QUICK]-Taste drückt.

 • Wenn man die [SCAN]-Taste gedrückt hält, kann man 
durch Drehen von [DIAL] eine Suchlaufart wählen. Zum 
Starten des Suchlaufs die [SCAN]-Taste loslassen.

VFO-Suchlauf
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 DÜbersprungfrequenzen markieren
Zur Beschleunigung des Suchlaufs lassen sich Fre-
quenzen, auf denen der Suchlauf anhält, in die Über-
sprung-Speichergruppe S (00 bis 99) als Übersprung-
kanal (PSKIP) speichern, damit sie beim Suchlauf 
übersprungen werden.

1. Wenn der VFO-Suchlauf auf einem Signal  
gestoppt hat, [MW] 1 Sek. lang drücken. 

 • Das oben stehende Fenster erscheint.
2. „Adds to SKIP MR Group“ wählen.

 • Zwei kurze Pieptöne sind zu hören.
 • Die Frequenz wird in der Übersprung-Speicher-
gruppe gespeichert.

 • Nach dem Speichern wird der Suchlauf fortgesetzt.
 L Ist kein Speicherkanal mehr frei, ertönt ein Fehlerton, 
da die Frequenz nicht gespeichert werden kann.

TIPP: Wenn ein Kanal als Übersprungkanal markiert 
ist, wird die Frequenz so lange übersprungen, bis 
man die Übersprungmarkierung entfernt.
Entfernen der Übersprungeinstellung s. S. 10-11.

 LDie Übersprungmarkierung wird auch entfernt, wenn 
man den markierten Speicherkanal löscht.

VFO-Suchlauf

 DProgrammsuchlauf-Name
Wenn für den Programmsuchlauf ein Name eingege-
ben wurde, lässt er sich direkt im Suchlaufauswahl-
fenster wählen. (S. 10-5)

 LDer Name wird während eines Suchlaufs nicht angezeigt.
 LDetails zur Namenseingabe s. S. 10-7.

Wenn ein Name für den Suchlauf eingegeben wurde

Wenn kein Name für den Suchlauf eingegeben wurde

 DProgramm-Link-Suchlauf-Name
Wurde für den Programm-Link-Suchlauf ein Name 
eingegeben, lässt er sich ebenfalls im Suchlauf-
auswahlfenster wählen. (S. 10-5)

 LDer Name wird während eines Suchlaufs nicht angezeigt.
 LDetails zur Namenseingabe s. S. 10-8.

Wenn ein Name für den Suchlauf eingegeben wurde

Wenn kein Name für den Suchlauf eingegeben wurde
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8. Nach dem Editieren <<Write>>“ wählen.
 • Ein Bestätigungsfenster öffnet sich.

9. „Yes“ wählen. 

 LZum Verlassen die [MENU]-Taste drücken.

TIPP:
 • Zum Löschen eines Suchlaufbereichs ist bei Schritt 6 
„Clear“ zu wählen.

 • Beim Suchlauf in einem Bereich ohne „TS“- oder  
„MODE“-Einstellung wird die Voreinstellung des jeweili-
gen Bandes genutzt.

VFO-Suchlauf

 DEckfrequenzen für  
Programmsuchlauf eingeben

Für den Programmsuchlauf kann man untere und 
obere Suchlauf-Eckfrequenzen in spezielle Speicher 
programmieren. Jeder so programmierte Suchlauf-
bereich hat eine eigene Abstimmschrittweite und 
Sendeart. Es ist möglich, bis zu 25 Suchlaufbereiche 
zu programmieren.

[MENU] > SET > Scan > P-Scan Edge

1. [MENU] drücken.
2. Im „SET“-Menü „Scan“ wählen. 
3. „P-Scan Edge“ wählen. 

4. Einen freien Speicher von 00 bis 24 wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Edit“ wählen. 

 • Das Editierdisplay wird angezeigt.
7. Bei „FREQ LOW“ die untere, bei „FREQ HIGH“ die 

obere Eckfrequenz einstellen, mit [ENT] bestätigen.

 L Information
 • Durch Drehen von [DIAL] kann man einen Menüpunkt 
auswählen und diesen dann durch Drücken der  
[ENT]-Taste editieren.

 • Die untere und obere Eckfrequenz werden wiederum 
durch Drehen von [DIAL] eingestellt. Um 1-MHz-Ab-
stimmschritte zu wählen, drückt man [VFO/MHz].

 • Wenn bei „NAME“ ein Name eingegeben wurde, 
lässt er sich im Suchlaufauswahlfenster auswählen. 
Hinweise zur Zeicheneingabe s. S. iii.

 • Erfolgt bei „TS“ (Abstimmschrittweite) und/oder  
„MODE“ keine Eingabe, wird die aktuelle Einstellung 
des VFO-Modus genutzt. Die Einstellungen bei „TS“ 
und „MODE“ müssen an die gewünschten Signale 
angepasst werden.
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VFO-Suchlauf

 DSuchlaufbereiche verlinken
[MENU] > SET > Scan > Program Link

1. [MENU] drücken.
2. Im „SET“-Menü „Scan“ wählen. 
3. „Program Link“ wählen. 

4. Programm-Link-Nummer von 1 bis 9 wählen. 

 • Das Programm-Link-Nummern-Display zeigt die vor-
programmierten Programmsuchlauf-Bereiche.
 LWenn kein Programmsuchlauf-Bereich ausgewählt 
ist, wird „– Blank –“ angezeigt.

5. [QUICK] drücken.
6. „Add“ wählen. 

7. Programmsuchlauf-Bereich wählen, der hinzugefügt 
werden soll. 

8. Die Schritte 6 und 7 wiederholen bis alle gewünschten 
Programmsuchlauf-Bereiche hinzugefügt wurden.

9. Zum Speichern des Programm-Links [ENT] drücken.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP:
 • Zum Editieren des Programm-Link-Namens bei Schritt 4 
[QUICK] drücken und „Edit Name“ wählen.

 • Um einen Programmsuchlauf-Bereich aus dem Pro-
gramm-Link zu löschen, bei Schritt 6 „Delete“ wählen.

 DProgramm-Link-Suchlauf
Zwei oder mehr nacheinander zu scannende Such-
laufbereiche können miteinander verlinkt werden. Die 
Funktion führt einen Suchlauf über alle Frequenzen 
innerhalb der verlinkten Bereiche durch.

Beispieleinstellung für einen Programm-Link

...

Program Link 0:

1:

9:

Name 

01: 144.000−440.000

Programm-Link-Nummer (0 bis 9)

leer

Add
Delete

untere 
Eckfrequenz

obere
Eckfrequenz

 L Information
 • Das Programm-Link-Nummern-Display zeigt die Fre-
quenzbereiche.

 • Wenn zwei oder mehr Programmsuchlauf-Bereiche 
(P-Scan Edge) eingegeben wurden, kann man durch 
Drücken von [QUICK] einen Link hinzufügen.

 • Wenn noch kein Programmsuchlauf-Bereich (P00 bis 
P24) programmiert wurde, wird nach dem Drücken von 
[QUICK] die Zeile „Add“ nicht angezeigt.

Programmsuchlauf-Bereich (S. 10-7)
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Speichersuchlauf

 DSuchlaufarten
 • ALL: Suchlauf über alle Speicherkanäle
 • BAND: Band-Speichersuchlauf
 • MODE: Sendearten-Speichersuchlauf
 • DUP:  Duplex-Suchlauf 

(Wird nur angezeigt, wenn Duplex  
eingestellt ist.)

 • GROUP LINK: Gruppen-Link-Suchlauf
 • GROUP 00 bis 99: Gruppensuchlauf
 • TONE:  Tonsuchlauf 

(Suche nach Signalen mit  
CTCSS-Tönen oder DTCS-Codes)

 LDer Speichersuchlauf ist erst nutzbar, wenn mindestens 
zwei Speicherkanäle ohne Übersprungmarkierung pro-
grammiert sind.
 LEin mit einer Übersprungmarkierung (PSKIP oder SKIP) 
versehener Kanal wird beim Suchlauf ausgelassen.  
(S. 10-11)

TIPP:
 • Dreht man während eines Suchlaufs [DIAL], ändert sich 
die Suchlaufrichtung.

 • Mit der [ ]-Taste kann man während eines Suchlaufs 
die Verriegelungsfunktion ein- bzw. ausschalten.

 • Der Suchlauf wird auch dann fortgesetzt, wenn man die 
[MENU]- oder [QUICK]-Taste drückt.

 • Wenn man die [SCAN]-Taste gedrückt hält, kann man 
durch Drehen von [DIAL] eine Suchlaufart wählen. Zum 
Starten des Suchlaufs die [SCAN]-Taste loslassen.

HINWEIS: Zum Starten eines Speichersuchlaufs 
müssen mindestens zwei Speicherkanäle ohne  
Übersprungmarkierung programmiert sein.

1. Zum Aufrufen des Speichermodus [MR] drücken.
2. [SCAN]-Taste 1 Sek. lang drücken.

 • Das Suchlaufauswahlfenster öffnet sich.
3. Suchlaufart wählen. 

blinkt

 • Der Suchlauf beginnt.
 • Der Dezimalpunkt und „ “ blinken.
 LBeim Empfang eines Signals zeigt das S-Meter die 
Empfangssignalstärke an.

4. [SCAN]-Taste 1 Sek. lang drücken.
 • Der Suchlauf stoppt.
 LDer Suchlauf lässt sich auch durch Drücken der 
[CLR]-Taste beenden.
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Speichersuchlauf

 DVerlinkung von Gruppen für einen 
Suchlauf

Im Menü bei „Group Link“ verknüpfte Speichergrup-
pen werden nacheinander gescannt.

 LVoreingestellt sind alle Gruppen miteinander verlinkt.

[MENU] > SET > Scan > Group Link

1. [MENU] drücken.
2. Im „SET“-Menü „Scan“ wählen. 
3. „Group Link“ wählen. 

4. Eine Gruppe von 00 bis 99 oder „S: SKIP CH“ 
wählen. 

5. [ENT] drücken, um die Verlinkung ein- oder  
auszuschalten.

 • Eine verlinkte Gruppe ist mit einem Häkchen „ “ 
gekennzeichnet.
 L [QUICK] drücken, um die Verlinkung für alle Gruppen 
ein- oder auszuschalten. 

 LZum Verlassen die [MENU]-Taste drücken.

 DNutzung von Gruppennamen  
für einen Suchlauf

Wenn ein Gruppenname für eine Speicherkanalgrup-
pe eingegeben wurde, erscheint dieser im Suchlauf-
auswahlfenster. (S. 10-9)

 LDer Name wird während eines Suchlaufs nicht angezeigt.
 LDetails zur Namenseingabe s. S. 9-11.

Wenn ein Gruppenname eingegeben wurde

Wenn kein Gruppenname eingegeben wurde
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Speichersuchlauf

 DÜbersprungkanäle einstellen
Übersprungmarkierungen lassen sich einstellen und 
wieder löschen. Speicherkanäle, die als Übersprung-
kanäle eingestellt sind, werden beim Suchlauf aus-
gelassen.

1. Zum Aufrufen des Speichermodus [MR] drücken.
2. Zu überspringenden Speicherkanal wählen.
3. [QUICK] drücken.
4. „SKIP“ wählen.
5. Eine Option wählen. 

Wenn ein Kanal als Über-
sprungkanal markiert ist,  
wird „SKIP“ oder „PSKIP“  
angezeigt.

 • OFF: Übersprungeinstellung löschen.
 • SKIP: Überspringen beim Speichersuchlauf.
 • PSKIP:  Überspringen beim VFO- und Speicher-

suchlauf.

Temporäre Übersprungfunktion

Mit dieser Funktion lassen sich unerwünschte Fre-
quenzen (oder Speicherkanäle) während des Such-
laufs für eine bestimmte Zeit oder unter bestimmten 
Bedingungen ohne Änderung der Übersprungeinstel-
lungen überspringen.

1. Wenn der Suchlauf auf einem Signal stoppt,  
[MW] 1 Sek. lang drücken.

2. „Temp Skip Set“ wählen. 

 • Die Frequenz oder der Speicherkanal werden als 
Übersprungfrequenz bzw. -kanal markiert.

 • Der Suchlauf wird fortgesetzt.

TIPP:
 • Temporäre Übersprungeinstellungen sind für bis zu 20 
Frequenzen bzw. Speicherkanäle möglich. Wenn die 
21. temporäre Übersprungeinstellung erfolgt, wird die 
älteste Einstellung automatisch gelöscht.

 • Die temporäre Übersprungfunktion lässt sich auch über 
das „QUICK“-Menü einstellen.

 • Die temporäre Übersprungfunktion endet, wenn die im 
Übersprung-Timer eingestellte Zeit (voreingestellt:  
5 min) vorüber ist, oder nach der Auswahl von  
„Tempo rary Skip Cancel“ im „QUICK“-Menü.  
([MENU] > SET > Scan > Temporary Skip Timer)
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FM-Repeater-Betrieb

Ein FM-Repeater empfängt Signale auf einer be-
stimmten Frequenz und sendet sie verstärkt auf einer 
anderen wieder aus. Beim Funkbetrieb über Repeater 
ist die Sendefrequenz um die Frequenzablage (Offset) 
gegenüber der Empfangsfrequenz verschoben.
Beim Duplex-Betrieb ist die Frequenzablage des 
Handfunkgeräts die gleiche wie die des Repeaters.
Details zum Zugriff auf einen D-STAR-Repeater sind 
im Abschnitt 5 dieser Anleitung zu finden.

 DRepeater-Frequenz einstellen
1. Zum Aufrufen des VFO-Modus [VFO/MHz] drücken.
2. [MODE] drücken, um den FM-Modus zu wählen. 

3. Mit [DIAL] die Empfangsfrequenz  
(Repeater-Sendefrequenz) einstellen. 

4. Frequenzablage und Ablagerichtung einstellen.  
(S. 11-4) 

 • Das Duplex-Symbol erscheint im Display.
5. Repeater-Ton einstellen. (voreingestellt: 88,5 Hz) 

([MENU] > SET > DUP/TONE... > Repeater Tone) 
(S. 12-4)

6. Zum Verlassen des Menüs die [MENU]-Taste 
drücken.

7. [QUICK] drücken.
8. „TONE“ wählen und den Repeater-Ton einschalten. 

 • Das „TONE“-Symbol wird angezeigt.

9. [PTT]-Taste 2 Sek. lang drücken.
 • Wenn das Sendesignal den Repeater erreicht hat, 
hört man nach dem Loslassen der [PTT]-Taste das 
Rufzeichen des Repeaters als Morsecode oder als 
Ansage.

10. Anschließend wie bei einem Simplex-Anruf kom-
munizieren, abwechselnd senden und empfangen.

TIPP: Wenn Frequenzablage oder Ablagerichtung dazu 
führen, dass die Sendefrequenz außerhalb des Amateur-
bandes liegt, wird beim Drücken der [PTT]-Taste „OFF 
BAND“ im Display angezeigt, Senden ist nicht möglich.  
(S. 11-5)

Station A
RX: 145,500 MHz
TX: 144,900 MHz

Station B
RX: 145,500 MHz
TX: 144,900 MHz

Repeater
RX: 144,900 MHz
TX: 145,500 MHz

Zugriff auf
einen Repeater

Empfangen 
vom Repeater

[PTT]  2 Sekunden lang 
drücken.

Empfang des 
Repeater-Rufzeichens

▲

um den  
Betrag der 

Frequenzablage 
verschoben

Empfangsfrequenz Sendefrequenz
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FM-Repeater-Betrieb

 DÜberprüfen der  
Repeater-Empfangsfrequenz

Mit dem Handfunkgerät kann ganz einfach überprüft 
werden, ob die Gegenstation, mit der man über einen 
Repeater in Funkkontakt steht, auch direkt zu emp-
fangen ist.
[SQL] drücken, um zu überprüfen, ob die Gegensta-
tion auch direkt auf der Empfangsfrequenz des Re-
peaters zu hören ist.

 D1750-Hz-Rufton
Die meisten europäischen Repeater benötigen für den 
Zugriff einen 1750-Hz-Ton.

Nur beim ID-52E:
Zum Senden eines 1750-Hz-Ruftons die [PTT]-Taste 
kurz drücken und loslassen, dann erneut drücken 
und halten.

1. [MENU] drücken.
2. Im „SET“-Menü „DTMF/T-CALL“ wählen. 

3. „DTMF Memory“ wählen. 

4. „T-CALL“ wählen. 

5. Zum Verlassen des Menüs die [MENU]-Taste 
drücken.

6. Mit [DIAL] die Empfangsfrequenz  
(Repeater-Sendefrequenz) einstellen.

7. Frequenzablage und Ablagerichtung einstellen.  
(S. 11-4)

 • Das Duplex-Symbol erscheint im Display.
8. Während man die [PTT]-Taste gedrückt hält 

[SQL] drücken, um einen 1750-Hz-Rufton zu 
senden.

 • Der Zugang zum Repeater erfolgt mit einem kurzen 
Ton.

9. Der weitere Betrieb kann wie gewohnt erfolgen.
 LWie bei einem Simplex-Anruf, abwechselnd senden 
und empfangen.

 L Information
 • Dabei leuchtet die TX/RX-LED grün und der erste Balken 
des S-Meters blinkt.

 • Die angezeigte Frequenz wechselt zur Sendefrequenz 
der Gegenstation (Repeater-Empfangsfrequenz).

 • Wenn die Gegenstation auf der Empfangsfrequenz des 
Repeaters zu hören ist, kann man dies der Gegenstation 
mitteilen und einen Frequenzwechsel auf eine Sim-
plex-Frequenz verabreden. (Duplex ausschalten)

Anzeige während der Überprüfung
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Duplex-Betrieb

Beim Duplex-Betrieb ist die Sendefrequenz gegen-
über der Empfangsfrequenz um eine einstellbare 
Frequenzablage nach oben oder unten verschoben.

 DFrequenzablage einstellen

HINWEIS: Bei Nutzung der DR-Funktion kann die 
Frequenzablage nicht geändert werden.

[MENU] > SET > DUP/TONE... > Offset Freq

1. [MENU] drücken.
2. Im „SET“-Menü „DUP/TONE...“ wählen. 

3. „OFFSET FREQ“ wählen. 

4. Mit [DIAL] die Frequenzablage einstellen. 

 L Information
 • Einstellbar sind 0.000.00 bis 59.99500 MHz.
 • Die im VFO-Modus eingestellte Abstimmschrittweite 
wird zur Einstellung der Frequenzablage genutzt.

 • Zum Verlassen die [MENU]-Taste drücken.

TIPP: Wenn Frequenzablage oder Ablagerichtung dazu 
führen, dass die Sendefrequenz außerhalb des Amateur-
bandes liegt, wird beim Drücken der [PTT]-Taste „OFF 
BAND“ im Display angezeigt, Senden ist nicht möglich.  
(S. 11-5)

 DDuplex-Ablagerichtung einstellen
1. [QUICK] drücken.
2. „DUP“ wählen. 

3. Duplex-Ablagerichtung wählen.
 • OFF:  Simplex-Betrieb (Empfangs und Sende-

frequenz sind gleich).
 • DUP–:  Die Sendefrequenz wird gegenüber der  

Empfangsfrequenz um die Frequenzablage 
nach unten verschoben.

 • DUP+:  Die Sendefrequenz wird gegenüber der  
Empfangsfrequenz um die Frequenzablage 
nach oben verschoben.

  

 • „D–“ oder „D+“ wird im Display angezeigt.

 DDuplex-Betrieb
1. [SQL] drücken und halten, um zunächst zu über-

prüfen, ob auf der Sendefrequenz eine andere 
Station sendet.

 • Die um den Ablagebetrag verschobene Sende-
frequenz des Handfunkgeräts erscheint dabei im 
Display.

2. Der weitere Betrieb kann wie gewohnt erfolgen.
 LWie bei einem Simplex-Anruf, abwechselnd senden 
und empfangen.
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Außer-Band-Anzeige

Wenn die Sendefrequenz infolge der Anwendung der 
Frequenzablage und der Ablagerichtung außerhalb 
des Amateurbandes liegt, erscheint als Außer- 
Band-Anzeige „OFF BAND“ im Display, sobald die 
[PTT] gedrückt wird. In diesem Fall müssen die einge-
stellte Frequenzablage und deren Richtung überprüft 
werden. (S. 11-4)
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Das Menü lässt sich durch Drücken der [MENU]-Tas-
te aufrufen. Im Menümodus kann man Werte und 
Funktionsoptionen einstellen, die nur selten geändert 
werden müssen.
Auf den Seiten 12-4 bis 12-36 sind zu jedem Menü-
punkt Optionen und Voreinstellungen aufgeführt.

 DMenübedienung

Menü

Menüpunkt oder Option wählen

zurück zu vorherigen
Menüebene

Umschalten zwischen
„MENU“- und
Stand-by-Display

[ENT]
bestätigen

zurück zu  
vorherigen 
Menüebene

zur nächsten 
Menüebene

Rückkehr zur 
Voreinstellung

Menüpunkt oder Option wählen

Kurzbeschreibung für das Wählen  
von Menüpunkten und Einstelloptionen
In dieser Anleitung wird eine vereinfachte Beschrei-
bung für das Wählen von Menüpunkten verwendet:

Kurzbeschreibung:
1. [MENU] drücken.
2. „30min“ wählen.

Bedienung:
1. [MENU]-Taste drücken, um das Menü zu öffnen.
2. Mit den Navigationstasten () die Option „30min“ 

auswählen und mit der [ENT]-Taste bestätigen.

TIPP: Das Menüsystem ist wie ein Baum struktu-
riert. Man kann leicht die nächste Menüebene auf-
rufen oder zur übergeordneten (vorherigen) zurück-
kehren.
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Menü

 DMenüpunkt wählen
Beispiel: „Auto Power OFF“ auf „30 min“ einstellen.

[MENU] > SET > Time Set > Auto Power OFF

1. [MENU] drücken.
2. „SET“ wählen.
3. „Time Set“ wählen. 

4. „Auto Power OFF“ wählen. 

5. „30min“ wählen. 

 • Nach der Bestätigung erfolgt die Rückkehr zur 
nächsthöheren Menüebene.  
(Das „TIME SET“-Display wird angezeigt.)
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Rückkehr zur Voreinstellung
1. Bei Schritt 5 [QUICK] drücken.
2. „Default“ wählen. 

 • Der Menüpunkt wird auf die Voreinstellung 
zurückgesetzt.
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Offset Freq (voreingestellt: 0.600.00*)

[MENU] > SET > DUP/TONE... > Offset Freq

Einstellung der Repeater-Ablage (Offset) für den Du-
plex-Repeater-Betrieb von 0.000.00 bis 59.995.00 MHz.

 L [VFO/MHz] drücken, um 1-MHz-Abstimmschritte zu 
wählen.
 LDie Duplex-Ablagerichtung (DUP–/DUP+) (S. 11-4) oder die 
Abstimmschrittweite werden im „QUICK“-Menü eingestellt.
 LBei eingeschalteter DR-Funktion, ist keine Bearbeitung 
möglich.

*  Die Voreinstellungswerte unterscheiden sich je nach Ver-
sion des Handfunkgeräts und dem Frequenzband, das vor 
dem Aufrufen des Menüs als Hauptband gewählt wurde.

Repeater Tone (voreingestellt: 88.5)

[MENU] > SET > DUP/TONE... > Repeater Tone

Einstellung der Frequenz des Subaudiotons für den 
Zugriff auf Repeater bzw. für andere Funktionen.  
50 Frequenzen (67,0 bis 254,1 Hz) sind wählbar.

TSQL Freq (voreingestellt: 88,5)

[MENU] > SET > DUP/TONE... > TSQL Freq

Einstellung der CTCSS-Frequenz für die 
Ton-Squelch-Funktion.
50 Frequenzen (67,0 bis 254,1 Hz) sind wählbar.

 • Wählbare Frequenzen für den Repeater-Ton  
und die TSQL (CTCSS) in Hertz

67,0 88,5 114,8 151,4 177,3 203,5 250,3
69,3 91,5 118,8 156,7 179,9 206,5 254,1
71,9 94,8 123,0 159,8 183,5 210,7
74,4 97,4 127,3 162,2 186,2 218,1
77,0 100,0 131,8 165,5 189,9 225,7
79,7 103,5 136,5 167,9 192,8 229,1
82,5 107,2 141,3 171,3 196,6 233,6
85,4 110,9 146,2 173,8 199,5 241,8

Tone Burst (voreingestellt: OFF)

[MENU] > SET > DUP/TONE... > Tone Burst

Ein- oder Ausschalten der Rufton-Funktion bei FM, 
wenn die TSQL (CTCSS) verwendet wird.

 • OFF:  Wenn man ein Signal sendet, das einen 
CTCSS-Ton enthält, kann es vorkommen, 
dass die Gegenstation direkt nach dem Ende 
des Sendens einen kurzen Rausch-Burst hört.

 • ON:  Wenn man ein Signal sendet, das einen 
CTCSS-Ton enthält, wird der ansonsten von 
der Gegenstation hörbare Rausch-Burst 
stummgeschaltet.

DTCS Code (voreingestellt: 023)

[MENU] > SET > DUP/TONE... > DTCS Code

Einstellung des DTCS-Codes für Coder und Decoder 
für die Nutzung der DTCS-Funktion. 104 Codes (023 
bis 754) sind wählbar.

 • Wählbare DTCS-Codes
023 072 152 244 311 412 466 631
025 073 155 245 315 413 503 632
026 074 156 246 325 423 506 654
031 114 162 251 331 431 516 662
032 115 165 252 332 432 523 664
036 116 172 255 343 445 526 703
043 122 174 261 346 446 532 712
047 125 205 263 351 452 546 723
051 131 212 265 356 454 565 731
053 132 223 266 364 455 606 732
054 134 225 271 365 462 612 734
065 143 226 274 371 464 624 743
071 145 243 306 411 465 627 754

DTCS Polarity (voreingestellt: Both N)

[MENU] > SET > DUP/TONE... > DTCS Polarity

Wahl der DTCS-Polaritäten für Senden und Empfang.
 • Both N: Normale Polarität bei TX und RX.
 • TN-RR:  Normale Polarität bei TX und reverse bei RX.
 • TR-RN:  Reverse Polarität bei TX und normale bei RX.
 • Both R:  Reverse Polarität bei TX und RX.

Digital Code (voreingestellt: 00)

[MENU] > SET > DUP/TONE... > Digital Code

Einstellung des Digitalcodes für den  
Digital-Code-Squelch.
100 Codes (00 bis 99) sind wählbar.

HINWEIS: Alle Voreinstellwerte beziehen sich auf die USA-Version des Handfunkgeräts. Dementsprechend kön-
nen die Voreinstellwerte Ihres Geräts davon abweichen.

DUP/TONE-Einstellungen
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Suchlaufeinstellungen

Pause Timer (voreingestellt: 10sec)

[MENU] > SET > Scan > Pause Timer

Einstellung des Pause-Timers. Wenn ein Signal empfan-
gen wird, hält der Suchlauf für die eingestellte Zeit an.

 LSeparat für Band A und B einstellbar.
 • 2sec bis 20sec:  Wenn ein Signal empfangen wird, 

hält der Suchlauf für 2 bis 20 Sek. 
an (Einstellung in 2-Sek.-Schritten).

 • HOLD:  Der Suchlauf hält solange an, bis 
das Signal wieder verschwindet.

Resume Timer (voreingestellt: 2sec)

[MENU] > SET > Scan > Resume Timer

Einstellung des Resume-Timers. Wenn ein gefunde-
nes Signal verschwindet, wird der Suchlauf erst nach 
Ablauf der eingestellten Zeit fortgesetzt.

 LSeparat für Band A und B einstellbar.
 • 0sec:  Der Suchlauf wird sofort nach dem 

Verschwinden fortgesetzt.
 • 1sec bis 5sec:  Der Suchlauf wird 1 bis 5 Sekunden 

nach Verschwinden fortgesetzt.
 • HOLD:  Der Suchlauf wird entsprechend 

der Einstellung des Pause-Timers 
angehalten, auch wenn das Signal 
bereits vorher verschwindet.

HINWEIS: Zum Fortsetzen des Suchlaufs [DIAL] 
drehen.

Temporary Skip Timer (voreingestellt: 5min)

[MENU] > SET > Scan > Temporary Skip Timer

Einstellung des Temporary-Skip-Timers. Unerwünsch-
te Frequenzen werden für diese Zeit beim Suchlauf 
übersprungen.

 LSeparat für Band A und B einstellbar.
 LDer Temporary-Skip-Timer wird für den VFO-, Speicher- 
und DR-Suchlauf aktiviert.
 • 5min/10min/15min:  Übersprungkanäle werden für 

diese Zeit beim Suchlauf über-
sprungen.

 • While Scanning:  Übersprungkanäle werden bis 
zum Anhalten des Suchlaufs 
übersprungen.

 • While Powered ON:  Übersprungkanäle werden bis 
zum Ausschalten des Hand-
funkgeräts übersprungen.

Program Skip (voreingestellt: ON)

[MENU] > SET > Scan > Program Skip

Ein- bzw. Ausschalten des programmierten Über-
sprungsuchlaufs im VFO-Modus. Unerwünschte Fre-
quenzen in Speicherkanälen die mit „PSKIP“ markiert 
sind, werden übersprungen.

 LSeparat für Band A und B einstellbar.
 • OFF:  Suchlauf über alle Frequenzen.
 • ON:  Frequenzen in Kanälen die mit „PSKIP“ mar-

kiert sind werden übersprungen.

Group Link 
 (voreingestellt:  ✔  00 bis ✔  99/ ✔  S: SKIP CH)

[MENU] > SET > Scan > Group Link

Auswählen der Gruppen für den Gruppen-Link-Such-
lauf. Alle Kanäle der verknüpften Gruppen werden 
beim Suchlauf gescannt.
Eine Gruppe von A bis Z wählen und dann [ENT] drü-
cken, um die Verlinkung ein- bzw. auszuschalten.

 LEine verlinkte Gruppe ist mit einem Häkchen „✔“ markiert.
 LSeparat für Band A und B einstellbar.

P-Scan Edge

[MENU] > SET > Scan > P-Scan Edge

Die unteren und oberen Eckfrequenzen program-
mierter Suchläufe lassen sich löschen, kopieren und 
editieren.
Das Handfunkgerät verfügt über 25 Speicherpaare 
(00 bis 24) bei denen man Name, Abstimmschrittwei-
te und Sendeart für jede Eckfrequenz einstellen kann.

 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.
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Suchlaufeinstellungen

Program Link

[MENU] > SET > Scan > Program Link

Einstellung der Link-Funktion für zwei oder mehrere 
programmierte Suchläufe, die beim Program-Link-
Scan nacheinander gescannt werden; Suchlauf über 
alle Frequenzen innerhalb der gewählten Bereiche.

Voreinstellungen des Program-Links:

 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.
 LWenn nur ein Programm-Suchlaufbereich zur Verfügung 
steht oder bereits alle Programm-Suchlaufbereiche 
hinzugefügt wurden, erscheint nach dem Drücken von 
[QUICK] nicht die Option „Add“.

DUP Check During MR Scan (voreingestellt: OFF)

[MENU] > SET > Scan > DUP Check During MR 
Scan

Wahl, ob während eines Speichersuchlaufs die  
Offsetfrequenz (Frequenz + Frequenzablage) eines  
auf Duplex eingestellten Kanals mitgescannt wird.

 • OFF: Die Offsetfrequenz wird nicht gescannt.
 • ON: Die Offsetfrequenz wird mitgescannt.

...

Program Link 0:

1:

9:

Name

01: 144.000−148.000

Programm-Link-Nummer (0 bis 9)

Blank

Programsuchlauf-Bereich

Add
Delete

Add
Delete

02: 430.000−450.000
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Bandskop-Einstellungen

Scope Mode (voreingestellt: Center)

[MENU] > SET > Scope > Scope Mode

Wahl des Anzeigemodus für das Bandskop.
 • Center:  Zeigt Signale in der Nähe der  

Betriebsfrequenz innerhalb des  
gewählten Anzeigebereichs an.  
Die Betriebsfrequenz befindet sich 
immer in der Mitte des Displays.

 • FIX:  Zeigt Signale innerhalb eines be-
stimmten Frequenzbereichs an.

 • Scroll (FIX):  Zeigt Signale innerhalb eines be-
stimmten Frequenzbereichs an. 
Bewegt sich die Betriebsfrequenz 
aus dem Anzeigebereich heraus, 
wandert dieser automatisch mit.

Displayed Steps (voreingestellt: ±15 Steps)

[MENU] > SET > Scope > Displayed Steps

Wahl der Anzahl der angezeigten Schritte rechts und 
links der Mittenfrequenz im Bandskop.

 LDie angezeigten Schritte sind von der Einstellung der  
Abstimmschrittweite abhängig.
 • ±15 Schritte: 

 • ±20 Schritte: 

Waterfall Function (voreingestellt: ON)

[MENU] > SET > Scope > Waterfall Function

Wahl, ob bei eingeschaltetem Bandskop eine Wasser-
fallanzeige erfolgen soll.

 • OFF: Die Wasserfallanzeige ist ausgeschaltet.
 • ON: Die Wasserfallanzeige ist eingeschaltet.

Waterfall Speed (voreingestellt: Fast)

[MENU] > SET > Scope > Waterfall Speed

Einstellung der Geschwindigkeit der Wasserfallanzeige.
 • Slow: Langsame Wasserfallanzeige.
 • Fast: Schnelle Wasserfallanzeige.

FIX Mode Center Frequency

[MENU] > SET > Scope > FIX Mode Center Frequency

Einstellung der Mittenfrequenz für den FIX-Modus 
des Bandskops für jedes Band.

 LZur Einstellung der Mittenfrequenz wird die für den 
VFO-Modus gewählte Abstimmschrittweite genutzt. 
Um die Abstimmschrittweite zu wählen, drückt man im 
Stand-by-Modus [QUICK].
 LUm zur Voreinstellung zurückzukehren, [QUICK] drücken 
und anschließend im „Center Freq. (FIX)“- oder  
„FREQUENCY“-Display die Option „Default“ wählen.
 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.

AF Output (DUAL/AIR Band) (voreingestellt: OFF)

[MENU] > SET > Scope > AF Output (DUAL/AIR Band)

Ein- und Ausschalten der NF-Wiedergabe beim 
Sweepen des Bandskops bei Nutzung der Zweikanal-
überwachung oder Wahl des Flugfunkbandes.

 • OFF: Keine NF-Ausgabe während des Sweeps.
 • ON:  Die empfangene NF wird während des 

Sweeps kurzzeitig ausgegeben.



12 SET-MODUS

12-8

Rufzeicheneinstellungen

Call Sign

[MENU] > SET > Call Sign

Einstellen oder Ansehen der für den DV-Betrieb ver-
wendeten Rufzeichen „UR“, „R1“, „R2“ und „MY“.
Die Rufzeichen kann man in diesem Display einstel-
len, wenn die DR-Funktion nicht genutzt wird.

Für den Simplex-Betrieb (im DV-Modus)
lassen sich die Rufzeichen „UR“ und „MY“ eingeben.

Für den Duplex (Repeater)-Betrieb
(im DV/DR-Modus)
lässt sich bei eingeschalteter DR-Funktion nur das 
Rufzeichen „MY“ eingeben.

< Manuelle Einstellung für den
Duplex (Repeater)-Betrieb>

Beispiel:  Gateway-Anruf im DV-Modus vom Hirano- 
Repeater (JP3YHH A) zum Kirkland-Repea-
ter (N71H B).

 LVor der Eingabe der Rufzeichen muss im Stand-by-
Display die Frequenz des Einstiegs-Repeaters und die 
Ablagerichtung eingestellt werden.

TIPP: Bei eingeschalteter Digital-Repeater-Set-
Funktion wird das Rufzeichen automatisch eingestellt.
([MENU] > SET > DV Set > Digital Repeater Set)

Schritt 1. Rufzeichen „R1“ einstellen
1. „R1“ wählen.

 LNICHT die [ENT]-Taste betätigen!
2. [QUICK] drücken.
3. „Edit“ wählen.
4. Zum Eingeben des ersten Zeichens [DIAL] drehen.

 LVerwendbar sind alle alphanumerischen Zeichen und 
der Schrägstrich („/“).

5. Der Cursor lässt sich mit den Navigationstasten  
() bewegen.

6. Schritte 4 und 5 wiederholen, um das Repea-
ter-Rufzeichen des mit bis zu 8 Zeichen, ein-
schließlich Leerzeichen, einzugeben.  
(Beispiel: JP3YHH A)

7. Eingabe mit [ENT] bestätigen.
 • Das eingegebene Repeater-Rufzeichen wird gespei-
chert.

Schritt 2. Gateway-Rufzeichen „R2“ einstellen
1. „R2“ wählen.

 LZur manuellen Eingabe eines Rufzeichens [QUICK] 
drücken und dann „Edit“ wählen.

2. „GW“ wählen.

Das „RPT2 SELECT“-Display
NOT USED* für Gebietsanrufe

GW
Gateway-Rufzeichen aus der Repeater-
Liste wählen.

Repeater name
Zur Auswahl des Repeaters,  
der das gleiche Gateway wie der 
„R1“-Repeater hat.

Schritt 3. Zielrufzeichen „UR“ einstellen
1. „UR“ wählen.

 LZur manuellen Eingabe eines Rufzeichens [QUICK] 
drücken und dann „Edit“ wählen.

2. „Gateway CQ“ wählen.
3. Repeater-Gruppe wählen, der der Ziel-Repeater 

zugeordnet ist.
4. Ziel-Repeater wählen.

Das „YOUR SELECT“-Display

CQCQCQ
Allgemeiner Anruf, der nicht an ein  
bestimmtes Rufzeichen geht.

Gateway CQ*
„Gateway CQ“ wählen, um einen Anruf 
über die Repeater-Liste zu tätigen.

Your Call Sign
Wahl des Zielrufzeichens „UR“ aus 
dem „Your Call Sign“-Speicher.

RX History
Wahl des Zielrufzeichens „UR“ aus der
RX-History.

TX History
Wahl des Zielrufzeichens „UR“ aus der
TX-History.

* Wird beim Simplex-Betrieb nicht angezeigt.
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Einstellungen für die eigene Station

My Call Sign

[MENU] > SET > My Station > My Call Sign

Das Handfunkgerät verfügt über insgesamt 6 Spei-
cher für die eigenen Rufzeichen zur Verwendung im 
DV-Modus. Rufzeichen können bis zu 8 Zeichen ent-
halten.
Außerdem lässt sich eine bis zu 4 Zeichen lange An-
merkung eingeben, z. B. für den Gerätetyp, das Ge-
biet usw.

 LDetails zur Eingabe des eigenen Rufzeichens „MY“ sind 
in der D-STAR-Anleitung zu finden, die in der Basis-Be-
dienungsanleitung enthalten ist.
 LUm im „MY CALL SIGN“-Display ein anderes „MY“-Ruf-
zeichen zu wählen, die Navigationstasten () und dann 
[ENT] drücken.

TX Message

[MENU] > SET > My Station > TX Message

Für Kurzmeldungen die im DV-Modus mit dem 
Sprachsignal gesendet werden sollen, stehen insge-
samt 5 Speicher zur Verfügung.
In jeden Speicher lässt sich eine 20 alphanumerische 
Zeichen umfassende TX-Meldung eingeben. 

 LZur Eingabe von TX-Meldungen s. S. 5-17.
 LUm im „TX MESSAGE“-Display eine andere TX-Meldung 
zu wählen, die Navigationstasten () und dann [ENT] 
drücken.

TIPP: Wenn man keine TX-Meldung senden möchte, 
wählt man „OFF“.
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DV-Einstellungen

RX Bass (voreingestellt: Normal)

[MENU] > SET > DV Set > Tone Control > RX Bass

Wahl der Wirkung des NF-Bassfilters für den Emp-
fang im DV-Modus

 • Cut: Beschneidung der tiefen Frequenzen.
 • Normal:  Normale Übertragung der tiefen Frequenzen.
 • Boost: Anhebung der tiefen Frequenzen.

RX Treble (voreingestellt: Normal)

[MENU] > SET > DV Set > Tone Control > RX Treble

Wahl der Wirkung des NF-Höhenfilters für den Emp-
fang im DV-Modus

 • Cut: Beschneidung der hohen Frequenzen.
 • Normal:  Normale Übertragung der hohen  

Frequenzen.
 • Boost: Anhebung der hohen Frequenzen

RX Bass Boost (voreingestellt: OFF)

[MENU] > SET > DV Set > Tone Control >  
RX Bass Boost

Ein- und Ausschalten der Bass-Boost-Funktion für 
den Empfang im DV-Modus.

 LDiese Funktion unterscheidet sich von der „Boost“-Ein-
stellung im Menüpunkt „RX Bass.“
 • OFF: Die Funktion ist ausgeschaltet.
 • ON: Verstärkte Basswiedergabe.

TX Bass (voreingestellt: Normal)

[MENU] > SET > DV Set > Tone Control > TX Bass

Wahl der Wirkung des NF-Bassfilters beim Senden im 
DV-Modus

 • Cut: Beschneidung der tiefen Frequenzen.
 • Normal:  Normale Übertragung der tiefen Frequenzen.
 • Boost: Anhebung der tiefen Frequenzen.

TX Treble (voreingestellt: Normal)

[MENU] > SET > DV Set > Tone Control > TX Treble

Einstellung der Höhen für gesendete Audiosignale.
 • Cut: Beschneidung der hohen Frequenzen.
 • Normal:  Normale Übertragung der hohen  

Frequenzen.
 • Boost: Anhebung der hohen Frequenzen

Auto Reply (voreingestellt: OFF)

[MENU] > SET > DV Set > Auto Reply

Einstellung der automatischen Antwortfunktion. Sie 
reagiert automatisch auf an das eigene Rufzeichen
gerichtete Anrufe, wenn man selbst nicht in der Nähe 
des Handfunkgeräts ist.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  Antwort nur mit dem eigenen Rufzeichen.
 • Voice:  Antwort mit dem eigenen Rufzeichen und 

der auf der Micro-SD-Karte gespeicher-
ten, max. 10 Sek. langen automatischen 
Antwort.

 LDie gesendeten Audiosignale lassen sich 
mithören.
 LWenn im Handfunkgerät keine Micro-SD- 
Karte eingesetzt ist oder auf der Micro-SD- 
Karte keine Antwort gespeichert ist, erfolgt 
die Antwort nur mit dem eigenen Rufzeichen.

 • Position:  Antwort mit dem eigenen Rufzeichen und 
Senden der vom eingebauten GPS-Emp-
fänger ermittelten eigene Position.

 LWenn bei „GPS Select“ die Einstellung 
„OFF“ oder „Manual“ gewählt ist, wird der 
eingebaute GPS-Empfänger vorübergehend 
eingeschaltet.

 LWenn „ON“ oder „Voice“ gewählt ist, schaltet sich die 
automatische Antwortfunktion aus, sobald man die 
[PTT]-Taste betätigt. Falls „Position“ gewählt ist, bleibt 
die automatische Antwortfunktion eingeschaltet, wenn 
man die [PTT]-Taste betätigt.

DV Data TX (voreingestellt: Auto)

[MENU] > SET > DV Set > DV Data TX

Wahl, ob im DV-Modus Daten PTT-gesteuert oder 
automatisch gesendet werden.

 • PTT:  [PTT]-Taste drücken, um das Senden der 
Daten manuell zu veranlassen.

 • Auto:  Vom PC an den [USB]-Port übertragene 
Daten werden automatisch gesendet.

Fast Data (voreingestellt: OFF)

[MENU] > SET > DV Set > DV Fast Data > Fast Data

Ein- und Ausschalten des DV-Fast-Data-Modus für 
die Datenkommunikation im DV-Betrieb. In diesem 
Modus erfolgt die Datenübertragung etwa mit der 
3,5-fachen Geschwindigkeit. Audiosignale können 
nicht gesendet werden.

 • OFF: Langsame Datenübertragung (etwa 950 bps).
 • ON: Schnelle Datenübertragung (etwa 3480 bps).
 LBei gedrückter [PTT] werden die Daten wegen der Audio-
signale langsam übertragen.
 LDie Übertragungsgeschwindigkeit von GPS-Daten hängt 
von der Einstellung bei „GPS Data Speed“ ab.
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DV-Einstellungen

GPS Data Speed (voreingestellt: Slow)

[MENU] > SET > DV Set > DV Fast Data >  
GPS Data Speed

Wahl der Übertragungsgeschwindigkeit von GPS-Da-
ten beim DV-Fast-Data-Modus.

 • Slow:  Langsame GPS-Datenübertragung 
(etwa 950 bps).

 • Fast:  Schnelle GPS-Datenübertragung 
(etwa 3480 bps).

TX Delay (PTT) (voreingestellt: 2sec)

[MENU] > SET > DV Set > DV Fast Data >  
TX Delay (PTT)

Wahl der Zeit nach dem Loslassen der [PTT] nach 
der das Handfunkgerät nach dem Datensenden im 
DV-Data-Modus wieder auf Empfang umschaltet.

 • OFF:  Nach dem Loslassen der [PTT] schaltet 
das Handfunkgerät sofort auf Empfang 
um.

 • 1 bis 10sec:  Nach dem Loslassen der [PTT] 
sendet das Handfunkgerät für die 
eingestellte Zeit automatisch im DV-
Fast-Data-Modus. Wenn die Daten 
innerhalb der eingestellten Zeit kom-
plett gesendet wurden, erfolgt die 
Umschaltung auf Empfang.

HINWEIS: Diese Funktion ist nur nutzbar, wenn im 
Menüpunkt „DV Data TX“ die Einstellung „PTT“ ge-
wählt ist.

Digital Monitor (voreingestellt: Auto)

[MENU] > SET > DV Set > Digital Monitor

Wahl der Empfangsbetriebsart für die Monitor-Funkti-
on, die im DV-Modus beim Gedrückthalten von [SQL] 
genutzt wird.

 • Auto:  DV oder FM, je nach empfangenen Signalen.
 • Digital: DV-Empfang.
 • Analog: FM-Empfang.

Digital Repeater Set (voreingestellt: ON)

[MENU] > SET > DV Set > Digital Repeater Set

Ein- und Ausschalten der Digital-Repeater-Einstell-
funktion. Diese Funktion übernimmt das Repea-
ter-Rufzeichen automatisch, falls das beim Zugriff auf 
den Repeater festgestellte Rufzeichen von dem im 
Handfunkgerät gespeicherten abweicht.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  automatische Übernahme des Repeater- 

Rufzeichens

DV Auto Detect (voreingestellt: OFF)

[MENU] > SET > DV Set > DV Auto Detect

Ein- und Ausschalten der automatischen DV-De-
tect-Funktion. Wenn man im DV-Modus ein nicht-di-
gitales Signal empfängt, kann diese Funktion das 
Handfunkgerät in die Sendeart FM umschalten.

 • OFF:  Funktion ausgeschaltet. Das Handfunkgerät 
bleibt im DV-Modus.

 • ON:  Das Handfunkgerät schaltet vorübergehend 
in den FM-Modus um.

RX Record (RPT) (voreingestellt: ALL)

[MENU] > SET > DV Set > RX Record (RPT)

Das Handfunkgerät kann bis zu 50 individuelle Anrufe 
speichern. Wenn empfangene Signale eine Status-
meldung („UR?“ oder „RPT?“), die vom Einstiegs-Re-
peater zurückgesendet wurde, enthalten, lassen sich 
bis zu 50 Meldungen oder nur die letzte speichern.

 • ALL: Aufzeichnung von bis zu 50 Anrufen.
 • Latest Only: Nur der letzte Anruf wird gespeichert.

[RX>CS] Key (voreingestellt: Call Sign Capture)

[MENU] > SET > DV Set > [RX>CS] Key

Wahl der Funktion der gedrückt gehaltenen [RX→CS]-
Taste.

 • Call Sign Capture:  Während des Haltens wird die 
RX-History angezeigt. Beim 
Loslassen werden die Rufzei-
chen der zuletzt empfangenen 
Station in „TO“ (Ziel) übernom-
men.

 • RX>CS List:  1 Sek. lang drücken, um die 
RX-History anzuzeigen. Mit  
[DIAL] ein Zielrufzeichen für 
„TO“ auswählen und mit [ENT] 
bestätigen.

BK (voreingestellt: OFF)

[MENU] > SET > DV Set > BK

Die BK- (Break-in)Funktion ermöglicht es, der Kom-
munikation zweier anderer Stationen beizutreten, die 
mit Rufzeichen-Squelch arbeiten.

 • OFF:  Die Funktion ist ausgeschaltet.
 • ON: Die Funktion ist eingeschaltet.
 LDie BK-Funktion wird automatisch beendet, sobald man 
das Handfunkgerät ausschaltet.
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DV-Einstellungen

EMR (voreingestellt: OFF)

[MENU] > SET > DV Set > EMR

Die EMR-Funktion (Enhanced Monitor Request) er-
möglicht allen Funkgeräten, die im DV-Modus ein 
EMR-Signal empfangen, automatisch den Squelch zu 
öffnen.

 • OFF:  Die Funktion ist ausgeschaltet.
 • ON: Die Funktion ist eingeschaltet.
 LDie EMR-Funktion wird automatisch beendet, sobald 
man das Handfunkgerät ausschaltet.

EMR AF Level (voreingestellt: 19)

[MENU] > SET > DV Set > EMR AF Level

Einstellung der Lautstärke für EMR-Signale. Wenn 
ein solches empfangen wird, hört man es mit der 
hier voreingestellten Lautstärke oder der mit dem 
[VOL]-Regler eingestellten, je nachdem welche lauter 
ist. 
Zur Deaktivierung wählt man „0“.

HINWEIS: Wenn das EMR-Signal nicht mehr emp-
fangen wird, verbleibt die Lautstärke auf dem vor-
eingestellten Wert. Zur Änderung der Lautstärke 
muss der [VOL]-Regler betätigt werden.
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Spracheinstellungen

RX Call Sign SPEECH (voreingestellt: ON (Kerchunk))

[MENU] > SET > SPEECH > RX Call Sign SPEECH

Ein- und Ausschalten der Ansagefunktion für empfan-
gene Rufzeichen im DV-Modus.

 L Information
 • Bei Nutzung des Digital-Squelchs wird das Rufzeichen 
der anrufenden Station nicht angesagt, wenn das emp-
fangene Signal nicht an Ihr Rufzeichen adressiert ist oder 
keinen passenden Digital-Code enthält.

 • Beim Empfang eines Signals von einem Repeater („UR?“ 
oder „RPT?“) wird das Rufzeichen der anrufenden Sta-
tion nicht angesagt.

 • Der Suchlauf wird während einer Ansage fortgesetzt.
 • Anmerkungen nach einem Rufzeichen werden nicht an-
gesagt

 • Wenn man während einer Ansage ein Signal empfängt, 
bricht das Handfunkgerät die Ansage ab und das emp-
fangene Signal ist hörbar.

 • OFF:  Funktion ausgeschaltet. Rufzei-
chen werden nicht angesagt.

 • ON (Kerchunk):  Nur bei kurzen Anrufen wird das 
Rufzeichen angesagt.

 • ON (All):  Das Rufzeichen des Anrufers wird 
immer angesagt.

RX>CS SPEECH (voreingestellt: ON)

[MENU] > SET > SPEECH > RX>CS SPEECH

Ein- und Ausschalten der RX>CS-Ansage-Funktion. 
Diese Funktion ermöglicht die Ansage eines Ruf-
zeichens, das durch Drücken von [RX→CS] aus dem 
„Received Call Record“ gewählt wird.

 LWenn man während der Ansage ein Anruf empfängt, wird 
das empfangene Signal stummgeschaltet und nicht auf 
der Micro-SD-Karte gespeichert.

 • OFF:  Rufzeichen wird nicht angesagt.
 • ON:  Rufzeichen wird angesagt.

DIAL SPEECH (voreingestellt: OFF)

[MENU] > SET > SPEECH > DIAL SPEECH

Ein- und Ausschalten der Dial-Ansagefunktion. Diese 
Funktion ermöglicht die Ansage der Frequenz oder 
des Repeater-Rufzeichens, die bzw. das beim Drehen 
an [DIAL] gewählt wird.

 L Im DR-Modus wird das Repeater-Rufzeichen angesagt. 
Falls Simplex-Betrieb gewählt ist, wird die Frequenz an-
gesagt.

 • Wenn man während einer Ansage ein Signal empfängt, 
bricht das Handfunkgerät die Ansage ab und das emp-
fangene Signal ist hörbar.

 • OFF:  keine Ansage
 • ON:  Frequenz oder Repeater-Rufzeichen werden 

1 Sekunde nach erfolgtem Drehen von [DIAL] 
angesagt.  
Im VFO-, Speicher- und Anrufkanalmodus 
wird die Frequenz angesagt. 
Im DR-Modus wird das Repeater-Rufzeichen 
angesagt.

MODE SPEECH (voreingestellt: OFF)

[MENU] > SET > SPEECH > MODE SPEECH

Ein- und Ausschalten der Ansage der Sendeart.
 LDie Ansage erfolgt, wenn während eines VFO-Suchlaufs 
die Sendeart gewechselt wird.
 • OFF:  Die gewählte Sendeart wird nicht angesagt.
 • ON:  Die gewählte Sendeart wird angesagt.

SPEECH Language (voreingestellt: English)

[MENU] > SET > SPEECH > SPEECH Language

Wahl der gewünschten Sprache für die verschiedenen 
Ansagen zwischen Englisch oder Japanisch.

Alphabet (voreingestellt: Normal)

[MENU] > SET > SPEECH > Alphabet

Wahl der Ansageart für Buchstaben.
• Normal:  Normale Ansage. 

(Beispiel: A, B)
• Phonetic Code:  Nutzung des englischen 

Buchstabier alphabets.  
(Beispiel: Alfa, Bravo)
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DTMF/T-CALL-Einstellungen

Programmierung der DTMF-Codes und -Speicher-
kanäle für den DTMF-Betrieb.
Details dazu s. S. 15-5.

DTMF Memory (voreingestellt: d0)

[MENU] > SET > DTMF/T-CALL > DTMF Memory

Anzeige der Liste der DTMF-Speicher.
 • T-CALL:  1750-Hz-Rufton
 • d0 bis d#: DTMF-Speicher

DTMF Speed (voreingestellt: 100ms)

[MENU] > SET > DTMF/T-CALL > DTMF Speed

Einstellung der DTMF-Sendegeschwindigkeit.
 • 100ms:  Übertragung der einzelnen DTMF-Töne mit 

etwa 100 ms pro Ton bzw. Pause.  
(5 DTMF-Töne pro Sekunde)

 • 200ms:  Übertragung der einzelnen DTMF-Töne mit 
etwa 200 ms pro Ton bzw. Pause.  
(2,5 DTMF-Töne pro Sekunde)

 • 300ms:  Übertragung der einzelnen DTMF-Töne mit 
etwa 300 ms pro Ton bzw. Pause. 
(1,6 DTMF-Töne pro Sekunde)

 • 500ms:  Übertragung der einzelnen DTMF-Töne mit 
etwa 500 ms pro Ton bzw. Pause. 
(1 DTMF-Ton pro Sekunde)

SPEECH Speed (voreingestellt: Fast)

[MENU] > SET > SPEECH > SPEECH Speed

Für die Ansagegeschwindigkeit kann man zwischen 
schnell und langsam wählen.

SPEECH Level (voreingestellt: 7)

[MENU] > SET > SPEECH > SPEECH Level

Einstellung der Ansagelautstärke von 0 (aus),  
1 (Minimum) bis 9 (Maximum).

 LDie Ansagelautstärke an die Einstellung des [VOL]-Reg-
lers gekoppelt. Sie wird allerdings nicht lauter als in 
diesem Menü eingestellt.

Spracheinstellungen
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QSO-/Empfangslog-Einstellungen

QSO Log (voreingestellt: ON)

[MENU] > SET > QSO/RX Log > QSO Log

Ein- und Ausschalten der QSO-Logfunktion, mit der 
sich ein Kommunikationslog im CSV-Format auf der 
SD-Karte speichern lässt.

 LZur Nutzung  dieser Funktion ist eine Micro-SD- 
Karte erforderlich (nicht im Lieferumfang enthalten).

 • OFF: QSO-Log-Funktion ausgeschaltet.
 • ON:  Das Handfunkgerät speichert das Kommuni-

kationslog auf der Micro-SD-Karte. Das Spei-
chern startet mit dem ersten Senden.

TIPP:
 • Der Ordner ist folgendermaßen benannt: [ID-52\QsoLog].
 • Die Dateinamen der QSO-Logs werden automatisch 
nach folgender Struktur vergeben: 
Log-Startdatum und -zeit: 1. November 2021 15:30:00 
Dateiname: 20211101_153000.csv

 • Die Inhalte der Log-Dateien lassen sich im Display des 
Handfunkgeräts nicht anzeigen.

 • Die Log-Dateien auf der Micro-SD-Karte kann man auf 
einem PC ansehen.

RX History Log (voreingestellt: OFF)

[MENU] > SET > QSO/RX Log > RX History Log

Ein- und Ausschalten der RX-History-Logfunktion 
für den DV-Modus, mit der sich ein Empfangslog im 
CSV-Format auf der Micro-SD-Karte speichern lässt.

 LZur Nutzung  dieser Funktion ist eine Micro-SD- 
Karte erforderlich (nicht im Lieferumfang enthalten).

 • OFF: Die RX-History-Logfunktion ist ausgeschaltet.
 • ON:  Das Handfunkgerät speichert für den DV-Modus 

ein Empfangslog auf der Micro-SD-Karte. Die 
Logeinträge erfolgen am Ende des Sendens.

TIPP:
 • Der Ordner ist folgendermaßen benannt: [ID-52\RxLog].
 • Die Dateinamen der RX-History-Logs werden automa-
tisch nach folgender Struktur vergeben: 
Log-Startdatum und -zeit: 1. November 2021 15:30:00 
Dateiname: 20211101_153000.csv

 • Die Inhalte der Log-Dateien lassen sich im Display des 
Handfunkgeräts nicht anzeigen.

 • Die Log-Dateien auf der Micro-SD-Karte kann man auf 
einem PC ansehen.

Separator/Decimal (voreingestellt: Sep[,] Dec[.])

[MENU] > SET > QSO/RX Log > CSV Format > Se-
parator/Decimal

Wahl der Sonderzeichen für Trennzeichen und Dezi-
malpunkt in den automatisch erzeugten CSV-Dateien.

 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.
 • Sep [,] Dec [.]:  Das Trennzeichen ist „,“ und der 

Dezimalpunkt ist „.“
 • Sep [;] Dec [.]:  Das Trennzeichen ist „;“ und der 

Dezimalpunkt ist „.“
 • Sep [;] Dec [,]:  Das Trennzeichen ist „;“ und der 

Dezimalpunkt ist „,“

Date (voreingestellt: mm/dd/yyyy)

[MENU] > SET > QSO/RX Log > CSV Format >  
Date

Wahl des Datumsformats zwischen „yyyy/mm/dd,“  
„mm/dd/yyyy“ und „dd/mm/yyyy.“
(y: Jahr, m: Monat, d: Tag)

 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.
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QSO-/Empfangslog-Einstellungen

In den QSO-Logdateien sind folgende Daten gespeichert:

Inhalt Beispiel Beschreibung

TX/RX TX RX Senden oder Empfang

Date
11/01/2021 
13:51:48

11/01/2021 
13:51:48

Sendebeginn und -datum

Frequency 438,010000 438,010000 Frequenz

Mode DV DV Sendeart (FM/FM-N/DV)

My Latitude 34,764667 34,764667
Breitengrad des eigenen Standorts in Grad
(+: nördliche Breite, –: südliche Breite)

My Longitude 135,375333 135,375333
Längengrad des eigenen Standorts in Grad
(+: östliche Länge, –: westliche Länge)

My Altitude 50,5 50,5
Höhe des eigenen Standorts in Metern,
Aufzeichnung mit einer Dezimalstelle

RF Power LOW (leer) Sendeleistung

S meter (leer) S0 Relative Empfangssignalstärke in 14 Stufen

RPT Call Sign JP3YHJ JP3YHJ A Repeater-Rufzeichen (nur DV-Modus)

TX Call Sign CQCQCQ (leer) TX-Rufzeichen (nur DV-Modus)

RX Call Sign (leer) JA3YUA A/52 RX-Rufzeichen (nur DV-Modus)

RX Latitude (leer) 34,764667

Breitengrad der Gegenstation in Grad  
(+: nördliche Breite, –: südliche Breite)
Nur wenn empfangen,  
Aufzeichnung nur im DV-Modus.

RX Longitude (leer) 135,375333

Längengrad der Gegenstation in Grad
(+: östliche Länge, –: westliche Länge)
Nur wenn empfangen,  
Aufzeichnung nur im DV-Modus.

RX Altitude (leer) 30,5
Höhe der Gegenstation in Metern
Nur wenn empfangen,  
Aufzeichnung nur im DV-Modus.
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QSO-/Empfangslog-Einstellungen

In den RX-Logdateien sind folgende Daten gespeichert:

Inhalt Beispiel Beschreibung

Frequency 438,010000 Empfangsfrequenz

Mode DV Sendeart (nur DV möglich)

Caller JA3YUA A Rufzeichen der empfangenen Station (Anrufer) (bis zu 8 Zeichen lang)

/ ID52
Anmerkung hinter dem Rufzeichen der empfangenen Station (Anrufer) 
(bis zu 4 Zeichen)

Called CQCQCQ Rufzeichen der angerufenen Station

Rx RPT1 JP3YHH G
Einstiegs-Repeater-Rufzeichen der anrufenden Station oder Gate-
way-Repeater-Rufzeichen des lokalen Repeaters im eigenen Gebiet

Rx RPT2 JP3YHH A Einstiegs-Repeater-Rufzeichen der angerufenen Station

Message Hello CQ D-STAR! Empfangene TX-Meldung (bis zu 20 Zeichen lang)

Status (leer)
Normal: leer, Uplink: „RPT UP“, Antwort des Einstiegs-Repeaters: „UR?“ 
oder „RPT?“

Received date
11/01/2021 
13:51:48

Empfangsdatum und -zeit
Das Format hängt von der Menüeinstellung ab.

BK * BK-Anruf: „*“, Normaler Anruf: leer

EMR * EMR-Anruf: „*“, Normaler Anruf: leer

Latitude 34,764667
Breitengrad der Gegenstation in Grad  
(+: nördliche Breite, –: südliche Breite)

Longitude 135,375333 Längengrad der Gegenstation in Grad (+: östliche Länge, –: westliche Länge)

Altitude 30,5 Höhe der Gegenstation in Metern, Aufzeichnung mit einer Dezimalstelle

SSID -A SSID des Anrufers, nur wenn gesendet (0, -1 bis -15, -A bis -Z)

D-PRS Symbol Car Icon: In Text umgesetzt; Keins: Code

Course 123 Kurs des Anrufers in Grad

Speed 23,5 Geschwindigkeit des Anrufers in km/h mit einer Dezimalstelle

Power 49 Sendeleistung in Watt

Height 24 Antennenhöhe in Metern

Gain 6 Antennengewinn in Dezibel

Directivity Omni Antennenstrahlrichtung (Omni, 45, 90, 135, 180, 225, 270, 315 oder 360)

Object/Item Name HAM FES Object- oder Item-Name (bis zu 9 Zeichen lang)

Data Type Live Object Status des Objects bzw. Items (Live oder Kill)

Temperature 20,5 Temperatur in °C, Aufzeichnung mit zwei Dezimalstellen

Rainfall 253,75 Regen in mm, Aufzeichnung mit zwei Dezimalstellen

Rainfall (24 hours) 253,75 Regen in 24 Stunden in mm, Aufzeichnung mit zwei Dezimalstellen

Rainfall (Midnight) 253,75 Regen (Mitternacht) in mm, Aufzeichnung mit zwei Dezimalstellen

Wind Direction 315 Windrichtung in Grad

Wind Speed 10,0 Windgeschwindigkeit in m/s, Aufzeichnung mit einer Dezimalstelle

Gust Speed 10,0 Böengeschwindigkeit in m/s), Aufzeichnung mit einer Dezimalstelle

Barometric 1013,0 Luftdruck in hPa, Aufzeichnung mit einer Dezimalstelle

Humidity 85 Luftfeuchtigkeit in %

GPS Time Stamp 12:00:00 Zeit, zu der die Positionsdaten beim Anrufer ermittelt wurden

GPS Message Osaka City/ID-52
Anrufer nutzt „NMEA“: Speichert GPS-Meldung
Anrufer nutzt „D-PRS: Speichert D-PRS-Anmerkung
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Funktionseinstellungen

Power Save (voreingestellt: Auto (Short))

[MENU] > SET > Function > Power Save

Einstellen der Energiesparfunktion, um den Strom-
verbrauch zu reduzieren und den Akku zu schonen. 
Bei aktivierter Funktion, wird das Rufzeichen oder der 
Beginn der Sendung möglicherweise nicht korrekt 
empfangen.

 • OFF:  Die Funktion ist ausgeschaltet.
 • Auto (Short):  Kurze Energiesparzeit.

15 ms

75 ms

Für 5 Sekunden wird
kein Signal empfangen

Stand-by

kein    →
Empfang

 • Auto (Middle):   Mittlere Energiesparzeit.
15 ms 15 ms

75 ms 150 ms

↑ 60 s
Für 5 Sekunden wird
kein Signal empfangen

Stand-by

kein    →
Empfang

 • Auto (Long): Lange Energiesparzeit.
 

↑

15 ms 15 ms

75 ms 300 ms

60 s
Für 5 Sekunden wird
kein Signal empfangen

Stand-by

kein    →
Empfang

HINWEIS: Die Energiesparfunktion ist deaktiviert:
 • wenn eine externe Gleichspannungsquelle benutz wird.
 • während eines Suchlaufs.
 • bei der Nutzung der DV-Gateway-Funktion.
 • bei der Nutzung der VOX-Funktion.

Monitor (voreingestellt: Push)

[MENU] > SET > Function > Monitor

Wahl einer Option für die [SQL]-Monitorfunktion.
(Siehe Basis-Bedienungsanleitung, Abschnitt 3)

 • Push:  [SQL] drücken und halten, um die Frequenz 
zu überwachen. Zum Beenden der Überwa-
chung Taste loslassen.

 • Hold:   [SQL] kurz drücken, um die Frequenz zu 
überwachen. Zum Beenden der Über-
wachung Taste erneut kurz drücken.

Dial Speed-UP (voreingestellt: ON)

[MENU] > SET > Function > Dial Speed-UP

Abstimmbeschleunigung ein- bzw. ausschalten.
Sie erhöht beim Drehen von [DIAL] automatisch die 
Abstimmgeschwindigkeit.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON: Die Funktion ist eingeschaltet.

Remote MIC Key

[MENU] > SET > Function > Remote MIC Key

Die zugewiesenen Funktionen der Tasten [A], [B],  
[] und [] am optionalen fernsteuermikrofons 
HM-75LS kann man ändern.
Zuweisbare Funktionen s. S. 12-19.

 • During RX/Standby:  Die zugewiesene Tastenfunk-
tion ist während des Empfangs 
oder im Stand-by-Modus 
aktiviert. 
(voreingestellt:  [A]: BAND 

[B]: VFO/
MR 
[]: UP 
[]: DOWN)

 • During TX:  Die zugewiesene Tastenfunk-
tion ist während des Sendens 
aktiviert. 
(voreingestellt:  [A]: T-CALL 

[B]: --- 
[]: --- 
[]: ---)

TIPP: Lautstärkeeinstellung während der  
Nutzung der Monitor-Funktion:

 • Wenn „VOL UP“/„VOL DOWN“ zugeordnet sind, diese 
Tasten drücken.

 • Wenn „VOL UP“/„VOL DOWN“ nicht zugeordnet sind, 
jedoch „UP“/„DOWN“, diese Tasten drücken.

 • Wenn „VOL UP“/„VOL DOWN“/„UP“/„DOWN“  nicht 
zugeordnet sind, []/[] drücken, es sei denn „Monitor 
(Push)“ oder „Monitor (Hold)“ ist []/[] zugewiesen.
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Funktionseinstellungen

Zuweisbare Tastenfunktionen
 • während des Empfangs/im Stand-by

Funktion Beschreibung

--- keine Funktion

UP Erhöht Frequenz, Nummer des Speicherkanals, des Repeaters oder Stationsrufzeichens.

DOWN Vermindert Frequenz, Nummer des Speicherkanals, des Repeaters oder Stationsrufzeichens.

VOL UP Erhöht die Lautstärke.

VOL DOWN Vermindert die Lautstärke.

SQL UP Erhöht den Squelch-Pegel.

SQL DOWN Vermindert den Squelch-Pegel.

Monitor (Push) Drücken und Halten, um den Squelch zu öffnen. Zum Schließen loslassen.

Monitor (Hold) Drücken, um den Squelch zu öffnen oder zu schließen.

CALL Wahl des Anrufkanals.

MR (00-00 CH) Im Speichermodus drücken, um Speicherkanal 00-00 zu wählen.

MR (00-01 CH) Im Speichermodus drücken, um Speicherkanal 00-01 zu wählen.

VFO/MR Wahl des VFO- bzw. des Speichermodus.

DR Ein- und Ausschalten der DR-Funktion.

FROM (DR) Im DR-Display drücken, um „FROM“ zu wählen.

TO (DR) Im DR-Display drücken, um „TO“ zu wählen.

Home CH
Im gewählten Modus (VFO-, Speicher- oder DR-Modus) drücken, um den Hauskanal direkt zu wählen.

 L Im Anrufkanalmodus oder wenn kein Hauskanal programmiert ist, ertönt beim Drücken ein Fehlerton.

BAND Drücken, um das Band umzuschalten.

SCAN Drücken, um den zuvor gewählten Suchlauf zu starten. Zum Stoppen des Suchlaufs erneut drücken.

Temporary Skip
Markieren einer Frequenz zum Überspringen während eines Suchlaufs.
Das temporäre Überspringen unerwünschter Frequenzen beschleunigt den Suchlauf.

RX>CS

1 Sekunde lang drücken, um das Rufzeichen der letzten anrufenden Station als Zielrufzeichen für „TO“ 
zu übernehmen.

 LWenn bei „[RX→CS] Key“ die Einstellung „RX > CS List“ gewählt ist, wird das Rufzeichen nicht 
übernommen. Stattdessen wird die RX-History angezeigt.
 LZum Wählen eines Rufzeichens aus der RX History mit dem optionalen Fernsteuermikrofon kann 
man diese Funktion den Tasten „UP“/„DOWN“ zuweisen.

SPEECH

 • Im VFO-, Speicher- und Anrufkanalmodus werden die Frequenz und die Sendeart angesagt.
 • Im DR-Modus erfolgt die Ansage des Rufzeichens.

 LBeim Simplex-Betrieb wird die Frequenz angesagt. 
Wenn ein FM-Repeater gewählt ist, werden die Frequenz und die Sendeart bzw. das Rufzeichen 
und die Sendeart angesagt.

MAIN/DUAL
 • Drücken, um Band A oder B als Hauptband zu wählen.
 • 1 Sek. lang drücken, um die Zweikanalüberwachung ein- bzw. auszuschalten.

MODE Wahl der Sendeart.

LOW Wahl der Sendeleistung.

DUP Ein- und Ausschalten des Duplex-Modus oder wechseln der Ablagerichtung zwischen DUP+ und DUP–.

TONE/D.SQL
 • Im FM/FM-N-Modus drücken, um einen CTCSS-Ton zu wählen.
 • Im DV-Modus drücken, um einen DCS-Code zu wählen.

MW
Im VFO-Modus oder im DR-Display drücken, um Speicherkanalinhalte in einen freien Speicherkanal zu 
schreiben.

REC
 • Eine Aufzeichnung starten.
 • Während einer Aufzeichnung 1 Sek. lang drücken, um die Aufzeichnung zu stoppen.

Voice TX
 • Drücken, um die auf der Micro-SD-Karte gespeicherte Sprachaufzeichnung ein Mal zu senden.
 • Drücken und Halten, um die Sprachaufzeichnung wiederholt zu senden.
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Funktionseinstellungen

Zuweisbare Tastenfunktionen
 • Während des Sendens

Funktion Beschreibungs

--- keine Funktion

VOL UP Erhöht die Lautstärke.

VOL DOWN Vermindert die Lautstärke.

Voice TX
 • Drücken, um die auf der Micro-SD-Karte gespeicherte Sprachaufzeichnung ein Mal zu senden.
 • Drücken und Halten, um die Sprachaufzeichnung wiederholt zu senden.
 LZum wiederholten Senden muss man die [PTT]-Taste nach Sendebeginn loslassen.

T-CALL Senden eines 1750-Hz-Ruftons.
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Funktionseinstellungen

Key Lock (voreingestellt: Normal)

[MENU] > SET > Function > Key Lock

Wahl der Art der Tastenverriegelung.

HINWEIS: Unabhängig von dieser Einstellung las-
sen sich die Tasten  [ ], [PTT] und [ ] immer 
bedienen.

 • Normal:  Alle Tasten und Bedienelemente außer 
[SQL] und [VOL] sind verriegelt.

 • No SQL:   Alle Tasten und Bedienelemente außer 
[SQL] sind verriegelt.

 • No VOL:  Alle Tasten und Bedienelemente außer 
[VOL] sind verriegelt.

 • ALL:  Alle Tasten und Bedienelemente sind  
verriegelt.

PTT Lock (voreingestellt: OFF)

[MENU] > SET > Function > PTT Lock

PTT-Verriegelung ein- bzw. ausschalten.
Um versehentliches Senden zu unterbinden, verhin-
dert diese Funktion alle Übertragungen.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON: Senden ist nicht möglich.

Busy Lockout (voreingestellt: OFF)

[MENU] > SET > Function > Busy Lockout

Busy-Lockout-Funktion ein- oder ausschalten.
Diese Funktion verhindert das Senden während des 
Empfangs eines Signals oder wenn die Rauschsperre 
geöffnet ist.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON: Die Funktion ist eingeschaltet.

Time-Out Timer (voreingestellt: 5min)

[MENU] > SET > Function > Time-Out Timer

Um unbeabsichtigtes Dauersenden zu verhindern, 
verfügt das Handfunkgerät über die Time-Out-Timer- 
Funktion. Senden ist nur für die eingestellte Zeit-
spanne möglich.

 • OFF: Die Funktion ist ausgeschaltet.
 • 1 bis 30 min:  Das Senden wird nach Ablauf der 

eingestellten Zeit beendet.  
(1, 3, 5, 10, 15 oder 30 Minuten).

Active Band (voreingestellt: All)

[MENU] > SET > Function > Active Band

Einstellung der fortlaufenden Frequenzwahl über alle 
Bänder mit [DIAL] .

 • Single:  Wenn man durch Drehen von [DIAL] die 
untere bzw. obere Bandgrenze erreicht, 
wird die höchste bzw. niedrigste Frequenz 
des angezeigten Bandes gewählt.

 • All:  Wenn man durch Drehen von [DIAL] die 
untere bzw. obere Bandgrenze erreicht, 
wird das jeweils nächste Band gewählt. Die 
Frequenzen aller Bänder lassen sich wählen.

 • HAM:  Wenn man durch Drehen von [DIAL] die 
untere bzw. obere Bandgrenze erreicht, wird 
die höchste bzw. niedrigste Frequenz des 
nächsten Amateurfunkband gewählt. Es 
sind nur Amateurfunkfrequenzen wählbar.

 LWenn man die Einstellung „Single“ gewählt hat und das 
Band wechseln möchte, drückt man [QUICK] und wählt 
dann „Band Select“.
 LDiese Einstellung gilt für [DIAL], d. h. alle Frequenzen 
werden gescannt.

MIC Gain (Internal) (voreingestellt: 2)

[MENU] > SET > Function > MIC Gain (Internal)

Einstellung der internen Mikrofonverstärkung zwi-
schen 1 (Minimum) und 4 (Maximum).
Bei höheren Werten ist das Mikrofon empfindlicher.

MIC Gain (External) (voreingestellt: 2)

[MENU] > SET > Function > MIC Gain (External)

Einstellung der externen Mikrofonverstärkung zwi-
schen 1 (Minimum) und 4 (Maximum).
Bei höheren Werten ist das Mikrofon empfindlicher.
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VOX (voreingestellt: OFF)

[MENU] > SET > Function > VOX > VOX

Ein- und Ausschalten der VOX-Funktion.
Die VOX (Voice Operated Exchange) schaltet das 
Handfunkgerät sprachgesteuert auf Senden um, so-
dass man nur in das Mikrofon sprechen muss, ohne 
dabei die [PTT] zu betätigen.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  Das Handfunkgerät schaltet beim Sprechen 

automatisch auf Senden und nach dem Ende 
des Sprechens auf Empfang zurück.

VOX Level (voreingestellt: 5)

[MENU] > SET > Function > VOX > VOX Level

Einstellung der VOX-Empfindlichkeit.
 • OFF: Die VOX-Funktion ist ausgeschaltet.
 • 1 bis 10:  1 (geringste Empfindlichkeit) 

10 (höchste Empfindlichkeit)

VOX Delay (voreingestellt: 0,5sec)

[MENU] > SET > Function > VOX > VOX Delay

Einstellung der VOX-Haltezeit zwischen 0,5, 1,0, 1,5, 
2,0, 2,5 oder 3,0 Sekunden. Wenn man aufhört zu 
sprechen, schaltet das Handfunkgerät erst nach Ablauf 
der eingestellten VOX-Haltezeit auf Empfang zurück.

VOX Time-Out Timer (voreingestellt: 3min)

[MENU] > SET > Function > VOX >  
VOX Time-Out Timer

Einstellung der Zeit für den VOX-Time-Out-Timer 
zur Verhinderung ungewollten Dauersendens infolge 
lauter Umgebungsgeräusche, die die VOX-Funktion 
aktivieren.

 • OFF: Die Funktion ist ausgeschaltet.
 • 1, 2, 3, 4, 5, 10 oder 15min:  
    Das VOX-gesteuerte Dauersenden wird nach 

Ablauf der eingestellten Zeit automatisch be-
endet.

Headset Select (voreingestellt: Other)

[MENU] > SET > Function > VOX > Headset Select

Wahl des Typs des angeschlossenen optionalen 
Headsets.

 • HS-95: Für die Nutzung des HS-95.
 • Other: Für die Nutzung des HS-94 oder HS-97.

CI-V Address (voreingestellt: A6)

[MENU] > SET > Function > CI-V > CI-V Address

Einstellung der CI-V-Adresse im Hexadezimalcode.
 LJedes CI-V-Gerät von Icom hat zur Unterscheidung seine 
eigene Standardadresse. Die voreingestellte ID-52E 
lautet „A6“. Wenn zwei oder mehr ID-52E gleichzeitig 
von einem PC aus gesteuert werden sollen, muss jedes 
Handfunkgerät eine unterschiedliche Adresse haben 
(Hexadezimalcodes von „02“ bis „DF“).

CI-V Baud Rate (SP Jack) (voreingestellt: Auto)

[MENU] > SET > Function > CI-V >  
CI-V Baud Rate (SP Jack)

Einstellung der CI-V-Datenübertragungsrate bei 
Steuerung des Handfunkgeräts über die [SP]- Buchse 
zwischen 300, 1200, 4800, 9600 und 19200 bps bzw. 
Auto. Bei „Auto“ wird die Datenrate entsprechend der 
des angeschlossenen Controllers automatisch ge-
wählt.

CI-V Transceive (voreingestellt: OFF)

[MENU] > SET > Function > CI-V > CI-V Transceive

Ein- und Ausschalten der CI-V-Transceive-Funktion.
 LBei Nutzung der Apps RS-MS1A oder RS-MS1I muss 
diese Funktion eingeschaltet sein.
 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  Wenn die CI-V-Transceive-Funktion einge-

schaltet ist, erfolgen alle Änderungen bzw. 
Einstellungen an einem der verbundenen 
Transceiver bzw. Empfänger immer auch auf 
dem anderen.

CI-V USB/Bluetooth→ 
REMOTE Transceive Address (voreingestellt: 00)

[MENU] > SET > Function > CI-V >  
CI-V USB/Bluetooth→REMOTE Transceive Address

Wenn das Handfunkgerät bei eingeschalteter Trans-
ceive-Funktion über ein USB-Kabel oder Bluetooth 
ferngesteuert wird, erfolgt die Steuerung eines ande-
ren Geräts im selben System über die [SP]-Buchse.
Um die externe Steuerung eines Icom-Transceivers 
zu verhindern, darf die Adresse nicht „00“ sein.
Das Steuersignal wird über die [SP]-Buchse ausgege-
ben. Hexadezimale Adresse zwischen „00“ und „DF“ 
einstellen.
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USB Connect (voreingestellt: Serialport)

[MENU] > SET > Function > USB Connect

Wahl der Option beim Anschluss des Handfunkgeräts 
an einen PC über ein USB-Kabel.

 • Charge Only: 
  Das USB-Kabel dient nur zum Laden des Akku-

packs im Handfunkgerät.
 • Serialport: 
  Das Handfunkgerät kann über das USB-Kabel 

programmiert und per CI-V ferngesteuert werden 
und es lassen sich D-STAR-Daten sowie GPS-In-
formationen ausgeben.

 L Information
 • Auf dem PC muss ein USB-Treiber installiert sein.
 • Wenn ein PC angeschlossen ist, erscheint die USB-Verbin-
dungsanzeige  im Display des Handfunkgeräts.
 • Die Art der Datenein- und Ausgabe wählt man im  
Menüpunkt „USB Serialport Function.“
 • Soll die Ausgabe von GPS-Daten erfolgen, muss bei  
„GPS Select“ die Einstellung „ON“ gewählt werden. 
([MENU] > GPS > GPS Set > GPS Select)

 • SD Card Mode: 
  Man kann über ein USB-Kabel vom PC aus auf 

die Micro-SD-Karte im Handfunkgerät zugreifen.
 LEin Bestätigungsdialog erscheint. (S. 2-9)

HINWEIS:
 • Zum Laden an einem PC ist bei „USB Power Input 
(Phone, Tablet, PC)“die Einstellung „ON“ zu wählen.

 • Verwenden Sie ein für Datenkommunikation kompatib-
les USB-Kabel, wenn „Serialport“ oder „SD Card  
Mode“ ausgewählt sind.

 • Im SD Card-Modus arbeitet das ID-52E nicht als Hand-
funkgerät, sondern dient als USB-Speichermedium. 
Auch die Aufzeichnung und das Loggen werden unter-
brochen.

TIPP: USB-Treiber und Installationsanleitung stehen 
auf der Icom-Website zum Herunterladen zur Ver-
fügung.
https://www.icomjapan.com/support/

USB Serialport Function 
 (voreingestellt: CI-V (Echo Back OFF))

[MENU] > SET > Function > USB Serialport Function

Einstellung der Serialport-Funktion zur Verbindung 
über USB mit einem PC usw.

 • CI-V (Echo Back OFF): 
    Die CI-V-Befehle werden über USB 

ein- oder ausgegeben. Die CI-V-Befehle 
werden nicht zurückgesendet.

 • CI-V (Echo Back ON): 
    Die CI-V-Befehle werden über USB ein- 

oder ausgegeben. Die CI-V-Befehle wer-
den über den USB-Port zurückgesendet.

 • DV Data:  DV-Daten werden über den USB-Port 
ein- oder ausgegeben.

HINWEIS: Bei der Wahl von „CI-V (Echo Back OFF)“ 
oder „CI-V (Echo Back ON)“ lässt sich das Hand-
funkgerät nicht über die [SP]-Buchse fernsteuern.

Heterodyne (voreingestellt: Normal)

[MENU] > SET > Function > Heterodyne

Wahl der Lage der Frequenz des 1. Local-Oszillators.
Je nach Kombination von zwei Frequenzen beim 
Doppelempfang kann es auf einzelnen Frequenzen 
zu schwachen Störsignalen kommen. Diese führen 
u. U. auch zum Ausschlag des S-Meters, obwohl kein 
Nutzsignal vorhanden ist. Diesem Effekt, der tech-
nisch bedingt ist und daher keine Fehlfunktion dar-
stellt, kann man begegnen, indem man die Lage der 
1. Oszillatorfrequenz verschiebt.



12 SET-MODUS

12-24

Funktionseinstellungen

Battery Pack Select (voreingestellt: BP-271/BP-272)

[MENU] > SET > Function > Battery Pack Select

Für die korrekte Anzeige des Akkuzustands empfiehlt 
es sich, in diesem Menüpunkt den Typ des verwende-
ten Akkupacks zu wählen.

Battery Pack Confirmation (voreingestellt: OFF)

[MENU] > SET > Function > Battery Pack Confirmation

Wahl, ob das Dialogfeld für die Akkuauswahl bei 
jedem Akkuwechsel angezeigt wird.

Charging (Power ON) (voreingestellt: ON)

[MENU] > SET > Function > Charging (Power ON)

Wenn ein Akkupack angebracht ist und das Hand-
funkgerät über eines der optionalen Kabel CP-12L 
oder OPC-254L mit Gleichspannung versorgt wird, 
lässt sich der Akkupack bei eingeschaltetem Hand-
funkgerät laden.

USB Power Input (Phone, Tablet, PC) 
 (voreingestellt: ON)

[MENU] > SET > Function >  
USB Power Input (Phone, Tablet, PC)

Ein- oder Ausschalten der Nutzung eines Mobilgeräts 
oder eines PCs als externe USB-Spannungsquelle.

Screen Capture [PWR] Key (voreingestellt: OFF)

[MENU] > SET > Function > Screen Capture [PWR] Key

Der Taste [ ] kann man die Screen-Capture-Funktion 
zum Erstellen von Displayfotos zuweisen.

 • OFF:  Mit [ ] können keine Displayfotos erstellt 
werden.

 • ON:  Durch kurzes Drücken von [ ] lässt sich ein 
Displayfoto erzeugen und auf der  
Micro-SD-Karte speichern.

Screen Capture File Type (voreingestellt: BMP)

[MENU] > SET > Function > Screen Capture File Type

Wahl des Datenformats für das Displayfoto zwischen 
PNG oder BMP.

LO/CALL Key Actions (voreingestellt: Standard)

[MENU] > SET > Function > LO/CALL Key Actions

Einstellen, ob die Bedienung der Tasten [CALL], [LO] 
und [MR] wie beim ID-51E erfolgen soll.

 • Standard:  Die Tastenbedienung ändert sich nicht.
 • ID-51 Compatible (CS/LOW): 
    Die Tastenbedienung ändert sich folgen-

dermaßen:
    [CALL]:  1 Sek. lang drücken, um die 

Sendeleistung zu ändern.
    [LO]:  Im DV-Modus 1 Sek. lang  

drücken, um das „CALL SIGN“- 
Display anzuzeigen.

    [MR]:  Drücken, um den Speichermo-
dus aufzurufen, erneut drücken, 
um den Anrufkanalmodus aufzu-
rufen. 

[CALL]
[MR]

[LO]
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Backlight (voreingestellt: Auto (DC IN:ON))

[MENU] > SET > Display > Backlight

Wahl einer Option für die Hintergrundbeleuchtung von 
Display und Tasten.

 • OFF: Keine Hintergrundbeleuchtung.
 • ON:  Die Hintergrundbeleuchtung ist dauerhaft 

eingeschaltet.
 • Auto:  Die Hintergrundbeleuchtung schaltet sich 

ein, sobald das Handfunkgerät bedient wird. 
Nach Ablauf der bei „Backlight Timer“ einge-
stellten Zeit wird die Helligkeit reduziert*.

 • Auto (DC IN:ON):  
    Die Hintergrundbeleuchtung schaltet sich 

ein, sobald das Handfunkgerät bedient wird. 
Nach Ablauf der bei „Backlight Timer“ einge-
stellten Zeit wird die Helligkeit reduziert*.

    L Bei Anschluss einer externen Gleichspannungs-
versorgung ist die Hintergrundbeleuchtung 
dauerhaft eingeschaltet.

 L Im GPS-Logger-Modus wirkt ständig die „Auto“-Einstel-
lung.

*  Wenn die Helligkeitsreduzierung bei „Dim Screen“ deak-
tiviert ist, schaltet sich die Hintergrundbeleuchtung nach 
Ablauf der bei „Backlight Timer“ eingestellten Zeit aus.

Backlight Timer (voreingestellt: 10sec)

[MENU] > SET > Display > Backlight Timer

Auswahl der Leuchtzeit der Hintergrundbeleuchtung 
zwischen 5, 10 und 30 Sekunden.
Nach Ablauf der eingestellten Zeit wird die Helligkeit 
reduziert.

 LWenn die Dimmer-Funktion deaktiviert ist, schaltet sich 
die Hintergrundbeleuchtung nach Ablauf eingestellten 
Zeit aus.

Brightness (voreingestellt: 8)

[MENU] > SET > Display > Brightness

Einstellung der Helligkeit der Hintergrundbeleuchtung  
zwischen 1 (dunkel, gedimmt) und 8 (hell).

Dim Screen (voreingestellt: ON)

[MENU] > SET > Display > Dim Screen

Ein- und Ausschalten der Dimmer-Funktion.
 • OFF:  Die Hintergrundbeleuchtung schaltet sich 

nach Ablauf der bei „Backlight Timer“ einge-
stellten Zeit aus.

 • ON:  Die Hintergrundbeleuchtung wird nach Ablauf 
der bei „Backlight Timer“ eingestellten Zeit 
automatisch auf die bei „Brightness (Dim)“ ein-
gestellte Helligkeitsstufe gedimmt und erlischt 
nach der bei „Dim Timer“ eingestellten Zeit.

Darstellung der Dimmer-Funktion

Dim Timer (voreingestellt: 1min)

[MENU] > SET > Display > Dim Timer

Einstellung des Dimm-Timers. Bei eingeschalteter 
Dimm-Funktion schaltet sich die gedimmte Hinter-
grundbeleuchtung nach der eingestellten Zeit auto-
matisch ab.

 • 1/2/5/10min:  Abschalten nach der eingestellten Zeit.
 • Hold:  Hintergrundbeleuchtung bleibt gedimmt.

Brightness (Dim) (voreingestellt: 1)

[MENU] > SET > Display > Brightness (Dim)

Wahl der Dimmer-Helligkeitsstufe zwischen  
1 (dunkel, gedimmt) und 7 (hell).

 LDie Dimmer-Helligkeit muss niedriger eingestellt sein als 
die Helligkeit der Hintergrundbeleuchtung.
 LDie eingestellte Helligkeit lässt sich im „Brightness“-Dis-
play überprüfen.

Background Color (voreingestellt: White)

[MENU] > SET > Display > Background Color

Wahl von Schwarz oder Weiß für den Displayhintergrund.

Contrast (voreingestellt: Standard)

[MENU] > SET > Display > Contrast

Kontrasteinstellung des Displays (Light, Standard 
oder Dark).

Bedienung keine Bedienung

Dimmer-Funktion
eingeschaltet

Helligkeit wie bei 
„Brightness“ gewählt

(voreingestellt: 8)

Helligkeit wie bei 
„Brightness (Dim)“ gewählt

(voreingestellt: 1)

Dim Timer
(voreingestellt: 

1min)

1 2 3 4 5 6 7 8

Backlight Timer
(voreingestellt:

10sec)

Beleuchtung
verlischt
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Busy LED (voreingestellt: ON)

[MENU] > SET > Display > Busy LED

Normalerweise leuchtet die TX/RX-LED grün, wenn 
ein Signal empfangen wird oder der Squelch geöffnet 
ist. Zur Reduzierung der Stromaufnahme kann die 
LED ausgeschaltet werden.

 LBeim Senden leuchtet die LED unabhängig von dieser 
Einstellung rot.
 • OFF:  Die LED leuchtet nicht, wenn ein Signal emp-

fangen wird oder der Squelch geöffnet ist.
 • ON:  Die LED leuchtet grün, wenn ein Signal emp-

fangen wird oder der Squelch geöffnet ist.

RX Call Sign (voreingestellt: Normal)

[MENU] > SET > Display > RX Call Sign

Einstellung für die Anzeige des Rufzeichens und der 
Meldung einer anrufenden Station beim Empfang 
eines Anrufs im DV-Modus.

 • OFF:  Rufzeichen und Meldung des Anrufers 
werden nicht angezeigt.

 • Normal:  Rufzeichen und Meldung des Anrufers 
scrollen einmal durch das Display und 
verschwinden danach.

 • RX Hold:  Rufzeichen und Meldung des Anrufers 
scrollen einmal durch das Display. Dann 
wird das Rufzeichen im Display angezeigt 
bis das Signal verschwindet.

 • Hold:  Rufzeichen und Meldung des Anrufers 
scrollen einmal durch das Display. Dann 
wird das Rufzeichen im Display angezeigt 
bis das Signal verschwindet. Nach dem 
Verschwinden des Signals, werden das 
Rufzeichen und die Meldung jeweils  
2 Sekunden lang wiederholt angezeigt.

 LWenn „Normal“, „RX Hold“ oder „Hold“ eingestellt ist und 
das Rufzeichen und der Name des Anrufers gespeichert 
sind, erscheint der Name hinter dem Rufzeichen.

RX Position Indicator (voreingestellt: ON)

[MENU] > SET > Display > RX Position Indicator

Wahl, ob mit einem Symbol angezeigt werden soll, 
dass das im DV-Modus empfangenen Signal Posi-
tionsdaten enthält.

 • OFF:  Keine Anzeige, auch wenn Positionsdaten im 
empfangenen Signal enthalten sind.

 • ON:  Ein Symbol signalisiert, dass das empfange-
nen Signal Positionsdaten enthält.

 LWenn bei „RX Call Sign“ die Einstellung „OFF“ gewählt 
wurde erfolgt keine Symbolanzeige, auch wenn Posi-
tionsdaten im empfangenen Signal enthalten sind.

RX Position Display (voreingestellt: ON (Main/Sub))

[MENU] > SET > Display > RX Position Display

Wahl, ob im DV-Modus empfangene GPS-Positions-
daten des Anrufers angezeigt werden sollen.

 • OFF:  Die Positionsdaten werden nicht angezeigt.
 • ON (Main/Sub): 
    Wenn das empfangene Signal Positionsdaten 

enthält, werden sie angezeigt.
 • ON (Main Only): 
    Wenn das auf dem Hauptband empfangene 

Signal Positionsdaten enthält, werden sie an-
gezeigt.

 LDie Anzeigedauer der Positionsdaten lässt sich bei  
„RX Position Display Timer“ einstellen.

RX Position Display Timer (voreingestellt: 10sec)

[MENU] > SET > Display > RX Position Display Timer

Einstellung der Anzeigedauer der Positionsdaten.
 • 5/10/15/30sec:  Die Positionsdaten werden für die 

eingestellte Zeit angezeigt.
 • Hold:  Die Positionsdaten werden so  

lange angezeigt, bis eine Bedienung 
erfolgt.

Reply Position Display (voreingestellt: ON)

[MENU] > SET > Display > Reply Position Display

Ein- und Ausschalten der Anzeige der Positionsdaten 
des Anrufers die in seiner automatischen Antwort ent-
halten sind.

 • OFF: Keine Anzeige der Positionsdaten.
 • ON:  Automatische Anzeige der Positionsdaten 

des Anrufers.

RX Picture Indicator (voreingestellt: ON)

[MENU] > SET > Display > RX Picture Indicator

Wahl, ob mit einem Symbol angezeigt werden soll, 
dass das empfangenen Signal ein Bild enthält.

 • OFF:  Keine Anzeige, auch wenn ein Bild im emp-
fangenen Signal enthalten ist.

 • ON:  Ein Symbol signalisiert, dass das empfange-
nen Signal ein Bild enthält.

 LWenn bei „RX Call Sign“ die Einstellung „OFF“ gewählt 
wurde erfolgt keine Symbolanzeige, auch wenn ein Bild 
im empfangenen Signal enthalten ist.
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DV RX Backlight (voreingestellt: ON)

[MENU] > SET > Display > DV RX Backlight

Ein- und Ausschalten der DV-RX-Hintergrund-
beleuchtung. Im DV-Modus kann diese Funktion die 
Displaybeleuchtung automatisch einschalten, sobald 
das Rufzeichen einer anrufenden Station oder eine 
Meldung im Display angezeigt wird.

 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  Die Hintergrundbeleuchtung schaltet sich 

automatisch ein, sobald das Rufzeichen einer 
anrufenden Station oder eine Meldung im 
Display angezeigt wird. Sie bleibt eingeschal-
tet, solange das Rufzeichen oder die Meldung 
durch das Display scrollt.

HINWEIS: Für die Nutzung dieser Funktion muss im 
Menüpunkt „Backlight“ die Einstellung „Auto“ oder 
„Auto (DC IN:ON)“ gewählt werden.

TX Call Sign (voreingestellt: Your Call Sign)

[MENU] > SET > Display > TX Call Sign

Einstellung für die Anzeige des eigenen Rufzeichens 
bzw. des Ziel-Rufzeichens beim Senden.

 • OFF: Die Funktion ist ausgeschaltet.
 • Your Call Sign:  Das Rufzeichen der Zielstation 

scrollt durch das Display.
 • My Call Sign:  Das eigene Rufzeichen scrollt durch 

das Display.
 LWenn man „Your Call Sign“ wählt und Rufzeichen und 
Name der Zielstation gespeichert sind, erscheint der 
Name in allen DV-Modi mit Ausnahme der DR-Funktion 
nach dem Rufzeichen.

Scroll Speed (voreingestellt: Fast)

[MENU] > SET > Display > Scroll Speed

Wahl der Scroll-Geschwindigkeit bei der Anzeige von 
Meldungen, Rufzeichen usw. aus „Slow“ (langsam) 
oder „Fast“ (schnell).

Opening Message (voreingestellt: ON)

[MENU] > SET > Display > Opening Message

Ein- und Ausschalten der Anzeige der Einschaltmel-
dung, die nach dem Einschalten des Handfunkgeräts 
im Display erscheint
Wählt man „ON“, werden das Icom-Logo, der Geräte-
name und das eigene Rufzeichen angezeigt.

Voltage (Power ON) (voreingestellt: ON)

[MENU] > SET > Display > Voltage (Power ON)

Wahl, ob beim Einschalten die Akku-Spannung bzw. die 
der externen Stromversorgung angezeigt werden soll.

HINWEIS: Falls die externe Versorgungsspannung 
höher als 15,6 V ist, wird „HI Voltage“ angezeigt. 
Trennen Sie in diesem Fall sofort das Handfunkgerät 
von der externen Spannungsversorgung.

Single Band Display (voreingestellt: Date)

[MENU] > SET > Display > Single Band Display

Wahl, ob Datum oder GPS-Informationen am unteren 
Rand der Einzelbandanzeige angezeigt werden sollen.

 • Date: Datumsanzeige.
 • GPS Information: Anzeige von GPS-Informationen.

Latitude/Longitude (voreingestellt: dddº mm.mm′)

[MENU] > SET > Display > Display Unit >  
Latitude/Longitude

Wahl des Anzeigeformats für Positionsdaten.

Altitude/Distance (voreingestellt: ft/mi)

[MENU] > SET > Display > Display Unit >  
Altitude/Distance

Wahl des Anzeigeformats für Höhe und Entfernung.
 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.

Speed (voreingestellt: mph)

[MENU] > SET > Display > Display Unit > Speed

Wahl des Anzeigeformats für die Geschwindigkeit.
 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.

Temperature (voreingestellt: ºF)

[MENU] > SET > Display > Display Unit > Temperature

Wahl des Anzeigeformats für die Temperatur.
 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.

Barometric (voreingestellt: inHg)

[MENU] > SET > Display > Display Unit > Barometric

Wahl des Anzeigeformats für den Luftdruck.
 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.
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Rainfall (voreingestellt: inch)

[MENU] > SET > Display > Display Unit > Rainfall

Wahl des Anzeigeformats für die Niederschlagsmenge.
 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.

Wind Speed (voreingestellt: mph)

[MENU] > SET > Display > Display Unit > Wind Speed

Wahl des Anzeigeformats für die Windgeschwindigkeit.
 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.

Display Language (voreingestellt: English)

[MENU] > SET > Display > Display Language

Wahl der Sprache für die Displaydarstellung aus Eng-
lisch oder Japanisch.

 LDieser Menüpunkt erscheint nur, wenn Japanisch als 
Systemsprache gewählt wurde.

System Language (voreingestellt: English)

[MENU] > SET > Display > System Language

Wahl der Systemsprache des Handfunkgeräts.
 • English:  Die Systemsprache ist Englisch. Es kön-

nen nur Buchstaben und Ziffern (A bis Z, 
a bis z, 0 bis 9) und Sonderzeichen (! „ # 
$ % & ‘ ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` 
{ | } ~) angezeigt werden.  
Falls japanische Schriftzeichen (Kanji, 
Hiragana und Katakana) in den Texten 
enthalten sein sollten, werden diese im 
Display mit „=“ oder „_“ anstelle des 
eigentlichen Schriftzeichens dargestellt. 
In diesem Fall kann man „=“ oder „_“ 
über den Editiermodus löschen.

 • Japanese:  Die Systemsprache ist Japanisch. Kanji-, 
Hiragana- und Katakana-Schriftzeichen 
sowie die 2-Bytes-Symbole werden an-
gezeigt. Um solche Zeichen für die An-
zeigen im DR-Modus und im Menü-Sys-
tem zu nutzen, muss im Menü „Display 
Language“ „Japanese“ gewählt sein.

 LWenn Englisch als Systemsprache eingestellt ist,  
wird der Menüpunkt „Display Language“ nicht angezeigt.

Wenn als Systemsprache Japanisch gewählt ist, 
kann das ID-52E sowohl japanische als auch eng-
lische Zeichen anzeigen. Wählt man jedoch Japa-
nisch als Sprache für die Displaydarstellung, er-
scheinen alle Menüs mit japanische Schriftzeichen, 
es gibt keine englischen Bezeichnungen. Sofern 
man nicht der japanischen Schriftsprache mächtig 
ist, sollte man unter keinen Umständen Japanisch 
wählen.
Wenn die Sprache auf Japanisch geändert wurde, 
kann man sie mit einem Teil-Reset auf Englisch  
zurücksetzen. Dabei bleiben die gespeicherten  
Rufzeichen erhalten. 

Folgende Schritte sind für einen Teil-Reset erforderlich:
1. MENU] drücken.
2. „SET“ wählen. 

3. Menüpunkt mit dem „etc“-Symbol wählen. 

4. Untersten Menüpunkt wählen. 

5. Oberen Menüpunkt wählen. 

 LNICHT den unteren Menüpunkt wählen! Er bewirkt 
einen Total-Reset, bei dem alle Eingaben gelöscht 
und alle Einstellungen auf die Werkseinstellung zu-
rückgesetzt werden.

6. Obere Option wählen. 

 • Wenn der Teil-Reset abgeschlossen ist, wird  
„PARTIAL RESET“ angezeigt, anschließend kehrt 
das Handfunkgerät zum Standard-Display zurück.
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Volume Select (voreingestellt: All)

[MENU] > SET > Sounds > Volume Select

Wahl der Wirkung der Lautstärkeeinstellung mit dem 
[VOL]-Regler.

 • All:  Die Lautstärkeeinstellung erfolgt gleich-
zeitig für den FM-Rundfunkempfang, das 
Band A (VFO A) und das Band B (VFO B).

 • FM Radio Separate:  
    Die Lautstärkeeinstellung für den 

FM-Rundfunkempfang erfolgt separat, 
für Band A (VFO A) und B (VFO B) erfolgt 
sie gleichzeitig. 

 • Separate:  Die Lautstärkeeinstellung erfolgt separat 
für den FM-Rundfunkempfang, das Band 
A (VFO A) und das Band B (VFO B).

HINWEIS: Beim Empfang eines EMR-Signals wird 
die Lautstärke für Band A und/oder Band B entspre-
chend dieser Einstellung auf die für den EMR-Emp-
fang voreingestellte festgelegt.

 LDie Lautstärke für den FM-Rundfunkempfang bleibt 
unverändert, da die EMR-Funktion nur im DV-Modus 
verfügbar ist.

Wenn „All“ oder „FM Radio Separate“ gewählt ist:
Die Lautstärke für Band A und Band B wird auf die 
für den EMR-Empfang voreingestellte festgelegt.

Wenn „Separate“ gewählt ist:
Die Lautstärke für das Band (A oder B) auf dem 
das Signal empfangen wird, ist auf die für den 
EMR-Empfang voreingestellte festgelegt.

FM Radio Level (voreingestellt: 0)

[MENU] > SET > Sounds > FM Radio Level

Einstellung der Lautstärkedifferenz zwischen FM-
Rund funkempfang sowie Band A und Band B für die 
Einstellung „All“ bei „Volume Select“.

 • +5 bis +1:  Die Empfangslautstärke für FM-Rundfunk 
ist höher als die der Bänder A und B.

 • 0:   Die Empfangslautstärke für FM-Rundfunk 
ist gleich der der Bänder A und B.

 • –5 bis –1:  Die Empfangslautstärke für FM-Rundfunk 
ist niedriger als die der Bänder A und B.

Earphone Mode (voreingestellt: OFF)

[MENU] > SET > Sounds > Earphone Mode

Ein- und Ausschalten des Ohrhörer-Modus.
Im Ohrhörer-Modus wird die Lautstärke eines op-
tionalen, an der [MIC/SP]-Buchse angeschlossenen 
Ohrhörers automatisch auf einen angenehmen Wert 
justiert.

Beep Level (voreingestellt: 3)

[MENU] > SET > Sounds > Beep Level

Einstellung der Lautstärke der Quittungs- und sons-
tigen Töne im Bereich von 0 (AUS) oder 1 (Minimum) 
bis 9 (Maximum).

Beep/Vol Level Link (voreingestellt: OFF)

[MENU] > SET > Sounds > Beep/Vol Level Link

Wahl, ob die Lautstärke der Quittungs- und sonstigen 
Töne durch Drehen von [VOL] eingestellt werden kann.

 • OFF:  Die Lautstärke entspricht der bei  
„Beep Level“ eingestellten.

 • ON:  Die Lautstärke wird mit dem [VOL]-Regler 
eingestellt.

Key-Touch Beep (voreingestellt: ON)

[MENU] > SET > Sounds > Key-Touch Beep

Ein- und Ausschalten der Tastentons.
 • OFF: Kein Tastenton.
 • ON: Beim Betätigen einer Taste ertönt ein Piepton.

Home CH Beep (voreingestellt: ON)

[MENU] > SET > Sounds > Home CH Beep

Ein- und Ausschalten des Hinweistons bei der Wahl 
des Hauskanals.

 • OFF: Kein Hinweiston.
 • ON:  Wenn der Hauskanal gewählt wird, ertönt ein 

Hinweiston.
 LWenn im VFO- oder Speichermodus die Hauskanalfre-
quenz oder der Hauskanalspeicher gewählt wird, ertönt 
ein Hinweiston.
 LWenn im DR-Display bei „FROM“ der Einstiegs-Repeater 
für den Hauskanal eingestellt wird, ertönt ein Hinweiston.

Band Edge Beep (voreingestellt: OFF)

[MENU] > SET > Sounds > Band Edge Beep

Ein- und Ausschalten der Bandgrenzenwarntöne.
 • OFF: Kein Bandgrenzenwarnton.
 • ON:  Wenn man beim Einstellen der Frequenz den 

Bereich des Flugfunk-, VHF- oder UHF-Ban-
des verlässt bzw. wieder in diesen eintritt, 
ertönt ein Warnton.

Scan Stop Beep (voreingestellt: OFF)

[MENU] > SET > Sounds > Scan Stop Beep

Ein- und Ausschalten des Hinweistons für das Stop-
pen des Suchlaufs.

 • OFF:  Kein Hinweiston.
 • ON:  Der Hinweiston ist hörbar, wenn der Suchlauf 

auf einem Signal stoppt.
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Standby Beep 
 (voreingestellt: ON (to me:Alarm/High Tone))

[MENU] > SET > Sounds > Standby Beep

Ein- und Ausschalten des Stand-by-Tons.
Der Stand-by-Ton ertönt, wenn im DV-Modus ein 
Signal nicht mehr empfangen wird.

 • OFF:  Stand-by-Ton ausgeschaltet.
 • ON:  Stand-by-Ton eingeschaltet.
 • ON (to me:High Tone): 
    Wenn ein an das eigene Rufzeichen gerich-

teter Anruf nicht mehr hörbar ist, ertönt ein 
hoher Ton, bei anderen Anrufen ein normaler 
Stand-by-Ton.

 • ON (to me:Alarm/High Tone): 
    Wenn ein an das eigene Rufzeichen gerich-

teter Anruf nicht mehr hörbar ist, ertönt ein 
Alarmton (PiRoPiRoPiRo), bei anderen Anru-
fen ein normaler Stand-by-Ton.

 LStand-by-Töne sind auch hörbar, wenn der Tastenton 
ausgeschaltet ist.
 LDie Lautstärke der Stand-by-Töne entspricht der Einstel-
lung bei „Beep Level“.

Sub Band Mute (voreingestellt: OFF)

[MENU] > SET > Sounds > Sub Band Mute

Einstellung für die Stummschaltung des Subbandes 
während des Empfangs auf dem Hauptband und/
oder des Hinweistons für auf dem Subband nicht 
mehr empfangbare Signale.

 • OFF: Die Funktion ist ausgeschaltet.
 • Mute:  Während des Empfangs auf dem 

Hauptband ist das Subband stumm-
geschaltet.

 • Beep:  Wenn das Signal auf dem Subband 
nicht mehr empfangen wird, ist ein 
Hinweiston hörbar.

 • Mute & Beep:  Während des Empfangs auf dem 
Hauptband ist das Subband stumm-
geschaltet. Wenn während des Emp-
fangs auf dem Subband das emp-
fangene Signal verschwindet, ist ein 
Hinweiston hörbar.

 LWenn man die Einstellung „Beep“ oder „Mute & Beep“ 
wählt, ist dieser Hinweiston auch hörbar, wenn auf dem 
Hauptband kein Signal empfangen wird.

Zeiteinstellungen

DATE

[MENU] > SET > Time Set > Date/Time > DATE

Manuelle Einstellung des Datums von 2020/01/01 bis 
2099/12/31.

 LDie Wochentag wird automatisch eingestellt.

TIME

[MENU] > SET > Time Set > Date/Time > TIME

Manuelle Einstellung der Zeit. Die Anzeige erfolgt im 
24-Stunden-Format rechts oben im Display.
Wenn bei „GPS Time Correct“ die Einstellung „Auto“ 
gewählt ist, stellt der GPS-Empfänger die Zeit auto-
matisch anhand der empfangenen UTC und der Zeit-
verschiebung ein.

GPS Time Correct (voreingestellt: Auto)

[MENU] > SET > Time Set > GPS Time Correct

Ein- und Ausschalten der automatischen Zeitkorrektur 
anhand empfangener GPS-Signale.

 • OFF: Die angezeigte Zeit wird nicht korrigiert.
 • Auto:  Die Zeit wird automatisch anhand der emp-

fangenen UTC und der Zeitverschiebung 
korrigiert.

UTC Offset (voreingestellt: ±0:00)

[MENU] > SET > Time Set > UTC Offset

Einstellung der Zeitverschiebung von –14:00 bis 
+14:00.

Auto Power OFF (voreingestellt: OFF)

[MENU] > SET > Time Set > Auto Power OFF

Diese Funktion schaltet das Handfunkgerät automa-
tisch aus, wenn innerhalb der eingestellten Zeit keine 
Bedienung erfolgt.

 L5 Sekunden bevor sich das Handfunkgerät ausschal-
tet, erscheint „AUTO POWER OFF“ im Display und ein 
Signalton ertönt. Erfolgt während dieser Zeitspanne eine 
Bedienung, wird der Timer für die automatische Abschal-
tung zurückgesetzt.
 • OFF:  Das Handfunkgerät schaltet sich nicht auto-

matisch aus.
 • 30/60/90/120min: 
    Das Handfunkgerät schaltet sich automatisch 

aus, wenn innerhalb der eingestellten Zeit kei-
ne Bedienung erfolgt.
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Einstellungen und Menübefehle für die Micro-SD-Karte

Date (voreingestellt: mm/dd/yyyy)

[MENU] > SET > SD Card > Import/Export >  
CSV Format > Date

Wahl des Datumsformats aus: „yyyy/mm/dd,“  
„mm/dd/yyyy“ und „dd/mm/yyyy.“ 
(y: Jahr, m: Monat, d: Tag)

 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.

Opening Picture

[MENU] > SET > SD Card > Opening Picture

Einstellen des Startbildes.
 LDetails s. S. 15-14.

SD Card Info

[MENU] > SET > SD Card > SD Card Info

Der freie Speicherplatz und die verbleibende Aufzeich-
nungszeit auf der Micro-SD-Karte werden angezeigt.

Screen Capture View

[MENU] > SET > SD Card > Screen Capture View

Anzeige eines gewählten Displayfotos.

TX/RX Picture View

[MENU] > SET > SD Card > TX/RX Picture View

Anzeige von auf der Micro-SD-Karte gespeicherten 
Bildern.

 LWährend des Sendens von Bilddaten können keine  
Bilder angezeigt werden.
 LBis zu 500 Bilder lassen sich anzeigen.

Firmware Update

[MENU] > SET > SD Card > Firmware Update

Aufrufen des Fimware-Update-Modus.

Format

[MENU] > SET > SD Card > Format

Formatieren der Micro-SD-Karte.
Eine fabrikneue Micro-SD-Karte muss zuerst im 
Handfunkgerät formatiert werden.

Unmount

[MENU] > SET > SD Card > Unmount

Abmelden der Micro-SD-Karte.
Bevor man eine Micro-SD-Karte aus dem eingeschal-
teten Handfunkgerät entnimmt, ist sie ordnungsge-
mäß abzumelden. Andernfalls können Daten beschä-
digt oder gelöscht werden.

Load Setting

[MENU] > SET > SD Card > Load Setting

Datei zum Laden von Einstellungen wählen.

Save Setting

[MENU] > SET > SD Card > Save Setting

Speichern von Einstellungen auf einer Micro-SD-Karte.

Save Form (voreingestellt: Now Ver)

[MENU] > SET > SD Card > Save Form

Wahl des Datenformats zum Speichern auf einer  
Micro-SD-Karte.

 • Now Ver:  Speichern im Format der aktuellen 
Version.

 • Old Ver (x.xx - x.xx):  
     Speichern in einem älteren Versions-

format (x.xx = Version).
 LWenn man „Old Ver (x.xx - x.xx)“ wählt, werden Daten 
von Funktionen, die durch ein Firmware-Update hinzuge-
kommen sind, nicht gesichert.
 LEinstellungsdaten einer aktuellen Firmware-Version lassen 
sich nicht mit einer früheren Version der Firmware laden.

Import

[MENU] > SET > SD Card > Import/Export > Import

Import der Speicherkanal- und Radiospeicherinhalte, 
UR-Rufzeichen, Repeater-Listen und GPS-Speicher-
daten aus einer CSV-Datei.

Export

[MENU] > SET > SD Card > Import/Export > Export

Export der Speicherkanal- und Radiospeicherinhalte, 
UR-Rufzeichen, Repeater-Listen und GPS-Speicher-
daten in eine CSV-Datei.

Separator/Decimal (voreingestellt: Sep[,] Dec[.])

[MENU] > SET > SD Card > Import/Export >  
CSV Format > Separator/Decimal

Wahl der Sonderzeichen für das Trennzeichen und 
den Dezimalpunkt in CSV-Dateien.

 LDie Voreinstellung kann je nach Version des Handfunk-
geräts abweichen.
 • Sep [,] Dec [.]: Trennzeichen „,“/Dezimalpunkt „.“
 • Sep [;] Dec [.]: Trennzeichen „;“/Dezimalpunkt „.“
 • Sep [;] Dec [,]: Trennzeichen „;“/Dezimalpunkt „,“
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Bluetooth-Einstellungen und -Menübefehle

Bluetooth (voreingestellt: OFF)

[MENU] > SET > Bluetooth Set > Bluetooth

Ein- und Ausschalten der Bluetooth-Funktion.

Auto Connect (voreingestellt: ON)

[MENU] > SET > Bluetooth Set > Auto Connect

Wahl, ob ein gekoppeltes Bluetooth-Gerät automa-
tisch verbunden werden soll, sobald es eingeschaltet 
wird.

 • OFF:  Das gekoppelte Bluetooth-Gerät wird nicht 
verbunden.

 • ON:  Das zuletzt genutzte Bluetooth-Gerät wird 
verbunden.

Pairing/Connect

[MENU] > SET > Bluetooth Set > Pairing/Connect

Suche nach Bluetooth-Geräten, mit denen sich das 
Handfunkgerät verbinden kann, bzw. Anzeige einer 
Liste mit allen gekoppelten Bluetooth-Geräten.

 LDetails s. S. 13-3.

<<Pairing Reception>>

[MENU] > SET > Bluetooth Set > <<Pairing Reception>>

Empfangsmodus für den Kopplungsvorgang aufrufen.
 LDetails s. S. 17-7.

AF Output (voreingestellt: Headset Only)

[MENU] > SET > Bluetooth Set > Headset Set >  
AF Output

Wahl des Geräts für die Audioausgabe bei ange-
schlossenem Bluetooth-Headset.

 • Headset Only:  Die Audioausgabe erfolgt nur über 
das Bluetooth-Headset.

 • Headset & Speaker:  
    Die Audioausgabe erfolgt über das 

Bluetooth-Headset und den internen 
Lautsprecher des Handfunkgeräts.

Headset Function Select (voreingestellt: Normal)

[MENU] > SET > Bluetooth Set > Headset Set > 
Headset Function Select

Wahl, in welcher Kombination [PTT]-Taste und Mikro-
fon des verbundenen Bluetooth-Headsets und des 
Handfunkgeräts genutzt werden sollen.

 • Normal:  Es wird das Mikrofon des Bluetooth-Head-
sets oder des Handfunkgeräts genutzt, je 
nachdem welche [PTT] gedrückt wurde.

 • Microphone: 
    Zur Spracheingabe wird nur das Mikrofon 

des Bluetooth-Headsets genutzt.  
Das Senden erfolgt mit der [PTT] am Blue-
tooth-Headset oder mit der am Handfunk-
gerät.

 • PTT:  Zur Spracheingabe wird nur das Mikrofon 
des Handfunkgeräts genutzt.  
Das Senden erfolgt mit der [PTT] am Blue-
tooth-Headset oder mit der am Handfunk-
gerät.

 LOptionen für den Betrieb mit dem Bluetooth-Headset. 

Option
Senden mit 
der [PTT]

Spracheingabe

Normal möglich möglich

Microphone möglich möglich

PTT möglich
nicht möglich

( Spracheingabe über das  
Mi krofon des Handfunkgeräts)

Auto Disconnect (voreingestellt: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Auto Disconnect

Ausschalten oder Einstellung des Timers für die  
Trennung der Verbindung zum Bluetooth-Headset  
von 0 bis 10 Sekunden.
Wird kein Audiosignal an das Bluetooth-Headset 
gesendet und es erfolgt für eine voreingestellte Zeit 
keine Bedienung, trennt das Handfunkgerät automa-
tisch den SCO-Link* (synchrone Punkt-zu-Punkt-Ver-
bindung).

 LWenn bei getrenntem SCO-Link ein Signal empfangen 
wird oder eine Bedienung erfolgt, stellt das Handfunkge-
rät die Verbindung automatisch wieder her.

*  Bluetooth-Verbindungsart für die zeitbezogene Über-
tragung von Sprachdaten
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RX Priority Setting (LE Device) 
 (voreingestellt: MAIN Band)

[MENU] > SET > Bluetooth Set > Headset Set >  
RX Priority Setting (LE Device)

Wahl der Empfangspriorität (schneller DV-Daten-
betrieb oder Audiosignale) wenn ein iOS-Gerät über 
eine Bluetooth-LE-Verbindung (Low Energy) verbun-
den ist. 
D-STAR-Fast-Data und Headset-Audiosignale können 
bei der Bluetooth-LE-Kommunikation nicht gleichzei-
tig verwendet werden.

 LBei der Verbindung mit einem SPP-Gerät (Serial Port 
Profile), wie z. B. einem Datenendgerät oder PC, funktio-
niert das Bluetooth-Gerät entsprechend der Einstellung 
bei „Serialport Function“ (S. 12-34).
 • DV Fast Data:  Empfangene Audiosignale, egal ob 

vom Haupt- oder Subband, werden 
nicht über das Headset ausgegeben.

 • RX Audio:  Kein schneller DV-Datenbetrieb wäh-
rend empfangene Audiosignale über 
das Headset ausgegeben werden.

 • MAIN Band:  Beim schnellen DV-Datenbetrieb auf 
dem Hauptband werden auf dem 
Subband empfangene Audiosignale 
nicht über das Headset ausgegeben. 
Während des Empfangs eines Sig-
nals auf dem Hauptband erfolgt kein 
schneller DV-Datenbetrieb auf dem 
Subband.

VOX (voreingestellt: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > VOX 
> VOX

Ein- und Ausschalten der VOX-Funktion.
Die VOX (Voice Operated Exchange) schaltet das 
Handfunkgerät sprachgesteuert auf Senden um, so-
dass man nur in das Mikrofon sprechen muss, ohne 
dabei die [PTT] zu betätigen. Nach dem Ende des 
Sprechens schaltet das Handfunkgerät automatisch 
auf Empfang zurück.

 LZur Nutzung der VOX-Funktion ist das optionale Headset 
erforderlich
 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  Das Handfunkgerät schaltet beim Sprechen 

automatisch auf Senden und nach dem Ende 
des Sprechens auf Empfang zurück.

VOX Level (voreingestellt: 5)

[MENU] > SET > Bluetooth Set > Headset Set > VOX 
> VOX Level

Einstellung der VOX-Empfindlichkeit zwischen 1  
(geringste Empfindlichkeit) und 10 (höchste Empfind-
lichkeit) bzw. OFF (VOX-Funktion ausgeschaltet).

 • OFF:  Funktion ausgeschaltet.
 • 1 bis 10:  1 (geringste Empfindlichkeit) 

10 (höchste Empfindlichkeit)

VOX Delay (voreingestellt: 0,5sec)

[MENU] > SET > Bluetooth Set > Headset Set > VOX 
> VOX Delay

Einstellung der VOX-Haltezeit auf 0,5, 1,0, 1,5, 2,0, 
2,5 oder 3,0 Sekunden. Wenn man aufhört zu spre-
chen, schaltet das Handfunkgerät erst nach Ablauf 
der eingestellten VOX-Haltezeit auf Empfang zurück.

VOX Time-Out Timer (voreingestellt: 3min)

[MENU] > SET > Bluetooth Set > Headset Set > VOX 
> VOX Time-Out Timer

Einstellung der Zeit für den VOX-Time-Out-Timer 
zur Verhinderung ungewollten Dauersendens infolge 
lauter Umgebungsgeräusche, die die VOX-Funktion 
aktivieren.

 • OFF: Die Funktion ist ausgeschaltet.
 • 1, 2, 3, 4, 5, 10 oder 15min:  
    Das VOX-gesteuerte Dauersenden wird nach 

Ablauf der eingestellten Zeit automatisch be-
endet.
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Power Save (voreingestellt: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > Power Save

Wahl, ob die Energiesparfunktion genutzt werden soll, 
wenn das optionale Bluetooth-Headset VS-3 ange-
schlossen ist.

 LWenn man ein anderes Headset oder ein Datenendgerät 
anschließt, wird die Energiesparfunktion unabhängig von 
dieser Einstellung automatisch ausgeschaltet.
 • OFF: Die Funktion ist ausgeschaltet.
 • ON:  Die Energiesparfunktion wird aktiviert, wenn 

120 Sekunden lang keine Kommunikation 
oder Bedienung erfolgt.

One-Touch PTT (voreingestellt: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > One-Touch PTT

Wahl, ob die Ein-Tasten-PTT-Funktion genutzt werden 
soll, wenn das optionale Bluetooth-Headset VS-3 an-
geschlossen ist.
Mit dieser Funktion lässt sich das Handfunkgerät 
durch kurzes Drücken der [PTT] auf Senden und 
durch nochmaliges kurzes Drücken wieder auf Emp-
fang umschalten.

 LWenn man ein anderes Headset anschließt, wird die 
Ein-Tasten-PTT-Funktion unabhängig von dieser Einstel-
lung automatisch ausgeschaltet.
 • OFF: Senden, wenn man die [PTT] gedrückt hält.
 • ON:  Wiederholtes Drücken der [PTT] schaltet zwi-

schen Senden und Empfang um.

PTT Beep (voreingestellt: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > PTT Beep

Ein- oder Ausschalten des Hinweistons beim Drücken 
der [PTT] am optionalen Bluetooth-Headset VS-3.

 • OFF: Kein Hinweiston.
 • ON:  Beim Drücken der [PTT] ist ein Hinweiston 

hörbar.

Custom Key Beep (voreingestellt: OFF)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > Custom Key Beep

Ein- und Ausschalten des Hinweistons, der beim
Drücken der Tasten [PLAY], [FWD] und [RWD] am
Bluetooth-Headset VS-3 hörbar ist.

 • OFF: Kein Hinweiston.
 • ON:  Beim Drücken einer der o. g. Tasten ist ein 

Hinweiston hörbar.

Custom Key (voreingestellt: [PLAY]: --- 
    [FWD]: UP 
    [RWD]: DOWN)

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset > Custom Key

Den Tasten [PLAY], [FWD] und [RWD] am  
Bluetooth-Headset VS-3 lassen sich bestimmte  
Funktionen zuweisen.

 LZuweisbare Funktionen s. S. 12-35.

Serialport Function 
 (voreingestellt: CI-V (Echo Back OFF))

[MENU] > SET > Bluetooth Set > Data Device Set >  
Serialport Function

Einstellung der seriellen Port-Funktion für die Blue-
tooth-SPP-Verbindung (Serial Port Profile) zu Daten-
endgeräten, PCs usw.

 • CI-V (Echo Back OFF): 
    Senden oder Empfangen eines CI-V-Be-

fehls. Kein Rücksenden der empfangenen 
seriellen Daten aus der SPP-Verbindung.

 • CI-V (Echo Back ON): 
    Senden oder Empfangen eines CI-V-Be-

fehls und Rücksenden der empfangenen 
seriellen Daten aus der SPP-Verbindung.

 • DV Data:  Daten senden oder empfangen im 
DV-Modus. Keine Eingabe von Cloning- 
oder Wetterdaten bzw. keine Ausgabe 
von GPS-Daten.

Bluetooth Device Information

[MENU] > SET > Bluetooth Set >  
Bluetooth Device Information

Anzeige der Bluetooth-Geräteinformationen.

Initialize Bluetooth Device

[MENU] > SET > Bluetooth Set >  
Initialize Bluetooth Device

Initialisierung (Reset) der eingebauten Bluetooth- 
Einheit.
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Zuweisbare Tastenfunktionen

Funktion Beschreibung

--- keine Funktion

UP Erhöht Frequenz, Nummer des Speicherkanals, des Repeaters oder des Stationsrufzeichens.

DOWN Vermindert Frequenz, Nummer des Speicherkanals, des Repeaters oder des Stationsrufzeichens.

VOL UP Erhöht die Lautstärke.

VOL DOWN Vermindert die Lautstärke.

SQL UP Erhöht den Squelch-Pegel.

SQL DOWN Vermindert den Squelch-Pegel.

Monitor (Push) Drücken und Halten, um den Squelch zu öffnen. Zum Schließen loslassen.

Monitor (Hold) Drücken, um den Squelch zu öffnen oder zu schließen.

CALL Wahl des Anrufkanals.

MR (00-00 CH) Im Speichermodus drücken, um Speicherkanal 00-00 zu wählen.

MR (00-01 CH) Im Speichermodus drücken, um Speicherkanal 00-01 zu wählen.

VFO/MR Wahl des VFO- bzw. des Speichermodus.

DR Ein- und Ausschalten der DR-Funktion.

FROM/TO (DR) Zum Auswählen der Felder „FROM“ und „TO“ im DR-Display drücken.

Home CH
Im gewählten Modus (VFO-, Speicher- oder DR-Modus) drücken, um den Hauskanal direkt zu wählen.

 L Im Anrufkanalmodus oder wenn kein Hauskanal programmiert ist, ertönt beim Drücken ein Fehlerton.

BAND Drücken, um das Band umzuschalten.

SCAN Drücken, um den zuvor gewählten Suchlauf zu starten. Zum Stoppen des Suchlaufs erneut drücken.

Temporary Skip
Markieren einer Frequenz zum Überspringen während eines Suchlaufs.
Das temporäre Überspringen unerwünschter Frequenzen beschleunigt den Suchlauf.

RX>CS

1 Sekunde lang drücken, um das Rufzeichen der letzten anrufenden Station als Zielrufzeichen für „TO“ 
zu übernehmen.

 LWenn bei „[RX→CS] Key“ die Einstellung „RX > CS List“ gewählt ist, wird das Rufzeichen nicht 
übernommen. Stattdessen wird die RX-History angezeigt.
 LZum Wählen eines Rufzeichens aus der RX History mit dem optionalen Fernsteuermikrofon kann 
man diese Funktion den Tasten „UP“/„DOWN“ zuweisen.

SPEECH

 • Im VFO-, Speicher- oder Anrufkanalmodus für die Ansage der Frequenz und der Sendeart drücken.
 • Im DR-Display für die Rufzeichenansage drücken.

 L Im Simplex-Modus wird die Frequenz angesagt. 
Wenn ein FM-Repeater ausgewählt ist, werden Frequenz und Sendeart bzw. Rufzeichen und 
Sendeart angesagt.

MAIN/DUAL
 • Drücken, um Band A oder B als Hauptband zu wählen.
 • 1 Sek. lang drücken, um die Zweikanalüberwachung ein- bzw. auszuschalten.

MODE Wahl der Sendeart.

LOW Wahl der Sendeleistung.

DUP
Ein- und Ausschalten des Duplex-Modus oder wechseln der Ablagerichtung zwischen DUP+ und 
DUP–.

TONE/D.SQL
 • Im FM/FM-N-Modus drücken, um einen CTCSS-Ton zu wählen.
 • Im DV-Modus drücken, um einen DCS-Code zu wählen.

MW
Im VFO-Modus oder im DR-Display drücken, um Speicherkanalinhalte in einen freien Speicherkanal zu 
schreiben.

REC
 • Drücken, um eine Aufzeichnung zu starten.
 • Während einer Aufzeichnung 1 Sek. lang drücken, um die Aufzeichnung zu stoppen.

Voice TX
 • Drücken, um die auf der Micro-SD-Karte gespeicherte Sprachaufzeichnung ein Mal zu senden.
 • Drücken und Halten, um die Sprachaufzeichnung wiederholt zu senden.

T-CALL Senden eines 1750-Hz-Ruftons.

Bluetooth-Einstellungen und -Menübefehle
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Weitere Einstellungen

Voltage

[MENU] > SET > Others > Information > Voltage

Anzeige der Spannung des Akkupacks und der exter-
nen Stromversorgung.

 LWenn man einen Li-Ionen-Akkupack nutzt, werden sein 
Ladezustand die Akkuspannung angezeigt.
 LBei Verwendung des optionalen Batteriebehälters wird 
seine Anschlussspannung angezeigt.

Version

[MENU] > SET > Others > Information > Version

Anzeige der Firmware-Versionsnummer des Hand-
funkgeräts.

Clone Mode

[MENU] > SET > Others > Clone > Clone Mode

Aufrufen des Modus zum Lesen oder Schreiben von 
CS-52-Daten von oder auf einen PC.

 LDer Modus lässt sich durch einen Neustart des Hand-
funkgeräts beenden.

Partial Reset

[MENU] > SET > Others > Reset > Partial Reset

Der Teil-Reset setzt alle Betriebseinstellungen 
(VFO-Frequenz, VFO-Einstellungen, Menüeinstellun-
gen usw.) auf die Werksvoreinstellungen zurück.

 LDetails s. S. 15-17.

All Reset

[MENU] > SET > Others > Reset > All Reset

Bei einem Total-Reset werden alle Einstellungen auf 
die Werksvoreinstellungen zurückgesetzt und sämt-
liche Speicher (Speicherkanalinhalte, Repeaterliste 
usw.) gelöscht.

 LDetails s. S. 15-17.
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Bluetooth®-BETRIEB

Bluetooth®-Betrieb

Mithilfe der Bluetooth-Funktion lassen sich Bluetooth- 
Geräte mit dem Handfunkgerät verbinden.

 LDetails zum Koppeln, zur Trennung einer Verbindung 
und zum Löschen von gekoppelten Geräten sind in der 
Basis-Bedienungsanleitung zu finden.

Icom-Headset
Wenn man das Bluetooth®-Headset VS-3 mit dem 
Handfunkgerät verwendet, kann man drahtlos senden 
und empfangen. Die [PTT]-Taste des VS-3 lässt sich 
genauso nutzen, wie die [PTT]-Taste des Handfunk-
geräts. Mit der VOX-Funktion kann das Handfunk-
gerät automatisch zwischen Senden und Empfang 
umgeschaltet werden, sodass echter freihändiger 
Betrieb möglich ist.
Bei Bedarf kann man den seitlichen Tasten des  
VS-3 Funktionen zuordnen, sodass das Handfunk-
gerät fernbedienbar ist.

Android™/iOS-Gerät
Wenn man ein Mobilgerät mit dem Handfunkgerät 
verbindet, lassen sich mit der kostenlosen App die 
erweiterten D-STAR-Funktionen, wie z. B. Daten- und 
Bildübertragung, nutzen.

 L Informationen über die Applikationen und über das 
Koppeln von Handfunk- und Mobilgerät sind auf S. 17-5 
zu finden.

Einschalten der  
Bluetooth®-Funktion

[MENU] > SET > Bluetooth Set > Bluetooth

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „Bluetooth“ wählen. 

4. „ON“ wählen. 

 LZum Verlassen die [MENU]-Taste drücken.

IMPORTANT: Die Reichweite von Bluetooth-Ver-
bindungen variiert je nach örtlichen Gegebenheiten. 
Bluetooth-Geräte arbeiten im 2,4-GHz-Band. In die-
sem Frequenzbereich arbeiten auch andere Geräte 
wie z. B. WLAN-Access-Points, Mikrowellenherde, 
RFID-Systeme, Amateurfunkstationen usw.
Wenn man Bluetooth®-Geräte in räumlicher Nähe 
zu anderen 2,4-GHz-Geräten verwendet, kann es 
zu Problemen bei der Kommunikation oder zu einer 
Verminderung der Datenübertragungsraten kom-
men. Sollte es nicht möglich sein, das die Störung 
verursachende Gerät auszuschalten, muss man den 
Abstand zu diesen vergrößern. 
Alle Bluetooth-Geräte haben eine bestimmte Reich-
weite. Für eine stabile Kommunikation verwenden 
Sie das Gerät innerhalb dieser Reichweite.

Bluetooth

ID-52E

     Headset

optionales  
Bluetooth®- 
Headset VS-3

Mobilgerät

Datenendgerät
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Bluetooth®-BETRIEB

Verbinden mit einem Bluetooth®-Headset

Das Handfunkgerät kann mit einem optionalen  
Bluetooth-Headset verbunden werden.

Schritt 1. Kopplungsmodus des Headsets wählen.
Zur Aktivierung des Kopplungsmodus lesen Sie die 
Bedienungsanleitung des gewählten Headsets.

Schritt 2. Headset suchen (Handfunkgerät)

[MENU] > SET > Bluetooth Set > Pairing/Connect

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „Pairing/Connect“ wählen. 

4. „Device Search“ wählen. 

5. „Search Headset“ wählen. 

 • Verfügbare Headsets werden in der Kopplungsliste 
angezeigt.

6. Ein Headset zum Koppeln wählen. 

 • Ein Bestätigungsfenster öffnet sich.

7. „YES“ wählen. 

 • Nach der Herstellung der Verbindung zum Headset 
erscheint  in der Kopplungsliste.

8. Zum Verlassen die [MENU]-Taste drücken. 

 LSolange eine Verbindung mit einem Bluetooth-Ge-
rät besteht, wird das Bluetooth-Symbol im Display 
angezeigt.
 LWenn bei „AF Output“ die Einstellung „Headset 
Only“ gewählt ist und die Bluetooth-Verbindung 
unterbrochen wird, erscheint eine Abfrage, ob der 
Ton über den Lautsprecher des Handfunkgeräts aus-
gegeben werden soll. (S. 13-4)
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Bluetooth®-BETRIEB

Bluetooth®-Headset-Einstellungen

Folgende Einstellungen können bei Nutzung eines 
Bluetooth-Headsets vorgenommen werden.

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „Headset Set“ wählen. 

 DAudioausgabe
[MENU] > SET > Bluetooth Set > Headset Set >  
AF Output

Man kann wählen, auf welchem Gerät die Audio-
ausgabe erfolgen soll, wenn ein Bluetooth-Headset 
angeschlossen ist.
Ist bei „AF Output“ die Einstellung „Headset &  
Speaker“ gewählt, werden das Bluetooth-Headset 
und der interne Lautsprecher des Handfunkgeräts  
zur Audioausgabe genutzt.

 LDetails s. S. 12-32.

TIPP: Wenn bei „AF Output“ die Einstellung „Head-
set Only“ gewählt ist und die Bluetooth-Verbindung 
unterbrochen wird, erscheint folgendes Dialogfenster:
 

 • YES:  Die Audioausgabe erfolgt über den Lautsprecher 
des Handfunkgeräts.

 • NO:  Der Lautstärkepegel des Handfunkgeräts wird 
auf 0 gesetzt und es erfolgt keine Audioausgabe.

 DFunktion von [PTT]-Taste  
und Mikrofon

In diesem Menüpunkt ist einstellbar, in welcher Kom-
bination [PTT]-Taste und Mikrofon des verbundenen 
Bluetooth-Headsets und des Handfunkgeräts genutzt 
werden sollen.

 LDetails s. S. 12-32.

[MENU] > SET > Bluetooth Set > Headset Set > 
Headset Function Select

 • Normal: 
Es wird das Mikrofon des Bluetooth-Headsets oder 
des Handfunkgeräts genutzt, je nachdem welche 
[PTT]-Taste gedrückt wurde.

 • Microphone: 
Zur Spracheingabe wird ausschließlich das  
Mikrofon des Bluetooth-Headsets verwendet.

 LDas interne Mikrofon des Handfunkgeräts ist nicht 
nutzbar
 LDas Senden erfolgt mit der [PTT]-Taste am Bluetooth- 
Headset oder mit der am Handfunkgerät.

 • PTT: 
Das Bluetooth-Headset wird nur zur Sende-Emp-
fangs-Umschaltung mittels [PTT]-Taste genutzt.

 LZur Spracheingabe wird ausschließlich das Mikrofon 
des Handfunkgeräts genutzt. Sprachsignale des  
Bluetooth-Headsets werden nicht gesendet.
 LDas Senden kann auch mit der [PTT]-Taste am Hand-
funkgerät erfolgen.

Optionen für den Betrieb mit dem Bluetooth-Headset.

Option
Senden mit der 

[PTT]
Spracheingabe

Normal ✔ ✔

Microphone ✔ ✔

PTT
✔ (Spracheingabe über  

das Mi krofon des Hand-
funkgeräts)
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Bluetooth®-BETRIEB

Bluetooth®-Headset-Einstellungen

 DVOX-Funktion
Die VOX (Voice Operated Exchange) schaltet das 
Handfunkgerät sprachgesteuert auf Senden um, so-
dass man nur in das Mikrofon sprechen muss, ohne 
dabei die [PTT] zu betätigen. Nach dem Ende des 
Sprechens schaltet das Handfunkgerät automatisch 
auf Empfang zurück.
Die VOX-Funktion lässt sich mit dem optionalen VS-3 
oder einem Bluetooth-Headset eines Drittanbieters 
verwenden.

Bei Headsets von Drittherstellern steht die VOX-Funk-
tion wegen unterschiedlicher Mikrofone evtl. nicht zur 
Verfügung.

HINWEIS:
 • Wenn das Handfunkgerät nicht mit einem Blue-
tooth-Headset verbunden ist, steht die VOX-Funktion 
nicht zur Verfügung, selbst wenn bei „VOX“ die Ein-
stellung „ON“ gewählt ist. Daher muss man unbedingt 
sicherstellen, dass die Bluetooth-Verbindung zwischen 
beiden Geräten besteht.

 • Die VOX-Funktion ist nur im Zusammenhang mit einem 
Bluetooth-Mikrofon nutzbar. 
Nutzung eines externen Mikrofons s. S. 15-10.

 LDetails zu den VOX-Einstellmöglichkeiten s. S. 12-33.

[MENU] > SET > Bluetooth Set > Headset Set > VOX

VOX
Ein- oder Ausschalten der VOX-Funktion.

VOX Level
Einstellung der VOX-Empfindlichkeit. Je höher der 
Wert desto höher ist die VOX-Empfindlichkeit.

VOX Delay
Einstellung der VOX-Haltezeit. Wenn man aufhört 
zu sprechen, schaltet das Handfunkgerät erst nach 
Ablauf der eingestellten VOX-Haltezeit auf Empfang 
zurück.

VOX Time-Out Timer
Einstellung der Zeit für den VOX-Time-Out-Timer 
zur Verhinderung ungewollten Dauersendens infolge 
lauter Umgebungsgeräusche, die die VOX-Funktion 
aktivieren. Zum Ausschalten des Timers wählt man 
die Einstellung „OFF“.

 DAutomatisches Trennen  
der Verbindung

[MENU] > SET > Bluetooth Set > Headset Set >  
Auto Disconnect

Der Timer für die Trennung der Verbindung zum  
Bluetooth-Headset lässt sich von 0 bis 10 Sekunden 
einstellen oder ausschalten.
Wird kein Audiosignal an das Bluetooth-Headset 
gesendet und es erfolgt für eine voreingestellte Zeit 
keine Bedienung, trennt das Handfunkgerät automa-
tisch den SCO-Link* (synchrone Punkt-zu-Punkt-Ver-
bindung).

 LWenn bei getrenntem SCO-Link ein Signal empfangen 
wird oder eine Bedienung erfolgt, stellt das Handfunkge-
rät die Verbindung automatisch wieder her.
 LDetails s. S. 12-32.

 DEmpfangspriorität 
[MENU] > SET > Bluetooth Set > Headset Set >  
RX Priority Setting (LE Device)

Wenn ein iOS-Gerät über eine Bluetooth-LE-Ver-
bindung (Low Energy) verbunden ist, kann man die 
Empfangspriorität (schneller DV-Daten betrieb oder 
Audiosignale) wählen.
D-STAR-Fast-Data und Headset-Audiosignale können 
bei der Bluetooth-LE-Kommunikation nicht gleichzei-
tig verwendet werden.

 LBei der Verbindung mit einem SPP-Gerät (Serial Port 
Profile), wie z. B. einem Datenendgerät oder PC, funktio-
niert das Bluetooth-Gerät entsprechend der Einstellung 
bei „Serialport Function“ (S. 12-34).
 LDetails s. S. 12-33.
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Bluetooth®-BETRIEB

Bluetooth®-Headset-Einstellungen

 DDas Bluetooth®-Headset VS-3  
von Icom

Wenn man das optionales Bluetooth-Headset VS-3 
von Icom verwendet, kann man einige spezielle Ein-
stellungen vornehmen.
Außerdem lassen sich im „Custom Key“-Display den 
Tasten [PLAY], [FWD] und [RWD] am VS-3 Funktionen 
zuordnen.

 LDetails zu dem Einstellmöglichkeiten s. S. 12-34.

[MENU] > SET > Bluetooth Set > Headset Set > 
Icom Headset

Power Save
Die Energiesparfunktion unterbricht die Blue-
tooth-Verbindung, wenn länger als 120 Sek. keine 
Kommunikation bzw. Bedienung erfolgt. Bei einge-
schalteter VOX-Funktion ist die Energiesparfunktion 
ausgeschaltet.

One-Touch PTT screen
Mit der Ein-Tasten-PTT-Funktion lässt sich das Hand-
funkgerät durch kurzes Drücken der [PTT] auf Senden 
und durch nochmaliges kurzes Drücken wieder auf 
Empfang umschalten.

PTT Beep
Ein- und Ausschalten eines Hinweistons, der beim 
Drücken der [PTT]-Taste am VS-3 hörbar ist.

Custom Key Beep
Ein- und Ausschalten des Hinweistons, der beim Drü-
cken der Tasten [PLAY], [FWD] und [RWD] am VS-3 
hörbar ist.

Custom key
Zuordnung bestimmter Funktionen zu den Tasten 
[PLAY], [FWD] und [RWD] am VS-3.

[FWD]

[PLAY]

[RWD]

optionales
Bluetooth®- 

Headset VS-3
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Bluetooth®-BETRIEB

Editieren des Namens der 
Bluetooth®-Einheit

Der Name der Bluetooth-Einheit des Handfunkgeräts 
lässt sich editieren.

 LNach der Initialisierung der Einheit bleibt der editierte 
Name erhalten.

[MENU] > SET > Bluetooth Set >  
Bluetooth Device Information

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „Bluetooth Device Information“ wählen. 

4. [QUICK] drücken.
5. „Edit Name“ wählen. 

6. Einen Namen mit bis zu 9 Zeichen* eingeben und 
mit [ENT] bestätigen. (Beispiel: ICOM BT(ID-52)A) 
*Nach „ICOM BT“. 

 LZum Verlassen die [MENU]-Taste drücken.

Initialisieren der  
Bluetooth®-Einheit

Bei Problemen mit dem Bluetooth-Betrieb ist es zu-
nächst zweckmäßig, die Bluetooth-Einheit des Hand-
funkgeräts zu initialisieren (Reset).

 LBei der Initialisierung der Bluetooth-Einheit wird die Kop-
plungs-/Verbindungsliste gelöscht, die Bluetooth-Einstel-
lungen und der Gerätename bleiben jedoch erhalten. Die 
Bluetooth-Einstellungen werden nur dann auf die Werks-
einstellungen zurückgesetzt, wenn man einen Teil- oder 
Total-Reset des Handfunkgeräts vornimmt.  
(S. 15-17)

[MENU] > SET > Bluetooth Set >  
Initialize Bluetooth Device

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „Initialize Bluetooth Device“ wählen. 

4. „YES“ wählen. 

 • Das Handfunkgerät startet automatisch neu.

Maximale Anzahl gekoppelter 
Geräte

Man kann zwei verschiedene Arten von Blue-
tooth-Geräten mit dem Handfunkgerät koppeln:
Headsets und Datenendgeräte.

Maximale Anzahl gekoppelter Geräte
 • Bis zu 5 Bluetooth-Geräte können mit dem Handfunkge-
rät gekoppelt werden, jedoch nicht mehr als 4 Headsets 
oder 4 Datenendgeräte (z. B. Android-Geräte).

 • Maximal 2 iOS-Geräte (Bluetooth LE) lassen sich koppeln.

Anzeige der gekoppelten 
Bluetooth-Geräte
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Share-Pictures-Funktion

Mit der Share-Pictures-Funktion kann man auf der 
Micro-SD-Karte gespeicherte Bilder senden und sich 
empfangene Bilder ansehen.

 L Information
 • Im Handfunkgerät muss eine Micro-SD-Karte eingesetzt 
sein.

 • Die Micro-SD-Karte muss zuerst im Handfunkgerät  
formatiert werden.

 • Während des Betriebs im Access-Point-Modus ist diese 
Funktion nicht nutzbar.

HINWEIS:
 • Auch wenn sich keine Micro-SD-Karte im Handfunkge-
rät befindet, ist der Bildempfang möglich. Das Bild wird 
jedoch nicht in der Bildempfangs-History gespeichert.

 LEmpfängt man ein Bild ohne dass sich eine Micro- 
SD-Karte im Handfunkgerät befindet, wird das Bild 
gelöscht, sobald man eine Karte einsetzt.

 • Während der Nutzung der Share-Pictures-Funktion darf 
die Micro-SD-Karte NICHT aus dem Handfunkgerät 
entnommen werden. Das könnte die Daten auf der 
Karten beschädigen oder löschen.

 • Wenn die Daten auf der Karten in einem nicht unter-
stützten Format vorliegen oder beschädigt sind, wird 
ein Fehlerdialog angezeigt. Wählen Sie in diesem Fall 
„YES“, um die fehlerhaften Daten zu löschen.

Anforderungen an die zu verwendende Bilddatei
 • Dateityp*1: JPEG (Dateiendung „jpg“)
 • Bildgröße*2: 640 × 480, 320 × 240 oder  
   160 × 120 Pixel

 • Dateigröße: maximal 200 KB
 • Dateiname:  bis zu 23 Zeichen 

(ohne Dateiendung)
*1  Dateien mit der Endung „jpeg“ und Dateien im Progres-

sive-JPEG-Format kann das Handfunkgerät nicht lesen.
*2  Bilddaten mit einer anderen als der angegebene Größe 

können ebenfalls nicht gelesen werden. Auch dann nicht, 
wenn das Seitenverhältnis 4:3 ist.
 LDas Handfunkgerät zeigt nur 500 Bilder an, auch wenn 
mehr auf der Micro-SD-Karte gespeichert sind.

Frei herunterladbare Software
Mit der Software ST-4001W (für Windows),  
ST-4001A (für Android) oder ST-4001I (für iOS) kann 
man Text in Bilder einfügen sowie die Bilder zu-
schneiden und herunterrechnen, um sie mit dem 
Handfunkgerät senden zu können. 
Bei Verwendung der Software ST-4001A oder 
ST-4001I lässt sich das bearbeitete Bild mittels 
Bluetooth auf das Handfunkgerät übertragen.

 LVor der Nutzung sind die jeweiligen Anleitungen zu 
lesen und die Software demgemäß zu verwenden.
 L In dieser Anleitung wird die Software ST-4001W,  
ST-4001A und ST-4001I als „Bildbearbeitungssoftware“ 
bezeichnet

Bild auf das Handfunkgerät übertragen
Um ein Bild von einem Mobilgerät auf das Hand-
funkgerät übertragen zu können, müssen beide über 
Bluetooth miteinander verbunden sein. (S. 17-5)

HandfunkgerätMobilgerät
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Nutzung des Picture-Displays

[MENU] > PICTURE

1. [MENU] drücken.
2. „PICTURE“ wählen.

 • Das Picture-Display wird angezeigt..
 LUm die Anzeige zu verlassen [QUICK] drücken und 
dann „<<Exit Picture Screen>>“ wählen.

Im Quick-Menü sind folgende Optionen wählbar:

Menüpunkt Option

Picture TX

OFF
Ausschalten der  
Share-Pictures-Funktion.

Single TX

Einschalten der  
Share-Pictures-Funktion.

 LDas Bild wird während 
des Sendens übertragen. 
Danach wird die Funktion 
wieder ausgeschaltet.

Repeat TX
Das Bild wird wiederholt 
gesendet.

<<TX All>>
Das Bild wird mit der  
DV-Fast-Data-Funktion gesendet.

<<Back To 
1st>>

Verschiebt die Startmarkierung für das 
Senden eines Bildes zurück zum ersten 
Block.

<< Exit Picture 
Screen>>

Schließen des Picture-Displays.

Wenn ein empfangenes Signal Bilddaten enthält
Enthält ein empfangenes Signal Bilddaten, wird dies 
mit einem Symbol angezeigt. 
 

Bildempfangssymbol

 LDie Symbolanzeige lässt sich ausschalten. 
([MENU] > SET > Display > RX Picture Indicator)

Das „RX PICTURE“-Display
 z [ENT] drücken, um die „RX PICTURE“-Detail-
anzeige zu öffnen.

 z Zum Anzeigen der Bildempfangs-History die  
Navigationstasten () drücken. (S. 14-7)

Das „TX PICTURE“-Display
 z [ENT] drücken, um das „TX PICTURE SET“-Display 
zu öffnen.

 z Zum Anzeigen der Bildsende-History die  
Navigationstasten () drücken. (S. 14-7)

*  Wenn man gleichzeitig Signale mit Bilddaten auf dem 
Haupt- und Subband empfängt, werden beide Bilder auf 
der Micro-SD-Karte gespeichert, aber nur das auf dem 
Hauptband empfangene angezeigt.

Empfangsband

Bildsendefenster;
wählen, um das  
„TX PICTURE“-Display  
zu öffnen.

Startmarkierung 
zum Senden

Bildempfangsfenster*;
wählen, um das  

„RX PICTURE“-Display  
zu öffnen.

aktuelle Uhrzeit
Nummer des History-Eintrags
Bildgröße
Bildqualität

Empfangszeit

Startmarkierung 
zum Senden
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Bild zum Senden vorbereiten

Es gibt zwei Möglichkeiten, ein Bild zum Senden vorzubereiten:
 • Durch Bluetooth-Übertragung eines Bildes von einem Mobilgerät mittels Bildbearbeitungssoftware.
 • Durch Speichern eines Bildes vom PC oder Mobilgerät aus auf einer Micro-SD-Karte.

 DBluetooth-Übertragung eines Bildes 
vom Mobilgerät

1. Micro-SD-Karte in das Handfunkgerät einsetzten 
und dann einschalten.

2. Auf dem Mobilgerät die Bildbearbeitungssoftware 
aufrufen.

 LVor der ersten Nutzung eines Android-Geräts zur 
Bildübertragung, muss es mit dem Handfunkgerät 
gekoppelt werden. (S. 17-7)

3. Einstellungen für die Datenübertragung öffnen.
4. „Using Bluetooth“ wählen und bei „Transfer  

Devices“ das Handfunkgerät einstellen.
 LVor der ersten Nutzung eines iOS-Geräts zur Bild-
übertragung, muss es mit dem Handfunkgerät ge-
koppelt werden. (S. 17-9)
 LDetails dazu sind in den Anleitungen der Soft-
ware ST-4001A und ST-4001I zu finden, die auf der 
Icom-Website zum Herunterladen zur Verfügung 
stehen.

5. In der Bildbearbeitungssoftware das zu übertra-
gende Bild öffnen.

6. Den Transfer-Button ( ) berühren.
 • Die Übertragung beginnt, das Bild wird auf der  
Micro-SD-Karte im Handfunkgerät gespeichert.
 LDie Vergabe des Dateinamens erfolgt automatisch 
nach folgendem Schema: yyyymmdd_hhmmss  
(yyyy: Jahr, mm: Monat, dd: tag, hh: Stunde,  
mm: Minute, ss: Sekunde).

HINWEIS: Wenn sich das Bild nicht übertragen 
lässt, ist Folgendes zu prüfen:

Am Handfunkgerät
 • Ist das Handfunkgerät eingeschaltet?.
 • Ist die Bluetooth-Funktion eingeschaltet?
 • Ist die Firmware des Handfunkgeräts auf dem  
neuesten Stand?

 • Befindet sich eine Micro-SD-Karte im Handfunkgerät?
 • Ist das Handfunkgerät in einem normalen Betriebsmo-
dus?

 L In folgenden Modi können keine Bilder gespeichert 
werden: im Firmware-Update-Modus, im Clone-Mo-
dus, beim Speichern von Einstellungen sowie im 
Import- oder Export-Modus.

Am Mobilgerät
 • Ist die Bluetooth-Funktion eingeschaltet?
 • Ist bei „Transfer Devices“ das Handfunkgerät einge-
stellt?

 DEin Bild mittels PC oder Mobilgerät 
auf der Micro-SD-Karte speichern

1. Handfunkgerät ausschalten und Micro-SD-Karte 
entnehmen.

2. Micro-SD-Karte in den Kartenslot des PC bzw. 
Mobilgeräts oder in ein Kartenlesegerät einsetzen. 
* Selbst zu beschaffen.

3. Ein Bild in den Ordner „Picture“ auf der  
Micro-SD-Karte kopieren („ID-52“ > „Picture“).

4. Micro-SD-Karte wieder entnehmen und in das 
Handfunkgerät einsetzen.

HINWEIS: Bevor man die SD-Karte entnimmt,  
muss sie ordnungsgemäß abgemeldet werden.  
Andernfalls können die Daten beschädigt oder  
gelöscht werden.

TIPP:
 • Wenn bei „USB Connect“ die Einstellung „SD Card 
Mode“ gewählt wurde und das Handfunkgerät über ein 
USB-Datenkabel mit dem PC verbunden ist, kann man 
vom PC aus direkt auf die im Handfunkgerät eingesetz-
te Micro-SD-Karte zugreifen. 
([MENU] > SET > Function > USB Connect)

 • Ein empfangenes Bild lässt sich im Ordner „Picture“ auf 
der Micro-SD-Karte speichern. (S. 14-7)
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Bild senden

Schritt 1. Bild zum Senden wählen
 L Im „TX PICT HISTORY“-Display lässt sich das Bild wie-
derholt senden. (S. 14-7)
 LWird das Bild mittels Bluetooth übertragen, ist es als  
„TX Picture“ markiert. Soll diese Einstellung nicht geän-
dert werden, gehen Sie zu „Schritt 2. Bild senden“.

[MENU] > PICTURE

1. [MENU] drücken.
2. „PICTURE“ wählen.
3. Mit den Navigationstasten () im Display das Bild-

sendefenster auswählen und mit [ENT] bestätigen. 

4. [ENT] erneut drücken.
5. „TX Picture“ wählen. 

6. Durch Drehen von [DIAL] ein Bild wählen.
 LWenn die Bilddaten in einem nicht unterstützten For-
mat vorliegen oder beschädigt sind, können sie nicht 
angezeigt werden. (S. 14-2)

7. [ENT] drücken.
8. „Picture Size“ (Bildgröße), „Picture Quality“ (Bild-

qualität und „Receiver“ (Empfanger) einstellen.
 LDetails zu den Einstellungen s. S. 14-6.

9. Zum Schließen des „TX PICTURE SET“-Displays 
[MENU]-Taste drücken.

Schritt 2. Bild senden
1. [QUICK] drücken.
2. „Picture TX“ wählen. 

3. „Single TX“ oder „Repeat TX“ wählen. 

Symbolanzeige während 
der eingeschalteten  
Share-Pictures-Funktion 

4. Zum Senden [PTT]-Taste drücken und halten.
 LDas Bild wird beim Senden übertragen.

5. Zum Empfang [PTT]-Taste loslassen.

Bild mit der DV-Fast-Data-Funktion senden
Bei Schritt 2 „<<TX All>>“ wählen, um ein Bild im 
schnellen Datenübertragungsmodus zu senden.
 

 LNICHT „<<TX All>>“ wählen, wenn das Bild an Trans-
ceiver gesendet werden soll, die Daten nur mit geringer 
Geschwindigkeit empfangen können.
 LWenn man die [PTT] am Mikrofon zum Senden von 
Sprachsignalen drückt, wechselt das Handfunkgerät 
automatisch in den langsamen Datenübertragungs-
modus.
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Bild senden

 DStartmarkierung für das  
zu sendende Bild bewegen

Man kann einen Block im Bild auswählen, an dem 
das Senden startet.

 LWährend des Sendens eines Bildes lässt sich die Start-
markierung nicht verschieben.

1. Mit den Navigationstasten () im Display das 
Bildsendefenster auswählen und mit [ENT]  
bestätigen. 

2. [QUICK] drücken.
3. „TX Picture Block Select“ wählen. 

4. Mit [DIAL] oder den Navigationstasten die Start-
markierung bewegen. 

 LUm die Startmarkierung für das zu sendende Bild 
zurück zum ersten Block zu bewegen, drückt man 
[QUICK] und wählt dann „BACK TO 1ST“.

5. [ENT] drücken.
6. Zum Schließen des „TX PICTURE“-Displays  

[MENU]-Taste drücken.

 DEinstellungen im  
„TX PICTURE SET“-Display

Dieses Display dient der Einstellung der Größe und 
der Qualität des Bildes sowie des Zielrufzeichens.

 LWährend des Sendens eines Bildes können die Einstel-
lungen nicht verändert werden.

1. Mit den Navigationstasten () im Display das Bild-
sendefenster auswählen und mit [ENT] bestätigen.

2. [ENT] erneut drücken.
3. Menüpunkt zum Einstellen wählen. 

4. Eine Option wählen. 

5. Zum Schließen des „TX PICTURE SET“-Displays 
MENU] drücken.

TIPP: Die Einstellungen lassen sich zurücksetzen, in-
dem man [QUICK] drückt und dann „Default“ wählt.

TX Picture
Auswählen des zu sendenden Bildes im Ordner  
„Picture“auf der Micro-SD-Karte („ID-52“ > „Picture“).

 LWenn man das zu sendenden Bild aus der Bildemp-
fangs-History wählt, wird vor dem Dateinamen des Bildes 
„(RE TX)“ angezeigt.

Picture Size (voreingestellt: 320 x 240)

Bildgröße des zu sendenden Bildes auf „160 x 120“, 
„320 x 240“ oder „640 x 480“ einstellen.

 LSie kann nicht größer als die des Originalbildes sein.

Picture Quality (voreingestellt: Standard (50%))

Einstellung der Qualität des zu sendenden Bildes 
auf„Low (25%)“, „Standard (50%)“ oder „High (75%)“.

Receiver (voreingestellt: -----)

Zielrufzeichen eingeben, damit alle Stationen, die das 
Bild empfangen, wissen, für wen das Bild bestimmt ist.

HINWEIS: Alle Stationen, die das Signal empfan-
gen, können das Bild sehen, auch wenn sie nicht 
das Ziel sind.
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Bilder ansehen

 DBilder aus der Bildempfangs-History 
ansehen

Wenn man einen DV-Anruf mit Bilddaten empfängt, wird 
der Anruf in der Bildempfangs-History gespeichert, die 
bis zu 50 Einträge enthalten kann. Beim Empfang des 
51. Bildes, wird der ältesten Eintrag gelöscht.

HINWEIS: Im Handfunkgerät muss eine  
Micro-SD-Karte eingesetzt sein.

[MENU] > PICTURE

1. [MENU] drücken.
2. „PICTURE“ wählen.
3. Mit den Navigationstasten () im Display das Bild-

empfangsfenster wählen und mit [ENT] bestätigen. 

4. Mit [DIAL] einen Eintrag aus der Bildempfangs- 
History wählen.

5. [ENT] drücken. 

 • Die Nummer des History-Eintrags, Bildgröße, Bild-
qualität, Rufzeichen des Anrufers sowie des Empfän-
gers, Empfangsdatum und -zeit werden angezeigt.

TIPP: Im Quick-Menü kann man Folgendes wählen:
 • Zoom Picture: Vergrößerte Darstellung.
 • Save:  Speichern des angezeigten Bildes auf der 

Micro-SD-Karte. 
L  Der Dateiname wird automatisch ver-

geben: Picyyyymmdd_callsign_xx  
( yyyy: Jahr, mm: Monat, dd: Tag,  
callsign: Rufzeichen des Anrufers,  
xx: fortlaufende Nummer).

 • Delete:  Löscht den Eintrag aus der Bildempfangs- 
History.

 • Delete All:  Löscht alle Einträge aus der Bildempfangs- 
History.

 DBilder aus der Bildsende-History  
ansehen

Wenn man einen DV-Anruf mit Bilddaten sendet, wird 
der Anruf in der Bildsende-History gespeichert, die bis 
zu 50 Einträge enthalten kann. Beim Senden des  
51. Bildes, wird der ältesten Eintrag gelöscht.

HINWEIS: Im Handfunkgerät muss eine  
Micro-SD-Karte eingesetzt sein.

[MENU] > PICTURE

1. [MENU] drücken.
2. „PICTURE“ wählen.
3. Mit den Navigationstasten () im Display das Bild-

empfangsfenster wählen und mit [ENT] bestätigen. 

4. Mit [DIAL] einen Eintrag aus der Bildsende- 
History wählen.

5. [ENT] drücken. 

 • Die Nummer des History-Eintrags, Bildgröße, Bild-
qualität, Rufzeichen des Anrufers, das Zielrufzeichen, 
Sendedatum und -zeit werden angezeigt.

TIPP: Im Quick-Menü kann man Folgendes wählen:
 • Retransmit: Markiert das Bild als „TX Picture“.
 • Zoom Picture: Vergrößerte Darstellung.
 • Delete:   Löscht den Eintrag aus der Bildsende- 

History.
 • Delete All:   Löscht alle Einträge aus der Bildsende- 

History.
 LWenn der gewählte Bildsende-History-Eintrag als 
„TX Picture“ (RE TX) markiert ist, lässt er sich nicht 
löschen.
 LWährend des Sendens eines Bildes lässt sich ein  
Bild nicht als „TX Picture“ markieren.
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Bilder ansehen

 DBilder im „Picture“-Ordner auf der 
Micro-SD-Karte ansehen

Die im Ordner „Picture“ auf der Micro-SD-Karte ge-
speicherten Bilder kann man sich auf dem Handfunk-
gerät ansehen.

 LWährend ein Bild gesendet wird, lässt sich kein Bild an-
zeigen
 LUm ein empfangenes Bild auf der Micro-SD-Karte zu 
speichern, drückt man im „RX PICT HISTORY“-Display 
die [QUICK]-Taste und wählt dann „Save“. (S. 14-7) 
Ansonsten ist das Bild nicht im Ordner „Picture“ auf der 
Micro-SD-Karte verfügbar.

[MENU] > SET > SD Card > TX/RX Picture View

1. [MENU] drücken. 
2. Im „SET“-Menü „SD Card“ wählen. 
3. „TX/RX Picture View“ wählen. 

4. Ein Bild zum Ansehen wählen. 

 LWenn die Bilddaten in einem nicht unterstützten For-
mat vorliegen oder beschädigt sind, können sie nicht 
angezeigt werden. (S. 14-2)
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Im Quick-Menü kann man Folgendes wählen:
 • File Information:  Anzeige des Dateinamens, der Datei-

größe und des Speicherdatums.
 • Delete:   Löscht das gewählte Bild.
 • Delete All:  Löscht alle Bilder.
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Bandskop

Das Bandskop ermöglicht die visuelle Prüfung der Ak-
tivität auf Frequenzen in der näheren Umgebung der 
eingestellten Frequenz. Mit dem Bandskop kann man 
Signale suchen und deren Signalstärke beurteilen.
Im Einzelbanddisplay lassen sich die Signal stärken 
mittels Wasserfallanzeige im zeitlichen Verlauf ver-
folgen. 
Außerdem kann man im Einzelbanddisplay im Bereich 
von 137 bis 174 MHz und von 375 bis 479 MHz wäh-
rend eines Sweeps die Audiosignale auf der ange-
zeigten Frequenz hören.

Das Bandskop kann im Single-Sweep- und Continu-
ous-Sweep-Modus betrieben werden:

 • Single Sweep:  Ein bestimmter Frequenzbe-
reich wird einmalig überprüft. 
Der Single-Sweep beginnt 
bei der unteren Frequenz und 
stoppt beim Erreichen der  
oberen Frequenz.

 • Continuous Sweep:  Ein bestimmter Frequenz-
bereich wird kontinuierlich 
überprüft.

Die Darstellungsbreite des Bandskops beträgt ± 15* × 
Abstimmschrittweite, wobei die angezeigte Frequenz 
in der Mitte liegt.
*  Die Darstellungsbreite lässt sich auf bis zu ± 20 Abstimm-

schritte ändern.  
([MENU] > SET > Scope > Displayed Steps)

Während eines Sweeps im Center-Modus

Beim Stoppen eines Sweeps

Für die Bandskop-Anzeige kann man aus drei ver-
schiedenen Modi wählen: dem Center-, dem FIX-  
und dem Scroll-(FIX)-Modus.

Center-Modus
Zeigt Signale um die Betriebsfrequenz innerhalb des 
gewählten Frequenzbereichs an.

Sweep-Marker

orangefarbener 
Rahmen bei Auswahl 
eines Bandskop- 
Bereichs

starke Signale

schwache Signale

Mittenfrequenz
(Beispiel: 146,010 MHz)

Bandskop- 
Anzeige

Betriebsfrequenz (bewegt sich)

Scroll-(FIX)-Modus
Zeigt Signale innerhalb eines bestimmten Frequenz-
bereichs an. Bewegt sich die Betriebsfrequenz aus 
dem Anzeigebereich heraus, wandert dieser automa-
tisch mit.

 LDer angezeigte Frequenzbereich lässt sich über das 
Menü einstellen. (S. 12-7) 
([MENU] > SET > Scope > FIX Mode Center Frequency)

FIX mode
 • Zeigt Signale innerhalb eines bestimmten  
Frequenzbereichs an.
 LDer angezeigte Frequenzbereich lässt sich über das 
Menü einstellen. (S. 12-7) 
([MENU] > SET > Scope > FIX Mode Center Frequency)

Wenn die Betriebsfrequenz außerhalb des 
Frequenzbereichs liegt, erscheint „“ oder 
„“ an den Enden der Bandskop-Anzeige.

Obergrenze des  
Frequenzbereichs

Modus- 
anzeige
(FIX-Modus)

Untergrenze des  
Frequenzbereichs

Betriebsfrequenz  
(bewegt sich)

Modusanzeige
(Scroll-(FIX)-Modus) Betriebsfrequenz (bewegt sich)
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Bandskop

HINWEIS: Während eines Continuous-Sweeps kann 
ein Geräusch auftreten, wenn man mit der Hand oder 
dem Körper in die Nähe des Bildschirms kommt.

 DNutzung des Bandskops
[MENU] > SCOPE

1. [MENU] drücken.
2. „SCOPE“ wählen. 

 • Rückkehr zum Stand-by-Display und der  
Continuous-Sweep startet.

3. [QUICK] drücken.
4. „Scope Mode“ wählen. 

5. Anzeigemodus für das Bandskop wählen.
 • Der gewählte Modus wird aufgerufen und der  
Continuous-Sweep startet.

6. [ENT] drücken.
 • Der Sweep stoppt.
 LErneut [ENT] drücken, um den Continuous-Sweep 
fortzusetzen.

7. Mit [DIAL] den Sweep-Marker auf ein gefundenes 
Signal bewegen.

 • Das Signal ist hörbar.
 LWenn der Sweep pausiert [CLR] drücken, um das 
Bandskop auszuschalten.

Bandskop-Bedienung

Taste Aktion

[DIAL] Durch Drehen eine Betriebsfrequenz wählen.

Navigations-
taste ()

Drücken, um die Auswahl des Bandskop- 
Bereichs aufzuheben.

Navigations-
taste ()

Drücken, um den Bandskop-Bereich auszu-
wählen (orangefarbener Rahmen).

[ENT] Starten oder Stoppen eines Sweeps.

[QUICK]
Öffnen des Quick-Menüs.

 LBeim Wählen des Bandskop-Bereichs 
wird nur das Bandskop-Menü angezeigt.

[CLR]

Beim Wählen des Bandskop-Bereichs:
 • Bei einem laufenden Sweep drücken, um 
diesen zu stoppen.

 • Bei einem gestoppten Sweep drücken, 
um das Bandskop auszuschalten.

 DNutzung der Wasserfallanzeige
Im Einzelbanddisplay kann man die Wasserfallanzeige 
ein- oder ausschalten.

TIPP:
 • Wenn die Abstimmschrittweite zu groß gewählt ist, 
kann es vorkommen, dass selbst stärkere Signale vom 
Bandskop nicht erfasst werden. Deshalb ist es ratsam, 
eine Abstimmschrittweite von 20 kHz oder weniger zu 
verwenden, wenn das Bandskop genutzt werden soll. 
Einzelheiten zur Einstellung der Abstimmschrittweite 
finden sich im Basis handbuch, Abschnitt 3.

 • Während eines Sweeps auf dem Flugfunkband sind 
die Audiosignale auf der angezeigten Frequenz nicht 
hörbar. Wenn bei „AF Output (DUAL/AIR Band))“ die 
Einstellung „ON“ gewählt ist, werden die während eines 
Sweeps empfangenen Audiosignale kurzzeitig ausge-
geben. Man hört also, dass ein Signal empfangen wird, 
ohne auf das Display zu schauen.
-  Die Audioausgabe lässt sich im Menü bei „AF Output 

(DUAL/AIR Band)“ ein- oder ausschalten. (S. 12-30)
-  Durch diese Funktion kann die Audioausgabe des 

FM-Rundfunkempfangs unterbrochen werden. In 
diesem Fall ist bei „AF Output (DUAL/AIR Band)“ oder 
bei „Auto Mute“ die Einstellung „OFF“ zu wählen.

([MENU] > SET > Scope > AF Output (DUAL/AIR Band)) 
([MENU] > FM RADIO > FM Radio Set > Auto Mute)

 L Information
 • Die Darstellung der Signalpegel erfolgt absteigend in den 
Farben Rot, Gelb, Grün, Hellblau, Blau und Schwarz (kein 
Signal).

 • Während eines Sweeps bewegen sich die Skalen auf 
beiden Seiten mit dem Wasserfall. Beim Anhalten eines 
Sweeps frieren die Skalen und der Wasserfall ein.

 • Die Geschwindigkeit der Wasserfallanzeige lässt sich 
einstellen. 
([MENU] > SET > Scope > Waterfall Speed)

Wasser-
fall- 

anzeige

Skala Skala

orangefarbener 
Rahmen bei Auswahl 
eines Bandskop- 
Bereichs
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Hauskanal-Funktion

Hauskanäle sind oft genutzte Frequenzen, Speicher-
kanäle oder Repeater und können im VFO-, Speicher- 
und DR-Modus programmiert werden. 

 DEinstellen des Hauskanals
1. Modus wählen (VFO- oder Speichermodus) in 

dem der Hauskanal programmiert werden soll 
oder das „DR“-Display öffnen.

2. Frequenz, Speicherkanal oder Repeater zur  
Nutzung als Hauskanal wählen.

3. [QUICK] drücken.
4. „Home CH Set“ wählen. 

5. Im VFO-Modus „Set Frequency“, im Speicher-
modus „Set Channel“ oder im „DR“-Display  
„Set Repeater“ wählen. 

 • Der Hauskanal wird eingestellt, anschließend erfolgt 
die Rückkehr zum Stand-by-Display.

TIPP: Wenn man bei Schritt 4 „Clear“ wählt, werden 
die Hauskanaleinstellungen gelöscht.

 DHauskanal-Signalisierung
Wählt man durch Drehen von [DIAL] einen Hauskanal, 
ist ein Hinweiston hörbar. Man muss also nicht unbe-
dingt auf das Display schauen.

Die Tastenfunktion [Home CH] kann man Tasten an 
einem optionalen Mikrofon oder Headset zuweisen. 
(S. 12-18, 12-34)

 LDie Hauskanal-Signalisierung lässt sich im Menü aus-
schalten. 
([MENU] > SET > Sounds > Home CH Beep)

Piep
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Nutzung der DTMF-Speicher

Das Handfunkgerät verfügt über 16 DTMF-Speicher 
zur Speicherung von bis zu 24-stelligen DTMF-Codes 
(DTMF-Tonfolgen).

 DDTMF-Codes programmieren

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1. [MENU] drücken.
2. Im „SET“-Menü „DTMF/T-CALL“ wählen.
3. „DTMF Memory“ wählen. 

4. DTMF-Speicher für die Eingabe wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [QUICK] drücken.
6. „Edit“ wählen. 

7. DTMF-Code eingeben, dann [ENT] drücken. 
(Beispiel: 123456A) 

 • Der DTMF-Code wird gespeichert, Rückkehr zum 
„DTMF MEMORY“-Display.
 LHinweise zur Zeicheneingabe s. S. iii.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Zum Löschen eines eingegebenen  
DTMF-Codes im „DTMF MEMORY“-Display 
[QUICK] drücken und dann „Clear“ wählen.

 DÜberprüfung programmierter  
DTMF-Codes

Die eingegebenen DTMF-Codes kann man sich  
anhören.

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1. [MENU] drücken.
2. Im „SET“-Menü „DTMF/T-CALL“ wählen.
3. „DTMF Memory“ wählen.
4. Zu überprüfenden DTMF-Speicher wählen. 

 LNICHT die [ENT]-Taste betätigen!
5. [SQL] drücken. 

 • Der DTMF-Code wird wiedergegeben.
 • Nach der Wiedergabe erfolgt die Rückkehr zum 
„DTMF MEMORY“-Display.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Der DTMF-Code lässt sich auch prüfen,  
wenn man bei Schritt 4 im „DTMF MEMORY“- 
Display [QUICK] drückt und anschließend  
„DTMF Monitor“ wählt. 
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DTMF-Codes senden

 DEinen programmierten  
DTMF-Code senden

[MENU] > SET > DTMF/T-CALL > DTMF Memory

1. [MENU] drücken.
2. Im „SET“-Menü „DTMF/T-CALL“ wählen.
3. „DTMF Memory“ wählen. 

4. Den gewünschten DTMF-Speicher wählen. 

 • Der gewählte DTMF-Speicher wurde für das Senden 
übernommen.

5. [MENU] drücken.
 • Das Menü wird verlassen.

6. Bei gedrückter [PTT] die Taste [SQL] drücken. 

 • Der bei Schritt 4 gewählte DTMF-Code wird gesendet.
 • Das Handfunkgerät sendet die DTMF-Tonfolge kom-
plett, selbst wenn die [PTT]-Taste vorzeitig  
losgelassen wird.

TIPP: Das Senden programmierter DTMF-Codes ist 
auch im Stand-by-Modus über das Quick-Menü 
möglich. Dazu [QUICK] drücken, dann „DTMF TX“ 
wählen und einen DTMF-Code zum Senden aus-
wählen. 
 

 DEinen direkt eingegebenen  
DTMF-Code senden

1. [QUICK] drücken.
2. „DTMF TX“ wählen. 

3. „Direct Input“ wählen. 

4. DTMF-Code eingeben, dann [ENT] drücken. 
(Beispiel: 012345#) 

 • Der eingegebene DTMF-Code wird gesendet.
 LDer DTMF-Code scrollt während des Sendens.
 LHinweise zur Zeicheneingabe s. S. iii.

TIPP: 1750-Hz-Rufton
Wenn man im „DTMF MEMORY“-Display die Option 
„T-CALL“ wählt, kann man einen 1750-Hz-Rufton 
senden. 
 

Bei gedrückter [PTT] die Taste [SQL] drücken.
 • Der 1750-Hz-Rufton wird gesendet.
 LDer 1750-Hz-Rufton ist aus dem Lautsprecher hörbar.
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DTMF-Codes senden

 DDTMF-Sendegeschwindigkeit  
einstellen

Die Sendegeschwindigkeit des DTMF-Codes lässt 
sich einstellen.

[MENU] > SET > DTMF/T-CALL > DTMF Speed

1. [MENU] drücken.
2. Im „SET“-Menü „DTMF/T-CALL“ wählen.
3. „DTMF Speed“ wählen. 

4. Die gewünschte DTMF-Geschwindigkeit wählen. 
(voreingestellt: 100ms) 

 LZum Verlassen die [MENU]-Taste drücken.

Beispiele für Sendegeschwindigkeiten  
des DTMF-Codes

Bei „100ms“ sind die 
DTMF-Töne in schneller 
Folge hörbar

Bei „500ms“ sind die 
DTMF-Töne in langsamer 
Folge hörbar

Pi, Po, Pa Pi–, Po–, Pa–
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TSQL-Betrieb

Die Tone-Squelch-Funktion gestattet es, bei stumm-
geschaltetem Empfänger den Anruf ganz bestimmter 
Stationen zu erwarten. Erst wenn ein Signal empfan-
gen wird, das den passenden Subaudio (CTCSS)-Ton 
enthält, wird die Rauschsperre geöffnet.
Die TSQL (CTCSS)-Funktion ist bei FM und FM-N 
verfügbar.
Bei der reversen TSQL-Funktion ist die Rauschsperre
normalerweise geöffnet und schließt, wenn ein Signal
mit dem passenden Subaudio (CTCSS)-Ton empfan-
gen wird.

Schritt 1. Tone-Squelch-Frequenz einstellen

[MENU] > SET > DUP/TONE... > TSQL Freq

1. Zum Aufrufen des VFO-Modus [VFO/MHz] drücken.
2. [MODE] drücken, um FM oder FM-N zu wählen.
3. Mit [DIAL] die gewünschte Frequenz einstellen.
4. [MENU] drücken.
5. Im „SET“-Menü „DUP/TONE...“ wählen.
6. „TSQL Freq“ wählen. 

7. Mit [DIAL] die gewünschte TSQL (CTCSS)- 
Frequenz einstellen und mit [ENT] bestätigen. 

 LDie wählbaren TSQL (CTCSS)-Frequenzen liegen 
zwischen 67,0 und 254,1 Hz.
 LZum Verlassen die [MENU]-Taste drücken.

Tone-Squelch-Typen
 • TSQL: TSQL-Funktion eingeschaltet.
 • TSQL-R:  Reverse TSQL-Funktion eingeschaltet.
 • TONE(T)/DTCS(R) 
(„T-DTCS“ wird angezeigt, „T“ blinkt): 
  Beim Senden wird der gewählte CTCSS-Ton 

mit übertragen. Beim Empfang öffnet ein 
Signal, das den passenden DTCS-Code mit 
der richtigen Polarität enthält, den Squelch, 
sodass das Empfangssignal hörbar ist

 • DTCS(T)/TSQL(R) 
(„D-TSQL“ wird angezeigt, „D“ blinkt.): 
  Beim Senden wird der gewählte DTCS-Code 

mit übertragen. Beim Empfang öffnet ein Sig-
nal, das den passenden CTCSS-Ton enthält, 
den Squelch, sodass das Empfangssignal 
hörbar ist.

 • TONE(T)/TSQL(R) 
(„T-TSQL“ wird angezeigt, „T“ blinkt.): 
  Beim Senden wird der gewählte CTCSS-Ton 

mit übertragen. Beim Empfang öffnet ein Sig-
nal, das den passenden CTCSS-Ton enthält, 
den Squelch, sodass das Empfangssignal 
hörbar ist.

Schritt 2. TSQL-Betrieb
1. [QUICK] drücken.
2. „TONE“ wählen. 

3. Tone-Squelch-Typ wählen. 

4. Das Handfunkgerät kann man jetzt normal  
weiterbedienen.

 • Es sind nur Signale von Stationen zu hören, die die 
gleiche Tone-Squelch-Frequenz verwenden. Alle 
anderen Signale sind stummgeschaltet.
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DTCS-Betrieb

Die Tone-Squelch-Funktionen des Handfunkgeräts 
gestatten es, bei stummgeschaltetem Empfänger den 
Anruf ganz bestimmter Stationen zu erwarten. Erst 
wenn ein Signal empfangen wird, das den passenden 
DTCS-Code enthält, wird die Rauschsperre geöffnet. 
Die DTCS-Funktion ist bei FM und FM-N verfügbar. 
Bei der reversen DTCS-Funktion ist die Rauschsperre 
normalerweise geöffnet und schließt, wenn ein Signal 
mit dem passenden DTCS-Code empfangen wird.

Schritt 1. DTCS-Code einstellen

[MENU] > SET > DUP/TONE... > DTCS Code

1. Zum Aufrufen des VFO-Modus [VFO/MHz] drü-
cken.

2. [MODE] drücken, um FM oder FM-N zu wählen.
3. Mit [DIAL] die gewünschte Frequenz einstellen.
4. [MENU] drücken.
5. Im „SET“-Menü „DUP/TONE...“ wählen.
6. „DTCS Code“ wählen. 

7. Mit [DIAL] den gewünschte DTCS-Code einstellen 
und mit [ENT] bestätigen. 

 LDie wählbaren DTCS-Codes liegen zwischen  
023 and 754.
 LZum Verlassen die [MENU]-Taste drücken.

DTCS-Code-Typen
 • DTCS: DTCS-Funktion eingeschaltet.
 • DTCS-R:  Reverse DTCS-Funktion eingeschaltet.
 • DTCS(T) („DTCS“ blinkt): 
  Beim Senden wird der gewählte DTCS-Code 

mit übertragen. Beim Empfang ist die DTCS 
ausgeschaltet.

 • TONE(T)/DTCS(R) 
(„T-DTCS“ wird angezeigt, „T“ blinkt): 
  Beim Senden wird der gewählte CTCSS-Ton 

mit übertragen. Beim Empfang öffnet ein 
Signal, das den passenden DTCS-Code mit 
der richtigen Polarität enthält, den Squelch, 
sodass das Empfangssignal hörbar ist.

 • DTCS(T)/TSQL(R) 
(„D-TSQL“ wird angezeigt, „D“ blinkt): 
  Beim Senden wird der gewählte DTCS-Code 

mit übertragen. Beim Empfang öffnet ein Sig-
nal, das den passenden CTCSS-Ton enthält, 
den Squelch, sodass das Empfangssignal 
hörbar ist.

Schritt 2. DTCS-Betrieb
1. [QUICK] drücken.
2. „TONE“ wählen. 

3. DTCS-Code-Typ wählen. 

4. Das Handfunkgerät kann man jetzt normal  
weiterbedienen.

 • Es sind nur Signale von Stationen zu hören, die den 
gleichen DTCS-Code verwenden. Alle anderen Sig-
nale sind stummgeschaltet.
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VOX-Funktion

Das Handfunkgerät besitzt eine VOX-Funktion  
(Voice Operated Exchange), die sprachgesteuert auf 
Senden umschaltet, sodass man nur in das Mi krofon 
sprechen muss, ohne dabei die [PTT] zu betätigen. 
Das ermöglicht freihändigen Betrieb. Dazu sind ein 
optionales Headset HS-94, HS-95 oder HS-97 und 
das Verbindungskabel OPC-2006LS erforderlich.

HINWEIS: Beim Anschließen des Kabels OPC-
2006LS an die [MIC/SP]-Buchse MUSS das Hand-
funkgerät ausgeschaltet sein.

TIPP: Die VOX-Funktion lässt sich auch mit dem 
Bluetooth-Headset nutzen.
([MENU] > SET > Bluetooth Set > Headset Set > VOX)
Details s. S. 13-5.

 DHeadset-Typ wählen
[MENU] > SET > Function > VOX > Headset Select

1. [MENU] drücken.
2. Im „SET“-Menü den Menüpunkt „Function“ wäh-

len.
3. „VOX“ wählen. 

4. „Headset Select“ wählen. 

5. Eine Option wählen. 

 • HS-95: Bei Nutzung des Headsets HS-95.
 • Other:  Bei Nutzung des Headsets HS-94 oder 

HS-97.
 LZum Verlassen die [MENU]-Taste drücken.

OPC-2006LS
(optional)

HS-94*
(optional)

ID-52E

in die 
[MIC/SP]-Buchse

*  Die Funktion kann auch mit den optionalen Headsets HS-95 oder 
HS-97 genutzt werden.
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VOX-Funktion

 DNutzung der VOX-Funktion
[MENU] > SET > Function > VOX > VOX

1. [MENU] drücken.
2. Im „SET“-Menü den Menüpunkt „Function“  

wählen.
3. „VOX“ wählen. 

4. „VOX“ wählen. 

5. „ON“ wählen. 

6. Zum Verlassen die [MENU]-Taste drücken. 

 • Wenn die Headsets HS-94, HS-95 oder HS-97 mit 
dem Handfunkgerät verbunden sind, erscheint die 
Anzeige „VOX“ im Stand-by-Display.

HINWEIS: Während des Empfangs eines Signals 
oder der Ausgabe eine Warn- bzw. Hinweistons, 
kann man das Handfunkgerät nicht stimmgesteuert 
auf Senden umschalten.

 DVOX-Empfindlichkeit einstellen

HINWEIS: Es empfiehlt sich die Mikrofonverstär-
kung auf Stufe 3 einzustellen, bevor man die 
VOX-Empfindlichkeit einstellt. 
([MENU] > SET > Function > MIC Gain (External))

[MENU] > SET > Function > VOX > VOX Level

1. [MENU] drücken.
2. Im „SET“-Menü den Menüpunkt „Function“  

wählen.
3. „VOX“ wählen. 

4. „VOX Level“ wählen. 

5. Während des Sprechens in das Mikrofon mit 
[DIAL] die VOX-Empfindlichkeit einstellen. 

 • Im Display erscheint „VOX“, wenn mit der zum 
Senden erforderlichen Lautstärke in das Mikrofon 
gesprochen wird.
 LDie VOX-Empfindlichkeit kann zwischen  
1 (Minimum) und 10 (Maximum) eingestellt werden 
(voreingestellt: 5).
 LJe höher der eingestellte Wert ist, desto empfindli-
cher reagiert die VOX-Funktion auf Sprache.

6. Zum Verlassen die [MENU]-Taste drücken.
 LWenn das Handfunkgerät nicht sendet und  
keine Anzeige des Sendepegels erfolgt, ist die 
VOX-Verzögerung einzustellen. 
([MENU] > SET > Function > VOX > VOX Delay)
 LWährend des Sendens mit der VOX-Funktion lässt 
sich die VOX-Empfindlichkeit durch Drehen an [DIAL] 
einfach verändern.
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VOX-Funktion

 DVOX-relevante Einstellungen
Im Menü lassen sich VOX-Verzögerung und
VOX-Time-Out-Timer einstellen.

VOX Delay

[MENU] > SET > Function > VOX > VOX Delay

Die VOX-Verzögerungszeit ist die Zeit, die nach dem 
Beenden des Sprechens vergeht, bis das Handfunk-
gerät automatisch auf Empfang schaltet. Sie ermög-
licht normale Sprechpausen. (S. 12-22)

VOX Time-Out Timer

[MENU] > SET > Function > VOX >  
VOX Time-Out Timer

Der VOX-Time-Out-Timer dient der Verhinderung un-
gewollten Dauersendens infolge lauter Umgebungs-
geräusche, die die VOX-Funktion aktivieren. (S. 12-22)
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Displayfoto-Funktion

Die Displayanzeige lässt sich als Bilddatei (Screen-
shot) auf einer Micro-SD-Karte speichern. Die meis-
ten Abbildungen in dieser Anleitung wurden mit die-
ser Funktion generiert. Allerdings lassen sich einige 
Displays nicht aufnehmen. 

 DDisplayfoto-Funktion einstellen
[MENU] > SET > Function >  
Screen Capture [PWR] Key

1. [MENU] drücken.
2. Im „SET“-Menü den Menüpunkt „Function“  

wählen.
3. „Screen Capture [PWR] Key“ wählen. 

4. „ON“ wählen. 

 LZum Verlassen die [MENU]-Taste drücken.

 DDisplayfoto aufnehmen
1. Gewünschtes Display anzeigen lassen.
2. [ ] drücken, um das Display zu „fotografieren“.

 • Die Bilddatei wird auf der Micro-SD-Karte
 • gespeichert.

 DDisplayfoto ansehen
[MENU] > SET > SD Card > Screen Capture View

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen. 
3. „Screen Capture View“ wählen. 

 • Die Displayfoto-Liste wird angezeigt.
 • Das neueste Displayfoto steht an erster Stelle.

4. Anzuzeigendes Displayfoto wählen. 

 • Das gewählte Displayfoto erscheint im Display.
 LWährend ein Displayfoto angezeigt wird, kann man 
mit [DIAL] durch alle anderen scrollen.
 LZum Verlassen die [MENU]-Taste drücken.

Ansehen der Dateiinformation und Löschen  
einer Datei
1. Das gewünschte Displayfoto wählen.

 LNICHT die [ENT]-Taste betätigen!
2. [QUICK] drücken.
3. Eine der Optionen „File Information“, „Delete“ 

oder „Delete All“ wählen. 

 • File Information:  Anzeige des Namens, der Größe 
und des Datums des gewählten 
Displayfotos.

 • Delete:  Löschen des gewählten Display-
fotos.

 • Delete All: Löschen aller Displayfotos.

[ ]
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Startbild einstellen

Man kann ein Startbild wählen, das beim Einschalten 
des Handfunkgeräts erscheint.

HINWEIS: Um ein Bild als Startbild zu einzustellen, 
ist eine Micro-SD-Karte (nicht im Lieferumfang ent-
halten) erforderlich.

Anforderungen an die zu verwendende Bilddatei
 • Dateityp:  24 bit Bitmap  

(Dateiendung „bmp“)
 • Bildgröße 320 x 280 Pixel
 • Dateiname:  bis zu 23 Zeichen 

(ohne Dateiendung)

Schritt 1.  
Ein Bild auf der Micro-SD-Karte speichern (PC)
1. Eine Bilddatei auf die Micro-SD-Karte in den  

Ordner „ID-52“ > „OpeningPicture“ kopieren.
 LDetails s. S. 2-5 .

2. Micro-SD-Karte in das Handfunkgerät einsetzen.

Schritt 2. Einstellen des Startbildes (Transceiver)

[MENU] > SET > SD Card > Opening Picture

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen. 
3. „Opening Picture“ wählen. 

4. Eine Bilddatei zum Ansehen wählen. 

 • Das gewählte Bild wird angezeigt.
5. [ENT] drücken.

 L [CLR] drücken, um ein anderes Bild zu wählen.
 • Ein Bestätigungsfenster öffnet sich.

6. „YES“ wählen.
 • Das Handfunkgerät wird automatisch neu gestartet. 
Dabei erscheint das ausgewählte Bild.

Das Startbild beim Einschalten nicht mehr  
anzeigen
Damit das Bild beim Einschalten nicht mehr angezeigt 
wird, wählt man bei Schritt 4 „<<Cancel Opening Pic-
ture Setting>>“.
 

 LDas ausgewählte Bild kann auch dann angezeigt  
werden, wenn:

 • sich keine Micro-SD-Karte im Handfunkgerät  
befindet,

 • das Handfunkgerät teilweise oder vollständig auf die 
Werkseinstellung zurückgesetzt wurde.
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Klonen

Das ID-52E verfügt über die Möglichkeit, Daten und 
Einstellungen zu klonen. Dies ist zweckmäßig, um 
zwei oder mehrere ID-52E mit den gleichen Speicher-
inhalten und Einstellungen zu versehen. Nachfolgend 
wird das Klonen mithilfe einer Micro-SD-Karte be-
schrieben.

Schritt 1.  Speichern von Einstellungsdaten und 
Speicherinhalten des Master-Handfunk-
geräts auf einer Micro-SD-Karte

[MENU] > SET > SD Card > Save Setting

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen. 
3. „Save Setting“ wählen. 

4. <<New File>>“ wählen. 

 LDer Dateiname wird automatisch nach folgendem 
Schema erzeugt: Setyyyymmdd_xx  
(yyyy: Jahr, mm: Monat, dd: Tag, xx: fortlaufende 
Nummer).

5. Zum Speichern der Datei unter dem angegebenen 
Namen [ENT] drücken.

 • Ein Bestätigungsfenster öffnet sich.
6. „YES“ wählen. 

 • Während des Speicherns wird ein Fortschrittsbalken 
angezeigt. Nach dem abgeschlossenen Speichervor-
gang erfolgt die Rückkehr zum „SD CARD“-Display.
 LZum Verlassen die [MENU]-Taste drücken.

Schritt 2.  Herausnehmen der Micro-SD-Karte 
aus dem Master- und Einsetzen in das 
Sub-Handfunkgerät

1. Master-Handfunkgerät ausschalten.
2. Micro-SD-Karte aus dem Master-Handfunkgerät 

entnehmen.
3. Micro-SD-Karte in das Sub-Handfunkgerät ein-

setzen und einschalten.

Master Sub

HINWEIS:
 • Zum Einsetzen oder Entnehmen der Micro-SD-Karte 
das Handfunkgerät immer ausschalten..

 • Das Handfunkgerät NIEMALS während des Speicherns 
oder Ladens von Daten ausschalten. Diese könnten 
dadurch beschädigt oder gelöscht werden.

TIPP: Die Einstellungsdaten werden im ICF-Format 
gespeichert, das von der programmiersoftware 
CS-52 verwendet wird.
Wenn die auf einer Karte gespeicherten Daten auf 
einen PC kopiert werden, kann man sie mit der 
Programmiersoftware bearbeiten. Details dazu 
sind in der CS-52-Anleitung zu finden, die von der 
Icom-Website heruntergeladen werden kann.

(Weitere Schritte auf der nächste Seite)

 LSprachspeicheraufzeichnungen werden nicht mit geklont. 
Um die Sprachspeicherinhalte des Master-Handfunk-
geräts auf einem anderen Gerät wiederzugeben, setzen 
Sie die Micro-SD-Karte in ein Sub-Handfunkgerät ein 
oder erstellen Sie mit einem PC eine Kopie auf der Mic-
ro-SD-Karte des Sub-Handfunkgeräts. 
 LVoraussetzung ist, dass die Micro-SD-Karte bereits in 
das Handfunkgerät eingesetzt wurde.
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Klonen

Schritt 3.  Laden der Einstellungsdaten in das 
Sub-Handfunkgerät

[MENU] > SET > SD Card > Load Setting

1. [MENU] drücken.
2. Im „SET“-Menü „SD Card“ wählen. 
3. „Load Setting“ wählen. 

4. Zu ladende Datei wählen. 

5. Zu ladende Inhalte wählen. 

 • ALL:  
Lädt alle Speicherkanäle, Menüeinstellungen und die 
Repeater-Liste in das Handfunkgerät.

 • Except My Station:  
Lädt alle Speicherkanäle, Menüeinstellungen mit 
Ausnahme der eigenen Rufzeichen und die Repea-
ter-Liste in das Handfunkgerät.

 • Repeater List Only: 
Lädt nur die Repeater-Liste in das Handfunkgerät.

6. „YES“ oder „NO“ wählen. 

 • YES: 
Die Übersprungeinstellungen in der Repeaterliste 
werden beibehalten. (S. 5-39)

 • NO:  
Die Übersprungeinstellungen in der Repeaterliste 
werden gelöscht.

7. „YES“ wählen. 

 • Die Datei wird geprüft und dann geladen.
 • Nach dem erfolgreichen Laden erscheint  
„COMPLETED!“ im Display.

8. Um mit den neuen Einstellungen zu arbeiten, 
muss das Handfunkgerät neu gestartet werden.
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Reset

Im Display können ausnahmsweise irreführende Zei-
chen oder Anzeigen erkennbar sein. Dies kann durch 
elektrostatische Aufladungen oder elektromagneti-
sche Felder verursacht werden.
Falls dieses Problem auftaucht, sollte das Handfunk-
gerät ausgeschaltet und nach einigen Sekunden wie-
der eingeschaltet werden. Führt das nicht zum Erfolg, 
ist ein Teil-Reset oder Total-Reset durchzuführen.

Hinweis zum Total-Reset: Nach einem Total-Reset 
lässt sich die DR-Funktion nicht mehr nutzen,  
weil dabei die Repeater-Listen gelöscht werden.
Es ist daher sinnvoll, diese Daten auf einer  
Micro-SD-Karte oder einem PC, auf dem die  
programmiersoftware CS-52 installiert ist, zu  
sichern, bevor der Total-Reset ausgeführt wird. 
Nach dem Total-Reset kann man die Daten wieder 
in das Handfunkgerät laden.

 DTeil-Reset
Der Teil-Reset setzt alle Betriebseinstellungen auf die 
Werksvoreinstellungen zurück. Folgende Einstellungen 
bleiben erhalten.

 • Speicherkanalinhalte
 • Anrufkanalinhalte
 • Inhalte der FM-Rundfunkspeicher
 • Suchlaufeckfrequenzen
 • Mitteilungsdaten
 • GPS-Speicherinhalte
 • Rufzeichenspeicher
 • Inhalte der DTMF-Speicher
 • Repeater-Liste
 • Bluetooth-Kopplungsliste
 • Startbild

[MENU] > SET > Others > Reset > Partial Reset

1. [MENU] drücken.
2. Im „SET“-Menü „Others“ wählen.
3. „Reset“ wählen. 

4. „Partial Reset“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
5. „YES“ wählen. 

 • Im Display erscheint „PARTIAL RESET“ und das 
Handfunkgerät kehrt zum Standarddisplay zurück.

 DTotal-Reset
Ein Total-Reset löscht alle Daten und setzt alle Ein-
stellungen auf die Werkseinstellungen zurück. Die 
Inhalte der Speicherkanäle, Filtereinstellungen usw. 
werden gelöscht, so dass alle Einstellungen erneut 
vorgenommen werden müssen, sofern keine Siche-
rungskopie vorhanden ist.

 LDie Bluetooth-Kopplungsliste und das Startbild werden 
nicht gelöscht.

[MENU] > SET > Others > Reset > All Reset

1. [MENU] drücken.
2. Im „SET“-Menü „Others“ wählen.
3. „Reset“ wählen. 

4. „All Reset“ wählen. 

 • Ein Bestätigungsfenster öffnet sich.
5. „YES“ wählen. 

 • Im Display erscheint „ALL RESET“ und das Hand-
funkgerät kehrt zum Standarddisplay zurück.
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 DZum Firmware-Update
Falls gewünscht, lässt sich die Firmware des ID-52E 
mittels Micro-SD-Karte aktualisieren. Durch das Firm-
ware-Update können neue Funktionen implementiert 
bzw. die Performance verbessert werden. Die aktuelle 
Firmware steht auf der Icom-Website zum Download 
zur Verfügung.
https://www.icomjapan.com/support/

IMPORTANT: Vor dem Update zuerst die Micro- 
SD-Karte mit dem ID-52E formatieren. Danach  
kopiert man die heruntergeladene Firmware-Datei 
vom PC auf die Karte in den Ordner „ID-52“.

 DÜberprüfen der Firmware-Version
Die Firmware-Version lässt sich im „VERSION“-Dis-
play prüfen.

[MENU] > SET > Others > Information > Version

1. [MENU] drücken.
2. Im „SET“-Menü „Others“ wählen.
3. „Information“ wählen. 

4. „Version“ wählen. 

 • Das „VERSION“-Display wird angezeigt.
 LZum Verlassen des „VERSION“-Displays,  
[MENU] drücken.

TIPP: Die Firmware-Version lässt sich auch beim 
Einschalten des Handfunkgeräts überprüfen.
 

Anzeige der Firmware-Version

Allgemein
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 DVorbereitung
Vom PC aus die folgende URL aufrufen und die  
Firmware-Datei herunterladen:

https://www.icomjapan.com/support/
 LDiese Anleitung basiert auf dem englischen Betriebssys-
tem Microsoft® Windows® 10.

1. Auf den Link „Firmware/Software“ klicken. 

Klick

2. „ID-52“ in das Suchfeld eingeben und auf 
[Search] klicken. 

3. Auf den Link der gewünschten Firmware-Datei 
klicken.

4. Die Hinweise „Regarding this Download Service“ 
aufmerksam lesen, dann auf „Agree“ und an-
schließend auf [Download] klicken. 

5. Im angezeigten Download-Dialog auf „Save as“ 
klicken. 

6. Im Download-Dialog den gewünschten Speicher-
ort für die Firmware-Datei auf dem PC wählen 
und danach auf [Save] klicken. 

Klick

 • Der Download der Datei beginnt.
 • Die Firmware und das Utility werden im ZIP-Format 
heruntergeladen. Vor der Nutzung sind die Dateien 
zu entpacken

Allgemein

2	Klick

1	Enter

2	Klick
1	Klick

 DEntpacken des Firmware-Ordners
1. Rechtsklick auf den heruntergeladenen  

Firmware-Ordner (ZIP-Format).
 • Das Kontextmenü erscheint.

2. „Extract All...“ anklicken. 

Klick

 • Nach dem Entpacken wird ein Ordner im selben Ver-
zeichnis angelegt, in dem sich die Download-Datei 
befindet.
 L Im Ordner „52*“wird die Datei „52*.dat“ erstellt. 
* Steht für die Versionsnummer der Firmware.
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Update der Firmware

VORSICHT: NIEMALS das Handfunkgerät aus-
schalten, während das Firmware-Update durch-
geführt wird. Falls Sie es während des Updates 
ausschalten oder sich beim Update ein Stromausfall 
ereignet, wird die Firmware beschädigt und das 
Handfunkgerät muss zur Instandsetzung einge-
schickt werden. Derartige Instandsetzungen werden 
durch die Garantie nicht abgedeckt, auch wenn das 
Problem während der Garantiezeit auftritt.

Empfehlung!
Es wird dringend empfohlen, den Akkupack vor Be-
ginn des Firmware-Updates vollständig aufzuladen, 
um ein Fehlschlagen des Updates durch unerwarte-
ten Stromausfall zu vermeiden.

TIPP: Die heruntergeladene Datei muss entpackt 
werden. Details dazu sind auf der vorhergehenden 
Seite zu finden.

1. Entpackte Firmware-Datei in den Ordner 
„ID-52“ auf der Micro-SD-Karte kopieren. 

Kopieren

2. Micro-SD-Karte in das Handfunkgerät einsetzen.
3. Das „SD CARD“-Display öffnen.

[MENU] > SET > SD Card

4. „Firmware Update“ wählen, 

5. Nach dem Lesen der Vorsichtsmaßnahmen  
„Yes“ wählen. 

 • Scrollen, um alle Vorsichtsmaßnahmen zu lesen.
 • Ein Bestätigungsfenster öffnet sich. 
Nach dem Wählen von [YES] wird eine Backup-Datei 
auf der Micro-SD-Karte erstellt und ein Fenster zur 
Firmware-Auswahl erscheint.

6. Firmware wählen (Beispiel: 52*). 
* Steht für die Versionsnummer der Firmware. 

 • Das abschließende Bestätigungsfenster erscheint.
 LVorsichtsmaßnahmen sorgfältig durchlesen.

7.  „Yes“ wählen, um zu bestätigen, dass man auch 
diese Vorsichtsmaßnahmen zur Kenntnis genom-
men hat. 

 • Das Firmware-Update startet.
8. Nach erfolgreichem Update erscheint „Firmware 

updating has completed.“ im Dialogfenster.
 • Das Handfunkgerät wird automatisch neu gestartet.
 LNach dem Neustart wird das normale Betriebs-
display angezeigt.

TIPP: Wenn bei „USB Connect“ die Einstellung „SD 
Card Mode“ gewählt wurde und das Handfunkgerät 
über ein USB-Datenkabel mit dem PC verbunden ist, 
kann man vom PC aus direkt auf die im Handfunk-
gerät eingesetzte Micro-SD-Karte zugreifen.
([MENU] > SET > Function > USB Connect)
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Informationen zum Zubehör sind auf folgender Web-
site zu finden:

https://www.icomeurope.com/support/

 LJe nach Version des Handfunkgeräts ist manches Zube-
hör eventuell nicht verfügbar.

Zubehörliste

Weiteres Zubehör

AD-92SMA antennenadapter
Zum Anschließen einer Antenne oder eines Antennenkabels 
mit BNC-Anschluss.

FA-S270C ukw-antenne
Wie im Lieferumfang.

LC-193 tragetasche
 LNicht verwendbar, wenn der Akkupack BP-307 am Hand-
funkgerät angebracht ist.

MB-127 gürtelclip
Wie im Lieferumfang.

VS-3 Bluetooth®-headset

Akkupacks/Ladegeräte

BC-167SA/BC-167SD ladegerät
Wie im Lieferumfang.
Je nach Version in abweichender Ausführung.

BC-202IP2 schnelllader

+  BC-123SA/BC-123SE (mit abgewinkeltem Stecker)  
netzadapter

BC-202IP3L schnelllader

+  BC-123SA/BC-123SE (mit geradem Stecker)  
netzadapter (für Einzeleinheit)

+ BC-228 netzadapter (für mehrere Einheiten)

BP-271 Li-ionen-akkupack
Spannung: 7,4 V
Kapazität: 1150 mAh (mind.), 1200 mAh (typisch)
Betriebszeit: etwa 4,25 Stunden (FM)

BP-272 Li-ionen-akkupack
Wie im Lieferumfang.
Spannung: 7,4 V
Kapazität: 1880 mAh (mind.), 2000 mAh (typisch)
Betriebszeit: etwa 7,25 Stunden (FM)

BP-273 batteriebehälter
Für drei LR6-Alkaline-Batterien (AA).

BP-307 Li-ionen-akkupack
Spannung: 7,2 V
Kapazität:  3050 mAh (mind.), 3150 mAh (typisch)
Betriebszeit:  etwa 12 Stunden (FM)

Kabel

CP-12L zigarettenanzünderkabel
Mit Rauschfilter.
Kennzeichnung: FUSE 125V 3A
Nennspannung: 125 Volt
Nennstrom: 3 Ampere

OPC-254L gleichstromkabel
Zum Anschließen an eine Gleichstromversorgung.
Kennzeichnung: FUSE 250V 3A
Nennspannung: 250 Volt
Nennstrom: 3 Ampere

CP-23L zigarettenanzünderkabel
Für BC-202IP2, 12 V

 LKann nicht an die [DC IN]-Buchse des Handfunkgeräts 
angeschlossen werden.

OPC-515L gleichstromkabel
Für BC-202IP2

 LKann nicht an die [DC IN]-Buchse des Handfunkgeräts 
angeschlossen werden.

CP-25H zigarettenanzünderkabel
Für BC-202IP3L, 12 V

 LKann nicht an die [DC IN]-Buchse des Handfunkgeräts 
angeschlossen werden.

OPC-2417 datenkabel (USB micro-B/USB micro-B)

OPC-2418 datenkabel (USB micro-B/USB Type-C)

Headsets/Ohrhörer

HS-94/HS-95/HS-97 headset

+ OPC-2006LS adapterkabel
HS-94:  Ohrhaken-Ausführung
HS-95:  Hinterkopf-Ausführung
HS-97  Kehlkopfmikrofon
OPC-2006LS:  Zum Anschließen von HS-94/HS-95/HS-97 

an das Handfunkgerät zur Nutzung der VOX.

HM-153LS ohrhörermikrofon

HM-166LS ohrhörermikrofon
Kleiner als das HM-153LS.

SP-40 ohrhörer

+ OPC-2144 adapterkabel
Für die Nutzung des SP-40 ist das Adapterkabel OPC-2144 
mit abgewinkeltem Stecker erforderlich.

Lautsprechermikrofone

HM-75LS fernsteuer-lautsprechermikrofon

HM-183LS lautsprechermikrofon
Wasserdicht gemäß Schutzart IPX7  
(in 1 m Wassertiefe für 30 min).

HM-186LS lautsprechermikrofon
Spritzwassergeschützt gemäß Schutzart IPX4.
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Zubehörliste

Kostenlos herunterladbare Software
CS-52 programmiersoftware

RS-MS1A (für Android-Geräte) Android-app

RS-MS1I (für iOS-Geräte) iOS™-app

RS-MS3A (für Android-Geräte) terminal-mode-/access-point-mode-software

RS-MS3W (für Windows) terminal-mode-/access-point-mode-software

ST-4001A (für Android-Geräte) bildbearbeitungssoftware

ST-4001I (für iOS-Geräte) bildbearbeitungssoftware

ST-4001W (für Windows) bildbearbeitungssoftware

Alle Anleitungen stehen auf der Icom-Website zum Herunterladen bereit.
 https://www.icomjapan.com/support/

 LLesen Sie vor der Benutzung alle Handbücher und Anleitungen und benutzen Sie die Software entsprechend den Anwei-
sungen.
 LAktualisierte Softwareversionen dienen der Funktionserweiterung oder der Leistungsverbesserung.
 LBevor Sie Ihre Softwareversion aktualisieren, lesen Sie die auf der Icom-Website zur Verfügung stehenden Anleitungen und 
Hinweise.
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Mit dem optionalen Fernsteuer-Lautsprechermikrofon 
HM-75LS lassen sich Frequenzen, Speicherkanäle 
usw. einstellen.
Für die Fernsteuerung lässt sich die Funktions-
zuordnung der einzelnen Tasten am HM-75LS über 
das Menü des Handfunkgeräts ändern. (S. 12-18)

Das HM-75LS besitzt auf der Rückseite einen Verrie-
gelungsschalter, um versehentliche Änderungen der 
Frequenzeinstellung usw. zu vermeiden

HINWEIS:
 • Vor dem Anschließen des HM-75LS an die [MIC/SP]- 
Buchse das Handfunkgerät ausschalten.

 • Der Stecker des HM-75LS muss fest und sicher in der 
Buchse sitzen.

 DFernsteuerfunktion zuweisen
Beispiel:  Die Funktion „TO (DR)“ der Taste [A]  

zuweisen.

[MENU] > SET > Function > Remote MIC Key

1. [MENU] drücken.
2. Im „SET“-Menü den Menüpunkt „Function“ wählen.
3. „Remote MIC Key“ wählen. 

4. „During RX/Standby“ wählen. 

5. „[A]“ wählen. 

 • Eine Liste mit zuweisbaren Funktionen wird angezeigt.
 LDetails zu den Funktionen sind auf den Seiten 12-19 
und 12-20 zu finden.

Optionales Fernsteuer-Lautsprechermikrofon HM-75LS

6. „TO (DR)“ wählen. 

 • Die Funktion „TO (DR)“ wurde zugewiesen.
 LZum Verlassen die [MENU]-Taste drücken.

TIPP: Rückkehr zur Voreinstellung
 • [QUICK]-Taste im „During RX/Standby“- oder „During 
TX“-Display drücken, danach „Default All“ wählen, um 
alle Tastenfunktionen auf die voreingestellten zurückzu-
setzen.

 • [QUICK]-Taste im „Key“-Display der betreffenden Taste 
drücken, danach „Default“ wählen, um die Tastenfunk-
tion auf die voreingestellte zurückzusetzen.

A

OFF ON

LOCK

B

A

B

Mikrofon

Sende-LED

[PTT]

Laut- 
sprecher

Verriegelungs-
schalter

[A]

[B]

[]

[]

Ohrhörerbuchse
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Nutzung einer App

Die nachstehend aufgeführten Applikationen sind mit Android- bzw. iOS-Geräten kompatibel.
Details sind den zugehörigen Anleitungen zu entnehmen.
Laden Sie sich die Apps auf ihr Gerät.

 DKompatible Apps
Folgende Apps sind mit dem ID-52E kompatibel.
 (Stand November 2021)

Für Android-Geräte
RS-MS1A:  Nutzung der erweiterten D-STAR- 

Funktionen, um Bilder oder Nachrich-
ten auszutauschen oder die empfan-
genen D-PRS-Stationsdaten in einer 
Kartensoftware anzuzeigen.

RS-MS3A:  Nutzung der DV-Gateway-Funktion.
ST-4001A:  Erstellung eines Bildes für die  

Share-Picture-Funktion und Über-
tragung auf das Handfunkgerät.

Für iOS-Geräte
RS-MS1I:  Nutzung der erweiterten D-STAR- 

Funktionen, um Bilder oder Nachrich-
ten auszutauschen oder die empfan-
genen D-PRS-Stationsdaten in einer 
Kartensoftware anzuzeigen.

ST-4001I:  Erstellung eines Bildes für die  
Share-Picture-Funktion und Über-
tragung auf das Handfunkgerät.

 DVoraussetzungen
Android-Gerät
Die Apps RS-MS1A/RS-MS3A/ST-4001A sind auf 
Geräten nutzbar, auf denen Android 5.0 oder neuer 
installiert ist.

 LDie Tests erfolgten mit: Android 5.x.x, 6.x.x, 7.x.x, 8.x.x, 
9.0 und 10.0. (Stand November 2021)

iOS-Gerät
Die Apps RS-MS1I/ST-4001I sind auf Geräten nutz-
bar, auf denen die iOS-Version 12 oder neuer bzw.  
die iPadOS-Version 13 oder neuer installiert ist.

 LDie App ST-4001I wurde mit iOS 12 und 13 sowie  
iPadOS 13 getestet. (Stand November 2021)

Haftungsausschluss
 • Je nach Betriebssystemversion, installierten Anwendun-
gen oder anderen Gründen funktioniert die Anwendung 
möglicherweise nicht ordnungsgemäß.

 • Darstellungen oder Menüpunkte können je nach  
Betriebssystemversion oder Einstellungen unterschied-
lich sein.

Bei Nutzung eines USB-Kabels
 • Android-Gerät 
Android 5.0 oder neuer mit USB-Host-Funktion.

 • Kabel (separat zu beschaffen) 
Datenkabel OPC-2417 (USB Micro-B/USB Micro-B) 
oder 
Datenkabel OPC-2418 (USB Micro-B/USB-C)

TIPP: Die USB-Host-Funktion wird benötigt, um ein 
USB-Gerät mit einem Android-Gerät zu verbinden. 
Ob Ihr Gerät über eine solche Funktion verfügt,  
erfahren Sie bei dessen Hersteller.

Bei Nutzung der Bluetooth-Funktion
 • Android-Gerät oder iOS-Gerät 
Android 5.0 oder neuer mit Bluetooth-Funktion. 
oder 
iOS-Version 12 oder neuer, iPadOS-Version 13 
oder neuer mit Bluetooth-Funktion.

 LBei Nutzung der RS-MS3A, kann man kein  
Android-Gerät über Bluetooth mit dem Handfunkgerät 
verbinden.

HINWEIS: Einige Funktionen sind evtl. nicht oder 
nur eingeschränkt nutzbar, wenn:

 • auf dem Mobilgerät andere Applikationen installiert 
sind, die die Funktionalität beeinflussen oder

 • die Speicherkapazität nicht ausreicht.
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Nutzung einer App

 DDownload für ein Android-Gerät
1. Android-Gerät einschalten.
2. Symbol „Play store“ berühren.
3. Den Namen der App ins Suchfeld eingeben.

 LDen Suchbegriff nicht abkürzen, um sicherzustellen, 
dass die richtige App gefunden wird.

4. „ “ berühren.
 • Der Name der App erscheint in den Suchergebnissen.
 LWenn die App nicht kompatibel mit dem Android-Ge-
rät ist, wird sie nicht angezeigt.

5. App zum Installieren berühren.
 • Das Startfenster der App erscheint.

6. <INSTALL> berühren.
 • Die Installation beginnt.
 • Nach erfolgreicher Installation erscheint das Applika-
tionssymbol auf dem Display.

 DDownload für ein iOS-Gerät
1. iOS-Gerät einschalten.
2. Symbol  „App Store“ berühren.
3. Den Namen der App ins Suchfeld eingeben.

 LDen Suchbegriff nicht abkürzen, um sicherzustellen, 
dass die richtige App gefunden wird.

4. „ “ berühren.
 • Der Name der App erscheint in den Suchergebnissen.
 LWenn die App nicht kompatibel mit dem iOS-Gerät 
ist, wird sie nicht angezeigt.

5. App zum Installieren berühren.
 • Das Startfenster der App erscheint.

6. <LADEN> berühren.
 • Die Installation beginnt.
 • Nach erfolgreicher Installation erscheint das Applika-
tionssymbol auf dem Display.

 DNutzung eines USB-Kabels

 LDen USB-Micro-B-Stecker des Kabels (beim OPC-2417 
den mit weißer Ummantelung gekennzeichneten)  
in das Handfunkgerät und den anderen Stecker in das 
Android-Gerät stecken.

HINWEIS:
 • Das Handfunkgerät vor dem Anschließen oder Abzie-
hen eines Kabels ausschalten.

 • Wenn ein Mobilgerät angeschlossen ist, erscheint das 
USB-Verbindungssymbol ( ) im Display des Hand-
funkgeräts. Erscheint die Anzeige nicht, wurde das 
USB-Gerät nicht erkannt.

 LAuf einem Mobilgerät mit automatischer Erkennung 
von USB-Geräten ist keine Bedienung erforderlich.

 • Bei Nutzung der App RS-MS1A ist Folgendes einzustellen: 
([MENU] > SET > Function > CI-V) 
Bei „CI-V Address“ die gleiche Einstellung wählen wie 
in der App RS-MS1A. (voreingestellt: A6)

 LRS-MS1A: Application Settings → CI-V settings 
(voreingestellt: Transceiver[A6])

Bei „CI-V Transceive“ die Einstellung „ON“ wählen. 

([MENU] > SET > Function > USB Serialport Function) 
Bei „USB SerialPort Function“ die Einstellung  
„CI-V (Echo Back OFF)“ wählen. 

([MENU] > SET > Function > USB Connect) 
„USB Connect“ auf „Serialport“ einstellen.

 • Im Access-Point-Modus ist die App RS-MS1A nicht 
nutzbar.

 • Bei Nichtbenutzung ist das USB-Kabel zu entfernen,  
da sich sonst der Akkupack schneller entlädt.

Android-Gerät mit 
USB-Host-Funktion

in die 
[USB]-Buchse

in die 
[USB]-Buchse

USB-Kabel

ID-52E



17 ZUBEHÖR

17-7

Verbindung mit einem Android™-Gerät über Bluetooth®

Bevor man eine Bluetooth-Verbindung mit einem 
Android-Gerät herstellen kann, muss man es koppeln. 
Informationen zum Verbinden des Handfunkgeräts mit 
einem Android-Gerät mithilfe der App RS-MS1A sind 
auf der nächsten Seite zu finden.

 DKopplung mit einem Android-Gerät

HINWEIS: Je nach Bluetooth-Gerät ist eine Kopp-
lung eventuell nicht möglich.

Schritt 1. Kopplungsmodus aufrufen 
 (Handfunkgerät)

[MENU] > SET > Bluetooth Set >  
<<Pairing Reception>>

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „<<Pairing Reception>>“ wählen.

Schritt 2. Bluetooth aufrufen (Android-Gerät)
Bluetooth auf dem Android-Gerät aufrufen.

 • Das Android-Gerät zeigt den Namen der Bluetooth- 
Einheit des Handfunkgeräts an.
 LDer Name der Bluetooth-Einheit lässt sich im  
„BLUETOOTH DEVICE INFO“-Display überprüfen. 
(voreingestellt: ICOM BT(ID-52)) (S. 13-7)
 LEinzelheiten sind in der Bedienungsanleitung des  
Android-Geräts zu finden.

Bluetooth auf dem Android-Gerät innerhalb 
des angezeigten Zeitraums aufrufen.
Ist die Zeit abgelaufen, verlässt das Handfunk-
gerät den Kopplungsmodus.

Schritt 3.  Kopplungsanfrage an das  
Handfunk gerät senden (Android-Gerät)

Den Namen der angezeigten Bluetooth-Einheit wäh-
len, um eine Kopplungsanfrage zu senden.

 • Das Android-Gerät sendet eine Kopplungsanfrage.
 • Auf dem Display des Android-Geräts erscheint die An-
zeige: „To pair with: ICOM BT(ID-52). Make sure it is 
showing this passkey: MMMMM.“

Schritt 4. Kopplungsanfrage empfangen 
 (Handfunkgerät)
1. Empfängt das Handfunkgerät eine Kopplungs-

anfrage, ist zu prüfen, ob der angezeigte Passkey 
übereinstimmt und dann „CONFIRM“ zu wählen. 

 • Die Kopplung beginnt.
2. „Pairing/Connect“ wählen.

Kopplungsliste

Nach erfolgreicher Kopplung wird der Name des 
Android-Geräts in der Kopplungsliste angezeigt.

HINWEIS: Bei der Kopplung von Bluetooth-Gerä-
ten von Fremdherstellern kann die Eingabe eines 
Pin-Codes o. Ä. erforderlich sein. Informationen 
dazu entnehmen Sie bitte der Bedienungsanleitung 
des entsprechenden Geräts.
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Verbindung mit einem Android™-Gerät über Bluetooth®

 DVerbindung
Nachfolgend wird beschrieben, wie man mithilfe der 
App RS-MS1A ein Android-Gerät mit dem Handfunk-
gerät verbindet.
Vor dem Verbinden muss das Handfunkgerät mit dem 
Android-Gerät gekoppelt werden. (S. 17-7)

 LBei Nutzung der Applikation ST-4001A verbinden sich 
Funkgerät und Android-Gerät während der Übertragung 
eines Bildes automatisch.

Schritt 1. Verbindung vorbereiten 
 (Handfunkgerät)

[MENU] > SET > Function > CI-V > CI-V Transceive

Bei „CI-V Transceive“ die Einstellung „ON“ wäh-
len, um das Handfunkgerät und die RS-MS1A mit 
CI-V-Befehlen zu steuern.

Schritt 2. RS-MS1A starten (Android-Gerät)
Zum Starten „RS-MS1A“ berühren.

 LDetails zum Herunterladen der App RS-MS1A s. S. 17-6.

Schritt 3.  Mit dem Handfunkgerät verbinden 
 (Android-Gerät)

Den in der RS-MS1A angezeigten Namen der Blue-
tooth-Einheit des Handfunkgeräts berühren.

 • Die Verbindung wird hergestellt.
 LVor dem Verbinden muss das eigene Rufzeichen im 
Handfunkgerät programmiert werden.
 L Ist die Verbindung erfolgreich hergestellt, erscheinen 
„MMM Connected.“ und das Bluetooth-Symbol im Dis-
play des Handfunkgeräts.

Anzeige des
Bluetooth-Symbols

 L Im „PAIRING/CONNECT“-Display wird „ “ angezeigt.

TIPP: Vom Handfunkgerät aus mit einem  
Android-Gerät verbinden
Wenn die App RS-MS1A auf dem Android-Gerät 
gestartet wurde, kann man sich vom Handfunkgerät 
aus mit dem Android-Gerät verbinden.

[MENU] > SET > Bluetooth Set > Pairing/Connect

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „Pairing/Connect“ wählen.
4. In der Kopplungsliste den Namen des  

Android-Geräts wählen.
5. „YES“ wählen.

 • „MMM Connecting...“ erscheint im Display des 
Handfunkgeräts 
( „MMM“ symbolisiert den Namen des Android- 
Geräts)
 L Im „PAIRING/CONNECT“-Display erscheint „ “ am 
Symbol des Android-Geräts.

HINWEIS: Lässt sich keine Verbindung herstellen,  
ist zu prüfen, ob für das Handfunkgerät und die  
RS-MS1A die gleiche CI-V-Adresse eingestellt wurde.
Die CI-V-Einstellung kann man folgendermaßen 
prüfen:
Handfunkgerät
Über das Menü „CI-V Address“ aufrufen.
([MENU] > SET > Function > CI-V > CI-V Address) 
(voreingestellt: A6)
RS-MS1A:
„Application Settings“ → „CI-V settings“
(voreingestellt: Transceiver[A6])

Gerätename
Anzeige während der  
Verbindung
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Schritt 3.  Kopplungsanfrage an das  
Handfunkgerät senden (iOS-Gerät)

1. In der App „Scan“ berühren.
 • In der App RS-MS1I ist dieser Menüpunkt unter  
„Other“ > „Bluetooth Connection“ zu finden.

 • In der App ST-4001I wird er unter „Transfer Device 
List“ angezeigt. 
( „...“ > Transfer Settings > Using Bluetooth >  
Transfer Device List)

 • Das iOS-Gerät zeigt den Namen der Bluetooth- 
Einheit des Handfunkgeräts an.
 LDer Name der Bluetooth-Einheit lässt sich im  
„BLUETOOTH DEVICE INFO“-Display überprüfen. 
(voreingestellt: ICOM BT(ID-52)) (S. 13-7)

2. Den Namen der angezeigten Bluetooth-Einheit 
wählen, um eine Kopplungsanfrage zu senden.

 • Das iOS-Gerät sendet eine Kopplungsanfrage.
 • Nach der erfolgreichen Kopplung erscheint „Pairing 
is complete“ im Display.

Displayanzeige auf dem Handfunkgerät
Wenn die Verbindung hergestellt ist erscheinen 
„MMM Connected.“ und das Bluetooth-Symbol im 
Display des Handfunkgeräts.
(„MMM“ symbolisiert den Bluetooth-Namen des 
iOS-Geräts.)
 Anzeige des 

Bluetooth-Symbols

 L Im „PAIRING/CONNECT“-Display wird „ “ angezeigt. 

Gerätename
Anzeige während der  
Verbindung

Verbindung mit einem iOS-Gerät über Bluetooth®

Vor dem Verbinden muss das Handfunkgerät mit dem 
iOS-Gerät gekoppelt werden.

 DKopplung mit einem iOS-Gerät

HINWEIS:
 • Die Kopplung mit einem iOS-Gerät ist nicht über die 
Bluetooth-Einstellung des iOS-Betriebssystems mög-
lich. Nutzen Sie dazu die Icom-Applikation.

 • Je nach Bluetooth-Gerät ist eine Kopplung eventuell 
nicht möglich.

HINWEIS: Bei Nutzung der App RS-MS1I
Vor dem Verbinden sind folgende Einstellungen zu 
prüfen:

 • Für das Handfunkgerät muss bei „CI-V Transceive“ die 
Einstellung „ON“ gewählt sein. 
([MENU] > SET > Function > CI-V > CI-V Transceive)

 • Für das Handfunkgerät und die RS-MS1I muss die 
gleiche CI-V-Adresse eingestellt sein.
Handfunkgerät:
Über das Menü „CI-V Address“ aufrufen.
([MENU] > SET > Function > CI-V > CI-V Address)  
(voreingestellt: A6)
RS-MS1I:

 • „Application Settings“ → „Select the default“ 
(voreingestellt: Auto Select)

 • „Application Settings“ → „CI-V address“ 
(voreingestellt: Auto Setting)

Innerhalb des angezeig-
ten Zeitraums muss eine 
Kopplungsanfrage gesendet 
werden (s. Schritt 3). Ist die 
Zeit abgelaufen, verlässt das 
Handfunkgerät den Kopp-
lungsmodus.

Schritt 2. Kopplungsmodus aufrufen 
 (Handfunkgerät)

[MENU] > SET > Bluetooth Set > <<Pairing Reception>>

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „<<Pairing Reception>>“ wählen.

Schritt 1. Applikation starten  (iOS-Gerät)
1. Auf dem iOS-Gerät Bluetooth einschalten.

 LEinzelheiten sind in der Bedienungsanleitung des  
iOS-Geräts zu finden.

2. App-Symbol zum Starten berühren.
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Verbindung mit einem iOS-Gerät über Bluetooth®

 DVerbindung
Im Folgenden wird beschrieben, wie man sich von 
einem iOS-Gerät aus mit dem Handfunkgerät verbin-
det.
Vor dem Verbinden muss das Handfunkgerät mit dem 
iOS-Gerät gekoppelt werden. (S. 17-7)

 LBei Nutzung der Applikation ST-4001A verbinden sich 
Funkgerät und iOS-Gerät während der Übertragung 
eines Bildes automatisch.

Schritt 1. RS-MS1I starten (iOS-Gerät)
Zum Starten „RS-MS1I“ berühren.

 LDetails zum Herunterladen der App RS-MS1I s. S. 17-6.

Schritt 2.  Mit dem Handfunkgerät verbinden 
 (iOS-Gerät)

1. „Other“ berühren.
2. „Bluetooth Connection“ berühren.
3. Zum Verbinden den Namen der Bluetooth-Einheit 

des Handfunkgeräts berühren.
 • Die Verbindung wird hergestellt.
 LVor dem Verbinden muss das eigene Rufzeichen im 
Handfunkgerät programmiert werden.
 L Ist die Verbindung erfolgreich hergestellt, erscheinen 
„MMM Connected.“ und das Bluetooth-Symbol im 
Display des Handfunkgeräts. 

Anzeige des 
Bluetooth-Symbols

 L Im „PAIRING/CONNECT“-Display wird „ “ angezeigt. 

Gerätename
Anzeige während der  
Verbindung

TIPP: Vom Handfunkgerät aus mit einem  
iOS-Gerät verbinden
Wenn die App RS-MS1I auf dem iOS-Gerät gestar-
tet wurde, kann man sich vom Handfunkgerät aus 
mit dem iOS-Gerät verbinden.

[MENU] > SET > Bluetooth Set > Pairing/Connect

1. [MENU] drücken.
2. Im „SET“-Menü „Bluetooth Set“ wählen.
3. „Pairing/Connect“ wählen.
4. In der Kopplungsliste den Namen des  

iOS-Geräts wählen.
5. „YES“ wählen.

 • „MMM Connecting...“ erscheint im Display des 
Handfunkgeräts 
( „MMM“ symbolisiert den Namen des iOS-Geräts)
 L Im „PAIRING/CONNECT“-Display erscheint „ “ am 
Symbol des iOS-Geräts.
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Icom (Europe) GmbH Garantie
(nur gültig für Deutschland und Österreich)

Icom-Produkte sind technisch sowie qualitativ hochwertige Artikel. Die Icom (Europe) GmbH garan -
tiert innerhalb eines Zeitraums von 24 Monaten nach dem Erstkauf für ori ginal durch die Icom
 (Europe) GmbH importierte Geräte.
Die Garantie umfasst alle Ersatzteile und Arbeitsleistungen zur Behebung nachgewiesener Fabrika-
tions- und Materialfehler. Autorisierte Icom-Fachhändler sind verpflichtet, die notwendigen Garantie -
reparaturen durchzuführen und schadhafte Teile an die Icom (Europe) GmbH zurückzusenden. Die
Kosten des Transports zum Icom-Fachhändler trägt der Kunde, die Rücksendung erfolgt zulasten
des Händlers.
Die Garantieleistung entfällt 
� bei allen Schäden, die nachweislich durch unsachgemäße Bedienung entstanden sind,
� nach Reparaturen oder Änderungen durch Unbefugte,
� nach Verwendung ungeeigneter Zusatzgeräte,
� durch Öffnen der versiegelten Bauteile,
� nach Änderungen an der Firmware bzw. am werksseitigen Abgleich,
� bei Schäden durch Stoß oder Fall,
� nach Einwirkung von Feuer, Wasser, Chemikalien, Rauch usw.,
� nach Manipulation oder Nichtvorlage dieser Garantieerklärung,
� für NiCd-Akkus, NiMH-Akkus, Lithium-Ionen-Akkus und Speichermedien.
Durch die Inanspruchnahme der Garantie verlängert sich die Garantiezeit weder für das Gerät noch
für die ausgewechselten Teile.
Diese Garantieerklärung ist zusammen mit dem Erstkauf-Beleg (Rechnung) sorgfältig aufzube-
wahren. Urheberrechtlich geschützt

18.  GARANTIEERKLÄRUNG
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